## Contents

### Preface

- Documentation Conventions ......................................................... 20
- Related Publications ........................................................................ 21
- Customer Support ............................................................................ 21
- Information You Should Have ............................................................ 22
- User Feedback .................................................................................. 23
- Information Builders Consulting and Training .................................... 23

### 1. Using HTML Composer

- Uses for HTML Composer ................................................................. 25
- Getting Started With HTML Composer .............................................. 26  
  - Procedure: How to Access HTML Composer .................................... 27
  - Reference: HTML Composer Windows and Toolbars ...................... 28
  - Reference: Standard Toolbar .......................................................... 30
  - Reference: Components Toolbar .................................................... 31
  - Reference: Formatting Toolbar ........................................................ 35
- Creating a Report Page Layout .......................................................... 36
  - Adding a Report, Graph, or Compound Document to HTML Composer. 37  
    - Procedure: How to Add a New Report or Graph to an HTML Page. 37
    - Procedure: How to Add an Existing Report or Graph to a Layout. 38
    - Reference: Report Properties in the Properties Window ................. 40
    - Reference: Graph Properties in the Properties Window .................. 41
    - Procedure: How to Add a Compound Document to an HTML Page. 41
- Selecting Components to Import Into a Procedure ............................ 42
  - Procedure: How to Select Components to Import Into a Procedure. 42
  - Reference: Manage Layout Dialog Box ............................................. 43
- Adding a Frame to the Layout ............................................................ 44
  - Procedure: How to Add a Frame to the Layout ................................. 44
  - Procedure: How to Assign a URL, HTML File, or Report to a Frame. 45
  - Procedure: How to Show/Hide a Frame in the Layout ..................... 46
  - Reference: Frame Properties in the Properties Window .................... 50
- Adding a Line to the Layout .............................................................. 50
  - Procedure: How to Add a Line to the Layout .................................... 50
  - Reference: Line Properties in the Properties Window ....................... 51
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding an Image to the Layout</td>
<td>52</td>
</tr>
<tr>
<td>Procedure: How to Add an Image to a Layout</td>
<td>52</td>
</tr>
<tr>
<td>Reference: Image Properties in the Properties Window</td>
<td>54</td>
</tr>
<tr>
<td>Adding Flash Content to the Layout</td>
<td>55</td>
</tr>
<tr>
<td>Procedure: How to Add Flash Content to a Layout</td>
<td>55</td>
</tr>
<tr>
<td>Reference: Flash Properties in the Properties Window</td>
<td>56</td>
</tr>
<tr>
<td>Adding Text to the Layout</td>
<td>57</td>
</tr>
<tr>
<td>Procedure: How to Add Text to a Layout</td>
<td>57</td>
</tr>
<tr>
<td>Procedure: How to Format Text in the Layout</td>
<td>58</td>
</tr>
<tr>
<td>Procedure: How to Insert a Bulleted or Numbered List Into a Text Element</td>
<td>59</td>
</tr>
<tr>
<td>Procedure: How to Insert Nested Lists Into a Text Element</td>
<td>60</td>
</tr>
<tr>
<td>Reference: Text Properties in the Properties Window</td>
<td>62</td>
</tr>
<tr>
<td>Adding a Hyperlink to the Layout</td>
<td>62</td>
</tr>
<tr>
<td>Procedure: How to Create a Hyperlink</td>
<td>65</td>
</tr>
<tr>
<td>Procedure: How to Add a Hyperlink to a Push Button or an Image</td>
<td>67</td>
</tr>
<tr>
<td>Adding a Group Box to the Layout</td>
<td>67</td>
</tr>
<tr>
<td>Procedure: How to Add a Group Box</td>
<td>68</td>
</tr>
<tr>
<td>Reference: Group Box Properties in the Properties Window</td>
<td>69</td>
</tr>
<tr>
<td>Adding a Push Button to the Layout</td>
<td>69</td>
</tr>
<tr>
<td>Procedure: How to Create a Push Button in Place of a Submit Button.</td>
<td>69</td>
</tr>
<tr>
<td>Procedure: How to Run Multiple Reports With One Submit Button</td>
<td>70</td>
</tr>
<tr>
<td>Reference: Push Button Properties in the Properties Window</td>
<td>73</td>
</tr>
<tr>
<td>Maintain From HTML Composer</td>
<td>74</td>
</tr>
<tr>
<td>Adding a Reset Button to the Layout</td>
<td>74</td>
</tr>
<tr>
<td>Procedure: How to Create a Reset Button</td>
<td>74</td>
</tr>
<tr>
<td>Reference: Reset Button Properties in the Properties Window</td>
<td>75</td>
</tr>
<tr>
<td>Adding a Tab Control to the Layout</td>
<td>75</td>
</tr>
<tr>
<td>Procedure: How to Create a Tab Control</td>
<td>76</td>
</tr>
<tr>
<td>Procedure: How to Enable Full Screen Mode for the Tab Control</td>
<td>77</td>
</tr>
<tr>
<td>Procedure: How to Add Additional Tabs</td>
<td>80</td>
</tr>
<tr>
<td>Reference: Tab Control Properties in the Properties Window</td>
<td>82</td>
</tr>
<tr>
<td>Procedure: How to Modify and Style the Tabs</td>
<td>83</td>
</tr>
<tr>
<td>Procedure: How to Modify the Size, Appearance, and Location of the Tabs</td>
<td>83</td>
</tr>
<tr>
<td>Procedure: How to Use the Tab Item Background Properties Field</td>
<td>84</td>
</tr>
<tr>
<td>Procedure: How to Add Background Images to Tabs</td>
<td>85</td>
</tr>
<tr>
<td>Procedure</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Procedure: How to Send the Display Value for Static and Dynamic Controls.</td>
<td>139</td>
</tr>
<tr>
<td>Procedure: How to Use Procedure Names as Values.</td>
<td>147</td>
</tr>
<tr>
<td>Procedure: How to Use Selected Values as the Default Value.</td>
<td>151</td>
</tr>
<tr>
<td>Updating Parameters in HTML Composer With Report Painter Changes.</td>
<td>158</td>
</tr>
<tr>
<td>Using Controls to Supply Incoming Parameter Values</td>
<td>158</td>
</tr>
<tr>
<td>Automatically Creating Controls From the New Parameters Dialog Box.</td>
<td>159</td>
</tr>
<tr>
<td>Procedure: How to Manually Create a Control in the Layout.</td>
<td>161</td>
</tr>
<tr>
<td>Procedure: How to Change the Type of Control Associated With a Parameter.</td>
<td>163</td>
</tr>
<tr>
<td>Procedure: How to Bind or Unbind a Parameter To/From an Existing Control.</td>
<td>164</td>
</tr>
<tr>
<td>Reference: Types of Controls.</td>
<td>164</td>
</tr>
<tr>
<td>Using the Delete Container Only Option.</td>
<td>165</td>
</tr>
<tr>
<td>Using Input Controls to Supply Parameter Values</td>
<td>166</td>
</tr>
<tr>
<td>Using a Text Box</td>
<td>167</td>
</tr>
<tr>
<td>Procedure: How to Create a Text Box</td>
<td>167</td>
</tr>
<tr>
<td>Procedure: How to Enter Masked Text in a Text Box.</td>
<td>168</td>
</tr>
<tr>
<td>Reference: Text Box Properties in the Properties Window.</td>
<td>170</td>
</tr>
<tr>
<td>Using a Text Area</td>
<td>171</td>
</tr>
<tr>
<td>Procedure: How to Create a Text Area</td>
<td>171</td>
</tr>
<tr>
<td>Reference: Text Area Properties in the Properties Window.</td>
<td>173</td>
</tr>
<tr>
<td>Using a Drop-Down List</td>
<td>173</td>
</tr>
<tr>
<td>Procedure: How to Add a Drop-Down List</td>
<td>174</td>
</tr>
<tr>
<td>Procedure: How to Select Multiple Values From a Drop-Down List.</td>
<td>175</td>
</tr>
<tr>
<td>Reference: Drop-Down List Properties in the Properties Window.</td>
<td>178</td>
</tr>
<tr>
<td>Using a List Box</td>
<td>178</td>
</tr>
<tr>
<td>Procedure: How to Add a List Box</td>
<td>179</td>
</tr>
<tr>
<td>Reference: List Box Properties in the Properties Window.</td>
<td>180</td>
</tr>
<tr>
<td>Procedure: How to Reorder the Selected Values in the List Box.</td>
<td>181</td>
</tr>
<tr>
<td>Using a Double List Control</td>
<td>181</td>
</tr>
<tr>
<td>Procedure: How to Add a Double List Control</td>
<td>182</td>
</tr>
<tr>
<td>Reference: Double List Box Properties in the Properties Window.</td>
<td>185</td>
</tr>
<tr>
<td>Adding a Paging Control in HTML Composer</td>
<td>185</td>
</tr>
<tr>
<td>Procedure: How to Add a Paging Control</td>
<td>186</td>
</tr>
<tr>
<td>Adding a Search Control in HTML Composer</td>
<td>191</td>
</tr>
<tr>
<td>Procedure: How to Add a Search Control</td>
<td>191</td>
</tr>
<tr>
<td>Using Global Search and Paging</td>
<td>193</td>
</tr>
<tr>
<td>Procedure</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Procedure: How to Enable Global Search and Paging.</td>
<td>194</td>
</tr>
<tr>
<td>Reference: Use Search and Paging Features.</td>
<td>198</td>
</tr>
<tr>
<td>Using Check Boxes.</td>
<td>198</td>
</tr>
<tr>
<td>Procedure: How to Add Check Boxes.</td>
<td>199</td>
</tr>
<tr>
<td>Reference: Check Box Properties in the Properties Window.</td>
<td>201</td>
</tr>
<tr>
<td>Using Radio Buttons.</td>
<td>201</td>
</tr>
<tr>
<td>Procedure: How to Add Radio Buttons.</td>
<td>201</td>
</tr>
<tr>
<td>Reference: Radio Buttons Properties in the Properties Window.</td>
<td>205</td>
</tr>
<tr>
<td>Using Tree Controls.</td>
<td>205</td>
</tr>
<tr>
<td>Procedure: How to Add a Tree Control to an HTML Page Using an Embedded</td>
<td>206</td>
</tr>
<tr>
<td>Procedure.</td>
<td></td>
</tr>
<tr>
<td>Procedure: How to Add a Tree Control to an HTML Page Using an Existing</td>
<td>207</td>
</tr>
<tr>
<td>Procedure.</td>
<td></td>
</tr>
<tr>
<td>Procedure: How to Populate a Multi Source Tree Control.</td>
<td>208</td>
</tr>
<tr>
<td>Procedure: How to Add a Tree Control to an HTML Page Using Static Values.</td>
<td>208</td>
</tr>
<tr>
<td>Procedure: How to Create a New Tree Control From the New Parameters Dialog</td>
<td>208</td>
</tr>
<tr>
<td>Box.</td>
<td>220</td>
</tr>
<tr>
<td>Reference: Usage Notes For Chaining Tree Controls.</td>
<td>222</td>
</tr>
<tr>
<td>Reference: Tree Control Properties in the Properties Window.</td>
<td>230</td>
</tr>
<tr>
<td>Using a Slider Control.</td>
<td>231</td>
</tr>
<tr>
<td>Procedure: How to Add a Slider Control.</td>
<td>231</td>
</tr>
<tr>
<td>Procedure: How to Change the Default Slider Bar.</td>
<td>233</td>
</tr>
<tr>
<td>Reference: Slider Control Properties in the Properties Window.</td>
<td>234</td>
</tr>
<tr>
<td>Adding a Dynamic Calendar.</td>
<td>235</td>
</tr>
<tr>
<td>Procedure: How to Set Calendar Properties.</td>
<td>235</td>
</tr>
<tr>
<td>Reference: Date Formats.</td>
<td>238</td>
</tr>
<tr>
<td>Reference: Calendar Properties in the Properties Window.</td>
<td>241</td>
</tr>
<tr>
<td>Using a Hidden Parameter Value.</td>
<td>243</td>
</tr>
<tr>
<td>Procedure: How to Add a Hidden Control.</td>
<td>243</td>
</tr>
<tr>
<td>Creating Hyperlink Actions With Additional Parameters.</td>
<td>245</td>
</tr>
<tr>
<td>Procedure: How to Create a Hyperlink Action With Additional Parameters.</td>
<td>245</td>
</tr>
<tr>
<td>Binding a Button, Hyperlink, or Image to Populate a Control.</td>
<td>247</td>
</tr>
<tr>
<td>Procedure: How to Bind a Button to Populate a Control.</td>
<td>248</td>
</tr>
<tr>
<td>Procedure: How to Use Controls to Populate Another Control Based on Selected Values</td>
<td>254</td>
</tr>
</tbody>
</table>
Supplying Parameter Values to External Reports .................................................. 258
  Procedure: How to Supply Parameter Values to External Reports With a Push Button. 258
  Procedure: How to Supply Parameter Values to an External Report With an Image .... 260
  Procedure: How to Supply Parameter Values to an External Report With a Hyperlink. 261
  Procedure: How to Supply a Parameter Value to a Report Using a URL ............... 265
  Procedure: How to Pass a Parameter From One Page to Another .................... 267

Styling Your Layout ................................................................................................. 272
  Adding a CSS or Script to the Layout ................................................................. 272
    Procedure: How to Add a CSS or Script to the Layout ................................ 273
  Setting HTML Page Properties ........................................................................ 273
    Reference: HTML Page Properties in the Properties Window ..................... 274
  Customizing the Layout ...................................................................................... 274

Specifying Browser Defaults With the Style Composer ........................................ 275
  Procedure: How to Access the Style Composer .............................................. 275
  Reference: Specifying Font Styles Using the Style Composer ..................... 276
  Reference: Specifying Background Properties Using the Style Composer ....... 277
  Reference: Specifying Text Styles Using the Style Composer ..................... 278
  Reference: Specifying Position Mode Using the Style Composer ............... 279
  Reference: Specifying Layout Styles Using the Style Composer ............... 281
  Reference: Specifying Edge Styles Using the Style Composer ................ 282
  Reference: Specifying List Styles Using the Style Composer ................... 283
  Reference: Specifying Interface Effects Using the Style Composer ........... 284

Laying Out Objects With HTML Composer .......................................................... 285
  Setting Relationships Between Objects ......................................................... 285
    Procedure: How to Set Object Size .......................................................... 285
    Procedure: How to Set the Distance Between Objects ......................... 286
    Procedure: How to Break Relationships .................................................. 286
    Procedure: How to Group Objects on the HTML Page ....................... 286
    Reference: Positioning Toolbar ............................................................... 287
    Reference: Utilities Toolbar ..................................................................... 290

Controlling the HTML Composer Environment .................................................... 291
  Procedure: How to Set Page Properties ..................................................... 291
  Procedure: How to Select Form Settings From the HTML Page Tab .......... 291
  Reference: HTML Page Tab .......................................................................... 294
  Reference: Form Settings Dialog Box .......................................................... 298
3. Using Templates in HTML Composer .................................................. 327
   Understanding and Using Templates ................................................. 327
      Reference: The Template Selector ............................................... 328
      Reference: Report Sets ............................................................... 330
      Procedure: How to Use the Template Selector ................................ 331
      Reference: Tabbed and Non-Tabbed Template Types ......................... 332
      Procedure: How to Turn the Template Selector On ............................ 333
      Reference: Template Usage Notes ............................................... 334
   Manipulating the Objects of Templates ............................................ 335
      Procedure: How to Insert Additional Report or Chart Frames ............. 335
      Procedure: How to Insert Additional Hyperlinks in Advanced Templates .. 336
      Procedure: How to Reorder Elements ......................................... 337
      Reference: Properties Restricted By Templates ................................ 338
      Procedure: How to Unlock a Template ......................................... 338

4. Creating Guided Report Forms ......................................................... 341
   Getting Started With Guided Reports .............................................. 341
      Procedure: How to Access Guided Report Mode ................................ 341
      Procedure: How to Create a Guided Report Form Using Templates .......... 343
      Procedure: How to Create a Guided Report Form Without Templates .......... 345
      Reference: New Parameters Dialog Box ............................................ 347
5. **Chaining Controls for Dependencies in HTML Composer** .......................... 351

- Automatically Chaining Parameters From the New Parameters Dialog Box .................. 352
- Procedure: How to Auto Chain Controls From the New Parameters Dialog Box. .......... 352
- Procedure: How to Chain Controls From the New Parameters Dialog Box .................. 355

- Chaining Controls on the Parameters Tab ..................................................... 358
- Procedure: How to Chain Controls on the Parameters Tab ................................. 358
- Procedure: How to Remove a Link in the Chain. .......................................... 359
- Procedure: How to Reverse the Order of Chained Controls ............................... 360

- Setting the Default Link .................................................................................. 363

- Applying Conditions to a Chain ...................................................................... 364
  - Reference: Properties and Settings Dialog Box (Conditions). ......................... 364
  - Procedure: How to Create a New Condition .................................................. 367
  - Procedure: How to Select the Action for a Condition ..................................... 368
  - Procedure: How to Select the Values Compare Operator for a Condition .......... 368
  - Procedure: How to Apply Selected Values With a Multiselect Operator to a Condition ... 369
  - Procedure: How to Resolve Parameters for a Condition .............................. 375
  - Procedure: How to Select the Compare Operator for the Parameter ................. 376
  - Procedure: How to Enable Cache Processing for Chained Values .................. 377

- Populating Controls One at a Time .................................................................. 385
  - Procedure: How to Populate Controls One at a Time ................................... 386

- Using the Chain Separator and Line Separator .............................................. 388
  - Procedure: How to Use the Chain Separator and Line Separator ................... 389

6. **Creating Active Technologies Dashboards With HTML Composer** .............. 393

- Binding Objects to an Active Technologies Report ........................................... 393
  - Procedure: How to Synchronize Report and Chart Objects to Active Technologies Reports .................................................. 394
  - Procedure: How to Show Synchronized Active Technologies Report Groups .. 396
  - Procedure: How to Select Properties for Synchronized Reports .................... 397
  - Procedure: How to Delete an Active Technologies Report Object ................. 398

- Configuring Active Technologies Controls in HTML Composer ....................... 398
  - Procedure: How to Add an Active Technologies Control to the Layout ............ 399
  - Reference: Properties and Settings Dialog Box (Active Technologies Reports) .... 399
  - Procedure: How to Configure an Active Technologies Control ..................... 403

- Refreshing Active Technologies Reports ......................................................... 407
Syntax: How to Pan To a Point ................................................................. 528
Function: showAllMarkers('mapId'). .................................................. 529
Syntax: How to Show All Map Markers .............................................. 529
Function: drawBullseye('mapId', 'lat', 'long', 'selectmarkers', 'units', 'rings', '(list-of-sizes)',
 '(list-of-colors)') ........................................................................... 529
Syntax: How to Draw a Bullseye ......................................................... 529
ESRI Flex Viewer Integration ............................................................... 531

10. Using Visual Discovery in HTML Composer ........................................ 533
Creating Visual Discovery Output Files ............................................ 533
Reference: Format Conversions for FORMAT VISDIS. .......................... 534
Procedure: How to Create a Visual Discovery Output File From Report Painter ............................................ 534
Syntax: How to Create a Visual Discovery Output File Using WebFOCUS Language ........................................ 535
Developing an Analytic Dashboard From Developer Studio .................. 536
Procedure: How to Create a WebFOCUS Visual Discovery Analytic Dashboard ............................................. 537
Naming Controls .................................................................................. 538
Selecting Data ...................................................................................... 538
Procedure: How to Add and Select Data .............................................. 538
Reference: Properties and Settings Dialog Box ................................. 539
Reference: Data Tab ............................................................................ 539
Reference: Data Tab Icons ................................................................. 540
Assigning Color to the Data and the Graph ....................................... 541
Procedure: How to Change Graph Element Colors ............................ 542
Reference: Colors Tab ....................................................................... 543
Coloring a Graph by a Field .............................................................. 546
Procedure: How to Color a Graph by a Selected Field ....................... 546
Values are VisDis Color By ............................................................... 547
Procedure: How to Color a Visual Discovery Control Using Values are VisDis Color By ........................................ 547
Choosing Selection Options .............................................................. 550
Reference: Selecting Tab ................................................................. 551
Specifying Fonts and Titles ............................................................... 553
Reference: Fonts Tab ....................................................................... 553
Reference: Titles Tab ....................................................................... 554
Using Goal Lines .............................................................................. 554
Procedure: How to Add Goal Lines ........................................... 554
Procedure: How to Move Goal Lines ........................................ 555
Procedure: How to Hide Goal Lines ........................................ 555
Procedure: How to Remove Goal Lines .................................... 555
Procedure: How to Select Values Above/Below the Goal Line ....... 555

Animating Data ........................................................................ 555
Procedure: How to Animate a Bar, Line, or Pie Chart ................. 556

Selecting Primary and Secondary Order .................................... 556
Procedure: How to Select Primary and Secondary Order .............. 556

Displaying Labels .................................................................... 557
Procedure: How to Select Label Mode ....................................... 557
Procedure: How to Show or Hide Individual Labels Using the Pop-up Menu .................................................. 558

Preselecting Values .................................................................. 558
Procedure: How to Preselect Values ........................................ 558

Passing Between a Report and a Visual Discovery Control .......... 559
Procedure: How to Pass a Parameter From a Visual Discovery Control to a Report ......................................................... 559
Procedure: How to Pass a Parameter From a Report to a Visual Discovery Control ..................................................... 561

Chaining Into a Visual Discovery Control ................................ 564
Procedure: How to Chain Into a Visual Discovery Control ......... 564

Excluding and Restoring Data .................................................. 567
Procedure: How to Exclude and Restore Data ........................... 567

Working With Visual Discovery Controls on the Web ................ 569
Selecting Data ........................................................................ 569
Restoring Excluded Data ........................................................ 569
Changing the Display ............................................................. 569

Saving a Control as an Image .................................................. 570
Saving the State of Analysis .................................................... 570
Reference: BookMarks Tab .................................................... 570

Accessing Visual Discovery Online Help ................................ 571
Procedure: How to Access Visual Discovery Online Help ........... 571

Visual Discovery Tutorial ....................................................... 574
Before You Begin .................................................................... 575
Building an Analytic Dashboard With Visual Discovery Components .......................................................... 575
11. Tutorial: Creating a Reporting Application Using HTML Composer .............. 615

11. Tutorial: Creating a Reporting Application Using HTML Composer .............. 615

HTML Composer Tutorial Overview .................................................. 615
Creating the Century Project ............................................................... 616
  Add Master Files to Your Project .................................................... 616
  Add the CENTORD Data Source to Your Project ............................... 617
Creating the Graph ............................................................................ 618
  Procedure: How to Create the Graph ............................................... 618
  Procedure: How to Create a Heading for the Graph ............................ 619
  Procedure: How to Limit Graphed Data ............................................ 619
Creating the Layout and the Report ..................................................... 621
  Procedure: How to Create the Report Layout ..................................... 621
  Procedure: How to Add Text and Color to the Layout .......................... 622
  Procedure: How to Create a Report From the Layout ........................... 623
  Procedure: How to Add a Calculated Value to the Report .................... 625
  Procedure: How to Limit the Data to a Selected Plant and Year .......... 627
  Procedure: How to Create a Page Heading for the Report ..................... 630
  Procedure: How to Style Your Report .............................................. 631
  Procedure: How to Set Up the Drill-Down Report ................................ 634
  Procedure: How to Customize Parameters ......................................... 637
12. Accessing an HTML Composer Application on a Mobile Device ................. 647
   Using an HTML Composer Application on an iPad or iPhone ......................... 647
   Double List Controls ................................................................. 647
   Scrolling ......................................................................................... 650
   Slider Controls .................................................................................. 651
   Chained Controls ............................................................................... 651
   Using an HTML Application on an Android Device ........................................ 652
   Double List Controls ........................................................................... 652
A. CSS Support Matrix for Browsers ......................................................... 653
   CSS Support Matrix for Internet Explorer .................................................... 653
   CSS Support Matrix for Firefox, Chrome, Safari, and Opera ....................... 656
B. CSS Class Mapping .................................................................................. 663
   CSS Class Mapping List ............................................................................ 663
C. Glossary ................................................................................................. 671
Customer Connections .................................................................................. 685
Preface

This documentation describes how to create a user interface in the local development environment with HTML Composer, and how to use Google Maps in HTML Composer. It is intended for developers.

Note: The WebFOCUS toolset generates the rich FOCUS fourth generation language. While this language is very extensive, the WebFOCUS toolset only supports a subset of the language and only specific syntax constructs. While the user can manually modify the content of these WebFOCUS procedures or files, there is no guarantee that the user will be able to open the modified procedure in the tool.

How This Manual Is Organized

This manual includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter/Appendix</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Using HTML Composer</td>
<td>Describes how to create a user interface in the local development environment using HTML Composer.</td>
</tr>
<tr>
<td>2 Creating and Using Parameters in HTML Composer</td>
<td>Describes how to create and use parameter values and input controls.</td>
</tr>
<tr>
<td>3 Using Templates in HTML Composer</td>
<td>Describes how to access and use predefined templates in HTML Composer.</td>
</tr>
<tr>
<td>4 Creating Guided Report Forms</td>
<td>Describes how to create Guided Report Forms using the Guided Report Mode feature in HTML Composer.</td>
</tr>
<tr>
<td>5 Chaining Controls for Dependencies in HTML Composer</td>
<td>Describes how to chain controls for dependencies. Chaining populates controls based on the selected value from the prior control in the chain.</td>
</tr>
<tr>
<td>6 Creating Active Technologies Dashboards With HTML Composer</td>
<td>Describes the process of creating active dashboards in HTML Composer.</td>
</tr>
</tbody>
</table>
## Chapter/Appendix | Contents
--- | ---
7 | Report Library Integration in HTML Composer
   | Describes how to integrate Report Library reports into an HTML Composer page and how to integrate a report with a Table of Contents and On Demand Paging.
8 | Creating a Rich Internet Application (RIA) With HTML Composer
   | Describes how to create a Rich Internet Application (RIA) in the local development environment using HTML Composer.
9 | Using Maps in HTML Composer
   | Describes how to integrate Google®, Bing®, and ESRI® JavaScript API Maps with reports generated from HTML Composer.
10 | Using Visual Discovery in HTML Composer
   | Describes how to develop an analytic dashboard. This topic covers tasks and options available for all the different graph components.
11 | Tutorial: Creating a Reporting Application Using HTML Composer
   | Describes how to use HTML Composer to create a layout in which you can insert text, an image, a report, a frame for drill-down output, and selection parameters. During this tutorial, you will directly access other tools, such as InfoAssist Graph and Report Painter, to create procedures and an HTML form.
12 | Accessing an HTML Composer Application on a Mobile Device
   | Describes certain issues when accessing an HTML Composer application on a mobile device.
A | CSS Support Matrix for Browsers
   | Describes which browsers support certain CSS properties.
B | CSS Class Mapping
   | This section contains two lists. One is a list of IBI classes that are used to style various components and controls. The second list contains the definitions for these IBI classes as defined in the Default_Theme.css file and ibi.css file. The ibi.css file is the css file that is used for the default Information Builders theme.
C | Glossary
   | Describes key terms found in this manual.

### Documentation Conventions

The following table describes the documentation conventions that are used in this manual.
<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>THIS TYPEFACE</strong></td>
<td>Denotes syntax that you must enter exactly as shown.</td>
</tr>
<tr>
<td>or</td>
<td></td>
</tr>
<tr>
<td><strong>this typeface</strong></td>
<td></td>
</tr>
<tr>
<td><strong>this typeface</strong></td>
<td>Represents a placeholder (or variable) in syntax for a value that you or the system must supply.</td>
</tr>
<tr>
<td><strong>underscore</strong></td>
<td>Indicates a default setting.</td>
</tr>
<tr>
<td><strong>this typeface</strong></td>
<td>Represents a placeholder (or variable), a cross-reference, or an important term. It may also indicate a button, menu item, or dialog box option that you can click or select.</td>
</tr>
<tr>
<td><strong>Key + Key</strong></td>
<td>Indicates keys that you must press simultaneously.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>{  }</strong></td>
<td>Indicates two or three choices. Type one of them, not the braces.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>[  ]</strong></td>
<td>Indicates a group of optional parameters. None are required, but you may select one of them. Type only the parameter in the brackets, not the brackets.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>**</td>
<td>**</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>...</strong></td>
<td>Indicates that you can enter a parameter multiple times. Type only the parameter, not the ellipsis (...).</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>.</strong></td>
<td>Indicates that there are (or could be) intervening or additional commands.</td>
</tr>
</tbody>
</table>

**Related Publications**

Visit our Technical Content Library at [http://documentation.informationbuilders.com](http://documentation.informationbuilders.com). You can also contact the Publications Order Department at (800) 969-4636.

**Customer Support**

Do you have questions about this product?
Join the Focal Point community. Focal Point is our online developer center and more than a message board. It is an interactive network of more than 3,000 developers from almost every profession and industry, collaborating on solutions and sharing tips and techniques. Access Focal Point at http://forums.informationbuilders.com/eve/forums.

You can also access support services electronically, 24 hours a day, with InfoResponse Online. InfoResponse Online is accessible through our website, http://www.informationbuilders.com. It connects you to the tracking system and known-problem database at the Information Builders support center. Registered users can open, update, and view the status of cases in the tracking system and read descriptions of reported software issues. New users can register immediately for this service. The technical support section of http://www.informationbuilders.com also provides usage techniques, diagnostic tips, and answers to frequently asked questions.

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212) 736-6130. Customer Support Consultants are available Monday through Friday between 8:00 a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can also give you general guidance regarding product capabilities. Please be ready to provide your six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders representative about InfoResponse Online, or call (800) 969-INFO.

Information You Should Have

To help our consultants answer your questions effectively, be prepared to provide the following information when you call:

- Your six-digit site code (xxxx.xx).
- Your WebFOCUS configuration:
  - The front-end software you are using, including vendor and release.
  - The communications protocol (for example, TCP/IP or HLLAPI), including vendor and release.
  - The software release.
  - Your server version and release. You can find this information using the Version option in the Web Console.
  - The stored procedure (preferably with line numbers) or SQL statements being used in server access.
- The Master File and Access File.
- The exact nature of the problem:
Are the results or the format incorrect? Are the text or calculations missing or misplaced?

Provide the error message and return code, if applicable.

Is this related to any other problem?

Has the procedure or query ever worked in its present form? Has it been changed recently? How often does the problem occur?

What release of the operating system are you using? Has it, your security system, communications protocol, or front-end software changed?

Is this problem reproducible? If so, how?

Have you tried to reproduce your problem in the simplest form possible? For example, if you are having problems joining two data sources, have you tried executing a query containing just the code to access the data source?

Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do you just have questions about functionality or documentation?

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff welcomes your opinions regarding this document. You can contact us through our website http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates, or to register for classes, visit our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an Education Representative.
Using HTML Composer

HTML Composer enables you to graphically create an HTML page that incorporates forms, reports, graphs, and web objects. You can invoke Maintain procedures using hyperlinks. HTML Composer is fully integrated with JavaScript and Cascading Style Sheets (CSS).

This section describes how to create a user interface in the local development environment. For information on creating a user interface in Managed Reporting, see your Managed Reporting documentation.

To take advantage of a tutorial on HTML Composer, see Tutorial: Creating a Reporting Application Using HTML Composer on page 615.

**Note:** HTML Composer does not support OLAP-enabled reports.

**In this chapter:**
- Uses for HTML Composer
- Getting Started With HTML Composer
- Creating a Report Page Layout

**Uses for HTML Composer**

You can do the following when creating an HTML form:

- Build an HTML webpage. HTML Composer enables you to add push buttons, hyperlinks, and other objects that launch other WebFOCUS reports in your application.

- Build an HTML page using predefined templates. The Template selector enables you to create an HTML page with a selected color scheme and layout. For more information on templates, see Using Templates in HTML Composer on page 327.


- Create a webpage for one or more reports that contain parameters.

- Create a webpage for WebFOCUS Maintain procedures, or run reports and Maintain procedures from the same HTML page.
Create a complete dashboard by adding multiple reports and graphs into a single HTML page.

Create an advanced report layout by including images, frames, and other web elements. You can change the location, size, and properties of all objects in your layout.

Set background, font, and other properties in the Style Composer tool.

Create a Rich Internet Application (RIA) to create an interactive webpage experience inside a browser. For details, see Creating a Rich Internet Application (RIA) With HTML Composer on page 431.

**Getting Started With HTML Composer**

You can create procedures and HTML forms in one integrated process with HTML Composer. When you save your layout, the procedures are embedded in the HTML file, creating a single file for your application.

You can build HTML pages using templates and/or Guided Report Mode. These features are designed to simplify and automate a majority of the process that goes into creating HTML pages. For more information on templates, see Using Templates in HTML Composer on page 327. For more information on Guided Report Mode, see Creating Guided Report Forms on page 341.

**Note:** HTML Composer does not support OLAP-enabled reports. If you execute a report from HTML Composer with this option, the output window will not display the OLAP controls, and you will receive a scripting error. In order to execute this type of report, you must use a frame. For more information, see Adding a Frame to the Layout on page 44.
Procedure: How to Access HTML Composer

1. Create a new HTML file by completing one of these actions:
   - With the HTML Files folder under localhost highlighted, select New from the File menu, then select HTML File.
   - or
   - Click Layout reports and graphs in the QuickLinks pane to create a new HTML file using Guided Report mode.
   - With the HTML Files folder under localhost highlighted, select New from the File menu, then select Guided Report Form.

   The Add HTML File dialog box opens.

   ![Add HTML File dialog box](image)

2. Enter a name for the new HTML file in the File name field.
3. Ensure that Composer is selected in the Create with field.
4. Click Open.

   The Template selector window opens. To create an HTML page without using templates, select Cancel. For more information on using templates, see Using Templates in HTML Composer on page 327.
You can select the Guided Report Mode check box to create a Guided Report Form. If you chose to create a HTML file using Guided Report Mode, for more information, see Creating Guided Report Forms on page 341.

Reference: HTML Composer Windows and Toolbars

The following image is an example of HTML Composer.

![HTML Composer Example](image)

The main elements of HTML Composer are:

**Menu Bar**

Displays pull-down menus for HTML Composer.

**Developer Studio Toolbar**

Displays tool buttons, such as Open and Run. For details, see the Creating Reporting Applications With Developer Studio manual.

**Standard Toolbar**

Displays buttons, such as Cut and Paste, that allow you to edit the layout.

**Components Toolbar**

Contains buttons that add reporting objects and controls to the layout.
**Formatting Toolbar**

Displays buttons that format and align text when using a text element in the layout.

**Positioning Toolbar**

Contains buttons that control the appearance of the layout. For details, see *Positioning Toolbar* on page 287.

**Utilities Toolbar**

Contains buttons that control synchronization and chaining. For details, see *Utilities Toolbar* on page 290.

**Properties Window**

Displays the Properties tab, which contains the Properties subtab and the Events subtab when an object is selected in the layout. The Properties window also contains the Thumbnails tab.

- The Properties subtab contains options for the properties of the object.
- The Events subtab displays the JavaScript events associated with objects in the layout.

For details, see *Working With the Properties Window* on page 88.

**Thumbnails Tab**

Enables you to view a thumbnail of the page layout. Thumbnail view allows objects on the page to participate in actions with controls on the Parameters tab. You may also refresh the Thumbnails tab, enlarge or reduce the thumbnails, and change the zoom levels. Reports and graphs appear as placeholder objects on the Thumbnails tab.

**QuickLinks Window**

Displays links to information on Help, configuration options, metadata creation, and reports and procedures.

**Note:** QuickLinks is turned off by default. If you need to access QuickLinks, select *QuickLinks* from the View menu (when you are in the Developer Studio Explorer).

**Design Tab**

Displays the design view where you can add and position objects to the layout.

**Parameters Tab**

Displays information about the parameter values and input controls in your report or graph. For details, see *Working With the Parameters Tab* on page 98.
**Embedded JavaScript**

Displays the HTML code and the JavaScript code for objects in the HTML layout.

**Note:** You may reorder the position of the Design tab, Parameters tab, and Embedded JavaScript by left-clicking and dragging the tabs on the bottom of the HTML layout.

---

**Reference: Standard Toolbar**

The Standard toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Folder" /></td>
<td>Saves the HTML file to the current project. This button is dimmed once the layout is saved and no new changes have been made. When a change has been made to the layout, the Save button is active until the layout is saved again.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Delete" /></td>
<td>Removes the highlighted object(s) and saves it to the clipboard.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Copy" /></td>
<td>Copies the highlighted object(s) to the clipboard.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Paste" /></td>
<td>Pastes the object(s) to the specified location.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Delete" /></td>
<td>Deletes the highlighted object(s).</td>
</tr>
<tr>
<td><img src="image5.png" alt="Undo" /></td>
<td>Resets the layout by reversing the last action performed.</td>
</tr>
</tbody>
</table>
### Button | Description
--- | ---
![Refresh](refresh_icon.png) | Repeats the last action performed.

The Refresh All option enables you to view any edits or changes that you made to your layout. Refresh All reloads all objects and reruns the reports and graphs in Design view.

**Note:** Refresh also shows changes made to reports and graphs that are referenced in your layout.

### Components Toolbar
The Components toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Report](report_icon.png) | Inserts a report object to the layout.  
For details, see *Adding a Report, Graph, or Compound Document to HTML Composer* on page 37. |
| ![Graph](graph_icon.png) | Inserts a graph object to the layout.  
For details, see *Adding a Report, Graph, or Compound Document to HTML Composer* on page 37. |
| ![Control](control_icon.png) | Inserts a placeholder for a control.  
For details, see *Using Controls to Supply Incoming Parameter Values* on page 158. |
| ![IFrame](iframe_icon.png) | Inserts a placeholder for an IFRAME. An IFRAME can have its own URL and contain HTML content, and it can be a placeholder for a drill-down report.  
For details, see *Adding a Frame to the Layout* on page 44. |
<table>
<thead>
<tr>
<th><strong>Button</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Image" /></td>
<td>Inserts a placeholder for an image. For details, see <em>Adding an Image to the Layout</em> on page 52.</td>
</tr>
<tr>
<td><img src="text.png" alt="Text" /></td>
<td>Inserts text. For details, see <em>Adding Text to the Layout</em> on page 57.</td>
</tr>
<tr>
<td><img src="line.png" alt="Line" /></td>
<td>Inserts a line. For details, see <em>Adding a Line to the Layout</em> on page 50.</td>
</tr>
<tr>
<td><img src="group-box.png" alt="Group Box" /></td>
<td>Adds a group box. For details, see <em>Adding a Group Box to the Layout</em> on page 67.</td>
</tr>
<tr>
<td><img src="text-box.png" alt="TextBox" /></td>
<td>Adds a text box. For details, see <em>Using a Text Box</em> on page 167.</td>
</tr>
<tr>
<td><img src="hidden-control.png" alt="Hidden Control" /></td>
<td>Adds a hidden control. For details, see <em>Using a Hidden Parameter Value</em> on page 243.</td>
</tr>
<tr>
<td><img src="drop-down.png" alt="Drop-Down List" /></td>
<td>Adds a drop-down list. For details, see <em>Using a Drop-Down List</em> on page 173.</td>
</tr>
<tr>
<td><img src="list-box.png" alt="List Box" /></td>
<td>Adds a list box (a drop-down list that allows multiple selections). For details, see <em>Using a List Box</em> on page 178.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Inserts a placeholder for a double list parameter control. For details, see <em>Using a Double List Control</em> on page 181.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Adds a push button. For details, see <em>Adding a Push Button to the Layout</em> on page 69.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Adds a reset button. For details, see <em>Adding a Reset Button to the Layout</em> on page 74.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Adds a radio button. For details, see <em>Using Radio Buttons</em> on page 201.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Adds a check box list. For details, see <em>Using Check Boxes</em> on page 198.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Inserts a text area. For details, see <em>Using a Text Area</em> on page 171.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Inserts a tree control. For details, see <em>Using Tree Controls</em> on page 205.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Inserts a hyperlink. For details, see <em>Adding a Hyperlink to the Layout</em> on page 62.</td>
</tr>
<tr>
<td><strong>Button</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| ![Calendar Icon](image) | Adds a calendar.  
For details, see *Adding a Dynamic Calendar* on page 235. |
| ![ActiveX Icon](image) | Adds an ActiveX control or a Visual Discovery control.  
When adding ActiveX controls in HTML Composer, only true ActiveX controls are shown in the list. The first time that an ActiveX control is added, a message appears indicating that it is reading ActiveX controls from the registry. This list is cached for future use and only ActiveX controls are added.  
For more information about Visual Discovery, see the *Using WebFOCUS Visual Discovery to Develop Analytic Dashboards* manual. |
| ![Flash Icon](image) | Inserts Flash content.  
For details, see *Adding Flash Content to the Layout* on page 55. |
| ![Save Selection Icon](image) | Inserts a Save Selection button.  
**Note:** This is specific to Managed Reporting and the ability to save parameterized reports with the Save Parameters dialog box. |
| ![Panel Icon](image) | Inserts a panel to group objects together. The panel is invisible at run time.  
For details, see *How to Group Objects on the HTML Page* on page 286. |
| ![Slider Icon](image) | Inserts a slider parameter control bar.  
For details, see *Using a Slider Control* on page 231. |
| ![Tab Icon](image) | Inserts a tab control.  
For details, see *Adding a Tab Control to the Layout* on page 75. |
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Description Button" /></td>
<td>Adds a Google map. For more information about Google Maps™, see <em>Using Maps in HTML Composer</em> on page 463.</td>
</tr>
<tr>
<td><img src="image" alt="Inserts Label" /></td>
<td>Inserts a label. A label is simply a piece of text. The label component enables you to create and name a label, and link it to a control. For details, see <em>Adding a Label to the Layout</em> on page 87.</td>
</tr>
<tr>
<td><img src="image" alt="Inserts Visual Discovery Control" /></td>
<td>Inserts a Visual Discovery control. For more information on Visual Discovery, see the <em>Using Visual Discovery in HTML Composer</em> on page 533.</td>
</tr>
</tbody>
</table>

**Reference: Formatting Toolbar**

The Formatting toolbar contains options that can be applied to individual strings of text, as well as to the entire text element, with the exception of the alignment options. The alignment options can only be applied to the text element.

For more information about using text elements, see *Adding Text to the Layout* on page 57.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Applies Bold Formatting" /></td>
<td>Applies bold formatting to the text.</td>
</tr>
<tr>
<td><img src="image" alt="Applies Italic Formatting" /></td>
<td>Applies italic formatting to the text.</td>
</tr>
<tr>
<td><img src="image" alt="Applies Underline Formatting" /></td>
<td>Applies underline formatting to the text.</td>
</tr>
</tbody>
</table>
### Table: Button Descriptions

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☞</td>
<td>Applies superscript typography to the text.</td>
</tr>
<tr>
<td>☞</td>
<td>Font style opens the Font dialog box where you can set the Font, Font Style, Size, Color, and Effect of the text.</td>
</tr>
<tr>
<td>☞</td>
<td>Aligns the text element to the left.</td>
</tr>
<tr>
<td>☞</td>
<td>Aligns the text element to the center.</td>
</tr>
<tr>
<td>☞</td>
<td>Aligns the text element to the right.</td>
</tr>
<tr>
<td>☞</td>
<td>Aligns the text to fill the width of the text element.</td>
</tr>
</tbody>
</table>

### Creating a Report Page Layout

You can use HTML Composer to create an HTML page that launches and displays your reports and graphs. You can add elements to the HTML page, such as reports, graphs, text, and controls. You can also set properties for the HTML page in HTML Composer. For details, see *Setting HTML Page Properties* on page 273.
Adding a Report, Graph, or Compound Document to HTML Composer

You can add reports and graphs to HTML Composer that will display when you run the layout. You can add a new report (that you create in Report Painter), a new graph (that you create in the Graph tool), or add an existing report or graph that resides on an available server. You can also launch Document Composer from HTML Composer and create compound documents.

You can also include parameters in a report or graph whose values can be assigned with controls that are added with HTML Composer. For information, see Using Controls to Supply Incoming Parameter Values on page 158.

You can set the graphic used as a placeholder for a report or graph in the layout using the HTML Page tab, located in the Developer Studio Options dialog box. For details, see How to Set Page Properties on page 291.

Note:

- In order for a graph to fit an HTML Composer frame properly at run time, in InfoAssist, you must select the Autofit command and verify that any graph headings are embedded. You must also embed the graph, into the HTML page, using the Import existing graph command.
- You can reference an existing graph in your HTML page. To ensure the entire graph is displayed without the need to scroll, you must resize the frame so the entire graph fits.
- InfoMini procedures cannot be referenced in an HTML page.

Procedure: How to Add a New Report or Graph to an HTML Page

1. Insert a report or graph object by doing one of the following:
   - Click the Report or Graph button from the Components toolbar.
   - From the Insert menu, select New Report or New Graph.
   - Right-click in the layout and select New Report or New Graph from the context menu.

   The cursor changes into a crosshair.

2. Drag the crosshair to create a report or graph object and adjust it to the size you want.
A report or graph object is created in the layout and assigned the name report\( (n) \) or graph\( (n) \), where \( n \) is a number. The object will appear in gray and white to indicate that the placeholder does not have a report or graph associated with it. Once a report or graph is associated with the object, the object displays the contents of the report or graph if live or simulated data is active (live data is the default) or a colored placeholder if preview is off in the HTML Page tab, located in the Developer Studio Options dialog box.

3. Create a report or graph by doing one of the following:
   - Double-click the placeholder.
   - Right-click the placeholder and select New Report for a report, or New Graph for a graph.

   The Open dialog box opens.

4. Select the Master File you want to report against from the Master File list, and click Open.

   The selected tool opens. For details on using these tools, see the Creating Reports With Report Painter manual and the WebFOCUS InfoAssist User’s Manual.

5. Optionally, after creating the report or graph, you can change its properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Report Properties in the Properties Window on page 40.

**Procedure: How to Add an Existing Report or Graph to a Layout**

1. Insert a report or graph object by doing one of the following:
   - Click the Report or Graph button from the Components toolbar.

     The cursor changes into a crosshair. Drag the crosshair to create a report or graph object and adjust it to the size you want.

     A report or graph object is created in the layout and assigned the name report\( (n) \) or graph\( (n) \), where \( n \) is a number. The object will appear in gray and white to indicate that the placeholder does not have a report or graph associated with it. Once a report or graph is associated with the object, the object displays the contents of the report or graph if live or simulated data is active (live data is the default) or a colored placeholder if preview is off in the HTML Page tab, located in the Developer Studio Options dialog box.

   - From the Insert menu, select Import Existing Procedure.

     **Note:** To access the Manage Layout dialog box, choose this method.
1. Using HTML Composer

- Right-click in the layout and select *New Report* or *New Graph* from the context menu.

2. Add a report or graph:
   - For a report, right-click the report object and select *Import existing report*.
   - For a graph, right-click the graph object and select *Import existing graph*.

   The Get source file dialog box opens.

3. Enter the name of the procedure you want to add to the layout.

4. Click *Open*.

   The report or graph object appears in the Design view of HTML Composer.

5. To edit the report or graph, double-click the object.

   The Procedure Viewer opens.

6. Open the report or graph, and make any necessary changes.

7. Close the Procedure Viewer to return to HTML Composer.

8. Optionally, change the properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see *Report Properties in the Properties Window* on page 40.
Reference: Report Properties in the Properties Window

When a report is selected, the Properties tab in the Properties window contains options that control the properties of your report and reporting objects.

Click a property to display a description of the selected property at the bottom of the Properties window.
Reference:  Graph Properties in the Properties Window

When a graph is selected, the Properties tab in the Properties window contains options that control the properties of your graph.

Click a property to display a description of the selected property at the bottom of the Properties window.

Procedure:  How to Add a Compound Document to an HTML Page

1. Insert a report object by doing one of the following:
   - Click the Report button from the Components toolbar.
   - From the Insert menu, select New Report.
Right-click in the layout and select New Report from the context menu. The cursor changes into a crosshair.

2. Drag the crosshair to create a report object and adjust it to the size you want.


Selecting Components to Import Into a Procedure

You can select to include or exclude components to be imported into your procedure with the Manage Layout dialog box. The Manage Layout dialog box allows you to select from components of your request, such as TABLE, SET, and GRAPH.

If you have several requests in one procedure, you can use the Manage Layout dialog box to suppress the display of individual TABLE, SET, and GRAPH components (for example, temporary HOLD files). By default, the last TABLE is set to display.

Procedure: How to Select Components to Import Into a Procedure

1. Select Import Existing Procedure from the Insert menu. The Get source file dialog box opens.

2. Select a file name and click Open. The Manage Layout dialog box opens. For details, see Manage Layout Dialog Box on page 43.
Reference: Manage Layout Dialog Box

The following image is the Manage Layout dialog box.

![Manage Layout Dialog Box](image)

The Manage Layout dialog box contains the following fields/options:

**Components**

Displays all the components (SET, DEFINE, and so on) in the request.

**Data**

Displays the contents of the selected component.

**Component Legend**

Determines whether the request is included in the procedure, outside of the procedure, or in the procedure and layout.

**In focexec and layout**

Activates the component and displays the component in the layout.
In focexec only

Deactivates the component and does not display the component in the layout. This is a good method for hiding report requests that produce temporary files.

Not in focexec

Removes the component from the procedure.

Show layout items only (reports and graphs)

Displays the layout reports and graphs in the Data field.

This check box only displays when you access the Manage Layout dialog box from the Insert menu. When accessing it from the context menu, only the report or graph component displays, and the check box does not apply.

Adding a Frame to the Layout

You can use a frame to embed additional web sources or run reports. You can also use a frame as the output location or target for a drill-down report. You can also use a frame to run a table of contents report, an OLAP report, a PDF report, an Excel® report, or a Maintain procedure.

Procedure: How to Add a Frame to the Layout

1. Insert a frame by doing one of the following:
   - Click the Frame button.
   - From the Insert menu, select Components, then click Frame.
     The cursor changes into a crosshair.

2. Drag the crosshair to create a frame and adjust it to the size you want.
   A frame is created in the layout and assigned the name iframe_n, where n is a number.

3. Optionally, change the properties of the frame by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Frame Properties in the Properties Window on page 50.
**Procedure:** How to Assign a URL, HTML File, or Report to a Frame

1. Insert a frame by doing one of the following:
   - Click the *Frame* button.
   - Or
   - From the Insert menu, select *Components*, then click *Frame*.
   
The cursor changes into a crosshair.

2. Drag the crosshair to create a frame and adjust it to the size you want.
   
   A frame is created in the layout and assigned the name iframe\((n)\), where \(n\) is a number.

3. Right-click the frame, and select *Frame Properties* from the context menu.
   
The Hyperlink Properties dialog box opens.
4. Click the New button to create a new action. From the drop-down list in the Action field you can select:

- **URL.** To assign a URL address to the frame, select *URL* and enter the fully-qualified URL in the Source field.

- **HTML File.** To assign an HTML file to the frame, click select *HTML File* and enter the file location in the Source field, or click the browse (...) button to browse to the location. An HTML file refers to the HTML files in your application.

- **External procedure.** To assign an external procedure to the frame, select *External procedure* and enter the procedure location in the Source field, or click the browse (...) button to browse to the location. You can also select Maintain procedures (.mnt, .fcm) here.

5. Click *OK*.

6. Optionally, change the properties of the frame by adjusting the properties displayed in the Properties tab of the Properties window. For details, see *Frame Properties in the Properties Window* on page 50.

**Procedure: How to Show/Hide a Frame in the Layout**

1. From HTML Composer, use the controls to supply parameter values for a report.

   **Note:** A report with parameters requires that you select values (at run time) in order to generate the output.

2. Click the frame (report object) and select *False* from the Auto Execute drop-down list in the Properties tab of the Properties window.

   **Note:** False is the default Auto Execute option for reports with parameters.
3. Right-click the frame (report object) in the Design view and select Style from the context menu.

The Style Composer opens.

4. Select Layout from the left side of the Style Composer to view the layout options for the selected frame.
5. From the Flow control area, select *Do not display* from the Display drop-down list.

![Style Composer window](image)

This option hides the frame at run time until the values are selected.

6. Click OK to close the Style Composer.

7. Run the HTML page.
In the example below, the frame is not shown before the values are selected.

![Frame not shown before values selected]

Please select a Year

2000 2001 2002

In the same example below, parameter values have been selected and the frame appears showing the output results.

![Parameters selected and frame showing output results]
**Reference:** **Frame Properties in the Properties Window**

When a frame is selected, the Properties tab in the Properties window contains options that control the properties of frames.

Click a property to display a description of the selected property at the bottom of the Properties window.

**Adding a Line to the Layout**

You can add a horizontal or vertical line to the layout. This is useful for distinguishing between sections of your launch or display page.

**Procedure:** **How to Add a Line to the Layout**

1. Do one of the following to add a line:
   - Click the *Line* button.
or

- From the Insert menu, select Components, then click Line.
  The cursor changes into a crosshair.

2. Drag the crosshair to create a horizontal or vertical line.
  A line is created in the layout.

3. Optionally, change the line properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Line Properties in the Properties Window on page 51.

**Reference:** Line Properties in the Properties Window

When a line is selected, the Properties tab in the Properties window contains options that control the properties of lines.
Click a property to display a description of the selected property at the bottom of the Properties window.

**Adding an Image to the Layout**

You can add an image to the layout. This is useful for including graphics, such as a company logo.

You can insert an image into your report layout and add a hyperlink to it. After you run your report and click the image you can launch a URL or run a report or Maintain procedure the same way you can by clicking a hyperlink or push button. For more information, see *How to Add a Hyperlink to a Push Button or an Image* on page 67.

**Note:** When inserting images, images must be referenced from a specific directory location. Links to images are not supported.

**Procedure: How to Add an Image to a Layout**

1. Do one of the following to add an image:
   - Click the *Image* button from the Components toolbar.
   - Or
   - From the Insert menu, select *Components*, then click *Image*.
     
     The cursor changes into a crosshair.

2. Drag the crosshair to create the image object and adjust it to the size you want.
   
   The Get source file dialog box opens.

3. Navigate to the directory where the image is located using the Look in drop-down list, then select the image you want to add to the layout.

   **Note:**
   - You may also specify a fully-qualified URL or a relative URL that points to an image file by entering it in the File name area. A fully-qualified URL must start with http:// or https://. A relative URL must start with a known context root that WebFOCUS uses, such as /approot/appname/imagename.png.
   - You can multiselect image files from the Get source files dialog box. The files will be cascaded on the canvas and can then be moved as required.
4. Click Open.

5. Optionally, change the properties of the image by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Image Properties in the Properties Window on page 54.

**Note:** You can always return an image to its original size by right-clicking the image and selecting Restore size from the context menu.

Images will retain their aspect ratio if they are resized by pressing and dragging their corner borders.
Reference: Image Properties in the Properties Window

When an image is selected, the Properties tab in the Properties window contains options that control the properties of selected images.

Click a property to display a description of the selected property at the bottom of the Properties window.
Adding Flash Content to the Layout

You can add .SWF files that are Adobe® Flash Player compatible to accompany reports or graphs on an HTML page.

Note:

- When inserting Flash animations, only files that are 1 MB or smaller can be run using HTML Composer.
- Internet Explorer® 6 does not support the use of Flash content.

Procedure: How to Add Flash Content to a Layout

1. Do one of the following to add an .SWF file that is Adobe Flash Player compatible:
   - Click the Insert Flash Content button from the Components toolbar.
   - or
   - From the Insert menu, click Components, then click Flash Content.
   The cursor changes into a crosshair.

2. Drag the crosshair to create the Flash content object and adjust it to the size you want.
   The Get source file dialog box opens.

3. Navigate to the directory where the .SWF file is located using the Look in drop-down list, then select the .SWF file you want to add to the layout.

4. Click Open.

5. Optionally, change the properties of the Flash content by adjusting the properties displayed in the Properties tab of the Properties window.

6. Click Run to view the flash content.
Reference: **Flash Properties in the Properties Window**

When Flash content is selected, the Properties tab in the Properties window contains options that control the properties of the Flash component.

Click a property to display a description of the selected property at the bottom of the Properties window.
Adding Text to the Layout

You can add text to the layout. This is useful for including headings in your webpage, or adding directions or an explanation for your report or graph.

Procedure: How to Add Text to a Layout

1. Insert text to the layout by doing one of the following:
   - Click the Text button from the Components toolbar.
   - or
   - From the Insert menu, select Components, then click Text.
     The cursor changes into a crosshair.

2. Drag the crosshair to create the text object and adjust it to the size you want.
   A text object is created in the layout and assigned the name `textn`, where `n` is a number.

3. Replace the text with the text you want to appear in the layout.

4. Optionally, change the text properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Text Properties in the Properties Window on page 62.
How to Format Text in the Layout

Procedure:  How to Format Text in the Layout

You may apply various formatting and style options to words and individual text characters within the text element. The formatting options are available from the text element shortcut menu in HTML Composer.

Note: Any formatting and styling that you may have applied to individual text strings within the text element will remain unchanged. Changes made to the entire text element are only applied to part of the text string that has not been formatted.

1. Insert a text element into the layout and type text in the text element.
2. Select the text that you wish to format.
   - To format the entire text element, click the text object in the layout.
   - To format an individual word or text character, highlight part of the text within the text element.

   The Formatting toolbar is activated.

   Note: The Bold, Italic, Underline, Superscript, and Font Style options are available when formatting individual words or text characters. The Font Style and Alignment options are available when the entire text element is selected.

3. Select from the formatting options available from the Formatting toolbar.
4. Select Font Style from the Formatting toolbar to open the Font dialog box, from which you can change the type, style, color, size, and effect of the font.

   Tip: You can also access the Font Style dialog box from the Font ellipsis button of the Styling Font field in the Properties window.

5. Click OK to close the Font dialog box.

   The format options are applied to the text selected.
Procedure: How to Insert a Bulleted or Numbered List Into a Text Element

To insert a bulleted or numbered list into a text element:

1. Insert a text element into the layout and enter text on different lines, as shown in the following image.

2. Highlight and right-click the text.

   The right-click context menu opens.

3. Select Bullets and then either Disc, Circle, or Square if you want a bulleted list. Select Numbering and then either Numbers, Lowercase Letters, Uppercase Letters, Small Roman numerals, or Large Roman numerals if you want a numbered list. Both options are shown in the following image.
For example, the following image shows each item of text on a different line with a bullet next to it.

- Eggs
- Milk
- Bread
- Butter

**Note:**

- Alternatively, you can select a bullet type before typing text to begin the list. Pressing Enter will begin the next item in the list on a separate line.
- To change the bullet or number list type of an existing list, place your cursor on the list level you want to change and reselect a bullet or number list type. Selecting *None* will remove the bullets or numbers for that level and move any nested lists up one level. In order to switch between bullets and numbers, you must first remove the current list option by selecting *None* and then applying the list option you want.

**Procedure:**  How to Insert Nested Lists Into a Text Element

To insert a nested list into the text element:

1. Insert a text element into the layout and create a list, as shown in the following image.
2. Place your cursor after a list item.
3. Right-click and select *Nested List* and then select a bulleted or numbered list option.

A list is started within the current list, allowing you to enter text on that list level, as shown in the following image.

![Image of nested list]

**Note:** Pressing Tab while your cursor is on the same line as a list item will move that item one level down, resulting in a nested list. The bullet or number type selected is the next list type in the right-click context menu. For example, if you have a bulleted list that uses the disc bullet type, pressing Tab to move an item down one level will cause that nested list to have a circle bullet type.

You can continue to nest lists within other lists by using the same steps shown above.

**Note:** You cannot skip a list level. For example, in order to insert a nested bulleted list or nested numbered list on a lower level, there must be a list one level up from it.
Reference: Text Properties in the Properties Window

When text is selected, the Properties tab in the Properties window contains options that control the properties of the text component.

![Properties Window](image)

Click a property to display a description of the selected property at the bottom of the Properties window.

Adding a Hyperlink to the Layout

You can create a hyperlink for your HTML page. A hyperlink can execute a report or Maintain procedure, link to a URL, or open an HTML page. You can create a hyperlink in two ways:

- **Insert a hyperlink.** For details, see *How to Create a Hyperlink* on page 65.
- **Add a hyperlink to a push button or image.** For details, see *How to Add a Hyperlink to a Push Button or an Image* on page 67.
The following is an image of the Hyperlink Properties dialog box.

**Action**

The URL action will create a hyperlink that brings you to a webpage. This action will allow you to enter a URL in the Source section.

The HTML File action will create a hyperlink that will bring you to an HTML Composer page. You will be able to select the HTML file to link to from the Source section.

The URL File action will create a hyperlink that will invoke a Managed Reporting .url file. You will be able to select the .url file to link to from the Source section. This action is only available if you are creating an HTML page hyperlink in the Repository area.

The Embedded Procedure action will link to a procedure that is already embedded in the page. The Source section will allow you to choose from the procedures already linked to the current page.

The Schedule action enables you to schedule a report or graph using ReportCaster. For more information on using scheduling, see *Adding ReportCaster Schedule Capability to HTML Composer* on page 300.

The External Procedure action will link to a procedure that is not embedded in the page. You must navigate to and specify the procedure from the Source section.
The Visual Discovery Exclude action is only available when a Visual Discovery control is used on the page. From the Source section, you will be able to choose a datapool already located on the page. This action will cause the currently Visual Discovery data to remain, while hiding the unselected data.

The Visual Discovery Restore action is only available when a Visual Discovery control is used on the page. From the Source section, you will be able to choose a datapool already located on the page. This action will cause hidden Visual Discovery data to be shown on the Visual Discovery control.

The Refresh Active Reports action is only available when an Active Report is on the page. This action will refresh all active reports currently on the page.

**Source**

The source of where the hyperlink directs to. For URL actions, this is a hyperlink. For HTML actions, you will need to navigate to the HTML file you are directing to. For the Embedded Procedure action, this would be a selection from a list of available procedures. For the External Procedure action, you would have to navigate to the procedure you are directing to.

**Target Type**

The Window Target Type will execute the action in a new window.

The Frame Target Type will execute the action in a selected frame.

The Deferred Target Type will run the report deferred.

The InfoWindow Target Type will execute the action in the WebFOCUS generated InfoWindow.

**Target/Template Name**

The Target/Template Name contains a list of targets in which the action can be executed from. These targets can be controls, frames, windows, or distribution methods when the Action is set to Schedule. These options can be different for specific actions.

**Note:** If the distribution method is a combination (for example, email, report library, and FTP) then, at run-time, you will be presented with an intermediate dialog requesting you to choose a single distribution method.

**Size (Width/Height)**

Allows for customization of the InfoWindow dimensions. This option will replace Target/Template Name when using InfoWindow as the Target Type.
When a parameter is added to the HTML page, the Additional parameters button becomes available at the bottom of the Hyperlink Properties dialog box, as shown in the following image.

The Additional parameters button lets you pass the selected parameter in the hyperlink being defined. Clicking the green OK button selects the parameter. Clicking the red Cancel button closes the parameter drop-down list.

**Procedure: How to Create a Hyperlink**

1. Do one of the following to create a hyperlink:
   - Click the *Hyperlink* button from the Components toolbar.
   - or
   - From the Insert menu, select *Components*, then click *Hyperlink*.
     The cursor changes into a crosshair.

2. Drag the crosshair to create a hyperlink object and adjust it to the size you want.
The Hyperlink Properties dialog box opens.

3. Enter the text you want to display as the hyperlink in the Display Text field.

4. Set the action of the hyperlink:
   - To link to a URL, select URL in the Action section, and enter the URL in the Source field.
   - To open an HTML page, click select HTML in the Action section, and enter the HTML page in the Source field.
   - To execute an embedded procedure, select Embedded procedure and enter the procedure name in the Source field, or click the browse (...) button to browse to the procedure.
   - To execute an external procedure, select External procedure and enter the procedure name in the Source field, or click the browse (...) button to browse to the procedure. You can also select Maintain procedures (.mnt, .fcm) here.
   - To refresh or repopulate active reports based on selected values in active controls, select Refresh active reports and specify the source or which active report(s) should be refreshed.

For more information about active controls, see Creating Active Technologies Dashboards With HTML Composer on page 393.

5. Optionally, direct the output to a specific location by selecting Window or Frame in the Target Type field.

6. Specify a name for the target window or frame by selecting one of the default values from the Target/Template Name drop-down list or by typing the name of a new or existing window or frame in the Target/Template Name field.

7. Click OK.
Note: If linking hyperlink properties to another page or procedure, HTML Composer parses the other file for unresolved parameters and opens the New Parameters dialog box.

8. Execute the request and click the hyperlink to launch the source you entered in the Hyperlink Properties dialog box.

Note: If your hyperlink target type is an InfoWindow, you can move the InfoWindow by clicking the title bar and dragging it. You can move the InfoWindow regardless of if it is pinned or unpinned.

Procedure: How to Add a Hyperlink to a Push Button or an Image

To add a hyperlink to a push button or image, complete the following steps.

1. Insert a push button or image from the Components toolbar and add it to the layout.
2. Right-click the push button or image, and select Create hyperlink. The Hyperlink Properties dialog box opens.
3. Click the New button to generate a new request and select URL from the Action drop-down list.
4. Type a URL in the Source field.
5. Optionally, in the Target Type field, direct the output to a specific location by selecting Window or Frame from the drop-down list.
6. In the Target/Template Name field, specify a target window or frame by selecting one of the default values from the drop-down list or by typing the name of a new or existing window or frame.
7. Click OK.

Note: If linking hyperlink properties to another page or procedure, HTML Composer parses the other file for unresolved parameters and opens the New Parameters dialog box.

8. Execute the request and click the push button, or image, to launch the source you entered in the Hyperlink Properties dialog box.

Adding a Group Box to the Layout

A group box can be used to create a border around a group of objects, for example, forms or reports and graphs.
Procedure: How to Add a Group Box

1. Insert a group box by doing one of the following:
   - Click the Group box button from the Components toolbar.
   - Or
   - From the Insert menu, select Controls, then click Group Box.
   The cursor changes into a crosshair.

2. Drag the crosshair to create a group box and adjust it to the size you want.
   A group box is created in the layout and assigned the name groupbox(n), where n is a number.

3. Optionally, you may change the default name of the group box and format the text, as shown in the image below.

   ![Image of a group box]

   For more information about formatting text, see How to Format Text in the Layout on page 58.

4. Optionally, change the group box properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Group Box Properties in the Properties Window on page 69.
**Reference:**  **Group Box Properties in the Properties Window**

When a group box is selected, the Properties tab in the Properties window contains options that control the properties of group boxes.

Click a property to display a description of the selected property at the bottom of the Properties window.

**Adding a Push Button to the Layout**

You can add a push button to the layout. A push button enables you to execute a report or Maintain procedure, or link to a URL or HTML file. This behavior is similar to a hyperlink.

**Procedure:**  **How to Create a Push Button in Place of a Submit Button**

1. If the submit button is deleted from the layout, a push button can be used to replace the button. Insert a push button by doing one of the following:
Click the Push Button from the Components toolbar.

or

From the Insert menu, select Controls, then click Push Button.

The cursor changes into a crosshair.

2. Drag the crosshair to create a push button and adjust it to the size you want.

A push button is created in the layout and assigned the name button(n), where n is a number.

3. Right-click the push button and click Create hyperlink.

The Hyperlink Properties dialog box opens. Use the Hyperlink Properties dialog box to assign a target and action to the push button.

4. Click OK to close the Hyperlink Properties dialog box.

5. Run the HTML page.

6. Click the push button to submit your request.

Procedure: How to Run Multiple Reports With One Submit Button

The submit button on a control enables you to submit your request after selecting parameter values at run time. You may run multiple reports with one submit button.

Note: A push button can also be used in place of a submit button.

1. Right-click the submit button or the frame for the whole control, and select Create hyperlink from the context menu.
The following image is an example of the submit button selected.

The following image is an example of the whole control selected.
The Hyperlink Properties dialog box opens.

2. Click the **New** button and use the drop-down lists to add the second report request to be executed with the submit button.

Repeat these steps for multiple procedures.
Reference: Push Button Properties in the Properties Window

When a push button is selected, the Properties tab in the Properties window contains options that control the properties of your buttons.

Click a property to display a description of the selected property at the bottom of the Properties window.
Maintain From HTML Composer

HTML Composer enables you to select Maintain procedures (.mnt, .fcm) to run from your HTML form, either within a frame or in a new window. Select a Maintain procedure as the source for the External procedure in the Hyperlink Properties dialog box. This makes it easy to create customized launch forms for WebFOCUS Maintain, and to integrate WebFOCUS reporting and Maintain in your applications. For details about inserting a frame, see How to Assign a URL, HTML File, or Report to a Frame on page 45.

Adding a Reset Button to the Layout

You can add a reset button to the layout. A reset button enables you to reset the entire page back to its initial settings.

Procedure: How to Create a Reset Button

1. If the reset button is deleted from the layout, you may create a new reset button. Insert a reset button by doing one of the following:
   - Click the Reset button from the Components toolbar.
   - From the Insert menu, select Controls, then click Reset Button.
   The cursor changes into a crosshair.

2. Drag the crosshair to create a reset button and adjust it to the size you want.
   A reset button is created in the layout and assigned the name reset(n), where n is a number.

3. Run the HTML page.

4. When selecting criteria to submit a report, click the reset button to reset the entire page back to its initial settings.
Reference:  Reset Button Properties in the Properties Window

When a Reset button is selected, the Properties tab in the Properties window contains options that control the properties of your buttons.

Click a property to display a description of the selected property at the bottom of the Properties window.

Adding a Tab Control to the Layout

You can add a tab control to the layout. Tab controls enable you to create multiple pages in one HTML form and present a better display for viewing secondary information.
When a tab control object is added to the layout, each tab control consists of:

- A tab item.
  
  A tab item is the tab label. You may edit the name of the tab item, style the tab item, and add multiple tab items. Each tab item is associated with a tab body.

- A tab body.
  
  A tab body is the tab page where you associate your components, such as report and graph objects, images, and lines.

The Tab control can be displayed as a full screen or part of an HTML page.

In the example below, the selected tab shows a report and a second tab that contains a graph.

![Tab Control Example](image)

**Procedure: How to Create a Tab Control**

1. Insert a tab control to the layout by doing one of the following:
   
   - Click the *Tab control* button from the Components toolbar.
   
   or
   
   - From the Insert menu, select *Components*, then click *Tab Control*.
   
   The cursor changes into a crosshair.

2. Drag the crosshair to create a tab control object and adjust it to the size you want.

**Tip:** You should make the object large enough to associate report/graph components within the tab control.
A tab control object is created in the layout and assigned the Properties name tab(n), where n is a number of the tab. By default, the tab control has one tab page. Each tab page consists of a tab item (tabitem(n)) and tab body (tabitembody(n)).

3. Optionally, change the properties of the tab control by adjusting the properties displayed in the Properties tab of the Properties window.

**Procedure: How to Enable Full Screen Mode for the Tab Control**

You may resize the tab control to fit the full screen of your layout, making the tab control the full background of your browser window at run time. When set to full screen mode, scroll bars will not be applied to the output window. Therefore, you may have to adjust the tab control (and any items on the tab) in the layout to ensure that they appear appropriately for display at run time.

**Note:** It is recommended you set the tab control to full screen mode at the beginning of the development process. If there are existing components on the layout that are not part of the tab control, these components will become inaccessible if the tab control is changed to full screen mode.

1. From the Insert menu, select **Components**, then click **Tab Control**.
   The cursor changes into a crosshair.

2. Drag the crosshair in the layout to create the tab control object.
3. Right-click the tab control and select *Full screen mode* from the context menu, as shown in the image below.
The tab control displays as a full screen in the layout, as shown in the image below.

Note: This setting can be applied only to one tab control in your application. If one tab control is set to full screen mode, the full screen mode item will be grayed out for any additional tab controls.

4. To resize the tab control, right-click and uncheck the Full screen mode option, as shown in the image below.
Procedure: How to Add Additional Tabs

1. Select the tab control object in the layout.
2. Right-click and select Add tab item from the context menu.

A tab is added to the tab control object.

3. To align multiple tab items, select the tab control object and click AutoArrange from the context menu,
The tab items are resized to the size of the widest tab item and evenly spaced.
When a tab control is selected, the Properties tab in the Properties window contains options that control the properties of your tabs.

**Note:** You may set options for the tab control, individual tab items, and the tab body.

Click a property to display a description of the selected property at the bottom of the Properties window.
**Procedure:** How to Modify and Style the Tabs

You may modify and style the tab items and tab body properties.

1. Use the Formatting toolbar to format the text in the tab item.

![Tab #1](image1)

2. Click the tab item/tab body and use the right-click context menu to edit the text (if applicable), Font Style, Style, and Properties.

![Add tab item](image2)

**Procedure:** How to Modify the Size, Appearance, and Location of the Tabs

When the tab control is selected, you may change the default size of the tab labels, the appearance of the tabs, and the location of the tab items on the tab control.

These properties are available from the Properties tab of the Properties window when the tab control is selected. The tab control appears as `tab(n)` in the Properties window drop-down list.

1. To change the default size of the tab labels, adjust the *Tab: default distance*, *Tab: default height*, and *Tab: default width* properties.
2. To change the appearance of the tabs, select *Straight* or *Round* from the Tab: edges properties field.

   The default tab edge is *Straight*.

3. To change the location of the tab items on the tab control, select *Top*, *Bottom*, *Left*, or *Right* from the Tab: location properties field.

   The default tab location is *Top*.

   **Note:** If the tab location changes, any background images applied to the tabs will not be rotated. You will have to reinsert a different image that is rotated appropriately.

**Procedure: How to Use the Tab Item Background Properties Field**

In addition to using the Style Composer, you can add background images to tab items by using the Background properties field.

The Background properties field is available from the Properties tab of the Properties window when the tab item is selected. The tab item appears as tabitem\(n\) in the Properties window drop-down list.

1. Select the tab item in the layout, or click the tabitem\(n\) property from the Properties window drop-down list.

2. Click the *Background* ellipsis button from the tab item properties window.

   The Get source file dialog box opens, as shown in the image below.
3. Select a File name and click Open.
   The background image is added to the tab item.
   You may have to manually resize the tab item to fit the image.

   **Note:** If the tab location is changed (from Top to Left for example), any background images applied to the tabs will not be rotated. You will have to reinsert a different image that is rotated appropriately.

**Procedure: How to Add Background Images to Tabs**

You may add background images to a tab item or tab body using the Style Composer. For example, you may add a small icon with text to a tab item or your company logo as the background image for a tab body.

   **Note:** Background images can also be applied to tab items by using the Background properties setting. For more information, see *How to Use the Tab Item Background Properties Field* on page 84.

1. Select Style from the right-click context menu of the tab item/tab body.
   The Style Composer dialog box appears.

2. Select *Background* to show the Background image options.
3. Select a source file in the *Image* field and adjust the Tiling, Scrolling, and Position options.
4. If you are using text in addition to a background image for a tab item, select Text from the Style Composer to view and change the Alignment options.

5. Click OK to close the Style Composer.

The background image is added to the tab item/tab body.

**Procedure: How to Associate Components to the Tab Body**

You may associate any component from the Insert menu (such as an image or line) to the tab body. This procedure details how to add a report or graph object component to the tab body.

1. To add a new report or graph object to the tab body:
   - Select *New Report* or *New Graph* from the Insert menu.
     - The cursor changes into a crosshair.
   - In the tab control body, drag the crosshair to create the report or graph object and adjust it to the size you want.
   - Open, import, or reference a report or graph procedure.

2. To associate an existing component in the layout to a tab body:
Select the component in the layout.

Press the Alt key and drag the component into the tab body.

The component is associated to the tab body.

Adding a Label to the Layout

You can add a label to the layout. A label is simply a piece of text. The label component enables you to create and name a label. You can also link it to a control by assigning the label HTML for property the same value as the Unique Identifier property for the control.

Procedure: How to Add a Label

1. Insert a label to the layout by doing one of the following:
   - Click the Insert Label button from the Components toolbar.
   - From the Insert menu, select Components, then click Label.

   The cursor changes into a crosshair.

2. Drag the crosshair to create the label and adjust it to the size you want.

   A label is created in the layout and assigned the name labeln, where n is a number.

3. Replace the label text with the text you want to appear in the layout.

4. Assign the label to an existing control in the layout by assigning the label properties:
   - Select the label in the layout.
   - Select the HTMLfor property field in the Properties tab of the Properties window.
   - Type in the Unique Identifier property name for the control you want to link the label to.

   For example, suppose you have a drop-down list in your layout. The default Unique Identifier property name assigned to the drop-down list object is combobox1. Enter combobox1 in the HTMLfor property field to link the label to the drop-down list in your layout.

   Optionally, change the label properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Label Properties in the Properties Window on page 88.
Reference:  Label Properties in the Properties Window

When label is selected, the Properties tab in the Properties window contains options that control the properties of the label in your layout. New pages will show labels as <LABEL> tags in the Properties window.

Click a property to display a description of the selected property at the bottom of the Properties window.

Working With the Properties Window

The Properties window is a dockable window that consists of several tabs and components.

- A Properties tab consists of the following components:
A hierarchical drop-down list of objects that are currently in the layout. For the selected object, there are additional subtabs on the Properties tab.

A Properties subtab that lists attributes for the selected object. The attributes appear on the left. Click in the right column to set the properties for the attribute.
The Properties subtab options are accessible in the Design view of HTML Composer.

- An Events subtab lists all JavaScript events that can be assigned an action for an object.

**Note:**

- To code a JavaScript event for an object, select a JavaScript event and click the ellipsis button in the Events subtab. HTML Composer adds the event to the HTML code and switches from Design to HTML view. In the HTML view, you are prompted to define the event. Add the appropriate JavaScript code.

- When copying a control that has event handlers, the copied control inherits the original controls event handlers. You must manually change the copied controls event handlers in the event tab. You can then create the JavaScript for those event handlers.
The following image is an example of the HTML code that appears when a JavaScript event is selected from the Events subtab in HTML Composer.

- A Thumbnails tab enables you to view a thumbnail of the page layout. Thumbnail view allows objects on the page to participate in actions with controls on the Parameters tab. You may also refresh the Thumbnails tab, enlarge or reduce the thumbnails, and change the zoom levels. Reports and graphs appear as placeholder objects on the Thumbnails tab.

**Procedure:** How to Dock the Properties Window

For layout purposes, you may want to dock or reposition the Properties window. You can dock the Properties window on all four sides of HTML Composer. When you choose to dock the Properties window on the top or bottom, the columns are split in half.

1. Click the *Properties* title bar on the Properties window.
The Properties window appears as shown in the following image when you double-click the title bar.

2. Drag the Properties window to the side of the screen that you prefer, or it can float in the middle of the screen.

3. Release the mouse when the Properties window is on the side of the screen that you prefer.

If you dock the Properties window on the bottom of the screen, it will appear as shown in the following image.
To undock the Properties window, click the *Properties* title bar, then move the window to the desired location in the layout.

**Layering Objects**

You can layer objects that are added to the page layout by using the object right-click menu, as shown in the following image.

![Object Layering Menu](image)

The options are:

- **Bring to front.** Moves an object to the front so that it is stacked on top of every other object it overlaps.

- **Send to back.** Moves an object to the back so that it is stacked below every other object it overlaps.

- **Move forward.** Moves an object forward one position in the stacking z-order.

- **Move backward.** Moves an object backwards one position in the stacking z-order.

When using any of these commands, the stacking order of the object will change. This is reflected in the z-index property in the Properties window. The z-index is the stacking order of a specific object.
Working With the Events Subtab

The Events subtab displays a list of all available JavaScript events that can be used in conjunction with an object. The events that are available change depending on what type of object is selected. For example, a report object has different events available than a button object. When no object is selected, events for the HTML page are displayed.

Double-clicking on an event will create a function block for the selected object, using that event. You can view the created functions in the Embedded JavaScript tab, where you can type the JavaScript code to execute when the selected event occurs.

The following is a list of events that are available from the Event subtab and the circumstances in which the JavaScript code is called.

<table>
<thead>
<tr>
<th>Event</th>
<th>Circumstance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td>Page is loaded.</td>
</tr>
<tr>
<td>UnLoad</td>
<td>Page is unloaded.</td>
</tr>
<tr>
<td>Click</td>
<td>Object or page is clicked.</td>
</tr>
<tr>
<td>Double Click</td>
<td>Object or page is double-clicked.</td>
</tr>
<tr>
<td>Mouse Down</td>
<td>Mouse pointer is moved down.</td>
</tr>
<tr>
<td>Mouse Up</td>
<td>Mouse pointer is moved up.</td>
</tr>
<tr>
<td>Mouse Over</td>
<td>Mouse pointer is moved over an object.</td>
</tr>
<tr>
<td>Mouse Move</td>
<td>Mouse pointer is moved.</td>
</tr>
<tr>
<td>Mouse Out</td>
<td>Mouse pointer is moved away from an object.</td>
</tr>
<tr>
<td>Key Pressed</td>
<td>Key is pressed and released.</td>
</tr>
<tr>
<td>Key Down</td>
<td>Key is pressed.</td>
</tr>
<tr>
<td>Key Up</td>
<td>Key is released.</td>
</tr>
<tr>
<td>Focus</td>
<td>Object is the current focus.</td>
</tr>
<tr>
<td>Blur</td>
<td>Object is not the current focus.</td>
</tr>
<tr>
<td>Event</td>
<td>Circumstance</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Before Load</td>
<td>Before a control is populated.</td>
</tr>
<tr>
<td>After Load</td>
<td>After a control is populated.</td>
</tr>
<tr>
<td>Value Selected</td>
<td>Value within the control is selected.</td>
</tr>
<tr>
<td>Value Changed</td>
<td>Value within the control is changed.</td>
</tr>
</tbody>
</table>
You may create an unbound parameter, an incoming parameter (a parameter that is bound to a control), a control that is bound to a parameter, or an unbound control.

In this chapter:

- Creating Parameter Values
- Using Controls to Supply Incoming Parameter Values
- Using Input Controls to Supply Parameter Values
- Supplying Parameter Values to External Reports
- Styling Your Layout
- Specifying Browser Defaults With the Style Composer
- Laying Out Objects With HTML Composer
- Controlling the HTML Composer Environment
- Adding ReportCaster Schedule Capability to HTML Composer
- Running a Managed Reporting Report Deferred From HTML Composer
- Using JavaScript Code With HTML Composer Pages
- Specifying an HTML File as a Load Screen

Creating Parameter Values

Parameter values and input controls can be created with a dynamic or static list of values:

- A dynamic list retrieves values from a specified data source when the request is run.
- A static list consists of a list of values you supply. These values do not change unless you change them.
Creating Parameter Values

- An active control lists active report values that mimic active report menu items.

  **Note:** The active controls cannot be associated to any parameters in the layout. This type of control can only be associated with an active report in the layout.

- The TOC control list gives you the ability to integrate a report with a Table of Contents and On Demand Paging in HTML Composer.

  **Note:** TOC controls cannot be associated to any parameters in the layout. This type of control can only be associated with certain input controls in the layout. For more information, see Integrating a Report With a Table of Contents and On Demand Paging on page 426.

**Working With the Parameters Tab**

The Parameters tab enables you to create and modify parameter values, input controls, and customize parameter conditions. You may also bind parameters to controls and chain controls to one another. The Parameters tab consists of the following components:

- **Input control objects.** You may select the input control object to view and edit the Properties and settings of the control.
  - Creating an input control from the Design view prompts you to create a bound parameter on the Parameters tab. For details, see Using Input Controls to Supply Parameter Values on page 166.
  - Editing an input control, which is inserted when setting input controls for new parameters. For details, see Automatically Creating Controls From the New Parameters Dialog Box on page 159.

- **Add new parameters.** Right-click anywhere on the Parameters tab to add a new parameter.

  **Note:** Manually adding a parameter creates an unbound parameter. For details about adding new parameters, see Adding a New Unbound Parameter on page 99.

- **Refresh unresolved parameters.** All parameters on the parameters tab are parsed every two minutes to check if any are unresolved. If there are, their surrounding polygon is colored red. If you want to check for unresolved parameters on demand, right-click and select Refresh unresolved.

- **Binding controls and parameters.** Input controls and parameters can be bound and unbound from the Parameters tab.

  You may bind a parameter to an input control, or bind an input control to a parameter.
Binding a parameter to a control makes it an incoming parameter that will populate the control. Drag a parameter object to a control object on the Parameters tab.

Binding a control to a parameter will populate the parameter. Drag a control object to a parameter object on the Parameters tab.

**Chain one control to another.** Chaining will populate controls based on the selected value from the prior control in the chain. You can chain static and dynamic controls, link or unlink parts of a chain, and create conditions on links in a chain. Chains are represented by lines connecting control objects on the Parameters tab. By clicking the arrow head in a link of a chain, the Properties and settings dialog box enables you to modify and set properties and conditions of the chain.

**Note:** Chaining is applicable only for controls, not parameters. For details about chaining, see *Chaining Controls for Dependencies in HTML Composer* on page 351.

### Adding a New Unbound Parameter

An unbound parameter is useful when passing a parameter value used on another page. You may also bind the new parameter to a control to create an incoming parameter, or bind a control to the parameter.

**Procedure:** **How to Add a New Unbound Parameter**

The following steps describe how to add a new parameter:

1. Right-click anywhere on the Parameters tab and select *Add parameter*.

2. If using a single value, select *Single select*.

Enter the parameter value information. Options are *Single select*, *Multiselect OR*, and *Multiselect AND*.

2. If using a single value, select *Single select*. 
**Note:** Single select is the default option when adding a new parameter.

![Properties and settings](image)

**a.** Enter the Selected Value to be assigned to a single variable.

**b.** Enter the name for the parameter in the Name field, or keep the default name.

**c.** Optionally, you may use the Format field to define the format of the parameter, such as A20, or D12.2.

If this field is left blank, it automatically applies the Alphanumeric format to the value field.

3. If using a multiselect value, select **Multiselect OR** or **Multiselect AND**.

The Value, Display, and Selected columns appear.
a. Click the New button to enter a list of static values.

b. In the Value column, enter the value to be passed to the selected parameter.

c. In the Display column, enter the text that represents the parameter value in the control the user views.

d. In the Selected column, check the box for the value you want to be selected by default. More than one value can be selected.

**Note:** If opening HTML Composer with an existing page from a previous release and the tool cannot resolve the Value and Display fields, XML index values appear for the fields instead. If creating a new page that cannot resolve the Value and Display fields, you can manually type them in the Properties and Settings dialog box from the Parameters tab, or leave them blank. Unresolved Value and Display fields occur as a result of -INCLUDE, or amper variables, that may exist in an existing procedure.

Repeat these steps until the list contains all of the values you want to include.
Creating Parameter Values

4. Optionally, you may select values and click the Delete button to eliminate any values, and use the up and down arrows to rearrange the order of the values.

5. Close the Properties and settings dialog box to create an unbound parameter.

6. To modify the parameter value, right-click the parameter on the Parameters tab and select Properties and settings to make your edits.

   **Tip:** You may also use the Undo and Redo buttons located on the Standard toolbar. Note that the undo/redo buttons treat the entire Properties and settings dialog as one action.

7. Optionally, bind a control to a parameter to populate the parameter. Select the center of the parameter name object, left-click and drag the parameter to the center of the control object, and release the mouse to complete the binding.

8. Optionally, bind the new parameter to a control to create an incoming parameter. Select the center of the control object, left-click and drag the control to the center of the parameter object, and release the mouse to complete the binding.

   For details about creating an input controls, see Using Input Controls to Supply Parameter Values on page 166.

**Creating a Static List of Values**

When creating a list of static values, you can select from the following options:

- Add new value
- Add ignore value
- Add everything value
- Use values from procedure
- Use values from external file
- No selection

   **Note:** The No selection option is unavailable for tree controls, calendar controls, text area controls, and slider controls.

   When the options are added to the Value list, the display text can be customized, but the value cannot be changed.

   You may create an unbound static parameter, an incoming static parameter (a parameter that is bound to a control), or a control that is bound to a static parameter. For details, see How to Add a New Static Value on page 107.
**Reference: Properties and Settings (Incoming Static Parameter and Unbound Control)**

The Properties and settings dialog box appears when creating or editing a static value on the Parameters tab.

The options available depend on the type of static value.

The following image is the Properties and settings dialog box that appears for an incoming static parameter (a parameter that is bound to a control), and an unbound control (a control that is not bound to a parameter).

The Properties and settings dialog box contains the following fields and options when Static is selected as the Data type.

**Data type**

Determines whether values are obtained from a static or dynamic list, an active report, or Table of Contents.

- **Static.** Uses a static list of values you supply. A list of static values can also be created in Report Painter. For an example of importing static values that were created in Report Painter, see *Adding Static Field Values From Report Painter* on page 112.
**Static values**

Is a list of supplied values for a static list.

**Value.** The value to be passed to the selected parameter.

**Display.** The text that represents the value in the control the user views. Press the Ctrl + Shift keys to add a value to the Display field.

**Selected.** The value to act as the default value. If the control is multi-select, more than one value can be selected.

**New.** Creates a new value.

**Delete.** Deletes a supplied value from the list.

**Move Up.** Moves the selected value up in the list.

**Move Down.** Moves the selected value down in the list.

**Send display value**

Select this option to send the display value, rather than the actual data, to the parameter. For more information, see *How to Send the Display Value for Static and Dynamic Controls* on page 139.

The Send display value option appears when creating an incoming static parameter (a parameter that is bound to a control), or an unbound control (a control that is not bound to a parameter). It is not available when creating an unbound static parameter.

**Values are procedures names**

Select this option to have a control populated with procedure names, so that when a value is selected, that procedure executes. The Value column is the procedure name itself and cannot be edited. The Display column is editable.

For more information on how to use the Values are procedures names option, see *How to Use Procedure Names as Values* on page 147.

**Reference:** Properties and Settings Dialog Box (Unbound Parameter)

The Properties and settings dialog box appears when creating or editing a static value on the Parameters tab.

The options available depend on the type of static value.
The following image is the Properties and settings dialog box that appears when adding a new unbound parameter.

![Properties and settings dialog box](image)

The Properties and settings dialog box contains the following fields and options when adding an unbound parameter with Single select. Single select is the default option when adding a new parameter.

**Name**

The default name assigned to the parameter. Optionally, you may enter a new name for the parameter.

**Format**

The Format field defines the format of the parameter, such as A20, or D12.2.

This field is optional. If this field is left blank, it automatically applies the Alphanumeric format to the value field.

**Selected Value**

Enter the selected value to be assigned to the parameter.
The Properties and settings dialog box contains the following fields and options when adding an unbound parameter with Multiselect OR or Multiselect AND, as shown in the image below.

![Properties and settings dialog box](image)

**Static values**

Is a list of supplied values for a static list.

**Value.** The value to be passed to the selected parameter.

**Display.** The text that represents the value in the control the user views. Press the Ctrl + Shift keys to add a value to the Display field.

**Selected.** The value to act as the default value. If the control is multi-select, more than one value can be selected.

**New.** Creates a new value.

**Delete.** Deletes a supplied value from the list.

**Move Up.** Moves the selected value up in the list.
**Move Down.** Moves the selected value down in the list.

**Reference:**  **Properties and Settings Dialog Box (Bound Parameter)**

The Properties and settings dialog box appears when selecting a bound parameter on the Parameters tab.

The Properties and settings dialog box for a parameter is read-only and displays the values for the bound control.

The following image is the Properties and settings dialog box that appears when selecting a bound static parameter.

![Properties and settings dialog box](image)

The Properties and settings dialog box contains the following read-only values:

**Value**

- Shows the selected value for the static parameter data.

**Display**

- Shows the static parameter display value.

**Procedure:**  **How to Add a New Static Value**

The steps below describe how to manually add a new static value.

You may create an unbound static parameter, an incoming static parameter (a parameter that is bound to a control), or a control that is bound to a static parameter.

1. Create a new parameter.
a. Right-click anywhere on the Parameters tab and select *Add parameter*. The Properties and settings dialog box opens.

b. Enter the parameter value information. Options are *Single select*, *Multiselect OR*, and *Multiselect AND*.

c. If using single value, select *Single select*.

Single select is the default option when adding a new parameter.

- Enter the Selected Value to be assigned to a single variable.
- Enter the name for the parameter in the Name field, or keep the default name.
- Optionally, you may use the Format field to define the format of the parameter, such as A20, or D12.2.

  If this field is left blank, it automatically applies the Alphanumeric format to the value field.

d. If using a multiselect value, select *Multiselect OR* or *Multiselect AND*.

The Value, Display, and Selected columns appear.
Click the New button to enter a list of static values.

- In the Value column, enter the value to be passed to the selected parameter.
- In the Display column, enter the text that represents the parameter value in the control the user views.
- In the Selected column, check the box for the value you want to be selected by default. More than one value can be selected.

Repeat these steps until the list contains all of the values you want to include.

Optionally, you may select values and click the Delete button to eliminate any values, and use the up and down arrows to rearrange the order of the values.

Close the Properties and settings dialog box to create an unbound parameter.

An unbound static parameter is useful when passing a parameter value used on another page. You may also bind the new parameter to a control to create an incoming parameter, or bind a control to the parameter.
2. Bind the new parameter to a control.

Binding a new parameter to a control creates an incoming parameter. An incoming parameter is a static parameter that is bound to a control. The parameter value will populate the control.

a. Select the Design tab and create an input control. For example, insert a list box or a drop-down list.

b. Click the Parameters tab.

The Properties and settings dialog box appears for the control.

c. Close the Properties and settings dialog box.

Close this dialog since you are populating the control with the parameter value, which has already been created in step 1.

d. Select the center of the parameter name object, left-click and drag the parameter to the center of the control object, and release the mouse to complete the binding.

The following image is an example of an incoming parameter. Notice the direction of the arrow.

1. Select the center of the parameter object, left-click and drag the parameter to the center of the control object.

2. Release the mouse to complete the binding.

e. To unbind the parameter, select the arrow head on the line, so that the line is bold, right-click and select Break binding.

3. Create a control that is bound to a parameter.

Create a control with static values and bind the control to a parameter to populate the parameter with the control values.
a. From the Design view of HTML Composer, select a control from the Controls sub-menu of the Insert menu. For example, insert a list box or a drop-down list.

   The cursor changes into a crosshair.

b. Drag the crosshair to create the control and adjust it to the size you want.

c. Click the Parameters tab.

   The Properties and settings dialog box appears for the control.

   ![Properties and settings dialog box]

   ![Diagram of controls and parameters]

d. Select Static as the Data type.

   Static is selected by default.

e. Create the parameter values for the control:

   • In the Value column, enter the value to be passed to the control.

   • In the Display column, enter the text that represents the static parameter value in the control the user views.

   • In the Selected column, check the box for the value you want to be selected by default. More than one value can be selected.

   Repeat these steps until the list contains all of the values you want to include.
Optionally, you may select values and click the Delete button to eliminate any values, and use the up and down arrows to rearrange the order of the values.

f. Close the Properties and settings dialog box to create the control with static values.

g. Bind the new control to a parameter: Select the center of the control object, left-click and drag the control to the center of the parameter object, and release the mouse to complete the binding.

The image below is an example of a control that is bound to a parameter. Notice the direction of the arrow.

h. To unbind the control, select the arrow head on the line, so that the line is bold, right-click and select Break binding.

i. To change the default type of control, right-click the control object on the Parameters tab or the Design tab and select Set Control Type.

The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button, Text Area, Text box, Single source Tree control, and Multi source Tree control.

4. To modify the static value, right-click the control or parameter on the Parameters tab, and select Properties and settings to make your edits.

**Reference:** Adding Static Field Values From Report Painter

Instead of adding new static values, you may also import static value parameters that you created from the Variable Editor. Parameter values can be data values to limit your data or field names to select the fields in your report. Both types of static lists can be created in Report Painter. This example details how to supply field values to a report through HTML Composer and Report Painter.

For the purposes of this example, use the CAR Master File (car.mas) that is supplied with Developer Studio.

1. From HTML Composer, select New Report from the Insert menu.

   The cursor changes into a crosshair.
2. Drag the crosshair to create a report object and adjust it to the size you want.

   
   The Open dialog box appears.

4. Select the car.mas Master File and click Open.
   
   Report Painter opens.

   
   The Variable Editor opens.
   
   - Enter SORTVAR in the Name and Prompt input fields, and keep the Variable Type as Single Select.
   
   - Select Static List from the Accept List section.
   
   - Double-click COUNTRY and BODYTYPE from the Fields from database Data Context area.
   
   The fields are added to the Static Accept List.
   
   - Click OK to save the variable.

6. Create a second variable.
   
   
   The Variable Editor opens.
   
   - Enter MEASURES in the Name and Prompt input fields.

   - Select Multiselect AND from the Variable Type drop-down list.

   - Select Static List from the Accept List section.

   - Double-click CAR, DEALER_COST, RETAIL_COST, and SALES from the Fields from database Data Context area.

   The fields are added to the Static Accept List.

   - Click OK to save the variable.

   
   The variables are added to the report.

8. Click &SORTVAR and select By from the Columns toolbar.
9. Save and close the report.

You are returned to HTML Composer. Since you are adding a report with parameters, the New Parameters dialog box appears.

10. From the New Parameters dialog box:

   - Select **Double list control** from the Control Type list for MEASURES.
   - Select **Do not create a form** from the Parameter grouping options drop-down list.
   - Click **OK** to close the New Parameters dialog box.

   The report and associated parameters are added as static field values. You may rearrange or lengthen the controls in the layout.

11. Save and run the layout.

    Select the static field values (By field and the associated measures) and run the report.

**Procedure: How to Add an Ignore Value**

The add ignore value option sends _FOC_NULL to the server at run time and is intended for use with complex applications. The add ignore value option is available for Multiselect OR and Multiselect AND static parameters.

1. From HTML Composer, use controls to supply parameter values for a report.

   A report with parameters requires that you to select values (at run time) in order to generate the output.

2. Click the **Parameters** tab.

   The parameters associated with each control can be controlled with the Parameters tab. The properties of a control can be controlled with the Properties tab.

3. Select a multiselect control object from the Parameters tab.

   The Properties and settings dialog box opens.
4. Select *Add ignore value* from the Static values drop-down list.

![Properties and settings dialog box](image)

5. Optionally, select *Send display value* to send the display value, rather than the actual data, for the parameter values in the report.

6. Close the Properties and settings dialog box.

7. Run the HTML page and select the *Ignore All* value to ignore the parameter values.

**Note:** Sending \_FOC\_NULL to a procedure will result in any clause of that procedure that uses that variable to be ignored.

**Procedure: How to Add an Everything Value**

The add everything value option uses JavaScript to send every value present in the parameter list to the server at run time. The add everything value option is available for Multiselect OR and Multiselect AND static parameters.

The add everything value option is not available for a Double List Control.

1. From HTML Composer, use controls to supply parameter values for a report.

2. Click the *Parameters* tab.
3. Select a multiselect control object from the Parameters tab.
   The Properties and settings dialog box opens.

4. Select *Add everything value* from the Static values drop-down list.

5. Optionally, select *Send display value* to send the display value, rather than the actual data, for the parameter values in the report.

6. Close the Properties and settings dialog box.

7. Run the HTML page and click the *Select All* parameter value to view all the parameter values.

**Procedure: How to Use Values From a Procedure**

This is the default option which populates the static list with field names predefined in the procedure. The use values from procedure option is available for Multiselect OR and Multiselect AND static parameters, and when adding static field values from Report Painter.

1. From HTML Composer, use controls to supply parameter values for a report.
2. Click the *Parameters* tab.
3. Select a multiselect control object from the Parameters tab.  
The Properties and settings dialog box opens.

4. Select *Use values from procedure* from the Static values drop-down list.  
The field names from the procedure appear in the Properties and settings dialog box.

5. Optionally, select *Send display value* to send the display value, rather than the actual data,  
for the parameter values in the report.

6. Close the Properties and settings dialog box.

7. Run the HTML page and select the parameter values from the procedure.

**Procedure:  How to Import Values From an External File**

This option enables you to use a local external file to provide values for the parameter. The import values from an external file option is available for Multiselect OR and Multiselect AND static parameters.

1. From HTML Composer, use controls to supply parameter values for a report.
2. Click the *Parameters* tab.
3. Select a multiselect control object from the Parameters tab.  
The Properties and settings dialog box opens.

4. Select *Use values from external file* from the Static values drop-down list.  
The Open dialog box appears.

5. Select a text file from your local machine and click *Open*.  
The external file can be a comma-delimited file with single values on each line, or two values per line.

For example, in the following text file, BOS is the data value and Boston is the display value.
The imported values are loaded into the Static values area of the Parameters tab.

If there is only one value on the line in the text file, the value will populate both the data value and the display values.

6. Run the HTML page to see the imported values for the selected parameter.

Creating a Dynamic List of Values

Dynamic values are available by default if a parameter used in the procedure is associated with the selected control. A dynamic list retrieves values from a specified data source when the request is run.

You may also create new dynamic parameters by adding a filter to a report or graph component in the layout. For details, see How to Create Dynamic Parameters by Adding a Filter on page 130.

Reference: Properties and Settings Dialog Box (Dynamic Values)

The Properties and settings dialog box appears when creating or editing a dynamic parameter on the Parameters tab.
The following image is the Properties and settings dialog box with a Dynamic Data type.

The Properties and settings dialog box contains the following fields and options when Dynamic is selected as the Data type:

**Data type**

Determines whether values are obtained from a static or dynamic list, an active report, or TOC.
Dynamic uses a list of values retrieved from a selected data source when the request is executed. This is the default if you use an Accept clause in a Master File to create an amper variable parameter within a procedure. For more information, see *How to Create a Dynamic Value* on page 123.

**Embedded procedure**

Is the data source from which the values will be retrieved.

**External Procedure**

Is the existing procedure that will be called.

You may modify the external procedure directly from the Properties and settings dialog box on the Parameters tab. If you modify the request, you can save the external procedure and overwrite the original request.

**Value field**

Is the data source field from which the values will be retrieved.

**Display field**

Is the text that represents the parameter value in the control the user views.

There should be a relationship between the Value field and the Display field. The Display field is user-friendly text corresponding to the Value field.

**Source Code for the procedure**

- When the Value field is selected for an Embedded procedure, the corresponding source code appears.

  **Tip:** You may manually edit the source code if you are familiar with WebFOCUS syntax. For example, you may right-click and choose *Select a field* from the data source to add to the request. Or right-click and choose to *Use the default request*.

  The source code for an embedded procedure includes the line `// TODO: Add your filters here to replace defaults`, as a placeholder for you to enter filters, or WHERE clauses, for the request to resolve at run time. If entering filters, only dynamic filters can be specified.

  The `//TODO` line must remain in the source code in order to resolve filters at run time. An example of this is when filters are based on chains that have conditions. If you want your own filters specified, then delete this line.

- When an external procedure is selected, the corresponding source code appears.
**Tip:** You may manually edit the source code if you are familiar with WebFOCUS syntax. For example, you may right-click and choose *Select a field* from the data source to add to the request. After editing the external procedure that is associated with a control, right-click and choose *Reload external procedure* to reload and display the new syntax in the Properties and settings dialog box. Or right-click and choose to *Save external procedure*. Saving the external procedure overwrites the original requests.

**Add "ALL" Option**

Adds the option to select ALL data source values to the control. Alternate text can be substituted for ALL using the text field to the right. For more information, see *Parameter Value List Options* on page 138.

**Add ‘No selection’ option**

Optimizes performance by populating a chain one control at a time, instead of all the controls when the page initially loads. Selecting the Add ‘No selection’ option enables you to populate controls when necessary.

**Cache run time data**

When adding dynamic parameters to the HTML page, input controls retrieve data through procedures. Select this option to cache the run-time data for the selected input control. This setting is off by default.

This setting overrides the Default caching option from the HTML Page tab, which is located in the Developer Studio Options dialog box. For more information about the HTML Page tab, see *HTML Page Tab* on page 294.

**Limit values returned**

Indicates that a specific number of field values will be retrieved from the data source. The specific number of fields is selected with the menu to the right.

**Sort**

Clicking Sort enables you to set the sort order for displaying values in dynamic list controls. This option is useful when you want to sort each control independently of the others.

By default, the request retrieves dynamic display values from the BY sort field in the request. The results display values based on the value field.

**Sort by**

When Sort is enabled, you may sort the display value by the Value field or the Display field selected from the Properties and settings dialog box. The default is Value field.
Sort order

When Sort is enabled, you may select the sort order as Ascending or Descending. The default sort order is Ascending.

Send display value

Select this option to send the display value, rather than the actual data, to the parameter. For more information, see How to Send the Display Value for Static and Dynamic Controls on page 139.

Selected Value

Enter the value(s) to be selected as the default value whenever the procedure is run. For more information, see How to Use Selected Values as the Default Value on page 151.

Check for duplicate values

When creating a dynamic list of values for a report, you may remove duplicate values from input controls. For more information, see How to Check for Duplicate Values on page 132.

Reference: Properties and Settings Dialog Box (Bound Parameter)

The Properties and settings dialog box appears when selecting a bound parameter on the Parameters tab.

The Properties and settings dialog box for a parameter is read-only and displays the values for the bound control.
The following image is the Properties and settings dialog box that appears when selecting a bound dynamic parameter.

![Properties and settings dialog box](image)

The Properties and settings dialog box contains the following read-only values:

**Datasource file**
- Shows the selected Master File for the parameter data source.

**Value field**
- Shows the value field for the dynamic parameter data.

**Display field**
- Shows the dynamic parameter display field.

**Multiselect**
- Shows OR or AND, if there is a Multiselect OR or Multiselect AND dynamic parameter.

**Selected Value**
- Shows the selected value, if there is one assigned to the variable.

**Procedure: How to Create a Dynamic Value**

The steps below describe how to create a dynamic list of values.

You may need to create a dynamic control that is bound to a parameter. Creating a control with dynamic values and binding the control to a parameter will populate the parameter with the control values.
1. From the Design view of HTML Composer, select a control from the Controls sub menu of the Insert menu. For example, insert a list box or drop-down list. The cursor changes into a crosshair.

2. Drag the crosshair to create the control and adjust it to the size you want.

3. Click the Parameters tab. The Properties and settings dialog box opens.

4. Select Dynamic as the Data type. The dynamic value options appear.

5. Create the dynamic values for the control.
   a. If you are using an Embedded procedure to supply dynamic values, follow the steps below.
      - Select Embedded procedure.
Click the Embedded procedure ellipsis button.

The Get source file dialog box opens.

Select the Master File name and click Open.

Click the ellipsis button from the Value field.

The Object Inspector opens with the field names from the selected Master File.

Double-click a field name to add it to the Value field.

**Tip:** You may also use the Object Inspector icons to select a field and close the Object Inspector. The green icon is OK, the red icon is Cancel, double-clicking a value will select the value and close the dialog without using any button, and pressing the Esc key will cancel the dialog without using any button.

The selected field is automatically added to the Display field and the source code for the embedded procedure appears.

Optionally, you may click the Display field ellipsis button to select a different field name for the Display field.
You may manually edit the source code if you are familiar with WebFOCUS syntax. Right-click and choose Select a field from the data source to add to the request. For example, add an additional BY sort field to the request.

To remove any syntax that you added, right-click and select Use default request.

The source code for an embedded procedure includes the line // TODO: Add your filters here to replace defaults, as a placeholder for you to enter filters, or WHERE clauses, for the request to resolve at run time. If you are entering filters, only dynamic filters can be specified. For example, enter a filter for the CITY in the request.

The //TODO line must remain in the source code in order to resolve filters at run time. One example of this is when filters are based on chains that have conditions. If you want your own filters specified, then delete this line.
If you are using an External Procedure to supply dynamic values, follow the steps below.

- Select *External Procedure*.
- Click the External Procedure ellipsis button.
  
  The Get source file dialog box opens.
- Select the procedure (.fex) file name and click *Open*.
  
  The parameter names from the procedure are automatically added to the Value field and Display field, and the source code for the external procedure appears. For details, see *Automatically Populating Fields With Dynamic Values* on page 138.
- Optionally, you may click the Value field and Display field ellipsis button to select a different field name.

**Tip:** You may also use the Object Inspector icons to select a field and close the Object Inspector. The green icon is OK, the red icon is Cancel, double-clicking a value will select the value and close the dialog without using any button, and pressing the Esc key will cancel the dialog without using any button.
Only the parameter names from the external procedure will be available for selection.

- You may manually edit the source code if you are familiar with WebFOCUS syntax. Additionally, you may right-click and choose Select a field from the data source to add to the request.

- If you modify the request that is associated with a control, you can right-click and choose Reload external procedure to reload and display the new syntax in the Properties and settings dialog box. Or right-click and choose to Save external procedure. Saving the external procedure overwrites the original requests.

Note: For more information about how a procedure can be used to populate a dynamic list of values, see *Using Custom Procedures to Retrieve Dynamic Values* on page 133.

6. Optionally, select the Add "ALL" option to add the select ALL data source values to the control.
7. Optionally, select the *Add 'No selection' option* to optimize performance by populating a chain one control at a time instead of all the controls when the page initially loads.

8. Optionally, select the *Cache run time data* option to cache the run time data for the selected input control.

9. Optionally, select *Limit values returned*, and select or type the number of field values you want to retrieve from the data source in the box to the right of this option.

10. Optionally, click the *Sort* option to enable and select the sort order options for displaying values in dynamic list control.

11. Optionally, select the *Check for duplicate values* option to remove any duplicate value entries from the input control at run time.

12. Close the Properties and settings dialog box to create the control with dynamic values.

13. Bind the new control to a parameter. Select the center of the control object, left-click and drag the control to the center of the parameter object, and release the mouse to complete the binding.

   The following image is an example of a control that is bound to a parameter. Notice the direction of the arrow.

   ![Control Bound to Parameter Diagram]

14. To unbind the control, select the arrow head on the line, so that the line is bold, right-click and select *Break binding*.

15. To change the default type of control, right-click the control object on the Parameters tab or the Design tab and select *Set Control Type*.

   The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button, Text Area, Text box, Single source Tree control, and Multi source Tree control.

16. To modify the dynamic value, right-click the control and select *Properties and settings* to make your edits.
Procedure: How to Create Dynamic Parameters by Adding a Filter

You may create new dynamic parameters by adding a filter to a report or graph component in the layout.

1. To create dynamic parameters for your report or graph in the Design view, right-click the report or graph object and select *Add a filter* from the context menu.

   The Filter options dialog box opens.

2. Select the field to be used for the parameter, the Multiselect option, and click OK.

   ![Filter options dialog box](image)

   The New Parameters dialog box appears.

   ![New Parameters dialog box](image)
You may select a control type for the parameter from this dialog box, or adjust them later using the Properties and settings dialog box on the Parameters tab.

If the New Parameters dialog box does not appear, ensure that Show New Parameters dialog is selected from the HTML Page tab. To access the HTML Page tab, select Options from the Window menu to open the Developer Studio Options dialog box. From the Developer Studio Options dialog box, select the HTML Page tab.

3. Click OK to close the New Parameters dialog box.
4. The filter appears above the report or graph object.

Repeat this procedure for each additional parameter for the report or graph.

**Procedure: How to Sort the Dynamic List of Values**

This option is useful when you want to sort each control independently of the others.

**Note:** If sort options are not selected, the request retrieves dynamic display values from the BY sort field in the request, and the results display values based on the value field. Sort options are not selected by default.

1. Select a dynamic control from the Parameters tab.
   
   The Properties and settings dialog box opens.

2. Select Sort to enable the sort options.
   
   You may select the Sort by and Sort order options for the control.

   The following image are the sort options that appear on the Properties and settings dialog box of the Parameters tab, when a dynamic control is selected.

   ![Sort Options Image]

3. Select the Sort by options:
   
   - Sort by Value sorts the value by the field name from the Value field. This is the default Sort by selection.

   - Sort by Display sorts the value by the field name from the Display field.

4. Select the Sort order options:
Sort order Ascending sorts the value from lowest to highest. This is the default Sort order selection.

Sort order Descending sorts the value from highest to lowest.

5. Close the Properties and settings dialog box.

**Tip:** You may repeat these steps and select sort options for each dynamic control on the HTML page.

6. Run the HTML page to see the sort results.

**Procedure:** How to Check for Duplicate Values

When creating a dynamic list of values for a report, you may remove duplicate values from input controls. This is useful if you are using your own procedure that does not use a structured data source.

The Check for duplicate values option is turned off by default.

1. From HTML Composer, create an input control with a dynamic list of values.
2. Select the input control and click the Parameters tab.
   
   The Properties and settings dialog box opens for the input control.

3. Select the Check for duplicate values check box.
   
   The Check for duplicate values option is only available when creating a dynamic list of values for an input control.

4. Close the Properties and settings dialog box to save your selection.
5. Save and run the HTML page.

   The input control removes duplicate value entries.
The following example shows a list box with a list of city values. The first list box shows the list of values with duplicate entries. The second list box shows the list with duplicate values removed.

![List Box Example](image)

### Using Custom Procedures to Retrieve Dynamic Values

You have the option to allow customized retrieval of dynamic parameter values. By using a custom procedure, you can use the FOCUS language to utilize temporary HOLD files, filtering, and so on. This allows HTML Composer to better integrate with a multitude of large and/or proprietary data sources that may require unique retrieval methods. The procedure must meet the following criteria:

- The procedure must return a name and value pair for each parameter value that will populate the list. The first value is the submission value which is passed to the control when you click the Submit button. The second value is the display value which is what you will see in the control. These two values can be the same or different.

- The procedure must return the two data values on a single data line in XML format (PCHOLD FORMAT XML).

**Note:** Different parameters in the same procedure can use both this option and the data source method.

For chained controls, there are two options based on whether caching is enabled:

- By default, caching is not enabled. Each parameter control must be mapped to its own procedure and the developer is responsible for writing filters or WHERE criteria to properly filter the hierarchy of controls.
If caching is enabled for the parameter values, a single procedure can be used to populate the controls of the chained variables. In this case, HTML Composer writes the WHERE criteria.

For details about enabling caching options for chained controls, see *How to Enable Cache Processing for Chained Values* on page 377.

**Example:**  
**Retrieving Dynamic Parameter Values With One Value**

The following example shows the same value being used for the submission value and display value.

```plaintext
TABLE FILE GGSALES
PRINT DST.PRODUCT
BY PRODUCT
ON TABLE SET HOLDLIST PRINTONLY
ON TABLE PCHOLD FORMAT XML
END
```
The XML output is:

```xml
<?xml version="1.0" encoding="ISO-8859-1" ?>
- <fxp version="1.0" data="hold">
- <report records="4317" lines="10" columns="2" rows="10">
  <target format="" version="" type="" destination="" HOLD"" />
- <column_desc>
  <col colnum="c0" fieldname="PRODUCT" alias="E01" datatype="char"
    width="16" focus_format="A16" description="Product name"
    accept="" help_message="" title="Product" within="" property=""
    reference="" valign="left" />
  <col colnum="c1" fieldname="PRODUCT" alias="E02" datatype="char"
    width="16" focus_format="A16" description="Product name"
    accept="" help_message="" title="Product" within="" property=""
    reference="" valign="left" />
</column_desc>
- <table>
  - <tr linetype="data" linenum="1">
    <td colnum="c0">Biscotti</td>
    <td colnum="c1">Biscotti</td>
  </tr>
  - <tr linetype="data" linenum="2">
    <td colnum="c0">Capuccino</td>
    <td colnum="c1">Capuccino</td>
  </tr>
  - <tr linetype="data" linenum="3">
    <td colnum="c0">Coffee Grinder</td>
    <td colnum="c1">Coffee Grinder</td>
  </tr>
  - <tr linetype="data" linenum="4">
    <td colnum="c0">Coffee Pot</td>
    <td colnum="c1">Coffee Pot</td>
  </tr>
</table>
```

**Example:** Retrieving Dynamic Parameter Values With Two Values

The following example shows two different field values being used for the submission value and display value. In this case, PRODUCT (Product Description) is used for the display value and PCD (Product Code) is used as the submission value.

```
TABLE FILE GGSALES
PRINT DST.PRODUCT
BY PCD
ON TABLE SET HOLDLIST PRINTONLY
ON TABLE PCHOLD FORMAT XML
END
```
The XML output is:

```xml
<?xml version="1.0" encoding="ISO-8859-1" ?>
  <xfx version="1.0" data="hold">
    <report records="4317" lines="10" columns="2" rows="10">
      <target format="" version="" type="" destination="HOLD" />
      <column_desc>
        <col colnum="c0" fieldname="PCD" alias="E01" datatype="char"
             width="4" focus_format="A04"
             description="Product Identification code (for sale)"
             accept=""
             help_message="" title="Product ID"
             property="" reference=""
             valign="left" />
        <col colnum="c1" fieldname="PRODUCT" alias="E02" datatype="char"
             width="16" focus_format="A16"
             description="Product name"
             accept=""
             help_message=""
             title="Product"
             property="" reference=""
             valign="left" />
      </column_desc>
      <table>
        <tr linetype="data" linenum="1">
          <td colnum="c0">C141</td>
          <td colnum="c1">Espresso</td>
        </tr>
        <tr linetype="data" linenum="2">
          <td colnum="c0">C142</td>
          <td colnum="c1">Latte</td>
        </tr>
        <tr linetype="data" linenum="3">
          <td colnum="c0">C144</td>
          <td colnum="c1">Capuccino</td>
        </tr>
      </table>
    </report>
  </xfx>
```

**Note:** The procedure does not have to follow this FOCUS syntax exactly, but the end result must be two values per data line in XML format.

**Example:** **Retrieving Values for Chained Variables With Caching Disabled**

In the following procedures, there are three parameters (REGION, ST, CITY). Caching is disabled, so each parameter control must be mapped to its own procedures.
**Procedure 1 (REGION)**

TABLE FILE GGSALES  
PRINT DST.REGION  
BY REGION  
ON TABLE SET HOLDLIST PRINTONLY  
ON TABLE PCHOLD FORMAT XML  
END

**Procedure 2 (ST)**

TABLE FILE GGSALES  
PRINT DST.ST  
BY ST WHERE REGION EQ '&REGION';  
ON TABLE SET HOLDLIST PRINTONLY  
ON TABLE PCHOLD FORMAT XML  
END

**Procedure 3 (CITY)**

TABLE FILE GGSALES  
PRINT DST.CITY  
BY CITY WHERE REGION EQ '&REGION'; WHERE ST EQ '&ST';  
ON TABLE SET HOLDLIST PRINTONLY  
ON TABLE PCHOLD FORMAT XML  
END

**Example:** Retrieving Chained Variable Values With Caching Enabled

In the following example, caching is enabled, so a single procedure is used to populate the controls. For details about caching options, see *How to Enable Cache Processing for Chained Values* on page 377.

TABLE FILE GGSALES  
PRINT DST.REGION DST.ST DST.CITY  
BY REGION  
BY ST  
BY CITY  
ON TABLE SET HOLDLIST PRINTONLY  
ON TABLE PCHOLD FORMAT XML  
END
The XML output is:

```xml
<table>
<tr linetype="data" linenum="1">
<td colnum="c0">Midwest</td>
<td colnum="c1">IL</td>
<td colnum="c2">Chicago</td>
<td colnum="c3">Midwest</td>
<td colnum="c4">IL</td>
<td colnum="c5">Chicago</td>
</tr>
</table>
```

**Automatically Populating Fields With Dynamic Values**

When the name of a dynamic parameter matches a corresponding field name in a data source, HTML Composer automatically populates the field name values for the parameter.

The data source is populated by a default based on the first data source specified by a TABLE FILE or GRAPH FILE command. The data source field is populated for the Value and Display fields in the Properties and settings dialog box of the Parameters tab (when Dynamic is selected as the Data type). This generates a layout report that is ready to run as long as the parameter names match the field names.

**Example:  Automatically Populating Fields With Dynamic Parameter Values**

When the following report request is called from HTML Composer with a push button control, the Properties and settings dialog box for the PRODUCT parameter on the Parameters tab is automatically populated to dynamically retrieve the values of the PRODUCT field.

```
TABLE FILE GGSALES
SUM UNITS
BY PRODUCT WHERE ( PRODUCT EQ '&PRODUCT.Product:.' );
END
```

**Parameter Value List Options**

When creating a static or dynamic list of values, you may add an ALL value to the list of values and/or send the display value in a parameter.

The ALL feature allows developers to automatically add an ALL value to a list of values. An ALL value does the following:

- For dynamic parameters, the ALL feature sends a value of FOC_NONE to the reporting server alerting the server to bypass or ignore the parameter altogether. Ignoring the parameter would return all values in the data source.
With static parameters, the ALL value typically uses JavaScript to return all of the values displayed in the list. This prevents you from having to select every value in the list manually. When using the ALL feature with static parameters, you can select from the following options:

- **Add ignore value.** This option sends FOC_NONE to the server at run time, alerting the server to bypass or ignore the parameter altogether. It is intended for complex applications.

- **Add everything value.** This option uses JavaScript to send every value present in the control list to the server at run time. The Add everything value option is only available with a Multiselect OR variable type.

When using a Dynamic or active report Data type, you may enter the value(s) to be selected as the default value whenever the procedure is run. For more information, see *How to Use Selected Values as the Default Value* on page 151.

**Note:** You may also enter the selected value when adding a new unbound parameter on the Parameters tab. For more information, see *Adding a New Unbound Parameter* on page 99.

**Procedure:** **How to Send the Display Value for Static and Dynamic Controls**

From HTML Composer, you may send the display value, rather than the actual data, to the parameter. The display value can also be used for headings and footings in the report output.

The Send display value option appears when creating an incoming static parameter (a parameter that is bound to a control), or an unbound control (a control that is not bound to a parameter). It is not available when creating an unbound static parameter.

1. From HTML Composer, import or create a report that contains a parameter.
When importing a report with parameters, the New Parameters dialog box appears prompting you to create the control type.

The report and control type is added to HTML Composer.

2. To send the display value for the parameter selection, select the control object (for example, select listbox) in the Design view and click the Parameters tab.

The Properties and settings dialog box opens.
3. For a static list of values, the Value, Display, and Selected columns appear on the Properties and settings dialog box.

- In the Display column, enter the text that represents the parameter value that the user views.

  Repeat this step until the list contains all of the values you want to include.

- Select Send display value.

  ![Properties and settings dialog box]

  **Tip:** You may also update the display values from the Variable Editor in Report Painter.

- Optionally, you may select values and click the Delete button to eliminate any values, and use the up and down arrows to rearrange the order of the values.

- Close the Properties and settings dialog box.

  For more information about static values, see *Creating a Static List of Values* on page 102.
Click the **Design** tab to view the display values in the control object of HTML Composer.

4. For a dynamic list of values, the Value field and the Display field appear on the Properties and settings dialog box.

Sending the display value for Dynamic values is only applicable if you are using a Data source that contains both an internal data value and a field that the internal data value maps to for display purposes.

**a.** If using an Embedded procedure to supply dynamic values, follow the steps below.

- Select *Embedded procedure*.

- Click the Embedded procedure ellipsis button.

  The Get source file dialog box opens.

- Select the Master File name and click *Open*.

- Click the ellipsis button from the Value field.

  The Object Inspector opens with the field names from the selected Master File.

- Double-click a field name to add it to the Value field.

  The selected field is automatically added to the Display field and the source code for the embedded procedure appears.

- Optionally, you may click the Display field ellipsis button to select a different field name for the Display field.

- Optionally, select *Add "ALL" option* to automatically add an ALL value to a list of parameter values.

- Optionally, select *Add 'No selection' option* to optimize performance by populating a chain one control at a time instead of all the controls when the page initially loads.
 Ensure that **Send display value** is checked.

Send display value is selected by default.

b. If using an External Procedure to supply dynamic values, follow the steps below.

- Select **External Procedure**.
- Click the External Procedure ellipsis button.
  
  The Get source file dialog box opens.
- Select the procedure (.fex) file name and click **Open**.
  
  The parameter names from the procedure are automatically added to the Value and Display field, and the source code for the external procedure appears.
- Optionally, you may click the Value field and Display field ellipsis button to select a different field name.

  **Note:** Only the parameter names from the external procedure will be available for selection.

- Optionally, select **Add "ALL" option** to automatically add an ALL value to a list of parameter values.
- Optionally, select **Add 'No selection' option** to optimize performance by populating a chain one control at a time, instead of all the controls when the page initially loads.
- Ensure that **Send display value** is checked.
  
  Send display value is selected by default.
The following image is an example of the Properties and settings dialog box with Send display value selected for a dynamic value.

**Tip:** For details about the //TODO line in the source code, see *Creating a Dynamic List of Values* on page 118.

- Close the Properties and settings dialog box.

For more information about dynamic values, see *Creating a Dynamic List of Values* on page 118.
Click the Design tab to view the display values in the control object of HTML Composer.

5. Optionally, you may add a heading to the report to show the display value. Double-click the report from HTML Composer to open and edit the report.

The report opens in Report Painter.

6. Manually add &Variable_TEXT to the report heading or footing.

**Note:** If the report procedure uses it, &Variable_TEXT will always be passed, regardless of if Send display value is selected.

For example, the image below shows the heading as Display Value: &STCD_TEXT, where Store Code (STCD) is the variable name.
Tip: This is different from adding the actual value from the data source, where clicking the variable name would add &STCD to the report heading.

7. Save and close the report to return to HTML Composer.

When you create the Text variable (&Variable_TEXT), you are not prompted to set a control type for this variable when returning to HTML Composer, as no control type is needed.

8. Run the HTML page.

9. Select the parameter for the report and run the report.

The display value is shown in the report heading.

For example, in the image below, Gotham 40 is selected as the Store Code and shows the display value in the report heading. The actual value, R1040, is shown in the Store ID column.

Note: HTML Composer passes &var_TEXT if the report procedure uses it, regardless of whether the send display value check box is checked or unchecked.
**Procedure:** How to Use Procedure Names as Values

The Values are procedures names option lets you populate a control with procedure names. When that procedure name is clicked, the procedure executes.

1. Create an HTML page that contains a list box, a push button, and a report.

   **Note:** In this procedure a list box is used. However, the following controls are also able to use the Values as procedures names option: double list, drop-down, radio button, and check box.

2. Select the list box to bring up the Properties and settings dialog box.

   **Note:** If the Properties and settings dialog box does not open, select View and click Properties and settings.

3. Select Static as the Data type.

4. At the bottom of the Properties and settings dialog box, select Values are procedures names, as shown in the following image.
5. Click the New button and select procedures from your directory, as shown in the following image.

![Image of Get source file dialog box]

**Note:** You can add multiple procedure names to the Properties and settings dialog box by multiselecting procedures while in the Get source file dialog box.

6. Once the procedures has been added to the Properties and settings dialog box, edit the display name of the procedures value by double clicking the display contents if they are not highlighted already.
The following image shows the procedure values with new display names.

![Properties and settings dialog box](image)

7. Right-click the button you created and click *Create Hyperlink*. The Hyperlink Properties dialog box opens.

8. Create a hyperlink that opens a selected procedure from a control in the report frame created earlier.

   a. For the Action, select *Procedures from control* from the drop-down list. This option coincides with the Values are procedures names option found in the Properties and settings dialog box. This option will point to an entire procedure for the hyperlink, rather than a simple value. This option is only available when a control on the HTML Page is using the Values are procedures names option.

   b. Select *listbox1* as the Source. The source can be different if you use a different control. For example, combobox1, customselect1, radio1, or checkbox1.

   c. Select *Frame* as the Target Type. You could also select *New Window* as the target if you wanted the procedure to open in a new window.
d. Select *report1* as the Target/Template Name.

The created hyperlink is shown in the following image.

9. Run the page.

10. Select the procedure from the list box and click the button.

The report is run, as shown in the following image.
**Procedure: How to Use Selected Values as the Default Value**

When using a Dynamic or active report Data type, you may enter the value(s) to be selected as the default value whenever the procedure is run.

If you import a procedure (.fex) that has a dynamic prompt value, then the input box is populated with values retrieved from the data source. If the selected value is available in the data source, the value(s) are selected by default. If the selected value is not available in the data source, then the value(s) that you entered are ignored and the first value retrieved from the data source is selected.

1. From HTML Composer, import or create a report that contains a parameter.

   When importing a report with parameters, the New Parameters dialog box appears prompting you to create the control type.

   ![New Parameters dialog box](image)

   The report and control type is added to HTML Composer.

2. To enter the selected value to be used as the default value, select the control object (for example, select listbox) in the Design view and click the **Parameters** tab.

   The Properties and settings dialog box opens.

   **Note:** The options available in the Properties and settings dialog box vary, depending on the type of values (static or dynamic) you are creating.
3. For a dynamic list of values, the Value field and the Display field appear on the Properties and settings dialog box.

a. If using an Embedded procedure to supply dynamic values, follow the steps below.

- Select *Embedded procedure*.
- Click the Embedded procedure ellipsis button.
  
  The Get source file dialog box opens.
- Select the Master File name and click *Open*.
- Click the ellipsis button from the Value field.
  
  The Object Inspector opens with the field names from the selected Master File.
- Double-click a field name to add it to the Value field.
  
  The selected field is automatically added to the Display field and the source code for the embedded procedure appears.
- Optionally, you may click the Display field ellipsis button to select a different field name for the Display field.
- Optionally, select *Add "ALL" option* to automatically add an ALL value to a list of parameter values.
- Optionally, select *Add 'No selection' option* to optimize performance by populating a chain one control at a time, instead of all the controls when the page initially loads.
- Enter the exact parameter value in the Selected Value input field, as it appears in the data source.
  
  Parameter values are case-sensitive.
- Optionally, you may enter more than one value by using a semicolon between the values. For example, CA;GA.
  
  You may enter selected values with a semicolon (;) or a comma (,). Additionally, you may also have embedded commas or semicolons in the data values. If you have these embedded characters, you must enclose all of the values in the input area in double quotation marks (" "). For example:

  ENGLAND;ITALY
  
  ENGLAND,ITALY
  
  "ENGLAND","IT,ALY"
2. Creating and Using Parameters in HTML Composer

Note that even though one value in the last set has the embedded comma, both values need to be enclosed in double quotation marks.

- Close the Properties and settings dialog box.

**b.** If using an External Procedure to supply dynamic values, follow the steps below.

- Select *External Procedure*.

- Click the External Procedure ellipsis button.

  The Get source file dialog box opens.

- Select the procedure (.fex) file name and click *Open*.

  The parameter names from the procedure are automatically added to the Value field and Display field, and the source code for the external procedure appears.

- Optionally, you may click the Value field and Display field ellipsis button to select a different field name.

  **Note:** Only the parameter names from the external procedure will be available for selection.

- Optionally, select the *Add "ALL" option* to automatically add an ALL value to a list of parameter values.

- Enter the exact parameter value in the Selected Value input field, as it appears in the data source.

  Parameter values are case-sensitive.

- Optionally, you may enter more than one value by using a semicolon (;) between the values. For example, CA;GA.

  You may enter selected values with a semicolon (;) or a comma (,). Additionally, you may also have embedded commas or semicolons in the data values. If you have these embedded characters, you must enclose all of the values in the input area in double quotation marks (" "). For example:

  
  ENGLAND;ITALY
  ENGLAND,ITALY
  "ENGLAND","IT,ALY"

  Note that even though one value in the last set has the embedded comma, both values need to be enclosed in double quotation marks.
Close the Properties and settings dialog box.

For more information about dynamic values, see *Creating a Dynamic List of Values* on page 118.

The following image is an example of the Dynamic Data type Properties and settings dialog box, with parameter values in the Selected Value field.

4. For an active report list of values, the Available active reports, Menu Option Types, and Common Columns appear on the Properties and settings dialog box.

Select one or more active reports from the list of Available active reports. The selected report will be bound to the active report control in the layout.

When an active report is selected, Refresh for active reports is enabled by default.
Select the Menu Options Types for the active report control to sort, filter, list or select columns. You can also change presentation styles of the bound active report and the associated report and graph objects synchronized to the active report.

Optionally, select the Add "ALL" option to automatically add an ALL value to a list of parameter values.

Enter the exact parameter value in the Selected Value input field, as it appears in the data source.

Parameter values are case-sensitive.

Optionally, you may enter more than one value by using a semicolon between the values. For example, CA;GA.

You may enter selected values with a semicolon (;) or a comma (,). Additionally, you may also have embedded commas or semicolons in the data values. If you have these embedded characters, you must enclose all of the values in the input area in double quotation marks. For example:

ENGLAND;ITALY

ENGLAND,ITALY

"ENGLAND","IT,ALY"

Note that even though one value in the last set has the embedded comma, both values need to be enclosed in double quotation marks (" ").

Close the Properties and settings dialog box.

For more information about active report values, see Creating Active Technologies Dashboards With HTML Composer on page 393.
The following image is an example of the active report Data type Properties and settings dialog box, with parameter values in the Selected Value field.

5. For a single-select unbound parameter, the Selected Value input field appears on the Properties and settings dialog box.

- Enter the exact parameter value in the Selected Value input field, as it appears in the data source.
  
  Parameter values are case-sensitive.

- Optionally, you may enter more than one value by using a semicolon between the values. For example, CA;GA.

  You may enter selected values with a semicolon (;) or a comma (,). Additionally, you may also have embedded commas or semicolons in the data values. If you have these embedded characters, you must enclose all of the values in the input area in double quotation marks (" "). For example:
ENGLAND;ITALY
ENGLAND,ITALY
"ENGLAND","IT,ALY"

Note that even though one value in the last set has the embedded comma, both values need to be enclosed in double quotation marks.

☐ Close the Properties and settings dialog box.

For more information about single-select parameters, see Adding a New Unbound Parameter on page 99.

The following image is an example of the Single select parameter Properties and settings dialog box, with parameter values in the Selected Value field.

Even though it is a Single select parameter, multiple values are specified and selected.

![Properties and settings dialog box with selected values](image)

6. Run the report.

The selected value, if available from the data source, is automatically selected (highlighted) in the parameter list.
The example below shows CT, GA as the selected values in the State parameter list in the report output.

7. Click the Run button to run the report with the selected value parameters.
   The report output appears.
   If the selected value is not available in the report results, then the value that you entered is ignored and the first value retrieved from the data source is shown.

** Updating Parameters in HTML Composer With Report Painter Changes **

When using HTML Composer, if changes are made to parameter values in Report Painter, you may want to update the values in HTML Composer with those entered in Report Painter.

** Using Controls to Supply Incoming Parameter Values **

Controls enable you to prompt users for a parameter value. When you create a parameter as part of a report or graph, HTML Composer automatically adds a control, Submit button, and Reset button for the parameter to your layout. The parameter appears on the Parameters tab. You can also add an input control and bind it to a parameter.

When you delete a parameter in Report Painter that was assigned a control in HTML Composer, you must delete the associated controls individually in the layout.

Controls, with the exception of a text box which does not supply a list of possible values, can supply values with a dynamic or static list of values:

- A dynamic list retrieves values from a specified data source when the request is run.
A static list consists of a list of values you supply. These values do not change unless you change them.

An active report control lists active report values that mimic active report menu items.

The active report controls cannot be associated to any parameters in the layout. This type of control can only be associated with an active report in the layout.

The properties of a control, as well as the parameters associated with each control, can be controlled with the Properties tab of the Properties window, and with the Parameters tab. For details, see Working With the Properties Window on page 88 and Working With the Parameters Tab on page 98, respectively.

**Note:** Pertaining to the Default selection property, at run time, when using a combo box, there must be a value selected. In order to have nothing selected, you must add the Make selection value.

For details about static and dynamic controls, see Creating a Static List of Values on page 102 and Creating a Dynamic List of Values on page 118.

For details about active controls, see Creating Active Technologies Dashboards With HTML Composer on page 393.

**Automatically Creating Controls From the New Parameters Dialog Box**

When a report contains one or more new amper variable parameters created in Report Painter, the New Parameters dialog box appears when you save the report. You can set the Control Type for each parameter prior to returning to HTML Composer. This eliminates the need to select each parameter individually to set the associated Control Type.

If you reference or import an existing report that uses a Master File containing a parameter, the New Parameters dialog box opens with that parameter in the list, as well as any parameters from the report procedure.

**Note:** When referencing or importing an existing report that uses a Master File containing a parameter, the Add “ALL” option and the Add “No Selection” option are unavailable.

If linking hyperlink properties to another page or procedure, HTML Composer parses the other file for unresolved parameters and opens the New Parameters dialog box.
The following image shows the New Parameters dialog box. For each parameter, you will find Name and Control Type fields, a Create control check box, and a Chain control check box. The Control Type ellipsis button enables you to select a new or existing control type for the parameter.

The Parameter grouping options menu in the New Parameters dialog box provides options for the placement of the controls associated with new amper variable parameters created in Report Painter. The option selected is set from the HTML Page tab, which is located in the Developer Studio Options dialog box. You may create a single or multiple layer form, or select an existing form from the layout.

- Select *Do not create a form* to insert the controls for each of the new parameters in separate locations on the HTML page.

- Select *New multiple layer form* to insert the controls for all of the new parameters inside one form element you can position anywhere on the HTML page. This form element also contains submit (run) and reset buttons. The multiple layer form contains group boxes around each element in the form. You may move and resize each element of the control.
Select *New single layer form* to insert the controls for all of the new parameters inside one form element, which you can position anywhere on the HTML page. This form element also contains submit (run) and reset buttons. The single layer form contains all of the elements within a single group box.

*Single layer* is the default form type selected in the HTML Page tab. To change the default form type, select *Options* from the Window menu. The Developer Studio Options dialog box will open. From the Developer Studio Options dialog box, select the HTML Page tab.

Select form\( (n) \), where \( n \) is the number of a control that already exists in the layout. The parameter is added to the selected control.

Select *Don't show this message again and use default selection* to control whether or not the New Parameters dialog box appears when adding parameters in HTML Composer.

**Tip:** You may view the New Parameters dialog box again by selecting *Show New Parameters dialog* from the HTML Page tab. To access the HTML Page tab, select *Options* from the Window menu. The Developer Studio Options dialog box will open. From the Developer Studio Options dialog box, select the HTML Page tab.

Select *Auto chain controls in above specified order* to automatically chain the selected controls from the New Parameters dialog box. The auto chain option is useful since it creates the chain, or links of a chain, automatically for the parameters selected in the Chain control column. For more information, see *Automatically Chaining Parameters From the New Parameters Dialog Box* on page 352.

Select *Create controls for all Parameters* to switch between creating controls for all or none of the parameters in the New Parameters dialog box. When importing or referencing a report with parameters to an HTML page, all of the controls will have *Create control* selected by default. The create controls for all parameters selection is useful when there is a long list of parameters that you do not want to add controls for on the HTML page.

To edit the Control Type that you selected from the New Parameters dialog box, select the parameter object on the Parameters tab or the Design tab, right-click, and select the control type option from the *Set Control Type* menu.

**Procedure:** *How to Manually Create a Control in the Layout*

When you create a parameter as part of a report or graph, HTML Composer automatically adds a control, Submit button, and Reset button for the parameter to your layout. Manually adding a control to the layout enables you to create the individual objects on the control.
Inserting a control in the Design view creates the control object in the layout with the Submit button and Reset button. You must manually add the input controls to be used in the control. For more information, see Using Controls to Supply Incoming Parameter Values on page 158.

1. Insert a control by doing one of the following:
   - Click the Insert form button from the Components toolbar.
     You may select Multiple Layer Form or Single Layer Form as the form type. If no form type is selected, single layer form is the default.
   - From the Insert menu, point to Components, then point to Form, then select a form type (Multiple Layer Form or Single Layer Form).

   ![Multiple Layer Form and Single Layer Form](image)

   The cursor changes into a crosshair.

   To change the default form type, select Options from the Window menu. The Developer Studio Options dialog box opens. From the Developer Studio Options dialog box, select the HTML Page tab.

   The multiple layer form contains group boxes around each element in the form. You may move and resize each element of the control. The single layer form contains all of the elements within a single group box.

2. Drag the crosshair to create a control and adjust it to the size you want.
   A control is created in the layout and assigned the form \( n \), where \( n \) is a number.

3. You may add input controls in the control object to create parameter values.
   - Create an insert control and add it in the control object. For example, insert a List Box, Drop Down List, and so on.
   - Click the Parameters tab to create parameter values.
     The Properties and settings dialog box opens. Creating an input control from the Design view prompts you to create a bound parameter on the Parameters tab.
   - Create the parameter values for the input control.
For details about creating parameter values, see *Creating Parameter Values* on page 97.

Optionally, you may close the Properties and settings dialog box for the input control if you wish to bind a parameter to a control.

4. Bind the input controls to a parameter.

Binding a control to a parameter will populate the parameter. Drag a control object to a parameter object on the Parameters tab. For details about creating input controls, see *Using Input Controls to Supply Parameter Values* on page 166.

5. Optionally, you may assign hyperlink properties to the Submit button. For more information, see *How to Add a Hyperlink to a Push Button or an Image* on page 67.

**Procedure: How to Change the Type of Control Associated With a Parameter**

1. In the Parameters tab or the Design tab, select the input control associated with the parameter name.

2. Right-click and select *Set Control Type*.

3. Select the type of input control for the form.

   Options are Calendar, Check box, Drop down list, Hidden, List box, Radio button, Text area, Text box, Single source Tree control, and Multi source Tree control.

The following image shows the input control options when right-clicking a control object on the Design tab.
Procedure: How to Bind or Unbind a Parameter To/From an Existing Control

When a control is automatically added to the layout with the New Parameters dialog box, it is associated (bound) to a parameter. Click the Parameters tab and notice the direction of the arrow. The control object is bound to the parameter object, which means that the control will populate the parameter.

If you deselect the Create control option from the New Parameters dialog box, the deselected parameter name is added to the Unbound Parameters box on the Parameters tab. The Unbound Parameters box is a container for the unbound parameters, only for parameters not selected from the New Parameters dialog box. Any parameters created or unbound from the Parameters tab are not automatically moved here. Optionally, you may click and drag parameters to and from the Unbound Parameters box for your own organization.

1. To unbind a parameter from a control:
   - Click the Parameters tab.
   - Select the arrow head on the line between the parameter and the input control, so that the line is bold.
   - Right-click and select Break binding.

2. To bind a parameter to a control:
   - Click the Parameters tab.
   - Select the center of the input control object.
   - Click and drag the control to the center of the parameter object.
   - Release the mouse to complete the binding.

Reference: Types of Controls

Controls can be single-select or multiselect. Single-select controls enable you to select a single value from a list of supplied values. Multiselect forms enable you to select multiple values from a list of supplied values.

Examples of single-select controls are:

- A text box. For details, see Using a Text Box on page 167.
- A drop-down list. For details, see Using a Drop-Down List on page 173.
- Radio buttons. For details, see Using Radio Buttons on page 201.
A text area. For details, see Using a Text Area on page 171.

Check boxes. For details, see Using Check Boxes on page 198.

Examples of multi-select controls are:

- A list box. For details, see Using a List Box on page 178.
- A tree control. For details, see Using Tree Controls on page 205.

A drop-down list is the default control type for all single-select parameters on the New Parameters dialog box. A list box is the default control type for all multi-select parameters on the New Parameters dialog box.

You can change the type of input control using the Parameters tab. For details, see How to Change the Type of Control Associated With a Parameter on page 163.

Note: Individual multiselect parameters must be designated as multiselect in Report Painter in order to process multiple values.

Using the Delete Container Only Option

When creating parameters, the Grouping option selected in the New Parameters dialog box generates a container for controls. After the container is created, you may choose to delete the container by using the Delete Container Only option. This option allows you to delete the container without deleting the objects inside. You can Delete Container Only using the Edit menu, by using the Ctrl + Delete keys, or by right-clicking the container and selecting Delete Container Only from the context menu.

The following image shows the Delete Container Only option on the Edit menu.
The following image shows the Delete Container Only option on the context menu when right-clicking a container.

![Image showing Delete Container Only option]

**Note:** If you delete a form container, the Reset button is deleted with the form. The Reset button is deleted because it is attached to the form.

**Using Input Controls to Supply Parameter Values**

Creating an input control from the Design view prompts you to create a bound parameter on the Parameters tab. Binding a control to a parameter will populate the parameter.

**Note:**

- You may also add input controls from the New Parameters dialog box that appears when creating a report or graph with parameters. For more information about the New Parameters dialog box, see *Automatically Creating Controls From the New Parameters Dialog Box* on page 159.
- Except for the Hidden control, the Properties and settings dialog box will display for all controls when in the Design tab and Parameters tab. The Properties and settings dialog box will display for the Hidden control only when in the Parameters tab.
Using a Text Box

A text box enables you to enter a value in a text entry field.

**Procedure: How to Create a Text Box**

A text box only provides a single-select value.

1. Add a text box by doing one of the following:
   - Click the **Text Box** button from the Components toolbar.
   - or
   - From the Insert menu, select **Controls**, then click **Text Box**.
   
The cursor changes to a crosshair.

2. Drag the crosshair to create a text box and adjust it to the size you want.
   
   A text box is created in the layout and assigned the name edit(n), where n is a number.

3. Optionally, change the properties of the text box by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Text Box Properties in the Properties Window on page 170.

4. To bind an existing parameter to the text box:
   
   Binding a parameter to a text box creates an incoming parameter. An incoming parameter is a parameter that is bound to a control. The parameter value will populate the text box with values.
   - Click the **Parameters** tab.
   
   The Properties and settings dialog box opens.

   - Close the Properties and settings dialog box.
   
   Close this dialog since you are populating the text box with a parameter value.

   - Select the center of the parameter name object, left-click and drag the parameter to the center of the text box object, and release the mouse to complete the binding.

   - To unbind the parameter from the text box, select the arrow head on the line, so that the line is bold, right-click, and select **Break binding**.

5. To bind the text box to a parameter:

   If binding a text box to a parameter, the value can only be single select. Binding the text box to a parameter will populate the parameter with the single value.
Click the Parameters tab.

The Properties and settings dialog box opens.

Create the single value for the text box. You can create a single Static or Dynamic value.

Close the Properties and settings dialog box to create the text box with the single value.

Bind the text box to a parameter. Select the center of the text box, left-click and drag the text box to the center of the parameter object, and release the mouse to complete the binding.

**Procedure: How to Enter Masked Text in a Text Box**

When entering a value in a text box at run time, you may set the mask text property so that the text is not displayed as text, but masked by default characters. This is recommended when using passwords or other sensitive information.

1. Select the Text Box object to view the associated properties.

You may also select the text box properties from the drop-down list of the Properties window. The properties for the text box appears as edit(n) <INPUT>. 


2. From the Mask text property field, select Yes.

3. Run the report and enter a value in the text box.
   The value being entered appears as masked text, as shown in the following image.
Reference: Text Box Properties in the Properties Window

When a text box is selected, the Properties tab in the Properties window contains options that control the properties of your text box.

Click a property to display a description of the selected property at the bottom of the Properties window.
Using a Text Area

A text area is a single-select control that enables you to enter multiple lines of text that can be assigned to a single variable. The behavior is similar to a text box, but you are not restricted to entering just one line of text. For example, if you want to assign a paragraph (multiple lines of text) to a variable that can be referenced by a procedure, you can add the paragraph to a text area from the Properties and settings dialog box on the Parameters tab.

**Note:** When the Multiple property is set for a text area control, you can enter data values separated by semicolons, commas, or carriage returns.

The following image shows the text area component in HTML Composer.

![Text Area Component](image)

**Procedure:** How to Create a Text Area

1. Click the Text Area button from the Components toolbar.
   
   or
   
   From the Insert menu, select Controls, then click Text Area.

   The cursor changes to a crosshair.

2. Drag the crosshair to create a text area and adjust it to the size you want.

   A text area is created in the layout and assigned the name textarea(n), where \( n \) is a number.

3. Optionally, you can change the properties of the text area in the Properties tab of the Properties window. For details, see *Text Area Properties in the Properties Window* on page 173.

4. To bind an existing parameter to the text area:
 Binding a parameter to a text area creates an incoming parameter. An incoming parameter is a parameter that is bound to a control. The parameter value will populate the text area with values.

- Click the Parameters tab.
  The Properties and settings dialog box opens.

- Close the Properties and settings dialog box.
  Close this dialog since you are populating the text area with a parameter value.

- Select the center of the parameter name object, left-click and drag the parameter to the center of the text box object, and release the mouse to complete the binding.

- To unbind the parameter from the text area, select the arrow head on the line, so that the line is bold, right-click, and select Break binding.

5. To bind the text area to a parameter:

If binding a text area to a parameter, the value can only be single select. You can create one or more lines of text for the single value. Binding the text area to a parameter will populate the parameter with the single value.

- Click the Parameters tab.
  The Properties and settings dialog box opens.

- Create the single value for the text area. You can create a single Static or Dynamic value.

  **Note:** If you are creating a Static Data type for the text area, you may enter one or more lines of text by typing or pasting text into the Selected Value input field.

- Close the Properties and settings dialog box to create the text area with the single value.

- Bind the text area to a parameter. Select the center of the text area, left-click and drag the text area to the center of the parameter object, and release the mouse to complete the binding.
Reference: Text Area Properties in the Properties Window

When a text area is selected, the Properties tab in the Properties window contains options that control the properties of your text area.

Click a property to display a description of the selected property at the bottom of the Properties window.

Using a Drop-Down List

A drop-down list enables you to select a single value from a list of supplied values. You can use a dynamic or static list of values for the drop-down list.
Procedure: How to Add a Drop-Down List

1. Add a drop-down list by doing one of the following:
   - Click the Drop Down List button from the Components toolbar.
   - From the Insert menu, select Controls, then click Drop Down List.
   The cursor changes to a crosshair.

2. Drag the crosshair to create a drop-down list, and adjust it to the size you want.
   A drop-down list is created in the layout and assigned the name combobox\((n)\), where \(n\) is a number.

3. Optionally, change the drop-down list properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Drop-Down List Properties in the Properties Window on page 178.

4. Binding a parameter to a drop-down list creates an incoming parameter. An incoming parameter is a parameter that is bound to a control. The parameter value will populate the drop-down list with values. To bind an existing parameter to the drop-down list:
   - Click the Parameters tab.
     The Properties and settings dialog box opens.
   - Close the Properties and settings dialog box.
     Close this dialog since you are populating the drop-down list with a parameter value.
   - Select the center of the parameter name object, left-click and drag the parameter to the center of the drop-down list object, and release the mouse to complete the binding.
   - To unbind the parameter from the drop-down list, select the arrow head on the line, so that the line is bold, right-click, and select Break binding.

5. To bind the drop-down list to a parameter:
   Binding the drop-down list to a parameter will populate the parameter with a list of values.
   - Click the Parameters tab.
     The Properties and settings dialog box opens.
   - Create the list of values for the drop-down list. You can create a list of Static or Dynamic values.
   - Close the Properties and settings dialog box to create the text box with the list of values.
Bind the text box to a parameter. Select the center of the text box, left-click and drag the text box to the center of the parameter object, and release the mouse to complete the binding.

**Procedure: How to Select Multiple Values From a Drop-Down List**

When using a drop-down list input control to supply parameter values, the Multiple property value indicates whether multiple values can be selected from a list of supplied values at run time.

**Note:** A multiselect list enables you to select multiple values by using the Ctrl key while selecting values. In order to select multiple values in the drop-down list, the procedure must be set up to accept multiple values. Ensure that the Variable Type for the parameter value is Multiselect OR or Multiselect AND in the procedure.

1. From HTML Composer, insert a report with parameters that accept multiple values.
   For example, create a report with *Multiselect OR* as the variable type for the parameter, accepting a dynamic list of values from *ggsales*, with *REGION* as the value for returned and displayed fields.

2. When the New Parameters dialog box appears, accept the default control type of *Drop down list* and click *OK*.
   A drop-down list is created in the layout and assigned the name *combobox*(n), where *n* is a number.

3. Select *Multiple* from the Multiple drop-down list in the Properties tab of the Properties window.
This indicates that multiple items can be selected from the drop-down list.

4. Save and run the HTML page.

Select multiple values by using the Ctrl key while selecting values from the drop-down list, as shown in the following image.
The drop-down list shows the selected multiple values. Click the *Run* button to run the report with the selected value parameters.
Reference: Drop-Down List Properties in the Properties Window

When a drop-down list is selected, the Properties tab in the Properties window contains options that control the properties of your drop-down list.

Using a List Box

A list box enables you to select single or multiple values at one time:

- A single-select list enables you to select only one value for each time a request is run.
- A multiselect list enables you to select multiple values by using the Ctrl key while selecting values. In order to provide multiple values, the procedure must be set up to accept multiple values.
List box values can be dynamic or static.

**Procedure: How to Add a List Box**

1. Add a list box by doing one of the following:
   - Click the *List box* button from the Components toolbar.
   - From the Insert menu, select *Controls*, then click *List Box*.
   The cursor changes to a crosshair.

2. Drag the crosshair to create a list box, and adjust it to the size you want.
   A list box is created in the layout and assigned the name listbox(n), where n is a number.

3. Optionally, change the properties of the list box by adjusting the properties displayed in the Properties tab of the Properties window. For details, see *List Box Properties in the Properties Window* on page 180.

4. Binding a parameter to a list box creates an incoming parameter. An incoming parameter is a parameter that is bound to a control. The parameter value will populate the list box with values. If binding a parameter to a list box, the value can be single or multiselect. To bind an existing parameter to the list box:
   - Click the *Parameters* tab.
     The Properties and settings dialog box opens.
   - Close the Properties and settings dialog box.
     Close this dialog since you are populating the list box with a parameter value.
   - Select the center of the parameter name object, left-click and drag the parameter to the center of the list box object, and release the mouse to complete the binding.
   - To unbind the parameter from the drop-down list, select the arrow head on the line, so that the line is bold, right-click, and select *Break binding*.

5. Bind the list box to a parameter.
   Binding the drop-down list to a parameter will populate the parameter with a list of values.
   - Click the *Parameters* tab.
     The Properties and settings dialog box opens.
Create the list of values for the list box control. You can create a list of Static or Dynamic values.

Close the Properties and settings dialog box to create the list box with the list of values.

Bind the list box to a parameter. Select the center of the list box, left-click and drag the list box to the center of the parameter object, and release the mouse to complete the binding.

**Reference:** List Box Properties in the Properties Window

When a list box is selected, the Properties tab in the Properties window contains options that control the properties of the selected list box.
Click a property to display a description of the selected property at the bottom of the Properties window.

**Procedure: How to Reorder the Selected Values in the List Box**

When using a list box, you may reorder the selected values in the report.

1. In the Design view of the HTML page, select the list box object, right-click, and select the *Add Move Items* control.

   An up and down arrow is added next to the list box control.

2. Run the HTML page.

3. Select values from the list box and run the report.

4. To reorder the selected values, click the up arrow to move the selected value up in the list box, or click the down arrow to move the selected value down in the list box.

5. Run the report again to view the results with the selected values.

   In the following example, CA is the first value in the By State list box. Select the down arrow to reorder the location of CA in the list box and rerun the report again.

**Using a Double List Control**

You may add a double list control for displaying multiselect values. This enables you to view a list of the available values and add or remove them from one list to another. At run time, a report is generated based on the values that are added.
Procedure: How to Add a Double List Control

1. Add a double list control by doing one of the following:
   - From the Components toolbar, click the Double List Control button.
   - or
   - From the Insert menu, select Controls, then click Double List Control.
     The cursor changes to a crosshair.

2. Drag the crosshair to create a double list control, and adjust it to the size you want.
   A double list control is created in the layout and assigned the name customselect(n)_selectfrom and customselect(n)_selectto, where n is a number.

3. You may edit the default description for the double list control by double-clicking Enter text, and typing the description of your choice.

4. Optionally, change the double list control properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Double List Box Properties in the Properties Window on page 185.

5. Bind an existing parameter to the double list control.
   Binding a parameter to a double list control creates an incoming parameter. An incoming parameter is a parameter that is bound to a control. The parameter value will populate the double list control with values. If binding a parameter to a double list control, the value can be single or multiselect.
   - Click the Parameters tab.
     The Properties and settings dialog box opens.

Note: When creating a static list of values for a double list control, the add everything value option is not available.
6. Bind the double list control to a parameter.

Binding the double list control to a parameter will populate the parameter with a list of values.

- Click the Parameters tab.

The Properties and settings dialog box opens.

- Create the list of values for the double list control. You can create a list of Static or Dynamic values.

- Close the Properties and settings dialog box to create the double list control with the list of values.

- Bind the double list control to a parameter. Select the center of the double list control, left-click and drag the double list control to the center of the parameter object, and release the mouse to complete the binding.

**Note:** You can change the default double list control to other types of controls by right-clicking the control object on the Parameters tab or the Design tab and selecting Set Control Type.

The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button, Text area, Text box, Single source Tree control, and Multi source Tree control.

7. Run the HTML page and select values by using the right and left arrows to add or remove values to the selected column.
The selected values appear in the second column. The output is generated based on the selected values in the second column. In the following example, Action and Comedy are the selected values for the report.

8. Optionally, you may reorder the selected values in the report.

The up and down arrows reorder the selected values that appear in the second column of the double list control.

Click the up arrow to move the selected value up in the second column of the double list control, or click the down arrow to move the selected value down in the double list control.
**Reference:** Double List Box Properties in the Properties Window

When a double list box is selected, the Properties tab in the Properties window contains properties of double list controls.

![Properties Window](image)

**Keep Selected Value.** When Yes is selected, this option will accumulate values you search for in the right-side box. When you search for another value, the previously searched values will not be deleted. **No** is selected by default.

Click a property to display a description of the selected property at the bottom of the Properties window.

**Adding a Paging Control in HTML Composer**

You may add a paging control to a List Box, Drop Down List, and the first control of a Double List Control, which enables you to page through a large list of values before selecting a value. The Add 'Paging' control option is available through the right-click context menu on the Design tab of HTML Composer when an input control is selected.
Procedure: How to Add a Paging Control

The Add 'Paging' control option enables you to page through a large list of values for a List Box, Drop Down List, and the first control of a Double List Control, before selecting a value. For example, suppose that you have a list box showing 50 values. Adding the paging control enables you to display these values as pages of values, as well as go directly to the first, previous, next, and last pages to select the value.

1. Select the input control on the Design tab of HTML Composer, right-click, and select Add 'Paging' control.

Note: The paging control is only valid for a List Box, Drop Down List, and the first control of a Double List Control.
The following image shows the Add ‘Paging’ control option in HTML Composer.
The paging control is added below the input control on the canvas, as shown in the following image.

![Paging control image]

**Note:** If the paging control is not visible, you may need to resize the control and input control objects on the canvas.

2. Optionally, change the *Number or Range* property for the paging control in the Properties tab of the Properties window.

The default *Number or Range* property is 1-50. This specifies the number or page range of values to show, per page, for the input control and the starting item number. For example, the input control starts at the first value and displays a range of 50 values per page.

**Note:** The paging control properties are available from the Properties tab of the Properties window when the paging control is selected. The paging control appears as navigator(n) in the Properties window drop-down list.
The following image shows the Number or Range property for the paging control in HTML Composer.

3. Run the HTML page.
4. Use the arrow buttons to page through the values to be displayed for the input control. You may select First, Previous, Next, or Last.

**Note:** You may also type in a page number or range in the paging control at run time, as described in the Number or Range property in step 2. This specifies the number or range of values, per page, for the input control.
The input control shows the values for the page selected in the paging control.

5. Select a value from the input control.

6. Click the Run button to refresh the report, showing the value selected in the input control.

In the following example, the paging control shows 101-200 of 1542. This indicates that there are 99 values available to select from on this page, as shown in the list box. The list box shows the value of 180 as the selected unit. Running the report shows the results with Unit Sales of 180.
Adding a Search Control in HTML Composer

You may add a search control to a List Box, Drop Down List, and the first control of a Double List Control, which enables you to search for a value in a control, before selecting a value. The Add 'Search' control option is available through the right-click context menu on the Design tab of HTML Composer when an input control is selected.

**Procedure: How to Add a Search Control**

The Add 'Search' control option enables you to search for a value in a control for a List Box, Drop Down List, and the first control of a Double List Control. For example, suppose that you have a list box showing 30 items. Adding the search control adds an additional input field to your output page. Type the value you are looking for and click the search button to find the value in your input control.

1. Select the input control on the Design tab of HTML Composer, right-click, and select *Add 'Search' control*.

   **Note:** The search control is only valid for a List Box, Drop Down List, and the first control of a Double List Control.

The following image shows the *Add 'Search' control* option in HTML Composer.
The search control is added above the input control on the canvas, as shown in the following image.

**Note:** If the search control is not visible, you may need to resize the control and input control objects on the canvas.

2. Run the HTML page.
3. Type the value to be displayed for the input control and click the search button.

   Pressing the Enter key will not execute the search. You must click the search button.

   The input control shows a suggested list of matched values.

4. Select a value from the input control.
5. Click the Run button to refresh the report showing the value selected in the input control.
In the following example, the search control shows 93 as the search value. This indicates searching the list box records for a value matching 93. The list box shows the value of 93 as the selected unit. Running the report shows the results with Unit Sales of 93.

Using Global Search and Paging

You can use the global search and paging option on the BODY object to have one search and paging control that can be used with each input control on the page.
Procedure: How to Enable Global Search and Paging

1. Click the Global search/paging property in the Properties tab of the Properties window for the BODY object, as shown in the following image.

2. Select Yes from the drop-down menu.
At run time, the Search/Paging window opens in the Home position, as shown in the following image.
When you click an input control, because the Auto-link to selected control option is on by default, the Search/Paging window appears under the input control, as shown in the following image. By default, the window shows all values on one page (for example 1-4 of 4).

The label for the input control is displayed showing that it is linked to that input control. If no label is associated with the input control, the window will show the unique identifier for the input control, for example, combobox1.

3. If you want multiple pages, type a range in the Search/Paging field in the format 1-2 of 4, as shown in the following image and press the Enter key.
4. Click the Show settings button on the Global Search and Paging window to expand the window and show the search and paging options, as shown in the following image.

![Search/Paging options](image)

The Search/Paging options are:

- **Match Case.** Search value must match the value in the input control exactly.
- **Match Whole Word Only.** Search value word must exist in the string.
- **Auto-link to selected control.** Search/Paging window appears under the selected input control. Auto-link is on by default.
- **Keep selected values.** This option only affects a double-list. When checked, this option will accumulate values you search for in the right-side box. When you search for another value, the previously searched values will not be deleted.

**Note:**

- The Global control option overrides individual control options. If Keep selected values is selected for Global searching/paging, that will override whether the double-list has it, regardless of whether it is set for the control itself.
- You can click the *up arrow* button on the expanded window to collapse the options.
- You can click the *House* icon on the Search/Paging window to move the window back to the Home position.
**Procedure: How to Use Search and Paging Features**

You can use the following buttons on the Search/Paging window to navigate through the pages.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="First" /></td>
<td><strong>First.</strong> Shows the first page of values.</td>
</tr>
<tr>
<td><img src="image" alt="Previous" /></td>
<td><strong>Previous.</strong> Shows the previous page of values.</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td><strong>Search.</strong> Initiates the search of values based on the text box input.</td>
</tr>
<tr>
<td><img src="image" alt="Next" /></td>
<td><strong>Next.</strong> Shows the next page of values.</td>
</tr>
<tr>
<td><img src="image" alt="Last" /></td>
<td><strong>Last.</strong> Shows the last page of values.</td>
</tr>
<tr>
<td><img src="image" alt="Reset All" /></td>
<td><strong>Reset All.</strong> Resets the paging back to the original.</td>
</tr>
<tr>
<td><img src="image" alt="Show Settings" /></td>
<td><strong>Show Settings.</strong> Expands the Global/Paging window and shows the options. Once expanded, use the <img src="image" alt="button" /> button to collapse the settings display.</td>
</tr>
</tbody>
</table>

**Using Check Boxes**

Check boxes enable you to select a single value from a list of supplied values. Note that if there are multiple check box input controls that are grouped together, you may select the *Multiple* properties for each control. Multiple ensures that you can select a single value from each check box control.

Check box list values can be dynamic or static.
Procedure: How to Add Check Boxes

1. Add check boxes by doing one of the following:
   - Click the Check box button from the Components toolbar.
   - or
   - From the Insert menu, select Controls, then click Check Box.

2. Drag the crosshair to create a check box list and adjust it to the size you want.
   A check box is created in the layout and assigned the name checkbox\(n\), where \(n\) is a number.

3. Optionally, change the properties of the check box list by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Check Box Properties in the Properties Window on page 201.

4. Bind an existing parameter to the check box.
   Binding a parameter to a check box creates an incoming parameter. An incoming parameter is a parameter that is bound to a control. The parameter value will populate the check box with values.
   - Click the Parameters tab.
     The Properties and settings dialog box opens.
   - Close the Properties and settings dialog box.
     Close this dialog since you are populating the check box with a parameter value.
   - Select the center of the parameter name object, left-click and drag the parameter to the center of the check box object, and release the mouse to complete the binding.
   - To unbind the parameter from the check box, select the arrow head on the line, so that the line is bold, right-click, and select Break binding.

5. Bind the check box to a parameter.
   Binding the check box to a parameter will populate the parameter with a list of values.
   - Click the Parameters tab.
     The Properties and settings dialog box opens.
   - Create the list of values for the check box. You can create a list of Static or Dynamic values.
Optionally, select Add display image to display images, in addition to the text next to the check box.

You can select the image by clicking the ellipsis button in the Display column of the Properties and settings dialog box.

To use dynamic image values, there must be a field in the data source that contains the image file name. The physical image file must exist in the current application if you are working in Local Projects. If you are working in Managed Reporting, the image must reside in the domain Other folder. This field name must be specified as the Display field in the Properties and settings dialog box.

If a report on the HTML page is coded to use the User Output format (Parameter name WFFMT), the user can select a check box control from the New Parameters dialog box. The tool will automatically associate the output type image, included with the product, to each check box.

**Note:** For more information on the User Output format, see the *Creating Reports With Report Painter* manual and the *WebFOCUS InfoAssist User's Manual.*

Close the Properties and settings dialog box to create the check box with the list of values.

Bind the check box to a parameter. Select the center of the check box, left-click and drag the check box to the center of the parameter object, and release the mouse to complete the binding.
Reference: Check Box Properties in the Properties Window

When a check box is selected, the Properties tab in the Properties window contains properties of the selected check box.

![Properties Window]

Click a property to display a description of the selected property at the bottom of the Properties window.

Using Radio Buttons

Radio buttons enable you to select a single value from a list of supplied values. Radio button values can be static or dynamic.

Procedure: How to Add Radio Buttons

1. Add radio buttons by doing one of the following:
   - Click the Radio button from the Components toolbar.
   - Or
   - From the Insert menu, select Controls, then click Radio Button.
The cursor changes to a crosshair.

2. Drag the crosshair to create a radio buttons list and adjust it to the size you want.

A radio button placeholder is created in the layout and assigned the name radio(n), where n is a number.

3. Optionally, change the properties of the radio buttons by adjusting the properties displayed in the Properties tab of the Properties window. For details, see Radio Buttons Properties in the Properties Window on page 205.

4. Bind an existing parameter to the radio button.

Binding a parameter to a radio button creates an incoming parameter. An incoming parameter is a parameter that is bound to a control. The parameter value will populate the radio button with values.

☐ Click the Parameters tab.

The Properties and settings dialog box opens.

☐ Close the Properties and settings dialog box.

**Note:** Close this dialog since you are populating the radio button with a parameter value.

☐ Select the center of the parameter name object, left-click and drag the parameter to the center of the radio button object, and release the mouse to complete the binding.

☐ To unbind the parameter from the radio button, select the arrow head on the line, so that the line is bold, right-click, and select Break binding.

5. Bind the radio button to a parameter.

Binding the radio button to a parameter will populate the parameter with a list of values.

☐ Click the Parameters tab.

The Properties and settings dialog box opens.

☐ Create the list of values for the radio button. You can create a list of Static or Dynamic values.
Optionally, as shown in the following image, select *Add display image* to display images in addition to the text next to the radio button.

You can select the image by clicking the ellipsis button in the Display column of the Properties and settings dialog box.

To use dynamic image values, there must be a field in the data source that contains the image file name. The physical image file must exist in the current application if you are working in Local Projects. If you are working in Data Servers, the image must reside in the Current Application folder. If you are working in Managed Reporting, the image must reside in the domain Other folder. This field name must be specified as the Display field in the Properties and settings dialog box.
If a report on the HTML page is coded to use the User Output format (Parameter name WFFMT), the user can select a radio button control from the New Parameters dialog box. The tool will automatically associate the output type image included with the product to each radio button, as shown in the following image.

![Image of radio button controls](image)

**Note:** For more information on the User Output format, see the *Creating Reports With Report Painter* manual and the *WebFOCUS InfoAssist User's Manual*.

- Close the Properties and settings dialog box to create the radio button with the list of values.
- Bind the radio button to a parameter: Select the center of the radio button, left-click and drag the radio button to the center of the parameter object, and release the mouse to complete the binding.
Reference: Radio Buttons Properties in the Properties Window

When a radio button is selected, the Properties tab in the Properties window contains options that control the properties of your radio buttons.

Click a property to display a description of the selected property at the bottom of the Properties window.

Using Tree Controls

By using a tree structure in an HTML report, you can show hierarchical data from a multidimensional data source (for example, SAP BW), that uses the parent/child model. You may also use a tree control for non-hierarchical data sources. Level hierarchies are not supported.
The behavior of the tree control is integrated with the parameter definition. If a parameter is defined as a single value and that parameter is bound to a tree control, the tree control uses option buttons for each node in the hierarchy. If the parameter is defined as Multiselect OR or Multiselect AND, and that parameter is bound to a tree control, then the tree control uses check boxes for each node in the hierarchy, enabling you to select multiple nodes.

The following image shows the Tree Control component in HTML Composer.

![Tree Control Component](image)

**Note:** Cube data should be used to populate single source trees.

**Procedure: How to Add a Tree Control to an HTML Page Using an Embedded Procedure**

This procedure describes how to add a tree control for a multi-dimensional data source, using an embedded procedure.

1. In HTML Composer, insert a tree control from the Components toolbar.

   **Tip:** You may select Single source Tree control or Multi source Tree control. If no type is selected, Single source Tree control is the default, as shown in the following image.

   ![Tree Control Options](image)

   The cursor changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

   A tree control is created in the layout and assigned the name treecontrol\((n)\), where \(n\) is a number. Additionally, the Properties and settings dialog box appears for the tree control.

3. Optionally, you may select the **Expanded** property from the Properties tab of the Properties window to show the tree control expanded at run time.

4. Optionally, you may select the **Hyperlink** property from the Properties tab of the Properties window to show the tree nodes as hyperlinks, instead of radio buttons at run time.

5. From the Properties and settings dialog box, select **Dynamic** as the Data type.
6. Keep *Embedded procedure* selected and click the *browse (...)* button adjacent to the first input field.

   The Get source file dialog box opens.

7. Select a multi-dimensional data source and click *Open*.

   The multi-dimensional data source is added as the embedded procedure.

8. Click the *Value field* browse button to select a field from the hierarchy.

   The Value field is the data source field from which the values will be retrieved.

9. Click the *Display field* browse button to select a field from the hierarchy.

   The Display field is the text that represents the parameter value in the tree control.

10. Save and run the page to view the multi-dimensional data source in the tree control.

**Procedure: How to Add a Tree Control to an HTML Page Using an Existing Procedure**

You can select an existing procedure to add to the tree control in an HTML page. When you select a procedure, it should use fields from the parent/child hierarchy and be set up as follows:

```
TABLE FILE file
SUM FST.dispfield
BY ParentUniqueField
BY UniqueField
BY datafield
ON TABLE PCHOLD FORMAT XML
END
```

where:

*file*

Is the name of the data source.

*dispfield*

Is the field whose values display in the tree control.

*ParentUniqueField*

Is the field that represents the parent for the parent/child hierarchy (PROPERTY = PARENT_OF).

*UniqueField*

Is the field that represents the unique IDs for the hierarchy members (PROPERTY=UID).
datafield

Is the field whose values are passed as the parameter value.

After the procedure is set up, follow these steps:

1. In HTML Composer, insert a tree control from the Components toolbar.
   
   **Tip:** You may select Single source Tree control or Multi source Tree control. If no type is selected, Single source Tree control is the default.

   The cursor changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

   A tree control is created in the layout and assigned the name treecontrol\((n)\), where \(n\) is a number. Additionally, the Properties and settings dialog box appears for the tree control.

3. Optionally, you may select the Expanded property from the Properties tab of the Properties window to show the tree control expanded at run time.

4. Optionally, you may select the Hyperlink property from the Properties tab of the Properties window to show the tree nodes as hyperlinks, instead of radio buttons at run time.

5. From the Properties and settings dialog box, select Dynamic as the Data type.

6. Select External Procedure and click the browse (...) button adjacent to the first input field.
   
   The Get source file dialog box opens.

7. Select a procedure and click Open.

   The procedure name is added as the external procedure.

8. Click the Value field browse button to select a field from the hierarchy.

   The Value field is the data source field from which the values will be retrieved.

9. Click the Display field browse button to select a field from the hierarchy.

   The Display field is the text that represents the parameter value in the tree control.

10. Save and run the page to view the multi-dimensional data source in the tree control.

**Procedure: How to Populate a Multi Source Tree Control**

You can show a tree structure for a non-hierarchical data source by using a tree control. By identifying the number of layers for the tree control, you are able to populate each layer of the tree control with its own procedure. Setting the number of layers creates a tree structure by which each layer is its own subcontrol, chained together with no conditions.
This procedure describes how to add parameters for a tree control, where the number of layers property is set.

1. In HTML Composer, insert a tree control by doing one of the following:
   - Click *Multi source Tree control* from the Tree control drop-down list, located on the Components toolbar, as shown in the following image:
   - ![Tree Control Drop-Down List](image)

   or

   - From the Insert menu, select *Controls*, then click *Multi source Tree control*.

   The cursor changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

   A tree control is created in the layout and assigned the name `treecontrol(n)`, where `n` is a number. Additionally, the Properties and settings dialog box appears for the tree control.

3. From the Properties tab of the Properties window, type in the Number of layers for the tree control, and press the Enter key.
This enables you to specify the number of layers to populate. The following image shows the Number of layers property with three (3) layers.

4. Optionally, you may select the *Expanded* property from the Properties tab of the Properties window to show the tree control expanded at run time.

5. Optionally, you may select the *Hyperlink* property from the Properties tab of the Properties window to show the tree nodes as hyperlinks, instead of radio buttons at run time.

6. With the tree control selected, click the *Parameters* tab.

The tree control object shows the set number of layers. For example, the following image shows a tree control with three layers on the Parameters tab.
7. Select each layer of the tree control and create the properties and settings for its data population.

When creating a Multi source Tree control, the static data type is not available. If creating static values for the tree control, you must create a single source tree control. To create a static list of values, see How to Add a Tree Control to an HTML Page Using Static Values on page 216.

For example, if you have a tree control with three layers:

- Select the first layer of the tree control and create a dynamic embedded procedure for the REGION field of the GGSALES data source.
Select the second layer of the tree control and create a dynamic embedded procedure for the ST field of the GGSALES data source.
Select the third layer of the tree control and create a dynamic embedded procedure for the CITY field of the GGSALES data source.

8. Optionally, to add an additional layer for the tree control, right-click the tree control object on the Parameters tab and select Add layer.
Note: The Add layer option only appears for a Multi source tree control object.

9. Click the added layer to view the properties and settings for that layer.
10. Switch to the Design tab of HTML Composer to preview the populated tree control.

![Diagram of tree control](image)

Note that the Properties window drop-down list for the tree control shows each layer of input values.

![Properties window](image)

11. Save and run the page.

**Note:** If a user selects a lower level node in one layer and a higher level node in another layer, when the procedure is executed, only the lowest level selections will take effect. For example, you have 3 layers: COUNTRY, CAR, and MODEL. Under ENGLAND, TRIUMPH, you select TR7. Under FRANCE, you select PEUGEOT. At run-time you will only receive the records for TR7 because you did not select a MODEL under the FRANCE node.
The tree control populates each layer with values. For example, the following image shows the REGION, ST, and CITY fields as a hierarchy of the GGSales data source in the tree control.

Note: A value must be selected for each layer before you can click the Save Selection button.

If a selected value is specified for a field that is not in Layer1, then corresponding selected values must also be specified for the preceding layers.

Only the first and second layers load at run time. If a selected value is specified for a field in Layer1, only values from the first two layers will be selected.

Procedure: How to Add a Tree Control to an HTML Page Using Static Values

This procedure describes how to add static data type parameters for a tree control, where the Number of layers property for the tree control is not set. This enables you to add a static list of values.

1. In HTML Composer, insert a tree control by doing one of the following:
Click *Single source Tree control* from the Tree control drop-down list, located on the Components toolbar.

or

- From the Insert menu, select *Controls*, then click *Single source Tree control*.

The cursor changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

A tree control is created in the layout and assigned the name `treecontrol(n)`, where `n` is a number. Additionally, the Properties and settings dialog box appears for the tree control.

3. From the Properties and settings dialog box, select *Static* as the Data type.

   Static is selected by default. You may select an item, delete it, or add a subitem.

4. Create the parameter values for the control:
- Click the add value button to add a list of values. The values are added in a sequential hierarchical structure. The last value added appears in the Value and Display Value fields.

- To edit the value, manually type the desired value in the Value and Display Value fields.
Select **Append child item** from the Static values drop-down list to append a value at the level currently selected, and create a new value as the child of the selected value. The following image shows an example. Note the number of the value.

![Append child item example](image)

*Value3_6 is added as the new child value of Value 2_3.*

Select **Insert before** from the Static values drop-down list to insert a value before the selected value, as shown in the following example. Note the number of the value.

![Insert before example](image)

Select **Insert after** from the Static values drop-down list to insert a value after the selected value, as shown in the following example. Note the number of the value.

![Insert after example](image)

Repeat these steps until the list contains all of the values you want to include.

Optionally, click the **Delete** button to eliminate any values.
The following image shows the Properties and settings dialog box and the Static data type options for a tree control.

5. Check the Selected check box to show the entry in the Value field as the default value.
6. Check the Send display value check box to send the display value, rather than the actual data, to the parameter.
7. Save and run the page to populate the tree control with static values.

**Procedure: How to Create a New Tree Control From the New Parameters Dialog Box**

When a report contains one or more new amper variable parameters created in Report Painter, the New Parameters dialog box appears when you save the report and return to HTML Composer. You can assign a new Single source or Multi source Tree control from the HTML page to the parameter from the New Parameters dialog box.

For each parameter, you will find Name and Control Type fields, a Create control check box, and options to set the Control Type to a Single source or Multi source Tree control.
1. From the Design tab of HTML Composer, import or create a report that contains a parameter. When importing a report with parameters, the New Parameters dialog box appears prompting you to create the control type.

2. Select the new tree control from the New Parameters dialog box. The following image shows the ST parameters with *Single source Tree control* being selected as the new control type for the parameter.

The Control Type column refreshes, showing the selected control.

3. Click OK to close the New Parameters dialog box.
The report is added and the associated parameters are bound to the tree control, as shown on the Parameters tab. As for any other type of input control, you can edit the Properties and settings, chain controls, change the control type, and so on.

Reference: Usage Notes For Chaining Tree Controls

The following usage notes apply when chaining tree controls. You may chain controls from the New Parameters dialog box and from the Parameters tab.

- When the Multi source Tree control is a link in the chain, the New Parameters dialog box enables you to share parameters with the same multi source control.
For example, the following image shows the New Parameters dialog box that appears when the first link in the chain, REGION, is a Multi source Tree control. When the Chain control column is checked for the parameters, the remaining parameters, ST and CITY, can share the tree control with the REGION parameter. Note that when parameters are shared with the Multi source Tree control, the Create control column is unselected.

The result of sharing the new control with a Multi source Tree control appears as follows from the Parameters tab. Note how the tree control shows multiple layers, chaining REGION, ST, and CITY.

You can chain a Multi source Tree control to a Single source Tree control.
For example, the following image shows the first layer of the Multi source Tree control populated with Account_Type from Account Properties of the Microsoft Analysis Services sample file, Adventure_Works. The second layer is populated with Accounts. The Multi source Tree is chained to the Single source Tree which is populated with Account_Number from Account Properties of the Adventure_Works data file.

- You can chain a Single source Tree control to another Single source Tree control.
For example, the following image shows an example of a Single source Tree control populated with sample data from the Microsoft Analysis Services Adventure Works sample file, Adventure_Works. Treecontrol1 is populated with Accounts Member Caption and treecontrol2 is populated with Account Type.

- You can chain a Multi source Tree control to another Multi source Tree control.
For example, the following image shows the New Parameters dialog box that shows two Multi source Tree controls. The first tree control contains REGION, ST, and CITY. Note that when parameters are shared with the Multi source Tree control, the Create control column is unselected. The second tree control contains CATEGORY and PRODUCT. The Chain control column is selected for all parameters, indicating that all the controls will be chained.
The result appears as follows from the Parameters tab. Note the first tree control, treecontrol1, is a Multi source Tree control with three layers, containing REGION, ST, and CITY. The second tree control, treecontrol2, is a Multi source Tree control containing two layers, CATEGORY and PRODUCT. Treecontrol1 is chained to treecontrol2.

- You can chain a tree control to another non-tree control, such as Drop down list or List box.
For example, the following image shows the New Parameters dialog box that shows a drop-down list and a Multi source Tree control. The drop-down list contains the CATEGORY parameter. The Multi source Tree control contains the REGION, ST, and CITY parameters. Note that when parameters are shared with the Multi source Tree control, the Create control column is unselected. The Chain control column is selected for all parameters, indicating that all the controls will be chained.
The result appears as follows from the Parameters tab. The drop-down list, combobox1, contains the CATEGORY parameters. treecontrol1 is a Multi source Tree control with three layers, containing REGION, ST, and CITY. Combobox1 is chained to treecontrol1.

- Chaining cannot be done with only field names.
- Dynamic population of controls with field names need to use SYSCOLUMN calls.
Reference: Tree Control Properties in the Properties Window

When a tree control is selected, the Properties tab in the Properties window contains options that control the properties of tree controls.

Click a property to display a description of the selected property at the bottom of the Properties window.

Select all children. The Select all children option, when set to Yes, makes it so that when a parent is selected, all children are selected and when a parent is unselected, all children are unselected. No is selected by default.

Note: The Number of layers property is not available in a single tree source property window.
Using a Slider Control

You may add a slider control for numeric range values in a report or graph. This enables you to use a slider bar to select from a range of values.

**Note:** When using a Slider control in a RIA page, you can drag the slider to any value. For example, if a slider control is populated using a field whose only valid values are 2, 4, and 5, you can drag the slider to 1 and 3.

**Procedure: How to Add a Slider Control**

1. Add a slider control by doing one of the following:
   - From the Components toolbar, click the *Slider* button. Next, select the slider direction (Horizontal or Vertical), then select the slider type (Simple, Color Bar and Arrows or Color Bar, Arrows Edit).
   
   or
   
   - From the Insert menu, select *Controls*, then select *Slider*. Next, select the slider direction (Horizontal or Vertical), then select the slider type (Simple, Color Bar and Arrows or Color Bar, Arrows Edit).

   The cursor changes to a crosshair.

2. Drag the crosshair to create a slider control, and adjust it to the size you want.

   A slider control is created in the layout and assigned the name slider(n), where n is a number.

   **Note:** The slider control is determined by the default slider control type selected from the HTML Page tab, located in the Developer Studio Options dialog box. For details about changing the slider bar, see *How to Change the Default Slider Bar* on page 233.

3. Optionally, change the slider control properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see *Slider Control Properties in the Properties Window* on page 234.

4. Bind an existing parameter to the slider control.

   Binding a parameter to a slider control creates an incoming parameter. An incoming parameter is a parameter that is bound to a control. The parameter value will populate the slider control with values.

   - Click the *Parameters* tab.

   The Properties and settings dialog box opens.
Using Input Controls to Supply Parameter Values

- Close the Properties and settings dialog box.
  
  Close this dialog since you are populating the slider control with a parameter value.

- Select the center of the parameter name object, left-click and drag the parameter to the center of the slider control object, and release the mouse to complete the binding.

- To unbind the parameter from the slider control, select the arrow head on the line, so that the line is bold, right-click, and select Break binding.

5. Bind the slider control to a parameter.

Binding the slider control to a parameter will populate the parameter with a range of values.

- Click the Parameters tab.
  
  The Properties and settings dialog box opens.

- Create the range of values for the slider control. You can create a list of Static or Dynamic range of values.

  **Note:** If creating a Static Data type for the slider control, enter the minimum and maximum values for the range in the Minimum and Maximum input fields. The Step input field indicates how the numbers increment on the slider bar.

- Close the Properties and settings dialog box to create the slider control with the range of values.

- Bind the slider control to a parameter. Select the center of the slider control, left-click and drag the slider control to the center of the parameter object, and release the mouse to complete the binding.
6. Run the HTML page and use the slider bar to slide the values up or down. You may also use the end arrows to increase or decrease the numbers in the range. The output is generated based on the selected number from the slider bar.

**Procedure: How to Change the Default Slider Bar**

The default slider type is determined from the HTML Page tab, located in the Developer Studio Options dialog box.

1. To change the default slider type, select Options from the Window menu. The Developer Studio Options dialog box opens.

2. Select the HTML Page tab.

3. Click the Form Settings button to open the Form Settings dialog box.

4. Use the drop-down list to change the default slider control type. You may select from:
   - Horizontal or Vertical Slider Simple bar. The slider bar has no end arrows, just a bar with the slider.
- Horizontal or Vertical Slider with Color Bar and Arrows. Arrows appear at each end of the slider bar.

- Horizontal or Vertical Slider with Color Bar, Arrows, and Edit. Arrows and an edit box appear at the end of the slider bar, showing the current value.

Once a slider control is inserted into HTML Composer, changing these options will not affect the existing sliders. The option is only applied to new slider controls. To change the existing slider bar type, delete the slider object and insert a new slider control.

**Reference:**  **Slider Control Properties in the Properties Window**

When a slider control is selected, the Properties tab in the Properties window contains options that control the properties of the slider control.
Click a property to display a description of the selected property at the bottom of the Properties window.

**Adding a Dynamic Calendar**

Date parameters can utilize a built-in calendar control that enables you to select the desired date or range of dates in a pop-up dynamic calendar. A procedure that is added to or referenced in HTML Composer and contains date parameters will have a Calendar control type available in the Properties tab of the Properties window.

When the Calendar control type is selected, a text box with a calendar icon will display in the Design view of the layout. The text box is the only control available for the calendar, and the icon will always display to the right of the text box. The icon cannot be positioned independently from the text box.

Note that when programmatically returning a date to the calendar, the date must be in a FOCUS date format that specifies the complete date from the list of supported data types in Calendar Properties.

**Procedure:  How to Set Calendar Properties**

1. Add a calendar by doing one of the following:
   - Click the *Calendar* button from the Components toolbar.
   - or
   - From the Insert menu, select *Controls*, then click *Calendar*.

   The cursor changes to a crosshair.

2. Drag the crosshair to create a calendar and adjust it to the size you want.

   A calendar placeholder is created in the layout and assigned the name calendar\(_n\), where \(n\) is a number.

3. Optionally, change the calendar properties by adjusting the properties displayed in the Properties tab of the Properties window. For details, see *Calendar Properties in the Properties Window* on page 241.

4. Bind an existing parameter to the calendar.

   Binding a parameter to a calendar creates an incoming parameter. An incoming parameter is a parameter that is bound to a control. If binding a parameter to a calendar, the parameter value must be in a FOCUS date format that specifies the complete date from the list of supported data types in Calendar Properties. The parameter value will populate the calendar with date values.
Click the Parameters tab.

The Properties and settings dialog box opens.

Close the Properties and settings dialog box.

Close this dialog since you are populating the calendar with a parameter value.

Select the center of the parameter name object, left-click and drag the parameter to the center of the calendar object, and release the mouse to complete the binding.

To unbind the parameter from the calendar, select the arrow head on the line, so that the line is bold, right-click, and select Break binding.

5. Bind the calendar to a parameter.

Binding the calendar to a parameter will populate the parameter with a date value.

Click the Parameters tab.

The Properties and settings dialog box opens, showing the calendar setup options. The calendar setup options enable you to set the range of dates available to the user at run time. Available dates will be represented as an active hyperlink (blue and underlined) and unavailable dates will be static (black without underlines).
Note: The Properties and settings dialog box for a calendar will contain different options depending on the selected data type.

- Create the values for the calendar. You can create Static or Dynamic values.

When the Current/Start date option is checked, the current date will be used in the calendar control at run time.

The Date Range options for setting up the calendar include:

- **Static.** This option will set a static date range in which the developer will select a start date and an end date using a pop-up calendar icon, or by clicking the month, day, or year from the controls.
The pop-up calendar icon appears in the From and To sections when the Static Date Range is selected. If you click the pop-up calendar icon, a pop-up calendar appears and shows the current date selected and circled in red by default. As you scroll through the calendar with the left/right arrows, the currently selected day will remain highlighted for each month. Clicking a date will add that date to the control. Dates can be selected by scrolling left to right, entering the month, day, and year as text, or by selecting the month, day, and year from the drop-down list and spin boxes.

- **Relative.** This option allows you to set a specific number of days, months, and years relative to the current date. The current date (at run time) will always be the reference or starting point and the calendar will show a number of days, months, and years relative to the current date. The range could be all in the past (for example, five years prior to the current date) or all in the future (for example, five years in the future). This is selected as the default Date Range.

- **Dynamic.** This option allows you to point to a procedure that returns a range of dates. Clicking the Select custom procedure browse (...) button allows the developer to choose a preexisting procedure located in the current APP (local projects/data server) or Domain (MR). The procedure must return two date values on the same data line in XML format. The date values must be returned in a format that returns two digits for the month and day, and four digits for the year, for example, MM/DD/YY. For an example of returning a range of dates from a procedure, please see the example shown later in this section.

- Close the Properties and settings dialog box to create the calendar with the range of date values.

- Bind the calendar to a parameter. Select the center of the calendar, left-click and drag the calendar to the center of the parameter object, and release the mouse to complete the binding.

**Reference: Date Formats**

The date format can be displayed differently by selecting one of the available formats from the Date format in data source drop-down list in the calendar controls Property and settings dialog box. The format you select must match the format in the data source or the virtual field, if that is the date field you are using. By default, it will match the format in the data source.

The following date formats are available:
<table>
<thead>
<tr>
<th>Display Date</th>
<th>Date Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/01/15</td>
<td>(YMD)</td>
</tr>
<tr>
<td>15/01/11</td>
<td>(DMY)</td>
</tr>
<tr>
<td>15/01/2011</td>
<td>(DMYY)</td>
</tr>
<tr>
<td>01/15/11</td>
<td>(MDY)</td>
</tr>
<tr>
<td>1/15/2011</td>
<td>(MDYY)</td>
</tr>
<tr>
<td>2011/01/15</td>
<td>(YYMD)</td>
</tr>
<tr>
<td>January, 2011</td>
<td>(trMYY)</td>
</tr>
<tr>
<td>January 15, 2011</td>
<td>(trMDYY)</td>
</tr>
<tr>
<td>Jan 15, 2011</td>
<td>(tMDYY)</td>
</tr>
<tr>
<td>15 Jan, 2011</td>
<td>(tDMYY)</td>
</tr>
<tr>
<td>Wednesday, January 15, 2011</td>
<td>(wrMtrDYY)</td>
</tr>
<tr>
<td>11 Q1</td>
<td>(YQ)</td>
</tr>
<tr>
<td>11.01.15</td>
<td>(Y.M.D)</td>
</tr>
<tr>
<td>11-01</td>
<td>(Y-M)</td>
</tr>
<tr>
<td>11 01 15</td>
<td>(YBMBD)</td>
</tr>
<tr>
<td>2011/01</td>
<td>(YYM)</td>
</tr>
<tr>
<td>01/11</td>
<td>(MY)</td>
</tr>
<tr>
<td>2011 Q1</td>
<td>(YYQ)</td>
</tr>
<tr>
<td>Q1 2011</td>
<td>(QYY)</td>
</tr>
<tr>
<td>Q1 11</td>
<td>(QY)</td>
</tr>
<tr>
<td>01</td>
<td>(M)</td>
</tr>
</tbody>
</table>
### Display Date

<table>
<thead>
<tr>
<th>Display Date</th>
<th>Date Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan</td>
<td>(Mt)</td>
</tr>
<tr>
<td>January</td>
<td>(Mtr)</td>
</tr>
<tr>
<td>Q1</td>
<td>(Q)</td>
</tr>
<tr>
<td>2011</td>
<td>(YY)</td>
</tr>
<tr>
<td>11</td>
<td>(Y)</td>
</tr>
<tr>
<td>15</td>
<td>(D)</td>
</tr>
<tr>
<td>1</td>
<td>(W)</td>
</tr>
<tr>
<td>Wednesday</td>
<td>(Wr)</td>
</tr>
<tr>
<td>Wed, Jan 15, 2011</td>
<td>(wMtDYY)</td>
</tr>
<tr>
<td>Wed, 15 Jan, 2011</td>
<td>(wtDMYY)</td>
</tr>
<tr>
<td>15 January, 2011</td>
<td>(trDMYY)</td>
</tr>
<tr>
<td>Wednesday, 15 January, 2011</td>
<td>(wrtrDMYY)</td>
</tr>
</tbody>
</table>

**Note:** When using a format that is missing a component (such as the day in the MY format), the missing component will be taken from the current day's date.
Reference: Calendar Properties in the Properties Window

When a calendar is selected in HTML Composer, the Properties tab in the Properties window contains the properties of the selected calendar.

Click a property to display a description of the selected property at the bottom of the Properties window.
Example: Returning a Range of Dates From a Procedure

The following returns the complete range of date values for HIREDATE.

- * This extracts minimum and maximum to a single record.
  DEFINE FILE EMPDATA
  NEWDATE/YYMD = HIREDATE;
  END
  TABLE FILE EMPDATA
  WRITE MIN.NEWDATE AS 'MINNEWDATE'
  MAX.NEWDATE AS 'MAXNEWDATE'
  ON TABLE SET ASNAMES ON
  ON TABLE HOLD
  END
  - * This reads that record twice to create two extract files with each field
    having the same name.
  TABLE FILE HOLD
  PRINT MINNEWDATE AS 'NEWDATE'
  ON TABLE SET ASNAMES ON
  ON TABLE HOLD AS MINNEWDATE
  END
  TABLE FILE HOLD
  PRINT MAXNEWDATE AS 'NEWDATE'
  ON TABLE SET ASNAMES ON
  ON TABLE HOLD AS MAXNEWDATE
  END
  - * This uses MORE to create two records.
  TABLE FILE MINNEWDATE
  PRINT NEWDATE
  ON TABLE PCHOLD FORMAT XML
  MORE
  MORE
  FILE MAXNEWDATE
  END
Using a Hidden Parameter Value

A hidden input control allows parameter values to be used in a control without the user seeing them. When a hidden control is used, the current input control assigned to the parameter will not be visible. The value of the parameter can be entered in the Properties and settings dialog box of the Parameters tab, or supplied through chaining.

Procedure: How to Add a Hidden Control

1. Add a hidden control by doing one of the following:
   - Click the Hidden control button from the Components toolbar.
   - Or
   - From the Insert menu, select Controls, then click Hidden.

   The cursor changes to a crosshair.

2. Drag the crosshair to create a hidden control and adjust it to the size you want.

   A hidden control is created and assigned the name inputhidden(n), where n is a number.

   A hidden control is not visible in the Design view of your layout. It is available as a control object on the Parameters tab.
3. Optionally, change the hidden control properties by adjusting the properties displayed in the Properties tab of the Properties window.

Select inputhidden from the Properties drop-down list. The Properties window contains a hierarchical drop-down list of objects that are currently in the layout.

4. Bind the hidden control to a parameter.

Binding the hidden control to a parameter will hide the parameter value when you run the HTML page.

- Click the Parameters tab.

  The Properties and settings dialog box opens.

- Create the list of values for the hidden control. You can create a Static or Dynamic value.

  **Note:** If you are not seeing the value, you should set the list to evaluate to one value.

- Close the Properties and settings dialog box to create the hidden control with the list of values.

- Bind the hidden control to a parameter. Select the center of the hidden control, left-click and drag the hidden control to the center of the parameter object, and release the mouse to complete the binding.

5. To change an existing input control to a hidden control:

- Select the input control on the Parameters tab.

- Right-click and select Hidden from the Set Control Type context menu.

  The input control is hidden on the control in the Design view and when you run the HTML page.

6. To show a hidden control in the control:

- Select the hidden control object from the Parameters tab.

- Right-click and select the desired control from the Set Control Type context menu.

  **Tip:** You may have to reposition the input control on the Design tab of the layout when changing control types.
Creating Hyperlink Actions With Additional Parameters

When you manually add a new parameter on the Parameters tab, you may pass the parameter variable to a hyperlink action. The additional parameters appear on the Hyperlink Properties dialog box when you create a new action.

The Hyperlink Properties dialog box is available when you create a Hyperlink, Push button, Frame, Image, and Submit button.

**Note:** When using Google Chrome™ and when a hyperlink action causes a report to be run in a new window, the report will run in a new tab instead of a new window.

**Procedure:** How to Create a Hyperlink Action With Additional Parameters

1. Create a new parameter:
   - Right-click anywhere on the Parameters tab and select *Add parameter*.
     The Properties and Settings dialog box opens.
   - Enter the name for the parameter in the Name field, or keep the default name.
   - Optionally, you may use the Format field to define the format of the parameter, such as A20 or D12.2.
     If this field is left blank, it automatically applies the Alphanumeric format to the value field.
   - Enter the parameter value information. Options are *Single select*, *Multiselect OR*, and *Multiselect AND*.
     These are static parameter options.
   - Close the Properties and settings dialog box to create an unbound parameter.
   - To bind the new parameter to a control, select the Design view and create an input control. For example, insert a list box, drop-down list box, and so on.
   - Click the *Parameters* tab.
     The Properties and settings dialog box appears for the control.
   - Close the Properties and settings dialog box.
   - Select the center of the parameter name object, left-click, and drag the parameter to the center of the control object.
This makes it an incoming parameter that will populate the control. If the control will populate the parameter, select the center of the control object, left-click and drag the control object to the center of the parameter object.

- Release the mouse to complete the binding.

The following image is an example of an incoming parameter.

1. Select the center of the parameter object, left-click and drag the parameter to the center of the control object.

2. Release the mouse to complete the binding.

To modify the parameter value, right-click the parameter on the Parameters tab and select Properties and settings.

**Tip:** You may also use the Undo and Redo buttons located on the Standard toolbar. Note that undo/redo treats the entire Properties and settings dialog as one action.

2. From the Design view, create and open the Hyperlink Properties dialog box for the input control to create the hyperlink action. For example, insert and right-click the Push Button object and select Create hyperlink.

The Hyperlink Properties dialog box opens for the selected object.

3. Click the New button to create a new action.

The Additional parameters button appears on the Hyperlink Properties dialog box.

The Additional parameters button only appears if parameters were created from the Parameters tab of HTML Composer.

4. Select the Action, Source, Target Type, and Target/Template Name for the hyperlink.
5. Click the **Additional parameters** button and select the parameter name(s) to pass in this hyperlink.

6. Click **OK** to close the Hyperlink Properties dialog box.

If you are linking hyperlink properties to another page or procedure, HTML Composer parses the other file for unresolved parameters and opens the New Parameters dialog box.

When you run the report and click the hyperlink, the action passes the parameter value to the entity specified in the Source column of the Hyperlink Properties dialog box.

**Binding a Button, Hyperlink, or Image to Populate a Control**

You may bind a button, hyperlink, or image to a control on the Parameters tab in HTML Composer. This enables you to dynamically repopulate the control with new values at run time by clicking the button, hyperlink, or image.
For example, the following image shows a report with a custom list of static values for the State field in a list box control. Clicking the button repopulates the list box control with a dynamic list of state values, enabling you to select a state and run the report.

**Procedure: How to Bind a Button to Populate a Control**

Using information from the sample data source GGSALES, create a report with a state parameter. A list box control shows a custom list of selected state values that you have created. A push button, bound to the list box, repopulates the control and shows a dynamic list of state values from the data source at run time. This enables you to selectively populate the list box with static or dynamic values before running the report.

1. Create the HTML page.

**Tip:** The Gotham Grinds Sales data source (ggsales.mas) is available from the ibisamp Applications on the localhost folder of Developer Studio. You may copy this source file to the project directory of your choice.

   a. Select the HTML Files folder from your project in Developer Studio.

   b. Right-click and select New/HTML File.
The Add HTML File dialog box opens.

c. Type binding_button in the File name text box and click Open.

HTML Composer opens.

2. Create the Gotham Grinds sales report.

   a. Select New Report from the Insert menu.

      The cursor changes into a crosshair.

   b. Drag the crosshair to create a reporting object and adjust it to the size you want.

   c. Double-click the report placeholder.

      The Open dialog box appears.

   d. Select the ggsales Master File and click Open.

      Report Painter opens showing the field names for the ggsales data source.

   e. Select By from the Columns toolbar.

      Double-click the following field names: CATEGORY, PRODUCT, REGION, ST, CITY

   f. Insert your cursor after the City field in the Report Painter canvas, and select Sum from the Columns toolbar.

   g. Double-click DOLLARS to add it to the report.

3. Create a parameter for the ST field. This parameter will be populated from a static list when you initially run the report on the HTML page.

   a. Click the Where/If button from the Columns toolbar.

      The Report Options dialog box opens at the Where tab.

   b. Click Assist.

      The Expression Builder opens.

   c. Create a parameter for ST from the Expression Builder:

      - From the Fields list, double-click ST.

      - From the Logical Relations drop-down list, select equals.

      - In the Compare Type box, select Parameter.

      - Double-click the Compare Value box to open the Variable Editor.
Keep the default Name as ST.

Type By State in the Prompt field.

Keep the default Static list from the Accept List section.

Type the following states as the Display and Return Values, respectively:

California, CA, Georgia, GA, Illinois, IL, New York, NY.

Click OK to close the Variable Editor.

d. Click OK to close the Expression Builder.

e. Click OK to close the Report Options dialog box.

f. Select Close from the File menu to close Report Painter.

g. When you are prompted to save your changes, click Yes.

You are returned to HTML Composer and the New Parameters dialog box appears.

h. Select List box from the Control Type ellipsis button and click OK to automatically add the state parameter control to the HTML page.

4. Insert a button, hyperlink, or image object.

Adding a button, hyperlink, or image to the layout enables you to execute a request at run time. For this example, insert a push button.

a. From the Insert menu, select Controls, then click Push Button.

The cursor changes into a crosshair.

b. Drag the crosshair to create a push button and adjust it to the size you want.

A push button is created in the layout and assigned the name button(n), where n is a number.

c. Optionally, you may rename the text of the button by typing text in the Value property field in the Properties window.

5. Add the button object to the Parameters tab.

a. Click the Parameters tab.

The Properties and settings dialog box opens, showing a Legend of the available controls for the values on the HTML page.

b. From the Thumbnails tab, select the button object.
c. Left-click and drag the object onto the Parameters tab.

d. Release the mouse to move the object onto the Parameters tab.

The button object appears on the Parameters tab and the Properties and settings for the button appear.

6. Bind the button object to the list box control.

Binding the button, hyperlink, or image to a control enables you to populate the control with alternative code.

a. Select the center of the button object, left-click and drag the object to the center of the list box control object, and release the mouse to complete the binding. A line indicates the direction of the bind.

7. Create the properties and settings for the bound object.

a. Click the arrow head in the link of the chain between the button and list box control.

The Properties and settings dialog box enables you to create alternative code to populate the list box at run time.

b. Create dynamic values for the state parameter.

- Select Dynamic as the Data type.
- Keep the default Embedded procedure selected.
- Click the browse button and double-click `ggsales.mas` from the Get source file dialog box.
- From the Value field, click the browse button and double-click ST.
The GGSALES data source is added as the Value and Display field, as shown in the following image.

- Close the Properties and settings dialog box.

8. Save and run the HTML page.
Using the default list of static state fields, run the report.

![HTML Page](image)

To illustrate, consider the following table:

<table>
<thead>
<tr>
<th>Category</th>
<th>Product</th>
<th>Region</th>
<th>State</th>
<th>City</th>
<th>Dollar Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coffee</td>
<td>Espresso</td>
<td>West</td>
<td>CA</td>
<td>Los Angeles</td>
<td>$606,079</td>
</tr>
<tr>
<td></td>
<td>Latte</td>
<td>West</td>
<td>CA</td>
<td>Los Angeles</td>
<td>$1,745,509</td>
</tr>
<tr>
<td>Food</td>
<td>Biscotti</td>
<td>West</td>
<td>CA</td>
<td>Los Angeles</td>
<td>$535,548</td>
</tr>
<tr>
<td></td>
<td>Croissant</td>
<td>West</td>
<td>CA</td>
<td>Los Angeles</td>
<td>$1,624,541</td>
</tr>
<tr>
<td></td>
<td>Scone</td>
<td>West</td>
<td>CA</td>
<td>Los Angeles</td>
<td>$608,423</td>
</tr>
<tr>
<td>Gifts</td>
<td>Coffee Grinder</td>
<td>West</td>
<td>CA</td>
<td>San Francisco</td>
<td>$401,680</td>
</tr>
<tr>
<td></td>
<td>Coffee Pot</td>
<td>West</td>
<td>CA</td>
<td>Los Angeles</td>
<td>$400,130</td>
</tr>
<tr>
<td></td>
<td>Mug</td>
<td>West</td>
<td>CA</td>
<td>San Francisco</td>
<td>$761,325</td>
</tr>
<tr>
<td></td>
<td>Thermos</td>
<td>West</td>
<td>CA</td>
<td>San Francisco</td>
<td>$372,728</td>
</tr>
</tbody>
</table>
9. Click the push button to repopulate the list box with the dynamic state values from the GGSALES data source. Note how the list of state values changed.

10. Select a state value from the list box and run the report.

**Tip:** Click the *Refresh* button to repopulate the list box with the default static values.

**Procedure:** How to Use Controls to Populate Another Control Based on Selected Values

In this procedure, you will create multiple list box controls that will all have parameters bound to them. When the appropriate combination of these four parameters is selected, the fifth list box control will be populated with the related information.

1. Create a procedure, using the car Master File, named countrycars.fex.
2. In the procedure:
   a. Insert two COUNTRY fields, Sum FST.COUNTRY BY COUNTRY.
      This ensures that you get each value of country one time and in sorted order.
   b. Create selection tests comparing CAR to &Parameter1, MODEL to &Parameter2, DEALER_COST to &Parameter3, and RETAIL_COST to &Parameter4.
   c. Set the output format for this procedure to XML.
3. Save and close the procedure.
4. Create a new HTML file named cars.htm.
5. In the HTML file, create a new, Single Layer Form.

6. Delete the Submit Form button, as shown in the following image.

7. Create four list boxes inside the form and one list box outside the form, as shown in the following image.

8. In the Properties and Settings dialog box, change Selection Required to Yes for all four list boxes inside the frame.

9. Insert labels for each list box. Name the four inside the form, Parameter1, Parameter2, Parameter3, and Parameter4. Name the list box on the outside Result.

10. Select the Parameters tab at the bottom of the HTML Composer window.
11. Add four parameters to the file, as shown in the following image.

12. Bind listbox1 to Parameter1, listbox2 to Parameter2, listbox3 to Parameter3, and listbox4 to Parameter4, as shown in the following image.

13. Bind listbox1, listbox2, listbox3, and listbox4 to listbox5, as shown in the following image.
14. Edit the properties of listbox1, listbox2, listbox3, and listbox4.
   a. Select the *Dynamic* Data type option for all four list boxes.
   b. Select *Embedded procedure* for all four list boxes.
   c. Click the *procedure ellipsis button* (…) and select *car.mas* for all four list boxes.
   d. Set the Value field for listbox1 to CAR; for listbox2, MODEL; for listbox3, DEALER_COST; and for listbox4, RETAIL_COST.

15. Edit the properties of listbox5.
   a. Select the *Dynamic* Data type option.
   b. Select *External procedure*.
   c. Click the *procedure ellipsis button* (…) and select *countrycars.fex*.
   d. If it is not set already, set the Value field for listbox5 to COUNTRY.

16. Edit the binding properties for each of the bindings between listbox1, listbox2, listbox3, and listbox4 to listbox5.
   a. Select the *Dynamic* Data type option.
   b. Select *External Procedure*.
   c. Click the *procedure ellipsis button* (…) and select *countrycars.fex* for all four bindings.
      The Value field and Display field are assigned the COUNTRY field upon the selection of the procedure.
   d. Change Resolves Parameter to the appropriate parameter for that list box.
      For example, listbox1 is bound to Parameter1. Therefore, you should select Parameter1 for the Resolves Parameter field.

17. Save and run the report.
    A new web browser window opens with four populated list boxes and one empty list box.

18. For Parameter1, select ALFA ROMEO. For Parameter2, select 2000 4 DOOR BERLINA. For Parameter3, select 4,915. And for Parameter4, select 5,925.
Listbox5 is populated with the value, ITALY, as shown in the following image.

![Listbox5 Image]

**Note:** Only when the appropriate combination of values are selected does the result display. If you were to choose 5,610 for Parameter4, no result would be displayed.

### Supplying Parameter Values to External Reports

You can supply parameters to external reports the same way you apply them to reports created with Report Painter. The HTML page can also contain multiple reports associated with a common set of parameters. Launch mechanisms such as a push button, hyperlink, or image can be associated to external reports that contain different sets of parameters. You can also update and target parameters for an external report to a frame or window directly within your HTML page.

Before you can supply parameter values to an external report, you must create a hyperlink to the report and associate a launch mechanism to it. After you associate a launch mechanism, such as a push button, hyperlink, or image, to the external report, the report layout is populated with the parameters.

#### Procedure: How to Supply Parameter Values to External Reports With a Push Button

In this procedure, you will create a push button to launch an external report and target the output to a window.

1. From the Insert menu, select *Controls*, then click *Push Button*.
   
   The cursor changes into a crosshair.

2. Drag the crosshair to create a push button and adjust it to the size you want.

3. Right-click the button and select *Create hyperlink*.
   
   The Hyperlink Properties dialog box opens.

4. Specify the text you want to display as the hyperlink in the Display Text input field.
5. To set the action of the hyperlink to execute an external report, select the New button, then select External procedure from the Action drop-down list.

6. Enter the external report procedure name in the Source field, or click the browse (...) button to browse to the procedure.

7. Optionally, direct the output to a specific location by selecting Window or Frame in the Target Type field.

8. Specify the Target/Template Name for the target frame or window.

9. Click OK.

The parameters for the report are automatically added to objects in the layout and displayed in the Parameters tab.

10. From the File menu, click Run.

11. Click the push button to view the external report.

The report opens in a separate window as you specified in the Hyperlink Properties dialog box for that push button.
Procedure: **How to Supply Parameter Values to an External Report With an Image**

In this procedure, you will insert an image that will launch an external report when you click it. You will target the output to a window.

1. From the Insert menu, select *Components*, then click *Image*.
   The cursor changes into a crosshair.

2. Drag the crosshair to position the image.
   The Get source file dialog box opens.

3. Navigate to the image using the Look in drop-down list, select the image, and click *Open*.

4. Adjust the image to the desired size and location.

5. Right-click the image and select *Create hyperlink*.
   The Hyperlink Properties dialog box opens.

6. To set the action of the hyperlink to execute an external report, select the *New* button, then select *External procedure* from the Action drop-down list.

7. Enter the external report procedure name in the Source field, or click the *browse (…)* button to browse to the procedure.

8. Direct the output to a window by selecting *Window* in the Target Type field.

9. Specify the Target/Template Name for the target frame or window.

10. Click *OK*.
   The parameters for the report are automatically added to objects in the layout and displayed in the Parameters tab.

11. From the File menu, click *Run*.

12. Click the image to view the external report.
Procedure: How to Supply Parameter Values to an External Report With a Hyperlink

In this procedure, you will create a frame and target report output from an external report to it. You will also create a hyperlink to launch the external report.

1. From the Insert menu, select Components, then click Frame. Drag the crosshair to create a frame and adjust it to the size you want. Enter a name for the frame by double-clicking the Name field in the Properties tab of the Properties window.

2. From the Insert menu, select Components, then click Hyperlink. Drag the crosshair to create a hyperlink and adjust it to the size you want.

The Hyperlink Properties dialog box opens.

3. Specify the text you want to display as the hyperlink in the Display Text input field.

4. To set the action of the hyperlink to execute an external report, select the New button, then select External procedure from the Action drop-down list.

5. Enter the external report procedure name in the Source field, or click the browse (...) button to browse to the procedure.

6. Direct the output to the frame you inserted by selecting Frame in the Target Type field.

7. Select the name of the frame you created from the Target/Template Name drop-down list.
8. Click OK.

The parameters for the report are automatically added to objects in the layout and displayed in the Parameters tab.

9. From the File menu, click Run.

10. Click the hyperlink to view the external report.

The report opens in the frame you specified in the Hyperlink Properties dialog box for that hyperlink.

---

**Example: Supplying Parameter Values to Multiple External Reports**

In this example, you will add two reports to a layout. You will associate a push button to one report and target the output to a window. You will associate a hyperlink to the second report and target the output to a frame.

1. From the Insert menu, select Controls, then click Push Button.

   The cursor changes into a crosshair.

2. Drag the crosshair to create a push button and adjust it to the size you want.

   A push button is created in the layout and assigned the name button(n), where n is a number.

3. Right-click the button, and select Create hyperlink.

   The Hyperlink Properties dialog box opens.
4. Type *Run report* in the Display Text input field.

5. Set the action of the hyperlink to execute a report by clicking the New button and selecting *External procedure* from the Action drop-down list.

6. Enter the external report procedure name in the Source field, or click the browse (...) button to browse to the procedure.

7. In the Target Type field, select *Window* from the drop-down list.

8. In the Target/Template Name field, select *New window frame* from the drop-down list.

9. Click OK.

   The parameters for the first report are automatically added to objects in the layout and displayed in the Parameters tab.

10. From the Insert menu, select *Components*, then click *Frame*. Drag the crosshair to create a frame and adjust it to the size you want.

11. Double-click the Name field in the Properties tab of the Properties window and enter frame1.

12. From the Insert menu, select *Components*, then click *Hyperlink*. Drag the crosshair to create a hyperlink and adjust it to the size you want.

   The Hyperlink Properties dialog box opens.

13. Type *Run report 2* in the Display Text input field.

14. Set the action of the hyperlink to execute a report by clicking the New button and selecting *External procedure* from the Action drop-down list.

15. Enter the external report procedure name in the Source field, or click the browse (...) button to browse to the procedure.

16. In the Target Type field, select *Frame* from the drop-down list.

17. In the Target/Template Name field, select the name of the frame you created (frame1).

18. Click OK.

19. From the File menu, select *Run*.

20. Click the push button to view the first external report.
The report opens in a separate window as specified in the Hyperlink Properties dialog box for that push button.
21. Click the hyperlink to view the second external report. The report opens in the frame you specified in the Hyperlink Properties dialog box for that hyperlink.

![Image](image.png)

**Procedure:** How to Supply a Parameter Value to a Report Using a URL

In this procedure, you will create a report within an HTML page where you can pass a parameter to the report, directly from a URL.

1. Using Report Painter in the Data Servers area of Developer Studio, create a procedure using the car Master File.
   
   a. Print the COUNTRY, CAR, DEALER_COST, and RETAIL_COST fields.
   
   b. Assign the COUNTRY field to a parameter named Parameter1.

   For more information on creating a report using Report Painter, see the *Creating Reports With Report Painter* manual.

2. Save and close the procedure.

3. Create a new HTML file named pass_on_url.htm.

4. In the HTML file, create a new report.

5. Right-click the report frame and select Reference existing procedure.

   The Get source file dialog box opens.

6. Select the procedure you created in step 1.
The New Parameters dialog box opens, as shown in the following image.

7. Click Cancel.

The page now has a report that requires a parameter but has no parameter value supplied.

8. Click Save, to save the HTML file.

9. Type the following into the address bar of a new web browser window:

   \[ \text{http://localhost:8080/approot/appname/pass_on_url.htm?Parameter1=ITALY} \]

   where:

   \[ \text{appname} \]
   
   Is the name of the application that contains the HTML page.

   \[ \text{Parameter1=ITALY} \]
   
   Sets Parameter1, which had no previous value, to ITALY.

10. Press the Enter key.
The report runs for the value of ITALY, as shown in the following image.

<table>
<thead>
<tr>
<th>COUNTRY</th>
<th>CAR</th>
<th>MODEL</th>
<th>DEALER_COST</th>
<th>RETAIL_COST</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITALY</td>
<td>ALFA ROMEO</td>
<td>2000 4 DOOR BERLINA</td>
<td>4,915</td>
<td>5,925</td>
</tr>
<tr>
<td>ITALY</td>
<td>ALFA ROMEO</td>
<td>2000 GT VELOCE</td>
<td>5,660</td>
<td>6,820</td>
</tr>
<tr>
<td>ITALY</td>
<td>ALFA ROMEO</td>
<td>2000 SPIDER VELOCE</td>
<td>5,660</td>
<td>6,820</td>
</tr>
<tr>
<td>ITALY</td>
<td>MASERATI</td>
<td>DORA 2 DOOR</td>
<td>25,000</td>
<td>31,500</td>
</tr>
</tbody>
</table>

**Procedure: How to Pass a Parameter From One Page to Another**

In this procedure, you will create an HTML file that contains a list box and a button. The HTML file can pass a parameter from one webpage to another.

**Note:** You will use the file, pass_on_url.htm, created in the procedure How to Supply a Parameter Value to a Report Using a URL on page 265. This is the webpage to which the parameter will be sent.

1. Create a new HTML file named pass_on_page.htm.
2. In the HTML file, create a List Box, as described in How to Add a List Box on page 179.
3. Select the Parameters tab at the bottom of the HTML Composer window.
4. Right-click and select Add parameter.

A new parameter is added to the HTML file. This parameter is named Parameter1 by default, as shown in the following image.

5. Click the newly created Parameter1 and in the Properties and settings dialog box, type A10 in the Format field.
A10 is the format of COUNTRY, the field used in pass_on_url.htm.

6. Bind listbox1 to Parameter1, as shown in the following image.

7. Select listbox1 and perform the following actions.
   a. In the Properties and settings dialog box, select the Dynamic option.
   b. Click the procedure ellipsis button (...) and select car.mas.
   c. Click the ellipsis button (...) for the Value field. Populate listbox1 with the COUNTRY field.
The Properties and settings dialog box for listbox1 will look similar to the following image.

8. Select the **Design** tab at the bottom of the HTML Composer window.
9. In the HTML file, create a new Push Button.
10. Right-click the button and select **Create Hyperlink**.
The Hyperlink Properties dialog box opens, as shown in the following image.

11. Create a new hyperlink with the following properties.

- Action set to HTML File.
- Source set to the file, pass_on_url.html, which was created in the previous procedure.
- Target Type set to Window.
- Target/Template Name set to New window.
12. While still in the Hyperlink Properties dialog box, click **Additional parameters**.

A small window opens, containing only Parameter1, as shown in the following image.

13. Double-click **Parameter1**.
The window closes.

This step tells HTML Composer that Parameter1 should be passed on the hyperlink.

14. Click OK in the Hyperlink Properties dialog box.

15. Run the page.

16. Select ENGLAND from the list box and click the button, as shown in the following image.

The report runs, showing the records for ENGLAND, as shown in the following image.

The value was passed from the first page to the second page.

**Styling Your Layout**

When you create an HTML page in HTML Composer, the objects in the layout will display in your browser using the default browser styles. You can customize the appearance of your HTML page by adding a theme or template. You can also use the predefined templates available through the Template selector. The theme property is available from the Properties window of the DOCUMENT object.

**Adding a CSS or Script to the Layout**

Cascading Style Sheets (CSS) or scripts can be added to your layout to determine the look of the webpage. This is a good way to quickly apply corporate styling to your layout or to assign global styling to a layout. It is also an easy method of assigning default styling to all elements in the entire layout with one action. Styling included in a CSS or script will display only in Preview mode.
Note:

- If you modify a Cascading Style Sheet that is already added to your layout, you can refresh the layout to display your changed by pressing the F5 key.

- HTML Composer assigns internal CSS class names to all objects. These class names are used in all of the packaged themes. It is recommended that you use these class names when creating your own CSS files so that objects are styled correctly. In order for user CSS files to be honored, you must assign a theme to a page. Once a theme has been assigned the user CSS files will override that theme. If the user specifies the <Not Set> value for the DOCUMENT object Theme property, the CSS classes will not be honored and no styling will occur.

Procedure: How to Add a CSS or Script to the Layout

1. From the Insert menu, select CSS/Scripts.
   The Insert Web Files dialog box opens.

2. Click the New button and navigate to the directory, in which your CSS or script resides. Select the file, and click Open.

   Note: You may also specify a fully-qualified URL or a relative URL that points to a stylesheet file or script file by entering it in the File name area. A fully-qualified URL must start with http:// or https://. A relative URL must start with a known context root that WebFOCUS uses, such as /approot/appname/scriptname.js.

3. Add additional files if desired. Click OK to add the specified files.

Setting HTML Page Properties

You can set properties for the HTML page you create in HTML Composer in the Properties tab of the Properties window.

Properties set for the HTML page will be inherited by most objects added to the layout. Once a style has been changed for an object in the layout, it cannot be styled with a template or theme. It is recommended that global styling of HTML page be set before properties are set for individual objects.
**Reference:**  **HTML Page Properties in the Properties Window**

When the background of a report is selected, the Properties tab in the Properties window contains options that control the body of the HTML page.

Click a property to display a description of the selected property at the bottom of the Properties window.

**Customizing the Layout**

All changes to your layout can be made in the Design view of HTML Composer or HTML editor. The changes made to a layout in an editor will be preserved when you reenter HTML Composer.
Specifying Browser Defaults With the Style Composer

You can use the Style Composer to control default settings for font, background properties, position mode, flow control, margins, list styles, and visual effects.

**Note:** On the following pages, the images of the Style Composer windows show many blank fields. You may actually see the words Not Set populated in these blank fields when viewing these Style Composer windows in Developer Studio.

**Procedure:** How to Access the Style Composer

To access the Style Composer, complete the following steps.

1. Right-click the background of an HTML page in HTML Composer.
2. From the context menu, select Style.

The Style Composer window opens.
Specifying Browser Defaults With the Style Composer

Reference: Specifying Font Styles Using the Style Composer

To specify the font styles that will be used in the browser for your HTML report, make your selections in the Font window of the Style Composer.

The Font window of the Style Composer is comprised of the following elements:

Font name

Determines the font displayed in a browser.

You can specify: Family (launches the Font Picker dialog box) or System Font.

Font attributes

Determines the attributes of the font displayed in a browser.

The options include: Color, Italics, Small Caps.

Size

Determines the size of the font displayed in a browser.

The options include: Specific, Absolute, Relative.

Bold

Determines whether the font is displayed as bold in a browser.

The options include: Absolute, Relative.

Effects

Determines whether the font effects are displayed in a browser.

The options include: None, Underline, Strikethrough, Overline, Capitalization.
Reference: Specifying Background Properties Using the Style Composer

To specify the background styles that will be used in the browser for your HTML report, make your selections in the Background window of the Style Composer.

The Background window of the Style Composer is comprised of the following elements:

**Background color**

Determines the background color of the HTML page.

You can specify: Color, Transparent.

**Background image**

Determines the properties of the background image displayed in a browser.

The options include: Image, Tiling, Scrolling, Position (Horizontal and Vertical), Do not use background image.
**Note:** When using a background image with scrolling enabled, you must specify the horizontal and vertical positions. If you do not specify these positions, your background image will not show. The horizontal and vertical positions are relative to window and not the individual element.

**Reference:** Specifying Text Styles Using the Style Composer

To specify the text styles that will be used in the browser for your HTML report, make your selections in the Text window of the Style Composer.

The Text window of the Style Composer is comprised of the following elements:

**Alignment**

Determines the alignment of a text.
You can specify: *Horizontal, Vertical, Justification*.

**Spacing between**

Determines the spacing.

You can specify spacing between the following text elements: *Letters, Lines*.

**Text flow**

Determines the flow of the text.

You can specify: *Indentation, Text direction*.

**Reference:**  Specifying Position Mode Using the Style Composer

To specify the position mode that will be used in the browser for your HTML report, make your selections in the Position window of the Style Composer.
The Position window of the Style Composer is comprised of the following elements:

**Position Mode**

From which you can specify: *Position in normal flow, Offset from normal flow, Absolutely position.*

**Height/Width**

When Absolutely Position is selected, you can specify position indicators in the measurements.

You may specify: *Top, Left, Z-Index.*

**Note:** Z-Index is optional. It sets or retrieves the stacking order for absolute or relatively positioned objects.
Reference: Specifying Layout Styles Using the Style Composer

To specify the layout styles that will be used in the browser for your HTML report, make your selections in the Layout window of the Style Composer.

The Layout window of the Style Composer is comprised of the following elements:

**Flow control**
From which you can specify: *Visibility, Allow text to flow, Display, Allow floating objects*.

**Content**
From which you can specify: *Overflow*.

**Clipping**
From which you can specify whether or not to clip the layout from the following positions: *Top, Bottom, Left, Right*. 
**Printing page breaks**

From which you can specify: *Before, After*.

**Reference:** Specifying Edge Styles Using the Style Composer

To specify the margins, padding, and border styles that will be used in the browser for your HTML report, make your selections in the Edges window of the Style Composer, which is shown in the following image.

The Edges window of the Style Composer is comprised of the following elements:

**Margins**

From which you can specify: *Top, Bottom Left, Right* margins.

**Padding**

From which you can specify: *Top, Bottom, Left, Right* padding.
**Borders**

From which you can specify: *Select the edge to be changed, Style, Width, Color.*

**Note:** Borders are displayed as a single line in the Style Composer preview window, regardless of whether you select a single line or double line border. Borders are accurately displayed in the Style Composer Design view and in the HTML output of an application.

**Reference:** Specifying List Styles Using the Style Composer

To specify the list styles that will be used in the browser for your HTML report, make your selections in the Lists window of the Style Composer.

The Lists window of the Style Composer is comprised of the following elements:

**Lists**

From which you can specify: *Bulleted, Unbulleted.*
Bullets

From which you can specify: Style, Position, Custom bullet.

Reference:  Specifying Interface Effects Using the Style Composer

To specify the interface styles and visual effects that will be used in the browser for your HTML report, make your selections in the Other window of the Style Composer.

The Other window of the Style Composer is comprised of the following elements:

User interface

From which you can specify: Cursor.

Tables

From which you can specify: Borders, Layout.
Laying Out Objects With HTML Composer

You can change the size and position of objects in your layout in the following ways:

- Set relationships between objects. This is done by setting relationships between objects and a controlling, or dominant, object. The controlling object is the last object selected. For details, see Setting Relationships Between Objects on page 285.

- Click and drag with your mouse.

- Copy and paste objects.

Setting Relationships Between Objects

You can set relationships between underlying objects and a controlling, or dominant, object. The controlling object is the last object or placeholder selected. You can use these relationships to set properties of the selected objects according to the controlling object. Any object on the HTML page layout can be the controlling object.

You can set the following types of relationships:

- Relationships that maintain a distance between objects. This is useful since a report or graph may take up more or less room when your procedure is run than is accounted for in the layout. When setting relationships between objects in this way, you should select the corners of the objects that are closest to each other. This will ensure that the reports do not overlap if either report takes up more room than anticipated.

- Relationships that affect the positioning of objects. This allows you to ensure that objects remain aligned regardless of a change in size or position of one of the objects and that objects remain the same size even when the size of an object is changed.

**Procedure:** How to Set Object Size

1. Highlight multiple objects with your mouse by holding the Shift key to select items contiguously, or the Ctrl key to select items non-contiguously. The controlling object is the last object selected.

   The size buttons on the positioning toolbar are active.

2. Click the button in the positioning toolbar that corresponds to what you want:

   - *Make same width* sets the width of the highlighted objects to the width of the controlling object.

   - *Make same height* sets the height of the highlighted objects to the current height of the controlling object.
Make same size sets the height and width of the highlighted objects to the height and width of the controlling object.

All selected objects change in size according to the size of the controlling object. If an image becomes distorted when you resize it, you can restore its original size. Right-click the image, and select Restore size. Images are not distorted when clicking and dragging their borders. This maintains their native aspect ratio.

**Procedure:** How to Set the Distance Between Objects

1. Highlight multiple elements with your mouse holding the Shift key to select items contiguously, or the Ctrl key to select items non-contiguously. The controlling object is the last object selected.

2. Click the button in the positioning toolbar that corresponds to the relationship you want. The position of the selected object will be set according to the controlling object, which is the last object selected. The options are:
   - **Relate Top_Left** maintains the distance between the top-left corner of the controlling object and the top-left corners of the highlighted objects.
   - **Relate Top_Right** maintains the distance between the top-right corner of the controlling object and the top-left corners of the highlighted objects.
   - **Relate Bottom_Right** maintains the distance between the bottom-right corner of the controlling object and the top-left corners of the highlighted objects.
   - **Relate Bottom_Left** maintains the distance between the bottom-left corner of the controlling object and the top-left corners of the highlighted objects.

For details on the buttons in the positioning toolbar, see *Positioning Toolbar* on page 287.

**Procedure:** How to Break Relationships

Click Break a relationship from the Positioning toolbar.

**Procedure:** How to Group Objects on the HTML Page

You may group objects together on an HTML page by inserting a group box, panel, or form. You can copy and paste components (such as images, push buttons, and so on) between the HTML page and the grouping object while maintaining the association to the grouping object or the page.
1. Insert a grouping object on the HTML page, and select Form or Panel from the Components submenu of the Insert menu or Group Box from the Controls sub-menu of the Insert menu.

   The cursor changes into a crosshair.

2. Drag the crosshair to create the grouping object on the HTML page.

3. Right-click the component(s) to be copied and select Copy.

4. Right-click the grouping object and select Paste.

   The component is copied into the grouping object as a new object. For example, button1 copied from the HTML page appears as button2 in the grouping object. The original, button1 is still associated with the HTML page, whereas button2 is associated with the grouping object.

5. To delete a grouping object, right-click the grouping object and select Delete.

   When deleting a grouping object, the associated components are also deleted.

Reference: Positioning Toolbar

The positioning toolbar contains the buttons listed in the following table.

For buttons that use relationships, the relationship is controlled by the controlling object, or dominant object, which is the last object or placeholder selected. These buttons are only highlighted when more than one object is selected.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Toggles the grid on and off. Use the grid to assist in lining up objects in the layout. This button is recessed when the grids are enabled.</td>
</tr>
<tr>
<td></td>
<td>Toggle visibility shows hidden objects. The hidden visibility option is set in the Layout section of the Style Composer.</td>
</tr>
<tr>
<td></td>
<td>Specifies Tab Order.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="align_left" /></td>
<td>Aligns the left edge of the highlighted object with the left edge of the controlling object.</td>
</tr>
<tr>
<td><img src="image" alt="align_right" /></td>
<td>Aligns the right edge of the highlighted object with the right edge of the controlling object.</td>
</tr>
<tr>
<td><img src="image" alt="align_top" /></td>
<td>Aligns the top edge of the highlighted object with the top edge of the controlling object.</td>
</tr>
<tr>
<td><img src="image" alt="align_bottom" /></td>
<td>Aligns the bottom edge of the highlighted object with the bottom edge of the controlling object.</td>
</tr>
<tr>
<td><img src="image" alt="align_center" /></td>
<td>Aligns objects at the horizontal center point of the canvas in Design view.</td>
</tr>
<tr>
<td><img src="image" alt="align_middle" /></td>
<td>Aligns objects at their vertical center (or middle) point of the canvas in Design view.</td>
</tr>
<tr>
<td><img src="image" alt="width" /></td>
<td>Sets the width of the highlighted objects to the width of the controlling object.</td>
</tr>
<tr>
<td><img src="image" alt="height" /></td>
<td>Sets the height of the highlighted objects to the current height of the controlling object.</td>
</tr>
<tr>
<td><strong>Button</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Sets the height and width of the highlighted objects to the height and width of the controlling object.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Maintains the distance between the top-left corner of the controlling object and top-left corners of the highlighted object.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Maintains the distance between the top-right corner of the controlling object and the top-left corners of the highlighted object.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>Maintains the distance between the bottom-right corner of the controlling object and the top-left corners of the highlighted object.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>Maintains the distance between the bottom-left corner of the controlling object and the top-left corners of the highlighted object.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>Breaks the relationship set between highlighted objects. This button is only highlighted when selected objects have relationships set.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>Toggles the display of arrows illustrating the relationships between objects. This button is only highlighted when selected objects have relationships set. This button will stay highlighted when relationships are displayed. It will not be highlighted when relationships are not displayed.</td>
</tr>
</tbody>
</table>
**Reference: Utilities Toolbar**

The Utilities toolbar contains the buttons listed in the following table.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Add Control to Chain](image) | Adds a control to a chain. Each time a selection is made, all chained controls will be dynamically updated. For details about chained controls, see *Chaining Controls for Dependencies in HTML Composer* on page 351.  
**Note:** The Add to current chain button is available when controls are multiselected on the Design tab or Parameters tab. This button is disabled if you multiselect controls that are already in a chain. |
| ![Remove Control from Chain](image) | Removes a control from a chain. For details about chained controls, see *Chaining Controls for Dependencies in HTML Composer* on page 351.  
**Note:** The Remove from current chain button is available when controls are multiselected on the Design tab or Parameters tab. This button is disabled for the first control in a chain, but enabled for all others. |
| ![Synchronize Report/Graph](image) | Synchronizes a report/graph object to an active report when using active dashboards. For more information, see *Creating Active Technologies Dashboards With HTML Composer* on page 393. |
| ![Show Synchronized Report Groups](image) | Shows the synchronized report groups when working with active dashboards. For more information, see *Creating Active Technologies Dashboards With HTML Composer* on page 393. |
**Description Button**

Unlocks the template. When designing an HTML page with a template certain actions are locked, to activate them the template must be unlocked. You are responsible for the placement and design of all elements on an unlocked page and unlocking cannot be undone. For more information on templates and unlocking, see *Using Templates in HTML Composer* on page 327.

The unlock button is not on the toolbar by default. For more information on accessing the unlock button, see *How to Unlock a Template* on page 338.

---

**Controlling the HTML Composer Environment**

You can set properties for HTML Composer with the HTML Page tab, located in the Developer Studio Options dialog box. The HTML Page tab enables you to set page properties such as the location of reports and graphs, the display of a grid in your layouts, the default form type, and setting the default caching option for the HTML page. The changes that are made in the HTML Page tab are saved to the registry. This allows a customized environment to be created for various users.

**Procedure: How to Set Page Properties**

1. Select *Options* from the Window menu.
   
   The Developer Studio Options dialog box opens.

2. Select the *HTML Page* tab.
   
   For more information about the HTML Page tab, see *HTML Page Tab* on page 294.

3. Make your changes, and click *OK*.

**Procedure: How to Select Form Settings From the HTML Page Tab**

1. Select *Options* from the Window menu.
   
   The Developer Studio Options dialog box opens.

2. Select the *HTML Page* tab.

3. Click the *Form Settings* button.
   
   The Form settings dialog box opens.
4. Select the orientation for the form object in the layout.

5. Use the spin buttons to increase or decrease the distance between the prompt, horizontal and vertical controls of the form, and the number of columns for the form.

   or

   Position the cursor in the input box and type a number.

6. Use the slider control type options to select how the slider bar appears.

   Slider bars are available when using numeric range value parameters in your report or graph.

7. Use the Add schedule button option to add a schedule button for referenced procedures with parameters if your WebFOCUS environment is licensed to use ReportCaster. For more information, see *Adding ReportCaster Schedule Capability to HTML Composer* on page 300.

8. Use the Add defer button option to add a defer button for running a report deferred in the Managed Reporting environment. For more information, see *Running a Managed Reporting Report Deferred From HTML Composer* on page 308.

9. Start each chain on a new line to create multiple chains from the New Parameters dialog box. Each set of chained parameters appears on new line of the Design tab, regardless of the grouping option selected from the New Parameters dialog box.

   Start each chain on a new line is selected by default.

   For example, the following image shows the default behavior where the first chain (Product Category and Product Type) is shown on one line and the second chain (Product Number, Plant, Year) start on a new line. This enables you to see the relationship of the chains within the form.
10. Click OK to close the Form Settings dialog box.

The form settings are applied and shown in the HTML Composer Design view.

11. To reset the default form settings, right-click the form object and select AutoArrange from the context menu.

**Note:** The AutoArrange option is only available when using a multiple layer form type.

The form is auto arranged on the layout, using the default form settings.
Reference: HTML Page Tab

The following options are available from the HTML Page tab, located in the Developer Studio Options dialog box.

Grid Settings

**Show Grid**

Displays a grid. If this is not selected, the grid is turned off for all layouts.

**Snap to Grid**

Causes objects in the layout to snap to grid lines when being positioned. For detailed positioning, deselect this option.

**Width**

The width of the grid in pixels.
Height
The height of the grid in pixels.

Preview Settings

Report and Graph Preview
Previews report and graph data in the Design view. If checked, additional options are available (Simulated Data or Live Data).

This option is selected by default.

If unchecked, icons are used to represent the area in the Design view for reports and graphs. This is the fastest method of loading reports since no request are made to the server.

Simulated Data
Selecting to preview simulated data sends a request to the reporting server that gathers formatting information from the Master File. The database is not accessed, but rather mock data is used to visually represent the report.

This option is only available when previewing reports and graphs.

Live Data
Selecting to preview live data sends a request to the reporting server, and to the database, to get a snapshot of the actual data in the report.

This option is only available when previewing reports and graphs.

Record limit for reports
Enables you to limit the number of records used to gather data for previewing the report in live data mode. For example, if you set 500 as the record limit for the report, then 500 rows of data are gathered for the report results.

This option is only available if the Live Data option is selected.

Record limit for input controls
Sets the number or records to be shown for the input controls when gathering data for reports and graphs.

This option is only available if the Live Data option is selected.
Use Prefix

Selecting Use Prefix will take any FOCUS syntax in the input box and apply it to the components at preview time. For example, SQL SQLORA SET OPTIMIZATION OFF. Since the settings are saved for all documents, you can select the Use Prefix option to indicate to the tool whether or not to use the prefix for the specific document.

Form type

Sets the default form type in the parameter grouping options of the New Parameters dialog box. Form types are None, Single layer, or Multiple layer.

- When None is selected, the parameter grouping option shows Do not create a form on the New Parameters dialog box.
- When Single layer is selected, the parameter grouping option shows New single layer form on the New Parameters dialog box. The single layer form contains all of the elements within a single group box.
  
  Single layer is the default form type.
- When Multiple layer is selected, the parameter grouping option shows New multiple layer form on the New Parameters dialog box. The multiple layer form contains group boxes around each element in the form. You may move and resize each element of the control.

You may override the set form type on the HTML Page tab from the Parameter grouping options drop-down list of the New Parameters dialog box. For details, see Automatically Creating Controls From the New Parameters Dialog Box on page 159.

Form settings

Options are available so that you may customize how the forms are populated and arranged in the document. For details, see Form Settings Dialog Box on page 298.

Show 'New Parameters' dialog

Controls whether or not the New Parameters dialog box shows when adding parameters in HTML Composer.

The New Parameters dialog box is shown by default.

Show 'Template Selector' dialog

Controls whether or not the Template selector dialog box shows when a new HTML page is created using HTML Composer.

Activate 'Unlock Template' option

Controls whether to add an unlock icon to the toolbar when a template is in use.
Default caching option

Controls whether cache run time data is on or off for the HTML page. The default is off.

When adding dynamic parameters to the HTML page, input controls retrieve data using procedures. You may cache the run time data for input controls by using the cache run time option on the Properties and settings dialog box in the Parameters tab. This setting overrides the Default caching option from the HTML Page tab. For more information about the Parameters tab, see Creating a Dynamic List of Values on page 118.

Auto Arrange Objects

Automatically arranges the objects on the Parameters tab so that they take the least amount of space without overlapping each other. Auto Arrange is on by default.

If this option is turned off, you may auto arrange objects directly from the Parameters tab. Right-click anywhere on the Parameters tab and select AutoArrange from the context menu.

Refresh thumbnails every

Automatically refreshes the content on the Thumbnail tab of the Properties window, every 20 seconds by default. You may change the time interval of the automatic refresh.

Default Theme

You can set the default theme for a new HTML page. The Information Builders theme is chosen by default.

The following is the list of themes that you can use.

- Information Builders
- Black
- Blue
- Green
- Orange
- Purple
- Red
- Silver
- Teal
- Plain
- Yellow red
Beige blue
- Dramatic blue
- Neutral gray
- Light blue
- Light green
- Light purple

**Reference:** Form Settings Dialog Box

The following options are available from the Form settings dialog box of HTML Composer.

![Form settings dialog box](image)

**Prompt orientation**

Prompt refers to the descriptive text used to label the control/parameter in the output.

**To the left of the input**

Places the descriptive text used to label the control/parameter to the left of the input.
**Above the input**

Places the descriptive text used to label the control/parameter above the input.

**Distance between the prompt and input**

Sets the distance between the prompt and input.

**Horizontal distance between controls**

Sets the horizontal distance between controls.

**Vertical distance between controls**

Sets the vertical distance between controls.

**Number of columns**

Determines when the form will wrap and start laying controls out in a new row.

**Default slider control**

Sets how the slider control appears. Select from the following types of slider bars:

- **Horizontal or Vertical Slider Simple bar.** The slider bar has no end arrows, just a bar with the slider.
- **Horizontal or Vertical Slider with Color Bar and Arrows.** Arrows appear at each end of the slider bar.
- **Horizontal or Vertical Slider with Color Bar, Arrows, and Edit.** Arrows and an edit box appear at the end of the slider bar, showing the current value.

Once a slider control is inserted into HTML Composer, changing these options will not affect the existing sliders. The option is only applied to new slider controls. To change the existing slider bar type, delete the slider object and insert a new slider control.

**Add schedule button**

Automatically adds a schedule button for referenced procedures with parameters. This option is selected by default. For more information about adding schedule capability to HTML Composer forms, see *Adding ReportCaster Schedule Capability to HTML Composer* on page 300.
Add defer button

Automatically adds a defer button for referenced procedures with parameters. This option is selected by default. For more information running reports deferred, see *Running a Managed Reporting Report Deferred From HTML Composer* on page 308.

Start each chain on a new line

When creating multiple chains from the New Parameters dialog box, each set of chained parameters appears on new line of the Design tab, regardless of the grouping option selected from the New Parameters dialog box.

Start each chain on a new line is selected by default.

Adding ReportCaster Schedule Capability to HTML Composer

You may create a control that adds a schedule button in HTML Composer. A schedule button enables you to schedule a report, or graph, using ReportCaster. Once you have created the schedule, you can access the ReportCaster HTML User Interface to edit and maintain information about the schedule.

**Note:** The Schedule option is only available in HTML Composer if your WebFOCUS environment is licensed to use ReportCaster.

Only procedures referenced in HTML Composer are able to be scheduled.

When referencing an existing procedure with parameters in HTML Composer, the schedule button is automatically added. You may also manually create schedule buttons for your report or graph.

**Procedure:** How to Add or Disable the Schedule Button for Controls

Controls appear when you reference a report or graph with parameters. HTML Composer automatically adds a control, Run button, Reset button, and Schedule button for the parameters in your layout, if your WebFOCUS environment is licensed to use ReportCaster.

The Form settings dialog box sets when the schedule button appears with the controls.

The Schedule button is selected by default.

To change the default behavior:

1. Select *Options* from the Window menu.
   
   The Developer Studio Options dialog box opens.

2. Select the *HTML Page* tab.
3. Click the Form Settings button.
   The Form settings dialog box opens.
4. Deselect the Add schedule button.

   **Note:** If you deselect this option, you have the ability to manually add a schedule button. For more information, see *How to Manually Add a Schedule Button* on page 303.

**Procedure:** How to Add a Schedule Button to a Referenced Existing Procedure With Parameters

This procedure provides instructions on how to automatically add a schedule button to an HTML page for a referenced procedure in the layout.

1. From HTML Composer, select *New Report* or *New Graph* from the Insert menu.
   The cursor changes into a crosshair.
2. Drag the crosshair to create a report (or graph) object and adjust it to the size you want.
3. Right-click the object and select *Reference existing procedure* from the context menu.
   The Get source file dialog box opens.
4. Select an existing report or graph with parameters and click *Open*. 
The New Parameters dialog box appears, as shown in the following image.

5. Click **OK** to add the new parameters and the controls to the HTML page.

The Run, Reset, and Schedule buttons appear with the parameters on the HTML page.

6. Optionally, select the schedule button on the HTML page to view or edit the properties. The properties appear in the HTML Composer Properties window.

7. Double-click in the **Title** properties value field to set the title of the schedule page window. The default title for the schedule page window is domain\standard reports\folder\foldername. You may change this to the text of your choice.
8. Optionally, you may launch the Hyperlink properties for the schedule button to change the template for the schedule page.

For more information about changing the template for the schedule page, see *How to Change the Default Template for the Schedule Page* on page 305.

**Procedure: How to Manually Add a Schedule Button**

This procedure provides instructions on how to manually add a schedule button to a HTML page. This is useful for adding new, or additional, schedule buttons to a report or graph that has already been referenced to the HTML page, or if you are referencing a report or graph without parameters.

1. From HTML Composer, select a control from the Controls or Components submenu of the Insert menu. You may insert a push button, image, or hyperlink as a schedule button.

   a. If inserting a push button as a schedule button:
      - From the Insert menu, select Controls, then click Push Button.
        The cursor changes into a crosshair.
      - Drag the crosshair to add the push button object and adjust it to the size you want.
      - Right-click the push button object from the HTML page and select Create hyperlink from the context menu.
        The Hyperlink Properties dialog box opens.
      - You may change the name of the push button in the Display Text field.

   b. If inserting an image as a schedule button:
      - From the Insert menu, select Components, then click Image.
        The cursor changes into a crosshair.
      - Drag the crosshair to add the image object.
        The Get source file dialog box opens.
      - Select an image and click Open.
        The image is added to the HTML page. You may adjust the image object to the size you want.
Right-click the image object from the HTML page and select Create hyperlink from the context menu.

The Hyperlink Properties dialog box opens.

c. If inserting a hyperlink as the schedule button:
   - From the Insert menu, select Components, then click Hyperlink.
     The cursor changes into a crosshair.
   - Drag the crosshair to create a hyperlink object and adjust it to the size you want.
     The Hyperlink Properties dialog box opens.
   - You may change the name of the hyperlink in the Display Text field.

2. From the Hyperlink Properties dialog box, select the New button to add a request to execute.

   ![Hyperlink Properties dialog box](image)

   **Note:** The Display Text field on the Hyperlink Properties dialog box is only available when inserting a push button or hyperlink as a schedule button.

3. Select the Action, Source, and Target/Template Name:
   - Select Schedule Report from the Action drop-down list.
   - Select the Source drop-down list to select the source of your Schedule Report.
     The Source drop-down will only list the referenced procedures in the layout.
   - The Target Type option is disabled and defaults to ReportCaster when the Schedule Report action is selected.
   - The Target/Template Name defaults to Email Library FTP when the Schedule Report action is selected.
For more information on changing the template for the schedule page, see *How to Change the Default Template for the Schedule Page* on page 305.

4. Click **OK** to close the Hyperlink Properties dialog box.

   The schedule button, image, or hyperlink is added to the HTML page.

5. Optionally, select the schedule object to view or edit the properties. The properties appear in the Properties window of HTML Composer.

6. Double-click in the **Title** properties value field to set the title of the schedule page window.

   The default title for the schedule page window is `domain\standard reports\folder\foldername`. You may change this to the text of your choice.

**Procedure: How to Change the Default Template for the Schedule Page**

This procedure provides instructions on how to change the template for the schedule page by using the Hyperlink Properties dialog box. This is the template that appears when the schedule page is run from the report output.

1. Right-click a schedule button, image, or hyperlink from the HTML page and select *Hyperlink properties* from the context menu.

   The Hyperlink Properties dialog box opens.

2. Select the **Target/Template Name** drop-down list to change the default template for the schedule.
The options are:

- Email Library FTP - This is the default template.
- All
- Email
- Library
- FTP
- Printer
- Report Library
- Managed Reporting

Note: The template names represent the type of distribution option for the schedule in ReportCaster.

3. Click OK to close the Hyperlink Properties dialog box.

The selected template appears when the schedule page is run from your report output.
**Reference: ReportCaster Schedule Page**

When you run your report, select the parameters (if applicable), and click the schedule button. The ReportCaster schedule page appears.

**Tip:** To change the schedule template that appears at run time, use the Hyperlink Properties dialog box to change the Target/Template Name.

The report and the selected parameters are scheduled to ReportCaster. From ReportCaster, the values entered or selected are stored with the schedule information.

You must have the Schedule user privilege to submit the schedule.
For more information about scheduling and distributing report output, see the ReportCaster manual.

Running a Managed Reporting Report Deferred From HTML Composer

A deferred report is a Managed Reporting report that you can run as a background task, while continuing other work. In HTML Composer, you may add a hyperlink to run a deferred report, or create a control that adds a Defer button.

Note: The deferred option is only available in HTML Composer from the Managed Reporting environment.

Procedure: How to Add or Disable the Defer Button for Controls

Controls appear when you reference a report or graph with parameters. HTML Composer automatically adds a control, Run button, Run Defer button, Reset button, and Schedule button for the parameters in your layout.

Note: A schedule button only appears if your WebFOCUS environment is licensed to use ReportCaster. For more information about the schedule button, see Adding ReportCaster Schedule Capability to HTML Composer on page 300.

You may use the Form Settings dialog box to set when the Defer button appears with the controls. The Defer button is selected by default.

To change the default behavior:

1. Select Options from the Window menu.
   The Developer Studio Options dialog box opens.
2. Select the HTML Page tab.
3. Click the Form Settings button.
   The Form settings dialog box opens.
4. Deselect the Add defer button.
**Note:** If you deselect this option, you have the ability to add a hyperlink button to run a report deferred. For more information, see *How to Add a Hyperlink to Run a Managed Reporting Report Deferred* on page 311.

**Procedure:** How to Add a Defer Button to a Referenced Existing Procedure With Parameters

A defer button enables you to execute the selected report in deferred mode.

When referencing an existing procedure with parameters in HTML Composer, the defer button is automatically added. Only procedures referenced in HTML Composer are able to be deferred.

Access the Standard Reports folder of your Managed Reporting environment to begin this procedure.

1. From HTML Composer, select *New Report* or *New Graph* from the Insert menu.
   - The cursor changes into a crosshair.
2. Drag the crosshair to create a report (or graph) object and adjust it to the size you want.
3. Right-click the object and select *Reference existing procedure* from the context menu.
   - The Get source file dialog box opens.
4. Select an existing report or graph with parameters and click *Open*.
   - The New Parameters dialog box opens.
5. Click *OK* to add the new parameters and the controls to the HTML page.
   - The Run, Run Defer, Reset, and Schedule buttons appear with the parameters on the HTML page.
6. Execute the request and click the *Run Defer* button.
Running a Managed Reporting Report Deferred From HTML Composer

The Deferred Report Notification is generated, as shown in the image below.

![Deferred Report Notification Image]

The cursor changes into a crosshair.

Thursday, February 05, 2009 12:35:32 PM
defered_report
has been successfully submitted for deferred execution.

**Procedure:** How to Add a Defer Button to a Run Only Deferred Procedure With Parameters

When referencing a Run Only Deferred procedure, HTML Composer automatically adds a control, Run Defer button, Reset button, and Schedule button for the parameters in your layout.

**Note:** A schedule button only appears if your WebFOCUS environment is licensed to use ReportCaster. For more information about the schedule button, see Adding ReportCaster Schedule Capability to HTML Composer on page 300.

The Managed Reporting deferred external procedure was created with the Only Run as Deferred Report option in the Managed Reporting environment.

**Note:** Access the Standard Reports folder of your Managed Reporting environment to begin this procedure.

1. From HTML Composer, select New Report or New Graph from the Insert menu.
   The cursor changes into a crosshair.
2. Drag the crosshair to create a report (or graph) object and adjust it to the size you want.
3. Right-click the object and select Reference existing procedure from the context menu.
   The Get source file dialog box opens.
4. Select an existing Run Only Deferred report or graph with parameters and click Open.
   The New Parameters dialog box opens.
5. Click OK to add the new parameters and the controls to the HTML page.
   The Run Defer, Reset, and Schedule buttons appear with the parameters on the HTML page.
The Run button is not applicable when adding a Run Only Deferred report.

6. Execute the request and click the Run Defer button.

The Deferred Report Notification is generated, as shown in the image below.

**Procedure:** How to Add a Hyperlink to Run a Managed Reporting Report Deferred

You may add a hyperlink to run a Managed Reporting report deferred. This is useful if you are referencing a report or graph without parameters.

1. From the Insert menu, select Components, then click Hyperlink.
   
   The cursor changes into a crosshair.

2. Drag the crosshair to create a hyperlink object and adjust it to the size you want.
   
   The Hyperlink Properties dialog box opens.
3. Enter the text you want to display as the hyperlink in the Display Text field.

4. Select *External procedure* and enter the procedure name in the Source field, or click the *browse (…)* button to browse to the procedure.

5. Select *Deferred* as the Target Type.

   When a deferred external procedure is selected as the Source, Target Type automatically defaults to *Deferred*.

   The Managed Reporting deferred external procedure was created with the *Only Run as Deferred Report* option in the Managed Reporting environment.

   The Target/Template Name field is not applicable when the Target Type is Deferred. The following image is an example of the Hyperlink Properties dialog box with the deferred option selected.

   ![Hyperlink Properties dialog box](image)

6. Click *OK*.

7. Execute the request and click the hyperlink to run the deferred report.
Using JavaScript Code With HTML Composer Pages

Although HTML Composer is fully integrated with JavaScript, it is suggested that you do not create custom JavaScript that manipulates HTML Composer generated controls, as WebFOCUS cannot support such custom JavaScript code. Additionally, there is no guarantee that the JavaScript code will work correctly in future releases.

### Note:
- HTML Composer run time is a set of JavaScript files. You should not be calling the functions within them directly. Should you call these functions directly, your code may not function in future releases and Information Builders cannot be held responsible.
- If you want JavaScript to run after a page loads completely, but before any reports are executed, you need to create a function called onInitialUpdate (this function was called onInitialUpdate() in previous releases). If you have another function, in that function, you can call IbComposer_onInitialUpdate(). Your code should be added inline in the HTML file after the line:

```
//End function window_onload
```

HTML Composer run time will call onInitialUpdate() if it exists.

### Function: IbComposer_populateDynamicCtrl

IbComposer_populateDynamicCtrl allows you to determine from which control data is drawn from to populate a destination control.

### Syntax: How to Populate a Control Dynamically

```
IbComposer_populateDynamicCtrl('controlID', 'fromControlId');
```
where:

controlID

Alphanumeric

Is the unique identifier of the control from which values are obtained. For example, listbox1.

fromControlId

Alphanumeric

Is the unique identifier of the control from which values are obtained, when two or more controls are chained to a destination control. For example, if listbox1 and listbox2 are both chained to listbox3, by default, the values of listbox3 will be determined by listbox1. You can use `IbComposer_populateDynamicCtrl('listbox3','listbox2')` to make listbox2 determine the values of listbox3. This identifier is optional.

**Example:** Populating a Control Dynamically

```javascript
function button3_onclick(ctrl) {
    var acc = IbComposer_populateDynamicCtrl('listbox3', 'listbox2');
    acc.selectNextPage();
}
```

**Function: IbComposer_getComponentById**

The `IbComposer_getComponentById` function obtains a component by using its ID.

**Syntax:** How to Obtain a Component by Using Its ID

```
IbComposer_getComponentById('controlID');
```

where:

controlID

Alphanumeric

Is the unique identifier of the control from which values are obtained. For example, listbox1.

**Example:** Getting the Accordion Report By Using Its ID

```javascript
function button3_onclick(ctrl) {
    var acc = IbComposer_getComponentById('accordion1');
    acc.selectNextPage();
}
```
**Function: IbComposer_getCurrentSelection**

The IbComposer_getCurrentSelection function gets the current selected values from a control.

**Syntax:**

How to Get the Current Selected Value From a Control

```javascript
IbComposer_getCurrentSelection('controlID', [layer]);
```

where:

- `controlID`
  - Alphanumeric
  - Is the unique identifier of the control from which values are obtained.

- `layer`
  - Integer
  - Is an optional parameter used to specify the layer number in a multi source Tree control if a Multi source Tree control is being used. The layer number starts with 1 for the first layer.

**Example:**

Getting the Current Selected Value for a Drop Down List

```javascript
function button1_onclick(ctrl) {
    var values = IbComposer_getCurrentSelection('combobox1');
    for(var i = 0; i < values.length; i++)
        alert(values[i]);
}
```

**Function: IbComposer_getCurrentSelectionEx**

The IbComposer_getCurrentSelectionEx function gets the current selected actual or display values from a control. The function can also be used to get the index values for List Boxes, Drop Down Lists, and Double Lists.

**Syntax:**

How to Get the Current Selected Value, Actual Value, or Display Value From a Control

```javascript
IbComposer_getCurrentSelectionEx('controlID', [layer]);
```

where:

- `controlID`
  - Alphanumeric
  - Is the unique identifier of the control from which values are obtained.
**layer**

Integer

Is an optional parameter used to specify the layer number in a multi source Tree control if a Multi source Tree control is being used. The layer number starts with 0 for the first layer.

**Example:** Getting the Current Selected Index Value, Actual Value, and Display Value for a Multi-Select List

```javascript
function button1_onclick(ctrl) {
  var values = IbComposer_getCurrentSelectionEx('combobox1');
  for(var i = 0; i < values.length; i++)
  {
    alert("Index Value: " + values[i].getIndex() + "\n" +
    "Actual Value: " + values[i].getValue() + "\n" +
    "Display Value: " + values[i].getDisplayValue());
  }
}
```

**Function: IbComposer_setCurrentSelection**

The `IbComposer_setCurrentSelection` function sets the current selected values for control parameters.

**Syntax:** How to Set the Current Selected Value for a Control

```javascript
IbComposer_setCurrentSelection('controlID', arrValues, bUpdateDependencies);
```

where:

- **controlID**
  - Alphanumeric
  - Is the unique identifier of the control for which to set the values.

- **arrValues**
  - Array
  - Is the array of values to be set.

- **bUpdateDependencies**
  - Boolean
  - Is an operator that can be set to true to update chained controls and triggered events. The default is false.
**Example:** Setting the Current Selected Value for a List Box

```javascript
function button2_onclick(ctrl) {
    var arr = [];
    arr.push('ITALY');
    arr.push('JAPAN');
    IbComposer_setCurrentSelection('listbox1', arr, false);
}
```

**Function: IbComposer_execute**

The IbComposer_execute function executes a report or chart.

**Syntax:** How to Execute a Report or Chart

```javascript
IbComposer_execute('reportID', ['outputTarget']);
```

where:

- `reportID`
  
  Alphanumeric
  
  Is the unique identifier of the report or chart to execute.

- `outputTarget`
  
  Alphanumeric
  
  Is the optional parameter to set the target of the output. Is one of the following:

  - The name of a frame.
  - `'_blank'`.
  - `'_target'`.
  - The name of a new window.

**Example:** Executing a Report in a New Window

```javascript
function button3_onclick(ctrl) {
    IbComposer_execute('report1', 'newwin');
}
```

**Function: IbComposer_isSelected**

The IbComposer_isSelected function determines if a control or value is selected.
**Syntax:**

How to Determine If a Control or Value Is Selected

\[\text{IbComposer\_isSelected('controlID', 'testValue')}\];

where:

*controlID*

Alphanumeric

Is the unique identifier of the control being tested.

*testValue*

Alphanumeric

Is the value the control is being checked against.

**Example:**

Determining If a Check Box Is Selected

\[
\text{function checkbox1\_onclick(ctrl){}
\quad \text{var curValue = IbComposer\_isSelected('checkbox1');}
\quad \text{IbComposer\_showHtmlElement('form1', curValue);}
\}]

**Function: IbComposer\_showHtmlElement**

The IbComposer\_showHtmlElement function shows or hides an HTML element.

**Syntax:**

How to Show or Hide an HTML Element

\[\text{IbComposer\_showHtmlElement('elementID', bShow);}\]

where:

*elementID*

Alphanumeric

Is the unique identifier of the element which is shown or hidden.

*bShow*

Boolean

Is an operator that can be set to true to show the element and false to hide it.
Example: Hiding or Showing a Check Box

```javascript
function checkbox1_onclick(ctrl) {
    var curValue = IbComposer_isSelected('checkbox1');
    IbComposer_showHtmlElement('form1', curValue);
}
```

Function: IbComposer_enableHtmlElement

The IbComposer_enableHtmlElement function enables or disables an HTML element.

Syntax: How to Enable or Disable an HTML Element

```javascript
IbComposer_enableHtmlElement('elementID', bEnable);
```

where:

- `elementID`
  - Alphanumeric
  - Is the unique identifier of the element which is enabled or disabled.

- `bEnable`
  - Boolean
  - Is an operator that can be set to true to enable the element and false to disable it.

Example: Enabling or Disabling Elements

```javascript
function checkbox2_onclick(ctrl) {
    IbComposer_enableHtmlElement('listbox1', IbComposer_isSelected('checkbox2', 'country'));
    IbComposer_enableHtmlElement('combobox1', IbComposer_isSelected('checkbox2', 'car'));
    IbComposer_enableHtmlElement('listbox2', IbComposer_isSelected('checkbox2', 'model'));
    IbComposer_enableHtmlElement('combobox2', IbComposer_isSelected('checkbox2', 'dcost'));
}
```

Function: IbComposer_ResetDownChainControls

The IbComposer_ResetDownChainControls function resets the controls down the chain from the current control to have correct corresponding values.
Syntax: How to Reset Chain Controls

IbComposer_ResetDownChainControls('ctrl');

where:

ctrl
   Alphanumeric
   Is the unique identifier of the first control.

Example: Resetting the Chain Started by a List Box

function button4_onclick(ctrl) {
   var arr = []; arr.push('ENGLAND');
   IbComposer_setCurrentSelection('listbox1', arr, false);
   IbComposer_ResetDownChainControls('listbox1');
}

Function: IbComposer_selectTab

The IbComposer_selectTab function selects the tab specified by the tabNumberToSelect and makes it the active tab.

Syntax: How to Select a Tab and Make It Active

IbComposer_selectTab('tabControlID', tabNumberToSelect);

where:

tabControlID
   Alphanumeric
   Is the unique identifier of the tab control being made active.

   tabNumberToSelect
   Integer
   Is the number of the tab to make active.

Example: Making a Tab Active

<FORM id=form1 onsubmit="OnExecute(this);
IbComposer_selectTab('tab1', 1) name="form1">
Function: IbComposer_selectTemplateTab

The IbComposer_selectTemplateTab function selects a tab on a template page and makes it the active tab.

Syntax: **How to Select a Template Tab and Make It Active**

```javascript
IbComposer_selectTemplateTab('tabId');
```

where:

- `tabId`
  - Alphanumeric
  - Is the unique identifier of the tab control being made active.

Example: **Making a Template Tab Active**

```javascript
function submit1_onclick(ctrl) {
    IbComposer_selectTemplateTab('tab5');
}
```

Function: IbComposer_getAllAmpersValues

The IbComposer_getAllAmpersValues is used to get the current selected values from all the controls on your page layout. It then takes those values and assembles them as a string that can be added to the end of a URL call. An example of this would be having a REGION control and multiselecting MidEast, NorthEast, and NorthWest. It will assemble these selections as shown below:

```
&REGION=%27MidEast%27%20OR%20%27NorthEast%27%20OR%20%27NorthWest%27
```

This function can be used in conjunction with the Business Intelligence Portal, where the generated string is appended to all Business Intelligence Portal calls that run reports or charts. This allows the parameter values to affect all portal components, even if new ones are added or existing ones are removed at runtime.

Syntax: **How to Get All Parameter Values**

```javascript
IbComposer_getAllAmpersValues([verifySelection]);
```

where:

- `verifySelection`
  - Boolean
Is an optional parameter. When true and when the Selection required property for the control is set to Yes, this returns an empty string for the parameter controls that do not have a selection made.

Note: All controls have the Selection required property. This property is set to Yes by default. If a control has no valid selection made at runtime, a red box appears around it and the following status bar message displays:

Please make required selections

Example: Retrieving a List of All Parameters Selected in a Report.

function button1_onclick(ctrl) {
    var val = IbComposer_getAllAmpersValues();
    alert(val);
    OnExecute(ctrl);
}

Event: onbeforeload

The onbeforeload event is an event handler that is used before a control is populated with values.

Syntax: How to Use the onbeforeload Event

onbeforeload('ctrl', 'arrValuesToLoad');

where:

ctrl

Is a static term and should not be changed.

arrValuesToLoad

Alphanumeric

Is the array of values that will be loaded into the control.

Example: Populating a List Box With the onbeforeload Event

function listbox1_onbeforeload(ctrl,arrValuesToLoad) {
    for(var i = 0; i < arrValuesToLoad.length; i++) {
        alert(arrValuesToLoad[i].dispValue + " " + arrValuesToLoad[i].value + " " + arrValuesToLoad[i].selected);
    }
}
Event: onafterload

The onafterload event is an event handler used after a control is populated with values.

Syntax: How to Use the onafterload Event

```javascript
onafterload('ctrl');
```

where:

```javascript
ctrl
```

Is a static term and should not be changed.

Example: Selecting the ALL Value in a List Box With the onafterload Event

```javascript
function listbox1_onafterload(ctrl){
  alert(IbComposer_isSelected(ctrl.id, 'ALL'));
}
```

Specifying an HTML File as a Load Screen

When running an HTML page from HTML Composer, the web browser displays a Loading, please wait... message, until the page is fully loaded.

You can use the Loading screen property for the BODY object to specify an HTML file of your own to use as a loading screen.
**Procedure:** How to Specify an HTML File as a Loading Screen

1. Click the *Loading screen* property in the Properties tab of the Properties window for the BODY object, as shown in the following image.

   ![Properties Window Screenshot]

2. Select *Custom* from the Loading screen drop-down menu.
The Get existing html page dialog box opens, as shown in the following image.

Note: Default will use the Information Builders supplied loading screen. Not Set will not use a loading screen.

3. Select an HTML file and click Open.
The file is added to the property, as shown in the following image.

When the page runs, the specified loading screen will display until the page is completely loaded.
HTML Composer offers templates that provide layouts and themes for HTML pages. You can select a pre-rendered design from the Template Selector that is provided when creating a new HTML file.

**In this chapter:**

- Understanding and Using Templates
- Manipulating the Objects of Templates

### Understanding and Using Templates

You can use templates to choose from a number of layouts and themes to assist in the creation of HTML pages. Templates provide report and chart frames, a form for controls, text boxes, and other objects arranged in a fixed layout that simplifies the design process. By using templates, styling is predefined for you so that you only have to provide information for the objects to create an HTML page that is ready to use. Controls cannot be added manually, they must come from parameters in the reports and charts. If you build a page using templates, you will not be able to freely arrange objects or add controls manually.

**Note:** To create an HTML page without using templates, select Cancel from the Template Selector window.
The main components of the Template selector are:

**Templates List Box**
Displays options for tabbed and non-tabbed templates. Both tabbed and non-tabbed templates have the option of simple or advanced. Advanced templates contain elements for additional titles, hyperlinks, and descriptions. Simple templates contain less objects.

**Layouts Pane**
Displays options for the layout part of the template. You can choose the number of reports or graphs for the HTML page to contain, as well as how those reports and graphs are laid out within the page.

**Themes Pane**
Displays options for the theme (color scheme) of the template. You can choose one of seventeen different themes. Move the pointer over a theme in the Themes pane to select it.

The theme options are:
- Information Builders
- Black
Guided Report Mode

Sets the HTML page to Guided Report Mode. For more information on Guided Reports, see Creating Guided Report Forms on page 341.

Don’t show again

Sets the Template Selector to be turned off by default. If you select this check box, the Template selector will not appear the next time you create an HTML page. To reactivate the Template Selector, see How to Turn the Template Selector On on page 333.
Reference: Report Sets

Report sets are containers on an HTML page designed in Template mode that hold a form and controls, reports, and the report set title. Adding a new report set to a page will add all of these elements to the page.

Note: The form and controls will not display on the HTML page until they are needed. For example, if you import a report that contains variables, the form and controls will display.
**Procedure: How to Use the Template Selector**

1. Create a new HTML file by completing one of these actions:
   - With the HTML folder highlighted, select New from the File menu, then select HTML file.
   - or
   - Right-click the HTML folder and select New then Guided Report Form.
   - or
   - Click Layout Reports and Graphs in the QuickLinks pane.

   The Add HTML File dialog box opens.

2. Enter a name for the new HTML file in the File name field.

3. Ensure that Composer is selected in the Create with field.

4. Click Open.

   The Template Selector opens.
Note: If Don’t show again was checked the last time the Template selector was opened, HTML Composer will open, skipping the Template selector window. To access the Template selector again, see How to Turn the Template Selector On on page 333.

5. From the Templates List Box, select Simple or Advanced from the Non-tabbed or Tabbed section. For more information on Tabbed and Non-tabbed templates, see Tabbed and Non-Tabbed Template Types on page 332.

6. From the Layouts pane, select a layout for the HTML page.

7. From the Themes pane, select a color scheme for the HTML page.

8. If desired, select the Guided Report Mode check box to enter Guided Report mode when the HTML page is created.

   If you selected the option to create an HTML page in Guided Report mode, this check box will not be visible. For more information on Guided Report mode, see Creating Guided Report Forms on page 341.

9. If desired, select the Don’t show again check box to skip the Template Selector window the next time an HTML page is created.

Reference: Tabbed and Non-Tabbed Template Types

When you create an HTML page using a template, there are two template types to choose from. Both template types have the option of simple or advanced. Advanced templates contain elements for additional titles and descriptions. Simple templates contain less objects. Advanced templates also contain a Hyperlinks strip.
The elements for titles and descriptions in advanced templates are text objects that you can double-click to enter edit mode and edit the text.

Tabbed templates contain numbered tabs for each report set. Non-tabbed templates have no tabs. The title of each tab can be edited.

The DOCUMENT object in HTML pages created with templates has the property Tabbed layout. If set to Yes, each report set will be converted to a tabbed layout. If set to No, tabs are removed from the layout.

### Procedure: How to Turn the Template Selector On

If you select the *Don't show again* check box on the Template selector window when you create an HTML page, the Template selector no longer appears when creating a new HTML page. The following procedure explains how to turn the Template selector on so that it shows up when creating a new HTML page.

1. Select Options from the Window menu. The Developer Studio Options dialog box opens.
2. Select the **HTML Page** tab.
3. Select the Show ‘Template Selector’ dialog check box from the HTML Page tab and click OK.

The Template Selector window appears the next time you create a new HTML page.

**Reference:** Template Usage Notes

The following describes the functionality and restrictions associated with HTML pages created with templates. Unless otherwise noted, these descriptions do not apply to a template that has been unlocked.

- HTML pages created with a template cannot use RIA themes. HTML pages that are created with a template and are then unlocked will still not be able to use RIA themes.

- All elements on the page use relative positioning. Objects are able to flow to accommodate the size of the browser window at run time. When the browser window is made smaller, the objects stack and when the window is made bigger, the objects show in a line.
Existing elements cannot be moved. You can resize elements from any area except for the top-left corner. Due to positioning properties, elements are anchored by their top-left corner. Restricting the movement and positioning results in certain properties being unavailable while designing from a template. For more information on restricted properties, see Properties Restricted By Templates on page 338.

The Insert menu is limited to only CSS/Scripts and Report set.

You can change the selected color scheme of the template by accessing the Theme property of the DOCUMENT object in the Properties window. The layout of the template cannot be changed. HTML pages that are created with a template and are then unlocked can use and change themes. Newly added objects use the theme colors.

If you wish to use active controls, you must unlock the template.

The property Number of columns is available for form objects on HTML pages designed with templates. The default is 4, but you can change the number of columns by using the Number of columns property from the Properties window. The form has a grid which controls the layout of the columns and the position of the objects on the form.

Manipulating the Objects of Templates

When using templates, controls cannot be added manually, reports and charts cannot be moved, and resizing options are limited. Despite these restrictions, you can add new reports and charts to existing report sets and reorder or hide certain elements.

In addition to these options, you can also unlock the template, which cannot be undone. Unlocking the template grants greater control over the layout of objects on the HTML page, but you are responsible for resizing many objects and accounting for any modifications done to the page. For more information on the functionality you lose when unlocked, see How to Unlock a Template on page 338.

Procedure: How to Insert Additional Report or Chart Frames

When creating an HTML page using a template, you can right-click an existing report or chart frame and add a new report or chart to the report set.

1. After creating an HTML page using a template, right-click an existing report or chart frame.
2. Select *Insert new report or graph before* or *Insert new report or graph after* to insert a new report or chart frame, as shown in the following image.

Depending on the option you select, a frame appears before or after the selected report or chart frame. For more information on ordering reports or charts, see *How to Reorder Elements* on page 337.

**Procedure: How to Insert Additional Hyperlinks in Advanced Templates**

When you create an HTML page using a template, you can right click an existing hyperlink and add a new one before or after it.

1. After you create an HTML page using a template, right-click an existing hyperlink.
2. Select *Insert hyperlink before* or *Insert hyperlink after* to insert a new hyperlink. The Hyperlink Properties dialog box will appear.

![Hyperlink properties dialog box](image)

3. From the Hyperlink Properties dialog box, create a new hyperlink and select the Action, Source, Target Type, and Target/Template Name, then press OK.

Depending on the option you selected in step 1, a new hyperlink will appear before or after the selected hyperlink. For more information on ordering report sets, see *How to Reorder Elements* on page 337.

**Procedure: How to Reorder Elements**

When creating an HTML page using a template, you cannot move the elements on the page, but certain elements can be reordered. Controls, tabs/report sets, and report and chart frames can all be reordered.

You can reorder report sets by reordering their corresponding tabs or by selecting the report set itself and using the left and right arrow keys to move it.

1. Select the element you wish to reorder.

   **Note:** Only controls, tabs/report sets, and report and chart frames can be reordered.

2. Press the arrow key that corresponds to the direction you wish to move the control.

   The element moves one position in the desired direction.

   **Note:** You cannot leave empty spaces between elements when reordering.
**Reference: Properties Restricted By Templates**

When you create an HTML page using a template, the positioning and sizing of objects is restricted. As a result, certain properties are unavailable in the Properties window and the Style Composer. The following is a list of the restricted properties:

- Alignment
- Margin height
- Margin width
- Position: Left
- Position: Top

**Note:** To access these properties, the template must be unlocked, which cannot be reversed. For more information about unlocking the template, see *How to Unlock a Template* on page 338.

**Procedure: How to Unlock a Template**

When using a template to design an HTML page, certain functionality is blocked. You cannot move reports, you cannot insert additional elements, and so on. To allow the blocked functionality, you must unlock the template. Unlocking the template cannot be reversed and the developer is responsible for resizing many objects and the effects any modifications may have on the HTML page. For more information on restricted operations while designing based on a template, see *Template Usage Notes* on page 334.

**Note:** By default, the Unlock button is hidden on the toolbar. The Unlock option should only be activated if there is a change that is completely necessary to the HTML page that cannot be accomplished in Template mode.

When you unlock a template the following functionality will change:

- Controls are no longer added to the layout automatically.
- The size and position of new reports and charts is no longer determined automatically.
- There is no option to insert report frames, hyperlinks, or report sets before/after the currently selected element.
- There is no option to add or delete entire report sets.
- Panels no longer resize automatically to accommodate new reports.
It is recommended that you make a backup of your page before you unlock.

1. Open an HTML page that was created with a template and select Options from the Window menu to open the Developer Studio Options dialog box.

2. Select the HTML Page tab.

3. Select the Activate 'Unlock Template' option check box from the HTML Page tab and click OK.

The Unlock button appears on the Utilities toolbar.

4. Select the Unlock button on the Utilities toolbar, as shown in the following image.

5. A prompt appears warning you of the changes to the HTML page once the template is unlocked. Select Yes to unlock and No to return to the locked HTML page.

Note: Once a template is unlocked it cannot be locked again. Any changes made after a template is unlocked need to be maintained by the developer.
Manipulating the Objects of Templates
Creating Guided Report Forms

HTML Composer offers the ability to create highly parameterized reports, called Guided Reports, through a feature called the Guided Report Mode. You can use Guided Report Mode to streamline the creation of Guided Report Forms.

In this chapter:

- Getting Started With Guided Reports

Getting Started With Guided Reports

Guided Report Mode is available in HTML Composer to help in the creation of a companion page for a Guided Report created in a tool, such as Report Painter. You can use HTML Composer to create a streamlined, highly parameterized report procedure that results in the ability to generate thousands of reports.

Note: The Generate Graph and Add Filter right-click options are unavailable when using a guided report.

Procedure: How to Access Guided Report Mode

1. In the Developer Studio Explorer, create a Guided Report form by completing any of these actions:
With the HTML folder highlighted, select New from the File menu, and then select Guided Report Form.

or

Right-click the HTML folder, and select New, and then Guided Report Form.

or

Create a new HTML form and then select the Guided Report Mode check box from the Template Selector window. (If you use either of the two previous methods, the Guided Report Mode check box will not appear on the Template Selector window.)
The Add HTML File dialog box opens, as shown in the following image.

2. Enter a name for the new HTML file in the File name field.
3. Click Open.

The Template Selector window opens. To create a Guided Report Form without using templates, select Cancel. For more information on using templates, see Using Templates in HTML Composer on page 327.

**Note:** If you select Cancel, the page is created without templates but is still in Guided Report Mode. To create a Guided Report Form with a RIA theme, you must select Cancel from the Template Selector window.

**Procedure:** How to Create a Guided Report Form Using Templates

The following procedure describes how to operate in Guided Report Mode while using a predefined template. For more information on templates, see Using Templates in HTML Composer on page 327.

1. Open HTML Composer in Guided Report mode, as outlined in How to Access Guided Report Mode on page 341. To create a Guided Report Form using a template, you cannot cancel the Template Selector. For more information on creating a Guided Report Form without templates, see the How to Create a Guided Report Form Without Templates on page 345 manual.
2. You can import an existing report, invoke Report Painter to create a report, or reference an existing procedure.

**Note:** When you embed a report, once the Master File is selected for the first report, you will not be prompted for the Master File again when creating subsequent reports. All joins, defines, WHEREs, includes, and stylesheets are copied to the component.

You cannot invoke Procedure Viewer or Document Composer from the right-click menu while in Guided Report Mode.

For more information about creating a Guided Report, see *Creating Reports With Report Painter*.

3. After you embed or import the report, the New Parameters dialog box appears. You can chain the controls, select which parameters to create a control for, and change the Control Type. For more information about the New Parameters dialog box, see *New Parameters Dialog Box* on page 347. Make the desired changes and select **OK**.
4. Import an existing report, invoke Report Painter, or reference an existing procedure for each additional Report or Chart frame.

Since you picked a Master File for your first report, you will not be prompted for one again if you embed the report.

The New Parameters dialog box appears and the parameters for each additional report are added to the form.

5. You can reorder the controls, change the number of columns in the form, and hide elements by changing the display property according to the rules dictated by templates. For more information on these procedures, as well as allowed functionality while designing in a template, see Using Templates in HTML Composer on page 327.

6. Run the page.

A page with controls for the Guided Report parameters appears so you can customize and run different versions of the report dynamically, as shown in the following image.

**Procedure:** How to Create a Guided Report Form Without Templates

1. Open HTML Composer in Guided Report mode, as outlined in How to Access Guided Report Mode on page 341. To create a Guided Report Form without a template, you must cancel the Template Selector. For more information on creating a Guided Report Form with templates, see How to Create a Guided Report Form Using Templates on page 343.
2. You can import an existing report, invoke Report Painter, or reference an existing procedure to create a report.

**Note:** When you embed a report, once you select the Master File for the first report, you are not prompted for the Master File again when creating subsequent reports. All Joins, Defines, WHEREs, Includes, and stylesheets are copied to the component.

You cannot invoke Procedure Viewer or Document Composer while in Guided Report Mode.

3. After you embed, import, or reference the report, the New Parameters dialog box appears. You can chain the controls, select which parameters to create a control for, change the Control Type, and choose where to insert the controls. Make the desired changes and select OK. For more information on the New Parameters dialog box, see *New Parameters Dialog Box* on page 347.

4. Embed, import, or reference the desired amount of Report or Chart frames. For each report added, the New Parameters dialog box appears.

5. Optionally, you can change the style and layout of the Guided Report Form, as desired. You also have the option to use RIA themes or the standard color schemes, but not both. For more information on RIA themes, see *RIA Overview* on page 431.
6. Run the page.

A page with controls for the Guided Report appears so you can customize and run different versions of the report dynamically.

Reference: New Parameters Dialog Box

When you import, embed, or reference reports into a Guided Report form, the New Parameters dialog box opens, as shown in the following image.

The main components of the New Parameters Dialog Box are:

**Parameters Sort Arrows**

You can reorder the parameters. Moves the selected parameter in the corresponding direction.

**Name**

Displays the name of each parameter that you add to the Guided Report Form.

**Create Control**

Inserts a control onto the form for the corresponding parameter. By default, all parameters have the Create Control check box selected.
**Control Type**

Displays options for control type for each parameter. You can choose one of ten different control types. The options are as follows:

- Calendar
- Check box
- Drop down list
- Hidden
- List box
- Radio button
- Text Area
- Text box
- Single source Tree control
- Multi source Tree control

**Chain control**

Sets the control to be chained in the order they are listed in the New Parameters dialog box.

**Parameter grouping options**

Displays the options for where to place the controls for the parameters to be added to the Guided Report Form. The options are as follows:

- Do not create a form
- New single layer form
- New multiple layer form

The drop-down box also lists the names of any existing forms and you can select that option to add the new parameter controls to an existing form.
**Note:** This option is only available when creating Guided Report Forms without using templates.

Don’t show again and use default selection

Sets the New Parameters dialog box to off and instead, uses the default selections.

Auto chain controls in above specified order

Selects the Chain control check box for each parameter.

Create controls for all Parameters

Selects the Create control check box for each parameter.

**Note:** After the options for each fieldname control, a Separator is automatically added to generate a new line. There is also an extra separator added at the bottom of the parameters list that can be used to add additional spacing, as needed.
You may chain controls to one another on the Parameters tab and apply conditions to links in the chain. Chaining will populate controls based on the selected value from the prior control in the chain. You can chain static and dynamic controls, link or unlink parts of a chain, and create conditions on links in a chain. Chains are represented by lines connecting control objects on the Design or Parameters tab. Note that chaining is applicable only for controls, not parameters.

**Note:**

- Although you may chain controls from the Design tab, you may only create conditions to links in the chain through the Parameters tab.
  
  By clicking the arrow head in a link of a chain, the Properties and settings dialog box enables you to modify and set the properties and conditions of the chain.

- If using static controls, you must apply conditions for each link in the chain. Conditions need to be created for each value of the control chained from, and those values must be mapped to the correct value(s) that will be displayed in the control that it is being chained to.

**In this chapter:**

- Automatically Chaining Parameters From the New Parameters Dialog Box
- Chaining Controls on the Parameters Tab
- Setting the Default Link
- Applying Conditions to a Chain
- Populating Controls One at a Time
- Using the Chain Separator and Line Separator
Automatically Chaining Parameters From the New Parameters Dialog Box

The auto chain option enables you to automatically chain selected controls from the New Parameters dialog box. Chaining populates controls based on the selected value from the prior control in the chain. The auto chain option is useful, since it creates the chain or links of a chain, automatically.

**Note:** Automatic chaining creates a basic chain with default functionality that does not include any conditions. You may create conditions for a chain through the Parameters tab.

When importing or referencing a report with parameters to an HTML page, the controls are not chained by default. You may choose to include or exclude individual controls in a chain with the Chain control column from the New Parameters dialog box.

Additionally, when the auto chain option is selected, a separator is added to the parameters list on the New Parameters dialog box. A separator is used to separate controls into multiple chains and can be moved up or down in the chain sequence.

**Procedure:** How to Auto Chain Controls From the New Parameters Dialog Box

The auto chain option creates the chain, or links of a chain, automatically. When the auto chain option is selected, a separator is added to the parameters list. A separator is used to separate controls into multiple chains and can be moved up or down in the chain sequence.

1. In HTML Composer, import or reference a report with parameters to an HTML page.

   The New Parameters dialog box opens.

2. Select *Auto chain controls in above specified order*.

   **Tip:** You may use the up or down arrows to change the order of the selected control before selecting this option.
The Chain control option is selected for all controls and a separator is added as the last object to the list of parameters, as shown in the following image.

3. To create multiple chains, click the separator row and use the up or down arrows to change the location of the separator in the chain.
Note: If the default separator is moved up, another separator is added to the end of the list, as shown in the following image.

4. Click OK to close the New Parameters dialog box and add the control to the HTML page.
On the Design tab, when creating multiple chains from the New Parameters dialog box, each set of chained parameters appears on a new line, regardless of the grouping option selected from the New Parameters dialog box. This behavior is set through the Start each chain on a new line option, located on the Form Settings dialog box in HTML Composer. For example, the following image shows the first link in the chain (REGION) on one line. The second chain (ST and CITY) starts on a new line within the control of the Design tab. This enables you to see the relationship of the chains within the form. Start each chain on a new line is selected by default.

On the Parameters tab, chains are represented by lines connecting control objects. For example, the selected value for the REGION field populates the available values for the STATE field. The selected value for the STATE field populates the available values for the CITY field in this chain.

5. If additional filters are added, use the chaining buttons on the Positioning toolbar to add or remove the selected control to the current chain.

Procedure: How to Chain Controls From the New Parameters Dialog Box

The Chain control column enables you to include or exclude individual controls in a chain, from the New Parameters dialog box.

1. In HTML Composer, import or reference a report with parameters to an HTML page.
The New Parameters dialog box opens.

2. Select the *Chain control* check box for the controls to be included in the chain.

The controls are chained in the order that they appear on the New Parameters dialog box. You may use the up or down arrows to change the order of the selected control before chaining controls.

**Note:** If a control is excluded from a chain, the chain automatically links only the selected controls. For example, the following image shows REGION and CITY as links in the chain.

3. Click *OK* to close the New Parameters dialog box and add the control to the HTML page.
On the Design tab, when creating multiple chains from the New Parameters dialog box, each set of chained parameters appears on a new line, regardless of the grouping option selected from the New Parameters dialog box. This behavior is set through the *Start each chain on a new line* option, located on the Form Settings dialog box in HTML Composer. For example, the following image shows the first link in the chain (REGION) on one line. The second chain (ST and CITY) starts on a new line within the control of the Design tab. This enables you to see the relationship of the chains within the form. Start each chain on a new line is selected by default.

![Image showing chain example](image)

On the parameters tab, chains are represented by lines connecting control objects. For example, the selected value for the REGION field populates the available values for the CITY field in this chain.

![Image showing parameter chain](image)

4. You can use the chaining buttons on the Positioning toolbar to add or remove a selected control to the current chain.
Chaining Controls on the Parameters Tab

Chaining enables you to associate two or more related values. When you chain controls together, chained values are filtered as selections are made to each parameter control. For example, if you chain the PLANT parameter to the STATE parameter, only PLANT values for the currently selected STATE value will be available, instead of all the plants in the data source. Each time a selection is made, all chained controls that come after will be dynamically updated. Chaining also enables you to add, remove, and reverse the order of controls in the chain.

Values are processed with a caching mechanism that gathers all of the necessary values, prior to loading the page. This method automatically combines all of the necessary requests into a single HTTP request and maps the result sets to the appropriate controls, greatly reducing the load time involved with sending multiple requests for data.

Procedure: How to Chain Controls on the Parameters Tab

1. Create an HTML page using input controls to supply parameter values. 
   For details, see Using Input Controls to Supply Parameter Values on page 166.

2. Click the Parameters tab.

3. Select the center of the control object, left-click and drag the control to the center of the next control object in the chain. Release the mouse to complete the link.

Repeat this step for each link in the chain.

Tip: Optionally, you may use the Positioning toolbar to add and remove controls to a chain. Both chaining options (drag and drop and the chaining icons) work in conjunction with each other. If you create a chain by one method, you can remove the chain by using the other method, and vice versa. For more information about chaining icons, see Positioning Toolbar on page 287.

The image below is an example of chained controls. Notice the direction of the arrows.

- The Region control starts the first link in the chain, chained to the State control.
The State control starts the second link in the chain, and is being chained to the Store_Name control.

Tip: You can also reverse the order of controls in the chain. For details, see How to Reverse the Order of Chained Controls on page 360.

4. Optionally, apply condition settings to the chain to determine how parameters are populated.

If using static controls, you must apply conditions for each link in the chain. Conditions need to be created for each value of the control chained from, and those values must be mapped to the correct value(s) that will be displayed in the control that it is being changed to.

For details about conditions, see Applying Conditions to a Chain on page 364.

Procedure: How to Remove a Link in the Chain

To remove a link in the chain on the Parameters tab:

- Select the arrow head on the line so that the line is bold.
- Right-click and select Break binding.

Repeat this step for each link in the chain that you want to break.
**Procedure: How to Reverse the Order of Chained Controls**

To reverse the order of chained controls on the Parameters tab:

1. Select the arrow head on the line so that the line is bold, right-click and select *Break binding*.

2. Select the center of the control object, left-click and drag the control to the center of the next control object in the chain, and release the mouse to complete the link.

   Notice the direction of the arrow between the control objects. You may reverse the direction of the link in the chain or reverse the order of the chain by changing the direction of each link.

   a. If reversing the direction of a link in the chain, click and drag the control object in the desired order.

      For example, in the image below:

      - The Region control starts the first link in the chain, chained to the State control.
      - The Store_Name control starts the second link in the chain, also chained to the State control.
**Note:** Conditions are needed in order to make Region disappear from the chain, and to make Store_Name control State. For details about conditions, see *Applying Conditions to a Chain* on page 364.

---

**b.** If reversing the order of a chain, click and drag the control objects in the desired order.

**Tip:** In some scenarios, when reversing the order of chained values, you may want to move the controls from the default location on the Parameters tab so that you can better see the direction of the chain. Moving objects on the Parameters tab will not affect the Design view of your layout.
Press the Shift key and select the control object and bound parameter to move the objects as a set.

Chain the control objects together.

For example, in the following image, the State control starts the first link in the chain, chained to the Region control. The Region control starts the second link in the chain, chained to the Store_Name control.

3. Optionally, apply condition settings to the chain to determine how parameters are populated. For details about conditions, see Applying Conditions to a Chain on page 364.
Setting the Default Link

If a control or parameter has two or more incoming bindings, one of those bindings can be set as the default link. This ensures that population occurs in the control or parameter. When a control or parameter has multiple incoming bindings, the shortcut menu for each of those bindings has the Default link option, as shown in the following image.

![Diagram showing the default link option in the shortcut menu]

When a binding is the default link, it will have a check mark next to the Default link option in the shortcut menu, as shown in the following image.

![Diagram showing a checked default link option]

**Note:** If only one control is chained to another control, the Default link option is unavailable from the shortcut menu. If a single control is chained to a single parameter, the Default link option is shown, but will be used for future development in a later release.
Applying Conditions to a Chain

If two controls are chained to a third control, the binding that has Default link selected shows which control will be used to populate the third control by default. Similarly, if two controls are bound to a parameter, the Default link option shows which control is used to populate the parameter.

If two parameters are bound to a control, the binding that has Default link selected makes the initial selection in the control.

Applying Conditions to a Chain

A chain contains conditions for each link in the chain. The conditions are linked to the values being selected in the control object. You may apply multiple conditions to one link. The properties and settings for the condition describe how the link should behave. The following options are available:

- Apply Actions for the links on the chain.
- Apply the Values compare operator for the condition.
- Apply Selected values with a Multiselect operator for the condition.
- Apply the Resolves parameter values for the condition.
- Apply the Parameter’s compare operator for the condition.

If using static controls, you must apply conditions for each link in the chain. Conditions need to be created for each value of the control chained from, and those values must be mapped to the correct value(s) that will be displayed in the control that it is being changed to.

Reference: Properties and Settings Dialog Box (Conditions)

The Properties and settings dialog box appears when creating a condition for a chain link on the Parameters tab. A chain contains conditions for each link in the chain.
The conditions are linked to the values being selected in the control object. The properties and settings for the condition inherit the values of the prior bound control and provide additional condition settings. This section describes the additional condition settings.

The Properties and settings dialog box contains the following fields and options when creating a condition:

**Conditions**

The conditions list enables you to create multiple conditions for the link. *Default* is the only initial condition.

- To create a new condition, click the *New* icon. Condition\(n\) is created, where \(n\) is the number, and added to the Conditions drop-down list. You may type in a unique condition name, choose Selected values, and set the condition settings.

- Click the *Delete* icon to remove the selected condition from the list. Note that the *Default* condition name cannot be deleted.

**Actions**

Select an action for the chain link to control. The options offer variations to populate, show, hide, execute, and select the values. The list of available options are:

- **Populate, show.** Populates the control and displays it at run time. This is the default action for all conditions.
Populate, hide. Populates the control and does not display it at run time.

Populate with alternate, show. Populates the control with alternate values derived from a procedure, or value list, that is not the default and displays the control at run time.

Populate with alternate, hide. Populates the control with alternate values derived from a procedure, or value list, that is not the default and does not display the control at run time.

Show. Shows the control but does not populate it.

Hide. Hides the control but does not populate it.

Execute. Executes the bound object. For example, if you bind a control to a Submit button and change the value in the control at run time, the report/graph automatically executes when you change the value, without having to click the Submit button.

Select. Selects the bound object. For example, if you bind a control to a tab item and select a value in the control at run time, the bound object (the tab item) is automatically selected as the active tab on the page.

Values compare operator

Values compare operator provides chaining logic scenarios to include options, such as Equal, Not Equal, Greater Than, Less Than, and so on. This option sets the condition for how to populate the control being linked to.

Equal is the default Values compare operator.

Selected values

Selected values enable you to provide the values used in the condition. When creating a new condition, the Selected values section is activated. You may type selected values in the input box or click the ellipsis button to select values from the list.

The list of values that appears is based on the values of the prior bound control in the chain. When selected values are entered, the Multiselect operator field is activated.

Multiselect operator

The Multiselect operator options are activated when selected values are entered for the condition. Options are One of or All of. One of is based on one of the values shown in the Selected values, being selected in the prior control, in the chain. All of is based on the value of all of the Selected values, being selected in the prior control, in the chain.

One of is the default multiselect operator.
**Resolves parameter (“To: field is required”)**

**From.** The From field specifies where to get the value used in the To field, if the control being chained from is a map or ActiveX control.

**To.** The To field is used to dynamically generate the selection list used to populate the control being chained to. This field displays the parameter whose value will drive the condition evaluation. The parameter name linked to the prior control in the chain is displayed by default. The ellipsis button provides a pop-up dialog of the other parameter values (from the report) to be resolved.

**Parameter’s compare operator**

The Parameter’s compare operator provides chaining logic scenarios to include options, such as Equal, Not Equal, Greater Than, Less Than, and so on. This sets the compare operator to populate the control.

*Equal* is the default Parameter’s compare operator.

For details about the Properties and settings dialog box options for Data type values, see *Properties and Settings (Incoming Static Parameter and Unbound Control)* on page 103 or *Properties and Settings Dialog Box (Dynamic Values)* on page 118.

**Procedure: How to Create a New Condition**

1. Insert a report with parameters in HTML Composer.
   
   For details about creating parameters, see *Creating Parameter Values* on page 97.

2. Drag control objects on the Parameters tab to create a chain.
   
   Chains are represented by lines connecting control objects on the Parameters tab.
   
   Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain. For details about chaining controls, see *Chaining Controls on the Parameters Tab* on page 358.

3. Click a link in the chain.
   
   The Properties and settings dialog box opens showing the bound control values and the *Default* condition settings for the link in the chain.

4. Click the *New* icon to create a multiple condition for the chain.
   
   *Condition(n)* is created, where *n* is the number, and added to the Conditions drop-down list, and the Selected values section is activated. You may type in a unique condition name.
5. You may type in a unique condition name, choose Selected values, and set the condition settings for the new condition.

6. Optionally, you may click the Delete button to remove the selected condition from the list.

   **Note:** Default, the initial condition, cannot be deleted.

7. Close the Properties and settings dialog box.

**Procedure: How to Select the Action for a Condition**

1. Insert a report with parameters in HTML Composer.
   For details about creating parameters, see *Creating Parameter Values* on page 97.

2. Drag control objects on the Parameters tab to create a chain.
   Chains are represented by lines connecting control objects on the Parameters tab.
   Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain. For details about chaining controls, see *Chaining Controls on the Parameters Tab* on page 358.

3. Click a link in the chain.
   The Properties and settings dialog box opens showing the bound control values and the condition settings for the link in the chain.

4. Select the action for the condition from the Actions drop-down list. For example, to hide the control being chained to, select *Hide*.
   *Populate, show* is the default option.

5. Close the Properties and settings dialog box.
   When running the HTML page, the action for the chained control is applied.

**Procedure: How to Select the Values Compare Operator for a Condition**

1. Insert a report with parameters in HTML Composer.
   For details about creating parameters, see *Creating Parameter Values* on page 97.

2. Drag the control objects on the Parameters tab to create a chain.
   Chains are represented by lines connecting control objects on the Parameters tab.
Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain. For details about chaining controls, see Chaining Controls on the Parameters Tab on page 358.

3. Click a link in the chain.

The Properties and settings dialog box opens showing the bound control values and the condition settings for the link in the chain.

4. Select the chaining logic for the parameter being chained to, in the condition, from the Values compare operator drop-down list.

Equal is the default option.

5. Close the Properties and settings dialog box.

The compare operator is applied to the value selected.

Procedure: How to Apply Selected Values With a Multiselect Operator to a Condition

1. Insert a report with parameters in HTML Composer.

For details about creating parameters, see Creating Parameter Values on page 97.

2. Drag the control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values selected in prior controls of the chain. For details about chaining controls, see Chaining Controls on the Parameters Tab on page 358.

3. Click a link in the chain.

The Properties and settings dialog box opens showing the bound control values and the condition settings for the link in the chain.

4. Click the New icon to create a multiple condition for the chain.

Condition(n) is created, where n is the number, and added to the Conditions drop-down list, and the Selected values section is activated. You may type in a unique condition name.

5. You may type selected values in the input box or click the ellipsis button to select values from the list.

The list of values that appears is based on the values of the prior bound control in the chain.
**Tip:** You may also use the pop-up icons to select a field and close the pop-up dialog. The green icon is OK, the red icon is Cancel, double-clicking a value will select the value and close the dialog without using any button, and pressing the Esc key will cancel the dialog without using any button.

When selected values are entered, the Multiselect operator field is activated.

6. Select the chaining logic for the selected values from the *Multiselect operator* drop-down list.

- *One of* is based on one of the values shown in the Selected values, being selected in the prior control, in the chain. This is the default selection.
- *All of* is based on the value of all of the Selected values, being selected in the prior control, of the chain.

![Properties and settings dialog box](image)

7. Close the Properties and settings dialog box.

The selected values and multiselect operator are applied to the condition.

**Example: Using the All Of Multiselect Operator**

The following example shows how to use the All Of multiselect operator when you perform conditional chaining. In this example, listbox2 is chained to the multiselect listbox1. The listbox2 is conditionally chained to be shown if all of the selected values in listbox1 meet the listed criteria. If all of the selected values do not meet the criteria, listbox2 will be hidden.

1. Create the HTML page.
   a. Select the *HTML Files* folder from your project in the Developer Studio Explorer.
   b. Right-click and select *New*, then *HTML File*.
      The Add HTML File dialog box opens.
   c. Type *allof_example* in the File name text box and click *Open*.
      The Template selector opens.
   d. Click *No, Thanks* to create a blank HTML page without using a template.
      HTML Composer opens.
2. Add a multiselect list box to the canvas, dynamically populated using the Car data source.
   a. From the Insert menu, select Controls, then List Box. The cursor changes into a crosshair.
   b. Drag the crosshair to create a list box and adjust it to the size you want.
   c. Select Properties and Settings from the View menu. The Properties and settings dialog box appears.
   d. Select the Dynamic radio button for the Data type.
   e. Select the ellipsis button from the Embedded procedure field, as shown in the following image.

   ![Properties and settings dialog box]

   f. Select the car Master File from the Get source file dialog box and click Open.
   g. Select the ellipsis button from the Value field.
   h. Select SEATS from the drop-down menu.
   i. Set the Multiple property to Multiple from the Properties pane.
The listbox1 is now a multiselect list box.

3. Add a second list box to the canvas, dynamically populated using the Car data source.
   a. From the Insert menu, select Controls, then List Box.
      The cursor changes into a crosshair.
   b. Drag the crosshair to create a list box and adjust it to the size you want.
   c. Select Properties and Settings from the View menu.
      The Properties and settings dialog box appears.
   d. Select the Dynamic radio button for the Data type.
   e. Select the ellipsis button from the Embedded procedure field.
      The Get source file dialog box appears.
   f. Select the car Master File and click Open.
   g. Select the ellipsis button from the Value field.
   h. Select CAR from the drop-down menu.

4. Chain the list boxes.
   a. Select listbox1 on the canvas.
      Resizing anchors appear around the list box.
   b. Hold down the Ctrl key and select listbox2.
      Resizing anchors appear around both list boxes.
   c. Select Add to current chain from the Utilities toolbar, as shown in the following image.

5. Set conditions for the chain.
   a. Click the Parameters tab.
   b. Right-click the arrow connecting listbox1 to listbox2 and select Properties and Settings.
      The Properties and settings dialog box appears.
   c. For the Default condition, set Actions to Hide.
   d. Press the New Condition button to create a new condition.
e. For the new condition, set the properties as follows:

- Selected values: 5
- Actions: Populate, show
- Values compare operator: Less Than
- Multiselect operator: All of

6. Run the page.

There is no default selection for listbox1 and by default listbox2 is not displayed when the page is first run. Select any single value less than 5 fulfills the condition set in step 5 and listbox2 is shown. Selecting 2 and 4 also fulfills the condition, all of the multiselected values are less than 5 and listbox2 is shown. Selecting 2 and 5, 4 and 5, or 2, 4, and 5 does not fulfill the condition, all of the multiselected values are not less than 5 and listbox2 remains hidden.
The following image shows all of the selected values meeting the condition and, as a result, listbox2 is shown.

![Image showing selected values meeting condition]

The following image shows all of the selected values failing to meet the condition and, as a result, listbox2 is hidden.

![Image showing selected values not meeting condition]

**Procedure: How to Resolve Parameters for a Condition**

It is recommended that you populate the controls first, before chaining. When you populate the controls first, certain information is obtained, which allows the determination of the best choice for Resolves parameter. If you chain first and then populate, the information cannot be obtained, because the chaining is already established. If you chain first, you must manually set Resolves parameter.

1. Insert a report with parameters in HTML Composer.
   For details about creating parameters, see *Creating Parameter Values* on page 97.

2. Drag the control objects on the Parameters tab to create a chain.
   Chains are represented by lines connecting control objects on the Parameters tab.
   Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain. For details about chaining controls, see *Chaining Controls on the Parameters Tab* on page 358.

3. Click a link in the chain.
   The Properties and settings dialog box opens showing the bound control values and the condition settings for the link in the chain.
4. Click the Resolves parameter ellipsis button to select a parameter name to resolve. If a custom procedure that has a filter (or filters) populates the control, the values list shows the parameters from the filters. If a data source populates the control, the values list shows all of the fields from the data source shown in the Object Inspector.

The value in the Resolves parameter field should be either:

- The field name that limits the values for the next control in the chain, if a data source populates the control.
- The parameter name from the procedure, if a procedure populates the control.

In most cases, this value will be populated by default and will not need to be changed.

Tip: You may also use the pop-up icons to select a field and close the pop-up dialog. The green icon is OK, the red icon is Cancel, double-clicking a value will select the value and close the dialog without using any button, and pressing the Esc key will cancel the dialog without using any button.

5. Close the Properties and settings dialog box.

The parameter value is resolved in the chain if no filter is specified.

**Procedure: How to Select the Compare Operator for the Parameter**

An example of when to apply chaining logic is when a form offers two lists of dates so that you can select a FROM/TO date range. By chaining these parameters together and applying the Greater than parameter compare operator, this ensures that when a date is selected for the FROM parameter, only dates that follow the FROM date display in the TO date control, eliminating the possibility of selecting an invalid date range.

1. Insert a report with parameters in HTML Composer.
   
   For details about creating parameters, see *Creating Parameter Values* on page 97.

2. Drag the control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.
Chaining controls will populate parameters with values at run time, based on values selected in prior controls on the chain. For details about chaining controls, see *Chaining Controls on the Parameters Tab* on page 358.

3. Click a link in the chain.

   The Properties and settings dialog box opens showing the bound control values and the condition settings for the link in the chain.

4. Select the chaining logic option from the *Parameter's compare operator* drop-down list. This sets the compare operator to populate the control.

   *Equal* is the default option.

5. Close the Properties and settings dialog box.

   The compare operator is applied to the parameter selected.

**Procedure: How to Enable Cache Processing for Chained Values**

You may enable cache processing for chained values in two ways:

- Enable the caching option for the HTML page and all objects on the page.
- Enable cache run time data for a dynamic control or a condition.

   A chain contains conditions for each link in the chain. The conditions are linked to the values being bound to the control object. If you change the options for the condition, it will also be applied to the control, and vice versa.

Caching options are turned off by default.

1. To enable caching options for all objects on the HTML page:
   - From the Design tab of HTML Composer, select *Options* from the Window menu.
     - The Developer Studio Options dialog box opens.
   - Select the *HTML Page* tab.
   - Select *Default caching option*.
   - Click OK to close the Developer Studio Options dialog box.

2. To enable caching options for a dynamic control or condition:

   A chain contains conditions for each link in the chain. The conditions are linked to the values being chained to the control object. If you change the options for the condition, it will also be applied to the control, and vice versa.
Applying Conditions to a Chain

a. For a dynamic control:
   - Create a dynamic input control to supply parameter values.
     For details about creating dynamic values, see *Creating a Dynamic List of Values* on page 118.
   - Select the dynamic control object from the Parameters tab.
     The Properties and settings dialog box opens, showing the dynamic control options.
   - Select *Cache run time data* to cache the run time data for the selected input control.
     
     **Note:** This setting overrides the *Default caching option* from the HTML Page tab.
   - Close the Properties and settings dialog box.
   - Select the center of the control object, drag the control to the center of the next control object, and release the mouse to complete the binding of the chain.
     When binding controls, the conditions inherit the values set in the dynamic control properties and settings.

b. For a dynamic condition:
   - Click a link on the chain to open the Properties and settings dialog box for the condition.
   - Select *Cache run time data* to cache the run time data for the selected input control.
     This option is only available for dynamic controls.
     This setting overrides the *Default caching option* from the HTML Page tab.

When running the HTML page, data for the chained value is cached to improve performance.

*Example: Chaining Controls in HTML Composer*

The following example shows how to create a report of the Gotham Grinds product sales for each category within each Region, State, and City.

Several chaining conditions will be created:
   - A chain consisting of the Region, State, and City controls.
     The values for the Region control populate the State control with the associated values, and the values for the State control populate the City control with the associated values.
   - Multiple conditions for links in the chain.
Conditions indicate that when Region is Southeast, the State control is hidden and the dependent City Values for Southeast are shown in the City control.

1. Create the HTML page.

**Tip:** The Gotham Grinds Sales data source (ggsales.mas) is available from the ibisamp Applications on localhost folder of Developer Studio. You may copy this source file to the project directory of your choice.

a. Select the *HTML Files* folder from your project in the Developer Studio Explorer.

b. Right-click and select *New/HTML File*.

   The Add HTML File dialog box opens.

c. Type *chaining_example* in the File name text box and click *Open*.

   HTML Composer opens.

2. Create the Gotham Grinds sales report.

   a. Select *New Report* from the Insert menu.

      The cursor changes into a crosshair.

   b. Click and drag the crosshair to create a reporting object and adjust it to the size you want.

   c. Double-click the report placeholder.

      The Open dialog box appears.

   d. Select the *ggsales* Master File and click *Open*.

      Report Painter opens showing the field names for the ggsales data source.

   e. Select *By* from the Columns toolbar and double-click the following field names: CATEGORY, PCD, PRODUCT, REGION, ST, CITY, STCD.

   f. Insert your cursor after the Store ID field in the Report Painter canvas and select *Sum* from the Columns toolbar.

   g. Double-click DOLLARS to add it to the report.

3. Create a list of parameters for the Region, ST, and City fields. These are the values you will be able to select when you run the report on the HTML page.

   a. Click the *Where/If* button from the Columns toolbar.

      The Report Options dialog box opens at the Where tab.

   b. Click Assist.
The Expression Builder opens.

c. Create a parameter for Region.

- From the Fields list, double-click REGION.
- From the Logical Relations drop-down list, select equals.
- In the Compare Type box, select Parameter.
- Double-click the Compare Value box to open the Variable Editor.
- Keep the default Name as REGION.
- Select Dynamic list from the Accept List section.
  
  GGSALES is automatically selected as the Source File and REGION is selected as Values for Return Fields.
- Click OK to close the Variable Editor.

d. Create a parameter for ST from the Expression Builder.

- From the Fields list, double-click ST.
- From the Logical Relations drop-down list, select equals.
- In the Compare Type box, select Parameter.
- Double-click the Compare Value box to open the Variable Editor.
- Keep the default Name as ST.
- Select Dynamic list from the Accept List section.
  
  GGSALES is automatically selected as the Source File and ST is selected as Values for Return Fields.
- Click OK to close the Variable Editor.

e. Create a parameter for City from the Expression Builder.

- From the Fields list, double-click CITY.
- From the Logical Relations drop-down list, select equals.
- In the Compare Type box, select Parameter.
- Double-click the Compare Value box to open the Variable Editor.
- Keep the default Name as CITY.
Select Dynamic list from the Accept List section.

GGSALES is automatically selected as the Source File and CITY is selected as Values for Return Fields.

Click OK to close the Variable Editor.

f. Click OK to close the Expression Builder.
g. Click OK to close the Report Options dialog box.
h. Select Close from the File menu to close Report Painter.
i. When you are prompted to save your changes, click Yes.

You are returned to HTML Composer and the New Parameters dialog box appears.

j. Click OK to automatically add your parameter controls to the HTML page.

4. Chain the controls to associate dependent values.

a. Click the Parameters tab.

When a control is automatically added to the layout with the New Parameters dialog box, it is associated (bound) to a parameter. The control object is bound to the parameter object, which means that the control will populate the parameter.

In this example, the Region, ST, and City controls are not chained to each other and thus have no dependencies. If you run this report as is, no HTML output would appear since the controls do not know how to associate the related values.

b. Select the center of the REGION control object, left-click and drag the REGION control to the center of ST control object, and release the mouse to complete the link.

c. Select the center of the ST control object, click and drag the ST control to the center of CITY control object, and release the mouse to complete the link.
Now the Region, ST, and City controls are chained to each other. The Region control starts the first link in the chain, chained to the ST control. The ST control starts the second link in the chain, chained to the City control.

If you run this page, the values for the Region control populate the ST control with the associated values, and the values for the ST control populate the City control with the associated values.

5. Create a condition for the ST control to be hidden if the Region is Southeast.

   a. Click the first link in the chain.

      The Properties and settings dialog box opens showing the bound control values for the Region control. Accept the default condition settings:

         - Actions is Populate, show.
         - The Value compare operator and Parameter compare operator is Equal.
         - The multiselect operator is One of.
         - Resolves parameter is REGION.

   b. Click the New icon to create multiple conditions for this chain link.

      Condition1 is created and the Selected values section is activated. Set the following options to hide the ST control if Region is Southeast.
Click the Selected values ellipsis button and select Southeast from the list of values. Since this starts the first link in the chain, the list of Region values appear, as indicated from the Resolves parameter field for the condition.

Select Populate, hide as the Action.

Select Equal as the Value compare operator and Parameter’s compare operator.

Select One of as the multiselect operator.

The Resolves parameter is REGION.

The following image shows the condition settings to hide the result of values (the list of State values) when Region is equal to Southeast.

![Properties and settings dialog box](image)

6. Create a condition to populate the City control with the dependent City values, when the State control is populated with States from the Southeast Region.

a. Click the second link in the chain.

   The Properties and settings dialog box opens showing the bound control values for the State control. Accept the default condition settings:

   - Actions is Populate, show.
   - The Value compare operator and Parameter’s compare operator is Equal.
The multiselect operator is *One of*.

Resolves parameter is *ST*.

b. Click the **New** icon to create multiple conditions for this chain link.

Condition1 is created and the Selected values section is activated. Set the following options to supply the City values when the States are FL, GA, TN (from the Southeast Region).

- Click the **Selected values** ellipsis button and select **FL**, **GA**, and **TN** from the list of values.
  
  Since this starts the second link in the chain, the list of ST values appear, as indicated from the Resolves parameter field for the condition.

- Select **Populate, show** as the Action.

- Select **Equal** as the Value compare operator.

- Select **One of** as the multiselect operator.

- The Resolves parameter is **ST**.

- Select **Greater Than or Equal** as the Parameter’s compare operator.

The following image shows the condition settings that the dependent City values will honor when the ST values are FL, GA, and TN.
7. Close the Properties and settings dialog box.
8. Run the HTML page.

When Region is Southeast, the State control is hidden and the dependent City Values for Southeast are shown in the City control.

**Populating Controls One at a Time**

When building complex pages, you can optimize performance by populating a chain one control at a time instead of all the controls when the page initially loads. Selecting the Add 'No selection' option enables you to populate controls when necessary.
Procedure: How to Populate Controls One at a Time

1. Click the Add ‘No Selection’ option check box on the Properties and Settings dialog box for the input control, as shown in the following image. Repeat this step for other input controls in the chain as desired.

2. Click the Run button.

The page opens and the first control, for example Region, contains a Make Selection drop-down list. The other controls, after it, have no values.

3. Select a value from the first control drop-down list (for example, Midwest).

When you make a selection in the first control, the next control, for example, State, will populate with selection values and the next control, City, has no values.
4. Select a value from the next control drop-down list (for example, IL), as shown in the following image.

The next control, for example, City, will populate with selection values.

5. Select a value from the next control drop-down list (City), as shown in the following image.

6. Click the Run button.
Using the Chain Separator and Line Separator

The chain separator and line separator options allow for chains and parameters to be grouped or split depending on which settings are turned on. When used, the two separators do the following:

**Chain separator.** When *Start each chain on a new line* is on, this separator creates new chain groups on new lines. When *Start each chain on a new line* is off, this separator starts a new chain wherever it is placed in the New Parameters dialog box. The controls are positioned in one row and wrap at the end of the form.

**Note:** *Start each chain on a new line* is turned on by default. This option can be found in the Form settings dialog box.

**Line separator.** This separator creates a line break wherever it is placed.
Procedure: How to Use the Chain Separator and Line Separator

To use the chain separator and line separator:

1. Create a new procedure that uses the CAR Master File and prints COUNTRY, CAR, MODEL, BODYTYPE, SEATS, and SALES.
2. Save the procedure, naming it separator_example.fex.
3. Create a new HTML file.
4. Insert a new report.
5. Right-click the report and select Reference existing procedure, as shown in the following image.
6. Select the previously created procedure, separator_example.fex, and click Open.
Using the Chain Separator and Line Separator

The New Parameter dialog box opens, as shown in the following image.

7. Check the *Auto chain controls in above specified order* option.

8. Move Line Separator above SALES.
   
   A copy of the line separator is moved up while the original stays in the starting position. This is so you can add multiple line separators.

9. Move Chain Separator above MODEL.
   
   A copy of the chain separator is moved up while the original stays in the starting position. This is so you can add multiple chain separators.
The New Parameters dialog box will look like the following image.

![New Parameters dialog box](image)

10. Click OK.

The report is added to the HTML page. COUNTRY and CAR are on the first line and make up one chain. MODEL, BODYTYPE, and SEATS are on the second line, while SALES is on a separate, third line. MODEL, BODYTYPE, SEATS, and SALES make up a second chain.

The parameters are shown in the following image.

![Parameter values](image)
Using the Chain Separator and Line Separator
Creating Active Technologies Dashboards
With HTML Composer

An active report is a report that is designed for offline analysis.

HTML Composer has extended the functionality of active reports by providing the features to build an active dashboard. An active dashboard is an HTML form with one or more active report procedures, and controls to mimic active report menu options to allow global modification of multiple active reports in HTML created pages.

The process of creating active dashboards in HTML Composer consists of:

- Adding an active report to HTML Composer.
- Binding or synchronizing other active report and active chart objects to the active report in the layout.
- Configuring active controls that mimic active report menu options at run time.
- Exporting the HTML form as a FOCUS procedure (.fex) for scheduling and distributing active dashboards.

In this chapter:

- Binding Objects to an Active Technologies Report
- Configuring Active Technologies Controls in HTML Composer
- Refreshing Active Technologies Reports
- Exporting the Active Technologies Dashboard
- Scheduling and Distributing Active Technologies Dashboards
- Usage Notes for Active Technologies Dashboards Created With HTML Composer

Binding Objects to an Active Technologies Report

You can create multiple views of an active report by binding an active report or active chart object to an active report. Binding or synchronizing is the act of configuring an association between an active report and an active report or active chart object in HTML Composer.
You can synchronize active report and active chart objects and show the synchronized report groups in HTML Composer. The synchronize options are available from the Positioning toolbar in HTML Composer.

You can only synchronize objects to one active report at a time. If you try to synchronize an object to a second active report, the first synchronization is removed.

**Procedure: How to Synchronize Report and Chart Objects to Active Technologies Reports**

1. In HTML Composer, you can add an active report to the layout by using any of the following methods:
   - Select *New Report* from the Insert menu.
   - Double-click the report object to create the active report in Report Painter.
   - Select *New Report* from the Insert menu.
   - Right-click the report object and select *Reference existing procedure* from the context menu to add the active report.
   - Select *Import Existing Procedure* from the Insert menu to add the active report.

2. Add an active report or active chart object to the layout.
   - Select *New Report* or *New Graph* from the Insert menu.
   - The cursor changes into a crosshair.
   - Drag the crosshair to create an active report or active chart object and adjust it to the size you want.
3. Select the objects to be synchronized.

- Select the active report or active chart object as the object to be synchronized.
- While pressing and holding the Ctrl key, select the active report as the report that you want to bind to.

The synchronize buttons on the Positioning toolbar are activated.

In the example below, the active report is the binding object and the chart object is about to be synchronized to the active report.

The binding object (active report) is indicated by clear boxes around the edges. The synchronized object (active report or active chart object) is indicated by solid black boxes around the edges.
4. Click the *Synchronize to active report* button on the Positioning toolbar.

![Synchronize to Active Report](image1.png)

The active report or active chart object is synchronized and refreshed with data from the active report.

There is no separate procedure associated with these active report objects. If you right-click these items, there are no options to edit the procedure.

**Procedure:**  **How to Show Synchronized Active Technologies Report Groups**

Select *Show synchronized reports* from the Positioning toolbar.

![Show synchronized reports](image2.png)

The synchronized groups are shown in the layout.
In the following example, there are two synchronized report groups. The Production Units Analysis graph is synchronized to the Production Units Analysis active report, and the Sales by Category graph is synchronized to the Sales by Category active report.

![Image of synchronized reports]

**Procedure:** *How to Select Properties for Synchronized Reports*

You can change the active report object properties by using the Properties tab in the Properties window.

1. Select the synchronized active report object in the layout and click the *Properties* tab.
   
The active report object properties appear.

2. Select the active report type drop-down list to change the type of active report for the object.
   
The options are *<Not Set>, Grid, Pivot, Bar, Line, Pie*.
3. Optionally, if you select Bar, Line, or Pie as the active report type, additional X-axis and Y-axis selections are available for the synchronized report.

- Select the active report X axis drop-down list.
- Select the active report Y axis drop-down list.

If you change the X and Y values for a chart object, the selections are not reflected in the Design view of HTML Composer. These values are applied at run time.

**Procedure:** How to Delete an Active Technologies Report Object

An active report object can only be populated if it is synchronized with an active report. To break the synchronization between an active report or active chart with an active report, delete the object.

1. Select the synchronized active report or active chart object in the layout.
2. Click **Delete** from the Edit menu.

The active report object is deleted.

**Configuring Active Technologies Controls in HTML Composer**

To add an active control, you need to insert a new control to the layout and configure it as an active control on the Parameters tab. Selecting active report as the control type creates an association between the HTML Composer control and an active report, thereby linking actions to directly affect bound active reports.

Only when there are active reports embedded or referenced in HTML Composer, are active controls applicable. An active control cannot be associated to any parameters in the layout. This type of control can only be associated with an active report in the Layout.
Note:

- An active report that has a password (ARPASSWORD) set for viewing restrictions is not supported in an active dashboard created with HTML Composer.

- When creating active dashboards in HTML Composer, the combination of using an active report with the active cache option enabled and using an active control that is a Date field (such as dates with format MDY and MDYY) results in an error. The active control date field works correctly if you deselect the active cache option in the active report.

- If a control displaying report types appears in an AHTML report in HTML Composer, and the Pivot report type is selected at run time, the report is incorrectly reduced in size. If the user selects Pie, Chart, Line, or the default report type of Grid, the frame is not resized to the original positioning set by the user. Although scroll bars are added, output cannot be fully viewed.

**Procedure:** How to Add an Active Technologies Control to the Layout

Any HTML Composer control can be configured as an active control, but the following controls are the most applicable: Check box, Drop down list, List box, Radio button, and Push button.

Add an HTML Composer control that mimics an active report menu option:

1. Select the control type (for example, Drop Down List or List Box) from the Components or Controls submenu of the Insert menu.
   
The cursor changes into a crosshair.

2. Drag the crosshair to create a control object and adjust it to the size you want.
   
The HTML Composer control is added as the active control. You can now configure the control by using the Parameters tab.

**Reference:** Properties and Settings Dialog Box (Active Technologies Reports)

The Properties and settings dialog box appears when creating or editing an active report value on the Parameters tab.
The following image is the Properties and settings dialog box with an active report Data type.

The Parameters tab contains the following fields and options when active report is selected as the Data type:

**Data type**

Determine whether values are obtained from a static or dynamic list, an active report, or TOC.

Selecting active report will require you to bind the HTML Composer control to an active report.

**Available active reports**

The Available active reports list binds active controls to active reports in the layout. At run time, when the Refresh for active reports setting is triggered, the active reports selected in the Available active reports list are modified based on the current state of each active control it is bound to.
Available active reports lists all active reports currently embedded in HTML Composer. No active reports are selected by default.

**Menu Option Types**

The Menu Option Types determine how active reports are modified when the Refresh for active reports setting is triggered. Menu Option Types configure active controls to sort columns, filter content, and change the active report presentation. Multiple active controls, each with different Menu Option Types settings, can be used in combination to modify the active dashboard.

Menu Option Types presents a list of options to designate which active report menu option an active control inherits. To set the behavior of the current active control, select only one Menu Option Types item.

If no option is selected, the active control has no effect on the active dashboard.

**List of columns**

At run time, the active control lists all common columns found in each bound active report. When the Refresh for active reports setting is triggered, the data is sorted by the selected column.

If using AS Names for a field in a report, all common columns must have the same name across all reports.

**Column value**

At run time, the active control lists all unique values found in a specified column, common in each bound active report. When the Refresh for active reports setting is triggered, the active control filters bound active reports based on the column value selected.

The Add "ALL" Option is activated when the Column value option is selected. This adds the option to select ALL data source values to the control.

**List of filters**

At run time, the active control lists multiple filtering actions. This type of control does not affect bound active reports by itself, but only when used in conjunction with active controls set to Column Value. When the Refresh for active reports setting is triggered, the active control instructs how to filter bound active reports based on the value selected in the Column Valued control.

The available list of filters is: Equals, Not equal, Greater than, Greater than or equal to, Less than, Less than or equal to, Between, Contains, Contains (match case), Omits, and Omits (match case).
Sort order
At run time, the active control lists two sorting actions, Sort Ascending and Sort Descending. When the Refresh for active reports setting is triggered, the active control sorts bound active reports based on the sorting action selected.

By default, the active control sorts the first common column in each of the bound active reports.

Report type
At run time, the active control lists different active report presentation types; Grid, Pie Chat, Line Chart, Bar Chart, and Pivot Table. When the Refresh for active reports setting is triggered, this active control changes bound active reports to the presentation type selected.

Common Columns
The Common Columns list only appears when the Column value Menu Option Type is selected. Common Columns lists all common columns found in each bound active report. Select one field to bind to the active control. At run time, the Column value control lists all unique values across each bound active reports Common Columns field selected.

The Common Column selection can be overridden at run time when the Column Value control is chained to the List of columns Menu Option Type.

Refresh for active reports
Enables active controls to automatically modify current views of bound active reports when you select a new value at run time.

Refresh for active reports is enabled by default when you select an Available active report from the Parameters window.

For more information about the Refresh for active reports option, see Refreshing Active Technologies Reports on page 407.

Selected Value
Enter the values to be selected as the default value whenever the procedure is run.

The Selected Value option is only available for active controls when the Column Value Menu Option Type is selected.

Add "ALL" Option
Adds the option to select ALL data source values to the control. Alternate text can be substituted for "ALL" using the text field to the right.
The Add "ALL" Option is available when the Column value option is selected from the Menu Option Types.

Procedure: How to Configure an Active Technologies Control

Once the active control is added to the layout, you can configure it by using the Properties and settings dialog box on the Parameters tab.

It is important to note that you can only chain List of columns to List of column values.

1. Select the active control in the layout and click the Parameters tab.
   The Properties and settings dialog box opens.

2. Select active report as the Data type.
   The active report options appear.

3. Bind the active control to an Available active report in the layout:
   - Select one or more active reports from the list of Available active reports.
When an active report is selected, Refresh for active reports is enabled by default.

The active reports selected in the Available active reports list are modified based on the current state of each active control it is bound to. Refresh for active reports refreshes current views of bound active reports when you select a new value at run time.

For more information about the Refresh for active reports option, see Refreshing Active Technologies Reports on page 407.

4. Select the Menu Option Types for the active control to sort, filter, list or select columns, and/or change presentation styles of the bound active report and the associated report and graph objects synchronized to the active report.

If no option is selected, the active control has no effect on the active dashboard.
a. Select *List of columns* from Menu Option Types to list all common columns found in each bound active report. At run time, the bound active report output is sorted by the selected column.

For example, the following active control shows a list of all the columns in the bound active report.

![Column Selection Example](image)

b. Select the *Column value* option from the Menu Option Types to list all unique values found in a specified column, common in each bound active report at run time.

**Note:** You can only chain *List of columns* to *Column value*. You cannot chain a *Column value* to another *Column value*.

When the Column value option is selected, the active control panel dynamically presents Common Columns in each of the selected active reports in the Available active reports list.

Select one column from the *Common Columns* list.

![Menu Option Types Example](image)

You can also use the *Selected Value* field to enter the values to be selected as the default value whenever the procedure is run. The *Add "ALL" option* adds the option to select ALL common column values to the control at run time.
For example, the following active control shows *RATING* as the selected common column for the bound active report.

![Active Control Example](image)

**c.** Select *List of filters* from the Menu Option Types to list multiple filtering actions at run time.

List of filters is used in conjunction with the Column value. Both controls should be bound to the same active reports. The active control instructs how to filter bound active reports based on the value selected in the Column value control.

For example, the following active control shows a list of filters in the bound active report.

![List of Filters](image)

**d.** Select *Sort order* from the Menu Option Types to list sorting options (Ascending or Descending) at run time. The active control sorts bound active reports based on the sorting action selected.

By default, the active control sorts the first common column in each of the bound active reports.
For example, the following active control shows list sort order options in the bound active report.

For example, the following active control shows report type options in the bound active report.

### Refreshing Active Technologies Reports

The Refresh for active reports setting enables active controls to automatically modify current views of bound active reports when you select a new value. Each bound active report is modified not only by the new selection in the active control with the Refresh for active reports setting, but is based on the current state of all active controls in the active dashboard. This action is triggered at run time when you select a new value in an active control with Refresh for active reports set.

- **Enabled (or checked)** empowers the active control, only after you make a new selection, to modify bound active reports.
- **Disabled (or unchecked)** prevents any bound active report from being modified when you select a new value in the active control.

In order to update active reports when a value in the active control changes, you must check the *Refresh for active reports* check box on the active reports Properties and settings dialog box.

Refresh for active reports is selected by default.
You may want to disable the Refresh option if there are multiple active controls that require each control to be set before you refresh your output. If you are using multiple controls, you can associate the refresh option with a Push Button or Hyperlink, enabling you to refresh the output once all the controls are selected.

**Procedure: How to Refresh Active Technologies Reports in the Active Technologies Control Panel**

1. From the Parameters tab, select active report as the Control Value.
   The active report options appear.
2. Select the Refresh for active reports check box.
   When an active report is first selected, Refresh for active reports is enabled by default.

**Procedure: How to Refresh Active Technologies Reports With a Push Button or Hyperlink**

1. Insert a Push Button or Hyperlink to the layout:
   - From the Insert menu, select Controls, then click Push Button.
   - From the Insert menu, select Components, then click Hyperlink.
   The cursor changes into a crosshair.
2. Drag the crosshair to add the Push Button or Hyperlink object to the layout and adjust it to the size you want.
   - If inserting a Push Button, right-click the push button object and select Create hyperlink from the context menu.
   The Hyperlink Properties dialog box opens.
   - If inserting a Hyperlink, the Hyperlink Properties dialog box opens.
3. Optionally, you may change the name of the Push Button or Hyperlink in the Display Text field.
4. From the Hyperlink Properties dialog box, select the New icon to add a request to execute.
5. Select Refresh active reports from the Action drop-down list.
6. Select the Source drop-down list to select which active reports should be refreshed.
The Source drop-down only lists the embedded or referenced active reports in the layout.

7. Click OK to close the Hyperlink Properties dialog box.

**Exporting the Active Technologies Dashboard**

A benefit of active reports is the ability to run these reports offline. You can export an HTML form as a FOCUS procedure (.fex) to provide the ability to schedule and distribute active dashboards, so these too can be run offline.

Export As Procedure converts the HTML page and embeds the code into a FOCUS procedure. The layout is no longer a webpage or HTML file, but a FOCUS procedure with embedded HTML code. The procedure (.fex) is added to the Procedures folder (in your local projects) or in your Standard Reports group folder (Managed Reporting environment).

Once the HTML form is saved as a procedure, it cannot be converted back to HTML Composer. The Export as procedure is recommended for saving active dashboards only, as many layout controls and report formats are not supported.

**Procedure: How to Use Export as Procedure**

Once the HTML form is exported as a procedure, it cannot be converted back to HTML Composer.

1. After creating an active dashboard in HTML Composer, select **Export as procedure** from the File menu.
   
   The New Procedure File dialog box opens.

2. Type a File name and click Create.
If the layout contains any parameter controls other than an active control, the Export as procedure option is unavailable.

**Reference: Conversions of Export as Procedure**

Export As Procedure converts the HTML page and embeds the code into a FOCUS procedure. The layout is no longer a webpage or HTML file, but a FOCUS procedure with embedded HTML code. This conversion requires conversion of each object on the HTML page.

The purpose of creating a procedure from an HTML form is to provide the ability to run these forms offline. Because you may not be connected to a WebFOCUS environment, the new procedure removes all referenced objects and adds them to the procedure. Layouts with controls that require multiple requests to the server are not supported.

The following conversions occur when exporting as a procedure:

- Referenced procedures get read from and written to, or embedded in, the saved procedure.
- The display format of FLEX and APDF reports and chart objects is converted to HTML format. For example, if the layout has embedded or referenced Excel, PowerPoint, or PDF documents, these are converted to an HTML-formatted output.
  
  The active reports (AHTML) format is preserved.
- A reference to an image file is removed, and the image is embedded in the procedure as inline HTML code.
  
  This code can become very long and it is recommended that only small images be used in layouts that will be exported as procedures.
**Reference: Limitations of Export as Procedure**

Note the following limitations when applying the Export As Procedure in HTML Composer:

- If using Static and Dynamic Parameter controls, the Export as Procedure menu item is disabled for any layouts with static or dynamic parameter controls. Any scheduled report supports only one request to the server at run time. These types of controls require multiple requests to the server, and cannot be supported offline.

- If exporting a procedure with background images, background images are not embedded into the procedure due to size. The procedure keeps the reference. In offline mode, if this reference cannot be resolved, no image is displayed.

- If exporting a procedure and using cascading style sheets, the referenced style sheets are not embedded into the procedure and the procedure keeps the reference. In offline mode, if this reference cannot be resolved, no style from the CSS file is applied.

**Scheduling and Distributing Active Technologies Dashboards**

If an HTML form has been exported as a procedure (.fex), it is now available to be scheduled with ReportCaster.

**Usage Notes for Active Technologies Dashboards Created With HTML Composer**

The following apply when you create an active dashboard with HTML Composer:

- HTML Composer enables you to graphically create and run an HTML page that incorporates reports, charts, forms, and web objects. Certain processing occurs when HTML Composer generates an active report or chart (format AHTML). An HTML Composer request is executed after the HTML file is loaded into the browser. The active report or chart is returned to the browser from the server and the result is appended to the HTML. The key operations are retrieving the active report or chart content from the server and merging the content with the HTML page.

  HTML Composer displays a progress message that informs you of the processing that is taking place.

- At run time, an active chart embedded in a frame on an active dashboard uses the frame size specified in the HTML Composer layout when one of the following settings is in effect: ARGRAPHENGINE=FUSION, ARGRAPHENGINE=JSFUSION, or ARGRAPHENGINE=JSCHART. With the default setting, ARGRAPHENGINE=DEFAULT, the active chart does not adjust to the frame size specified.
Report Library Integration in HTML Composer

When you create a schedule in ReportCaster, you have the option to distribute the scheduled output to the ReportCaster Report Library, a storage and retrieval facility. HTML Composer enables you to integrate Report Library reports into an HTML Composer page, utilizing the ReportCaster API to obtain records for reports in the Report Library.

**Note:** The Report Library options only appear when accessing HTML Composer from the Managed Reporting environment, as ReportCaster must be installed in the active WebFOCUS environment.

For more information about using the Report Library in ReportCaster, see the *ReportCaster* manual.

**In this chapter:**
- Integrating the Report Library

**Integrating the Report Library**

The main steps for integrating the Report Library are:

1. Logging into the Managed Reporting environment and accessing HTML Composer.
2. Creating an HTML page with a report or graph object.
3. Creating an input control that contains a static or dynamic list of Report Library values.
   - The following input controls provide additional options to display the content list from Report Library: Drop Down List, List Box, Check Box, Radio Button, and Tree Control.
4. Inserting a hyperlink, image, button, or frame and setting the properties to activate the Report Library retrieval for the input control.
5. Running the HTML page to view the Report Library values from the input control.
6. Additionally, you may retrieve a report from the Report Library that contains a Table of Contents and On Demand Paging by inserting an additional input control for the Table of Contents on the HTML page.
**Procedure:** How to Create a Static List of Values From the Report Library

The Report Library includes secure access to library content and the ability to save multiple versions of the same output. When integrating Report Library in HTML Composer, you may create a static list of values from Report Library (including all versions of that report that are currently in the library).

1. Create a new HTML file, from a folder in the WebFOCUS Repository, of your Managed Reporting environment.

2. From HTML Composer, select *New Report*, or *New Graph*, from the Insert menu.
   
The cursor changes into a crosshair.

3. Drag the crosshair to create a report or graph object and adjust it to the size you want.
   
   A report or graph object is created in the layout and assigned the name report\(n\), or graph\(n\), where \(n\) is a number.

4. Create an input control to supply the Report Library content. For example, insert a Drop Down List, List Box, Check Box, Radio Button, or Tree Control from the Controls submenu of the Insert menu and create the input control, adjusting it to the size you want.

   **Note:** Only the input controls mentioned above provide options to display the content list from Report Library.

   The input control object is created in the layout and assigned the name object\(n\), where \(n\) is a number. For example, combobox\(n\), listbox\(n\), checkbox\(n\), radio\(n\), treecontrol\(n\).

5. Click the *Parameters* tab.
   
The Properties and settings dialog box appears for the control.

6. Select *Static* as the Data type.
   
   Static is selected by default.

7. Create the Report Library values for the control.
   
   You may create a static list of values from Report Library (including all versions of that report that are currently in the library).
a. Select *Use values from Library* from the Static values drop-down list.
The Report Library content is retrieved in the Display column of the Properties and settings dialog box, as shown in the following image.
b. Select *Use values from Library (include versions)* from the Static values drop-down list.
The Report Library content is retrieved in the Display column of the Properties and settings dialog box, as shown in the following image.

8. Optionally, you may select values and click the Delete button to eliminate any values, and use the up and down arrows to rearrange the order of the values.

9. Optionally, use the Selected column to check the box for the value you want to be selected by default. More than one value can be selected.

10. Close the Properties and settings dialog box.
Running the HTML page shows the input control with the Report Library static list, as shown in the following image.

11. Click the Design tab in HTML Composer and insert a hyperlink. The hyperlink obtains the report/graph when selecting a Report Library value from the input control.

   This step requires that you create hyperlink properties. You can create hyperlink properties by inserting an image, hyperlink, button, or frame.

12. From the Hyperlink Properties dialog box, select the Action, Source, and Target/Template Name:

   - Select Library from the Action drop-down list.
     - Library only appears if a static or dynamic list of values was created for Report Library on the Parameters tab.

   - Select the Source drop-down list to select the input control as the source of your Report Library content. The selected input control will be populated by the Report Library data.

   - Select the Target Type as Frame, Window, or InfoWindow for the hyperlink output. Frame is the default selection.
The Target Type option does not appear on the Hyperlink Properties dialog box if you are inserting a frame as the hyperlink. Frame is the default target for a frame object.

- Select the Target/Template drop-down list to select the report object for the Report Library results.

The Target/Template option does not appear on the Hyperlink Properties dialog box if inserting a frame as the hyperlink. Clicking the input control automatically populates the report at run time.

The following image shows the Hyperlink Properties dialog for a button that retrieves content from the Library and displays that content in the report1 object when clicking a value from the drop-down list.

- Click OK to close the Hyperlink Properties dialog box.

13. Save and run the HTML page.
14. Select a value from the Report Library and click the hyperlink to run the report. The following example shows a drop down list input control with a static list from Report Library. Clicking the hyperlink button runs the report with the selected Report Library content.

**Procedure:**  How to Create a Dynamic List of Values From the Report Library

Creating a dynamic list of values uses the default Custom library JSP from WebFOCUS to load the Report Library content.

1. From HTML Composer, select *New Report* or *New Graph* from the Insert menu. The cursor changes into a crosshair.
2. Drag the crosshair to create a report or graph object and adjust it to the size you want. A report or graph object is created in the layout and assigned the name report\((n)\), or graph\((n)\), where \(n\) is a number.
3. Create an input control to supply the Report Library content. For example, insert a Drop Down List, List Box, Check Box, Radio Button, or Tree Control from the Controls submenu of the Insert menu and create the input control, adjusting it to the size you want.
4. Click the Parameters tab.
   The Properties and settings dialog box appears for the control.

5. Select Dynamic as the Data type.
   The dynamic value options appear.

6. Select Other to create the Report Library values for the control.
   The following image shows the dynamic library options on the Properties and settings dialog box.

   ![Properties and settings dialog box](image)

   - Library appears indicating that HTML Composer will gather data from the Report Library.
   - The Custom library field specifies the JSP to call to get the Report Library content. The default is the JSP delivered with WebFOCUS. If the Custom library location is changed from the default for one control, other controls will not inherit that change.
Optionally, select Show versions to have the Report Library content show multiple versions of the reports, if multiple versions exist. This option is off by default, indicating that only the last version of the report in Report Library will be retrieved.

Optionally, click the Sort option to enable and select the sort order options for displaying values in dynamic list control.

When Sort is enabled, you may select the Sort by and Sort order options for the control.

Optionally, enter the exact value in the Selected Value input field, as it appears in the Report Library, if a value should be selected by default.

**Note:** Values are case-sensitive.

7. Close the Properties and settings dialog box to create the control with dynamic values.

Running the HTML page shows the input control with the Report Library dynamic list, as shown in the following example.

8. Click the Design tab in HTML Composer and insert a hyperlink. The hyperlink obtains the report/graph when selecting a Report Library value from the input control.
This step requires that you create hyperlink properties. You can create hyperlink properties by inserting an image, hyperlink, button, or frame.

9. From the Hyperlink Properties dialog box, select the Action, Source, and Target/Template Name:

  - Select Library from the Action drop-down list.
    
    Library only appears if a static or dynamic list of values was created for Report Library on the Parameters tab.

  - Select the Source drop-down list to select the input control as the source of your Report Library content. The selected input control will be populated by the Report Library data.

  - Select the Target Type as Frame, Window, or InfoWindow for the hyperlink output. Frame is the default selection.
    
    The Target Type option does not appear on the Hyperlink Properties dialog box if you are inserting a frame as the hyperlink. Frame is the default target for a frame object.

  - Select the Target/Template drop-down list to select the report object for the Report Library results.
    
    The Target/Template option does not appear on the Hyperlink Properties dialog box if you are inserting a frame as the hyperlink. Clicking the input control automatically populates the report at run time.
The following image shows the Hyperlink Properties dialog box for a hyperlink that retrieves content from the Library and displays that content in the report1 object when clicking a value from the list box.

- Click OK to close the Hyperlink Properties dialog box.

10. Save and run the HTML page.
11. Select a value from the Report Library and click the hyperlink to run the report. The following example shows a list box input control with a dynamic list from Report Library (showing versions). Clicking the hyperlink runs the report with the selected Report Library content.

1. Select a value from Report Library.
2. Click the hyperlink to run the report with Report Library content.
3. The Report Library content appears in the report.

<table>
<thead>
<tr>
<th>DIV</th>
<th>DEPT</th>
<th>LASTNAME</th>
<th>FIRSTNAME</th>
<th>HIREDATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>CORP</td>
<td>ACCOUNTING</td>
<td>SANCHEZ</td>
<td>EVELYN</td>
<td>90/03/05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ANDERSON</td>
<td>TIM</td>
<td>90/05/14</td>
</tr>
<tr>
<td>SOPENA</td>
<td></td>
<td>WANG</td>
<td>JOHN</td>
<td>91/05/08</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LOPEZ</td>
<td>ANNE</td>
<td>90/11/07</td>
</tr>
</tbody>
</table>

**Integrating a Report With a Table of Contents and On Demand Paging**

When creating a report in Report Painter with the HTML output format, the Table of Contents options are enabled for a report when using the On Demand Paging feature. The combination of using the Table of Contents with On Demand Paging displays at run time when the report is used in HTML Composer.

Running a report with a Table of Contents and On Demand Paging outside of HTML Composer shows only On Demand Paging.

Integrating a report with a Table of Contents and On Demand Paging in HTML Composer requires that you create an input control as a placeholder for the Table of Contents at run time. Selecting the TOC option for the input control on the Properties and settings dialog box enables the Table of Contents to appear on the HTML page. This permits both the Table of Contents and On Demand Paging features to display at run time. When these specific reports are retrieved, the Table of Contents is extracted from the report and displayed separately (from the report) on the HTML Composer page, but still maintains its ability to interact with the report.
When importing or referencing a report using On Demand Paging, the full navigational toolbar may not be viewable in the report output. You must resize the report frame in the HTML Composer Design View to display the full On Demand Paging navigational bar and view the toolbar correctly at run time.

Integrating a report with a Table of Contents and On Demand Paging in HTML Composer is limited to the following input controls: Drop Down List, List Box, Check Box, Radio Button, and Tree Control.

**Procedure: How to Show a Table of Contents for an On Demand Paging Report in HTML Composer**

This procedure describes how to create an additional input control for retrieving the Table of Contents, if you are using a report with a Table of Contents and On Demand Paging in HTML Composer.

1. Create a new HTML file, from a folder in the WebFOCUS Repository, of your Managed Reporting environment.

   The TOC option also appears when accessing HTML Composer from the Data Servers and Projects on localhost areas of Developer Studio.

2. From HTML Composer, select New Report from the Insert menu.

   The cursor changes into a crosshair.

3. Drag the crosshair to create a report object and adjust it to the size you want.

   A report object is created in the layout and assigned the name report(n), where n is a number. This object may be populated with a report from Report Library, or a procedure (containing a Table of Contents and On Demand Paging) can be opened, imported, or referenced.

4. Create an input control as a placeholder for the Table of Contents from the report. For example, insert a List Box from the Controls submenu of the Insert menu and adjust it to the size you want.

   Integrating a report with a Table of Contents and On Demand Paging in HTML Composer is limited to the following input controls: Drop Down List, List Box, Check Box, Radio Button, and Tree Control.

   The input control object is created in the layout.

   **Tip:** If you are creating an input control for static or dynamic list values from a Report Library, the Table of Contents input control should be a separate, additional control on the HTML page.
5. Click the **Parameters** tab.

   The Properties and settings dialog box appears for the control.

6. Select **TOC** as the Data type.

   The available TOC objects appear in the drop-down list.

7. Select the report name from the Available TOC objects drop-down list.

   This option must be enabled for a report that contains a Table of Contents, as it ensures the HTML page displays both the Table of Contents and On Demand Paging features at run time.

8. Close the Properties and settings dialog box and run the HTML page.
The Table of Contents and On Demand Paging appear at run time, as shown in the following image. The Table of Contents from the report appears in the list box placeholder, and the On Demand Paging feature appears within the report.

9. Both the Table of Contents and On Demand Paging features are available on the HTML page:

- The Table of Contents is extracted from the report and displayed separately in the input control on the HTML Composer page, but still maintains its ability to interact with the report.
The On Demand Paging options are available from the report frame on the HTML page.

Click items from Table of Contents to refresh the report.

Report with TOC and On Demand Paging

<table>
<thead>
<tr>
<th>Category</th>
<th>Product</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coffee</td>
<td>Latte</td>
<td>268</td>
</tr>
<tr>
<td>Food</td>
<td></td>
<td>218</td>
</tr>
<tr>
<td>Gifts</td>
<td></td>
<td>206</td>
</tr>
</tbody>
</table>

On Demand Paging appears within the report.
A Rich Internet Application (RIA) enables you to create an interactive webpage experience inside a browser. Using RIA, you can generate the exact look and feel of a Windows-based graphical user interface in your web applications. RIAs provide rich and powerful graphics and themes. You may set an RIA theme and animation properties for objects in the Design tab in HTML Composer. Additionally, you may convert an existing page to an RIA or create a new page as an RIA.

**In this chapter:**

- RIA Overview
- Creating an RIA With HTML Composer
- Usage Notes and RIA Example

### RIA Overview

The process of creating an RIA with HTML Composer consists of:

- Enabling an RIA theme from the document properties of the HTML page.

**Note:** When RIA is enabled, the RIA Components toolbar is added to HTML Composer. The Window and Accordion Control options are available from the RIA Components toolbar. These components are additional controls that are available only when an RIA theme is enabled. The traditional controls, buttons, tabs, and so on, all inherit an RIA look and feel when an RIA theme is applied.

- an RIA Window component enables you to create movable and resizable windows on your HTML page that function as a container for other objects.

- an RIA Accordion Control component enables you to create multiple pages within the control that you can scroll through, each containing objects.

- Setting the animation properties for the objects on the HTML page.

**Note:** An HTML page created with templates cannot use an RIA theme.
Creating an RIA With HTML Composer

You may apply an RIA theme to an existing page in HTML Composer. You may also change RIA themes for a page. RIA themes are only available for pages created without using a template.

**Note:** Applying an RIA theme to an existing page overwrites your current HTML page. You should make a copy of your original HTML file if you do not wish to overwrite it.

**Procedure: How to Apply an RIA Theme**

By applying an RIA theme to an existing non-RIA page, you convert the HTML page to an RIA.

**Tip:** This procedure also applies to changing between RIA themes on a page.

1. Open an existing HTML file in HTML Composer.
2. Select *DOCUMENT* from the Properties window drop-down list.
   
   The available properties for the document object appear.
3. Select a theme from the *RIA Theme* drop-down list.

   ![Properties window with RIA Theme settings]

   The RIA theme is applied to all components on the page. You may need to resize some of your components.
4. Save and run the HTML page to see the RIA.
Note: You cannot revert your page back from RIA. Create a copy of your HTML page if you do not wish to overwrite it, or close the page without saving.

The following image shows an RIA theme that was applied to an existing page.

Optionally, you may want to animate objects and add RIA components (windows/accordion controls) to the existing page to further graphically enhance your page. For details, see How to Create an RIA Page on page 433.

Procedure: How to Create an RIA Page

This procedure describes how to create an RIA page, add RIA components, and animate objects on the page.

1. Create a new HTML file with HTML Composer.
2. Select DOCUMENT from the Properties window drop-down list.
   The available properties for the document appear.
3. Select a theme from the RIA Theme drop-down list.
The RIA Components toolbar is added to HTML Composer.

4. Add objects to the layout, such as buttons and images, from the Components toolbar.

5. Optionally, add RIA specific objects to the layout, such as windows and accordions, from the RIA Components toolbar.

**Note:** These additional controls are optional to enhance the development of your page and are not required. Your page is an RIA once you apply an RIA theme. For details about how to add these components, see *How to Add an RIA Window Component* on page 435 and *How to Add an RIA Accordion Control Component* on page 440.

6. Set the animation properties for the objects with the Animation Properties dialog box.
   - Select an object from the Design tab in HTML Composer.
   - Click the *Animation Properties* ellipsis button from the Properties window.
     
     The Animation Properties dialog box opens.
   - Set the animation properties for the location, size, and/or opacity for the selected object.
     
     For descriptions of the available animation properties, see *Animation Properties Dialog Box* on page 447.

7. Save and run the HTML page to see the RIA.

In the following example, the RIA shows the following:

- An HTML page with an image.
A push button that, when clicked, animates the Sales Report window.

An accordion control that shows a Sales Graph on one page.

A report with controls to supply incoming parameter values on the Sales by Region page.

Click the title of the accordion pages to switch between pages. For step-by-step instructions on how to create this example, see Usage Notes and RIA Example on page 450.

Procedure: How to Add an RIA Window Component

A window component behaves as a parent component, enabling you to add children, such as a report or graph, within the window. The window object can be animated, moved, or resized at run time.

1. Select the Window button from the RIA Components toolbar.
   The cursor changes into a crosshair.

2. Drag the crosshair to create the window and adjust it to the size you want.
   A window component is created in the layout and assigned the name window(n), where n is a number.
3. Add an object, as a child, within the window component.

**Note:** Report, graph, and frame objects are added as children of the RIA component. The role of a child indicates that they are grouped within the selected component and function inside of that component.

To add objects as a child of a window component:

- Select an object from the Components toolbar from the Design tab in HTML Composer.
- Drag the selected object component from the toolbar inside of the RIA component.

**Tip:** If you have other objects on your Design canvas, you may press and hold the Alt key, left-click, and drag that object onto an RIA parent component.

- Release the mouse and resize the object inside your component.

For example, to create a report that runs within a window, drag a report from the Components toolbar into the window object on the Design tab, release the mouse, and resize the report object within the window component. Note that all the report options and properties are available from the right-click context menu of the report, within the window component.

4. You can automatically resize a report, graph, or frame to take up the entire window or accordion page by selecting **True** for the Auto Fit property field of the Properties window, as shown in the following image.
The following image shows the design time view of a report that has been automatically resized to take up the entire window. This property carries through to run time so when the window is resized, the report will resize with it.
5. You can choose whether the window starts expanded or collapsed by using the Initial State option, located in the Properties window. The two options are Expanded and Collapsed. The Expanded option sets the window to be expanded at run time and is set by default. The Collapsed option sets the window to be collapsed at run time. The following image shows this property on the Property window.
6. You may rename the default window title by typing text in the Caption properties field of the Properties window.

7. You may animate the window component itself, and any child object within the window. Select the object and set the animation properties from the Properties window for the location, size, and opacity. For details about animation properties, see *Applying Animation Properties to the RIA* on page 447.

**Procedure:** How to Minimize the Size of a Window Control

Minimize and restore buttons on a window control enable you to minimize the size of a window to show just the title bar or to restore the window back to its original size.
1. Run your RIA page and click the minimize button on the control, as shown in the following image.

The window will collapse to show just the title bar, as shown in the following image.

2. To restore the size of the window, click the restore button on the control, as shown in the following image.

The image is restored to its original size.

Procedure: How to Add an RIA Accordion Control Component

An accordion control behaves as a parent component, enabling you to create multiple pages within the control that you can scroll through, each containing objects as children. An accordion control can be animated at run time.

1. Select the Accordion Control button from the RIA Components toolbar.
   
   The cursor changes into a crosshair.

2. Drag the crosshair to create the accordion control and adjust it to the size you want.

   An accordion control with three pages is created by default and assigned the name accordion(n), where n is a number.
3. You may add and remove pages from the accordion control by using the right-click context menu when the accordion component is selected.

4. Add objects, as children, to the accordion control page.

   **Note:** Report, graph, and frame objects are added as children of the RIA component. The role of a child indicates that they are grouped within the selected component and function inside of that component.

   To add objects as a child within the selected page of the accordion control:

   - Select an object from the Components toolbar from the Design tab in HTML Composer.
   - Drag the selected object component from the toolbar inside of the RIA component.

   **Tip:** If you have other objects on your Design canvas, you may press and hold the Alt key, left-click, and drag that object onto an RIA parent component.

   - Release the mouse and resize the object inside your component.
For example, to create a graph that runs within an accordion page, drag a graph from the Components toolbar into the selected accordion page on the Design tab, release the mouse, and resize the graph object within the accordion component. Note that all the graph options and properties are available from the right-click context menu of the graph, from within the accordion component.

5. Add objects to other pages within the accordion control. Right-click the accordion component and choose Select next page, from the context menu.

**Tip:** Double-clicking within an accordion control closes the selected page and opens the next page of the accordion control.
The next page in the accordion control is selected. Insert and resize objects, such as reports, graphs, and frames, within the selected page of the accordion component.
6. You may rename the page titles by typing text in the Selected Page Title properties field of the Properties window.
7. To change the name of a different accordion page, right-click the accordion component and choose Select next page from the context menu.

The next page in the accordion control is selected. Type the name for the page in the Selected Page Title properties field in the Properties window.

**Tip:** Repeat this action (right-click the accordion component and choose Select next page from the context menu) multiple times to get to the desired page of the accordion. Optionally, double-clicking within an accordion control closes the selected page and opens the next page of the accordion control.

8. You may set the accordion control properties, specific to the behavior of accordion page speed in the RIA, by turning the animation on or off, and by setting the animation speed for switching between pages.

The accordion page speed properties are Animated and Animation Speed in the Properties window when an accordion component is selected.

- Animated is set to Yes. The accordion control animation speed is turned on by default, enabling you to set the animation speed for switching between accordion pages. The default speed is Normal.

  Selecting No turns off the animation speed for the accordion control, ignoring the Animation Speed setting, and displaying the default speed in the RIA.
Animation Speed is set to Normal by default. The animation speed indicates the speed for switching between pages in an accordion control. You may select from Very Slow, Slow, Normal, Fast, Very Fast.

The animation speed is only applied if Animation is set to Yes.

The following image shows an accordion control with the default animation and animation speed properties.

9. You may animate the accordion component itself, and any child object within the accordion pages. Select the object and set the animation properties from the Properties window for the location, size, and opacity. For details about animation properties, see Applying Animation Properties to the RIA on page 447.

**Note:** These location, size, and opacity animation properties are not the same as the accordion Animated and Animated Speed properties, which are specific to accordion page speed in the RIA.
Applying Animation Properties to the RIA

Adding animation properties to the RIA enables you to create visual effects and animated movement for your web application. The Animation Properties dialog box is available from the Properties tab of the Properties window in HTML Composer. By default, the location, size, and opacity animation options are not enabled for objects on an HTML page.

You may apply animation properties to the RIA with the Animation Properties dialog box in HTML Composer.

Note: Animation properties are disabled for all objects by default, with the exception of the accordion page speed options.

Reference: Animation Properties Dialog Box

The Animation Properties dialog box enables you to set the Location Animator, Size Animator, and Opacity Animator options for RIA objects on the HTML page.

Note: The Animation Properties option is only available from the Properties window if an RIA theme is enabled for the page. You may set animation properties for all objects on the page, such as reports, graphs, buttons, windows, and accordions.

Click the Animation Properties ellipsis button from the Properties window in HTML Composer.
The Animation Properties dialog box opens, as shown in the following image.

**Location Animator**

The Location Animator options set up the location animation for an object. The animator is then instructed to move objects from one point to another in the RIA, based on the control action, or automatically, after the page fully loads.

**From/To Position Left/Top**

The From Position and To Position indicates the starting position and ending position for the location animation event.

**Note:** It is suggested that you keep the From Position Left/Top values the same as the current position on the layout, otherwise, it will jump to the From Position Left/Top when the animation starts.

**Speed**

Controls the acceleration and deceleration of the animation. Options range from slowest to fastest, with normal being the default selection.
Control to activate

Indicates the event that will start the animation. The default is Auto Start, which starts the animation automatically. Otherwise, you may select another object from the drop-down list to identify another control that will be used to start the animation, like a button, for example.

Reverse on second click

Indicates that on a second click of the control to activate, the animation should be executed in reverse.

Size Animator

The Size Animator options set up the width and height animation for the object. This enables an object to grow or shrink in size when the animation is selected.

From/To Size Width/Height

The From Size and To Size indicates the starting size of the object and the ending size it will be after the animation event is executed.

Speed

Controls the acceleration and deceleration of the animation. Options range from slowest to fastest, with normal being the default selection.

Note: The location and size animation takes the same amount of time to complete. They will be synchronized if used in conjunction with each other.

Control to activate

Indicates the event that will start the animation. The default is Auto Start, which starts the animation automatically. Otherwise, you may select another object from the drop-down list to identify another control that will be used to start the animation, like a button, for example.

Reverse on second click

Indicates that on a second click of the control to activate, the animation should be executed in reverse.

Opacity Animator

The Opacity Animator options set up the opacity animation for the objects. Setting the opacity enables you to fade RIA components on your page.
### Speed
Controls the acceleration and deceleration of the animation. Options range from slowest to fastest, with normal being the default selection.

### Control to activate
Indicates the event that will start the animation. The default is Auto Start, which starts the animation automatically. Otherwise, you may select another object from the drop-down list to identify another control that will be used to start the animation, like a button, for example.

### Type
Sets the type of background opacity. Options are pulsate, blink, fadeIn, and fadeOut, with pulsate being the default selection.

### Usage Notes and RIA Example
This section describes usage notes for creating an RIA and provides steps to create an RIA example.

### Reference: Matching RIA Themes and StyleSheets
The RIA look and feel that is inherited when an RIA theme is applied can be matched by the Report or Chart StyleSheet in order for the styling to match the theme. The table below describes the RIA themes and the StyleSheets that correspond to the theme for each tool.

<table>
<thead>
<tr>
<th>RIA Theme</th>
<th>BI Portal Theme</th>
<th>Report and Chart StyleSheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean</td>
<td>Any</td>
<td>Any</td>
</tr>
<tr>
<td>Ocean Rounded</td>
<td>Teal</td>
<td>ENria_ocean_rounded_theme</td>
</tr>
<tr>
<td>Carbon Rounded</td>
<td>Black</td>
<td>ENria_carbon_rounded_theme</td>
</tr>
<tr>
<td>Dark Ocean Rounded</td>
<td>Green</td>
<td>ENria_dark_ocean_rounded_theme</td>
</tr>
<tr>
<td>Olive Rounded</td>
<td>Green</td>
<td>ENria_olive_rounded_theme</td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>ENria_blue_theme</td>
</tr>
<tr>
<td>Charcoal</td>
<td>Black</td>
<td>ENria_charcoal_theme</td>
</tr>
<tr>
<td>Gray</td>
<td>Silver</td>
<td>ENria_gray_theme</td>
</tr>
<tr>
<td>RIA Theme</td>
<td>BI Portal Theme</td>
<td>Report and Chart StyleSheet</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>High Contrast</td>
<td>Any</td>
<td>Any</td>
</tr>
<tr>
<td>Ruby</td>
<td>Red</td>
<td>ENria_ruby_theme</td>
</tr>
<tr>
<td>Information Builders</td>
<td>Information Builders</td>
<td>ENInformationBuilders_Dark ENInformationBuilders_DarkComp ENInformationBuilders_Default1 ENInformationBuilders_Light1 ENInformationBuilders_Light2 ENInformationBuilders_Medium1 ENInformationBuilders_Medium2</td>
</tr>
<tr>
<td>Black</td>
<td>Black</td>
<td>ENBlack_Dark ENBlack_DarkComp ENBlack_Light1 ENBlack_Light2 ENBlack_Medium1 ENBlack_Medium2 ENblack_theme ENblackbluepurple</td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>ENBlue_Dark ENBlue_DarkComp ENBlue_Light1 ENBlue_Light2 ENBlue_Medium1 ENBlue_Medium2 ENblue_theme ENblue-medium</td>
</tr>
<tr>
<td>RIA Theme</td>
<td>BI Portal Theme</td>
<td>Report and Chart StyleSheet</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Green</td>
<td>Green</td>
<td>ENGreen_Dark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENGreen_DarkComp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENGreen_Light1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENGreen_Light2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENGreen_Medium1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENGreen_Medium2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENGreen-gray</td>
</tr>
<tr>
<td>Orange</td>
<td>Orange</td>
<td>ENOrange_Dark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENOrange_DarkComp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENOrange_Light1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENOrange_Light2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENOrange_Medium1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENOrange_Medium2</td>
</tr>
<tr>
<td>Purple</td>
<td>Purple</td>
<td>ENPurple_Dark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENPurple_DarkComp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENPurple_Light1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENPurple_Light2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENPurple_Medium1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENPurple_Medium2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENpurple-light</td>
</tr>
<tr>
<td>RIA Theme</td>
<td>BI Portal Theme</td>
<td>Report and Chart StyleSheet</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Red</td>
<td>Red</td>
<td>ENRed_Dark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENRed_DarkComp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENRed_Light1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENRed_Light2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENRed_Medium1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENRed_Medium2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENred-bronze</td>
</tr>
<tr>
<td>Silver</td>
<td>Silver</td>
<td>ENSilver_Dark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENSilver_DarkComp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENSilver_Light1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENSilver_Light2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENSilver_Medium1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENSilver_Medium2</td>
</tr>
<tr>
<td>Teal</td>
<td>Teal</td>
<td>ENTTeal_Dark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENTTeal_DarkComp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENTTeal_Light1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENTTeal_Light2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENTTeal_Medium1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENTTeal_Medium2</td>
</tr>
</tbody>
</table>

When applying StyleSheets and Templates it is important to note the following:

- You need to put the StyleSheet file in the Other folder of the Managed Reporting domain in order for it to be visible by the tool.

- For Report Painter, you can select the appropriate name from the Predefined Templates section of the Style File Selection tool. The names listed correspond to the names in the InfoAssist column in the preceding table.
Reference: Usage Notes For Creating an RIA

The following apply when creating an RIA in HTML Composer.

- If you use the Olive Rounded RIA theme and reference a parameterized report, the Schedule button is blank. The Schedule button displays correctly if you use other RIA themes.

- RIA only supports pixels for font size (Bindows limitation).

- For iframes, reports, and graphs, you will only see a border if you specify a width. By default, RIA gives the border a solid 1px border. If you want to specify a greater value, select Custom, and give it a number in pixels (Bindows limitation).

- Overline is not supported in RIA (Bindows limitation).

- The following features are not supported in RIA:
  - Multi-Select Drop-Down List control
  - Global Search and Paging control
  - Making an ActiveX control a child of another control
  - Undo/Redo option

- The RIA theme overrides any styling that has been applied to individual objects.

- If you have a CSS class referenced in a non-RIA page, when you convert to RIA, the CSS reference is removed from the HTML source and is replaced with the RIA CSS. This is because the RIA theme includes its own styling and will most probably require you to update your styling to go better with the RIA theme.

- When using an RIA-enabled page with an AHTML report, the Export as Procedure option is not available in the File menu.

- In migrating from a non-RIA page to an RIA page, any JavaScript calls that go against the controls cannot be in the window_onload function because the controls are not available until the RIA framework completely loads in the browser. This means that these JavaScript calls need to be moved out of the window_onload function and placed in other functions that get called after the page and RIA framework are loaded.

- Migrating a non-RIA HTML page removes any custom styling. Applying an RIA theme provides its own color scheme and styling. You may add custom styling after converting the RIA page.

- RIA only supports integers and pixels when specifying a measurement for font size and border size.
When adding existing objects from the canvas to an RIA window or accordion control, you may not just copy or move the object into the RIA parent component. Press and hold the Alt key, left-click, and drag the object into the RIA component to make it a child of the RIA component.

If you are adding objects as children to any RIA control by using the Insert menu, draw the object in an open space on the canvas, press and hold the Alt key to drag that object to the parent object, and release the mouse.

The location of accordion pages cannot be changed.

To support RIA controls in HTML Composer, additional WebFOCUS StyleSheet templates are available in Report Painter and InfoAssist.

**Note:** The file extensions of the RIA StyleSheet templates vary, depending on the tool, but all appear as `ria_stylesheet_theme.file extension`, where the file extension is .txt or .sty. The available RIA StyleSheets are:

- `ria_carbon_rounded_theme`
- `ria_dark_ocean_rounded_theme`
- `ria_ocean_rounded_theme`
- `ria_olive_rounded_theme`
- `ria_blue_theme`
- `ria_charcoal_theme`
- `ria_gray_theme`
- `ria_ruby_theme`
- `ria_turquoise_theme`

Selecting one of these templates in your tool enables you to inherit the same RIA look and feel for the report or chart when the same RIA theme is applied in HTML Composer. For more information on StyleSheets/Templates matching the look of a certain RIA theme, see *Matching RIA Themes and StyleSheets* on page 450.

Multiple vertical lines may appear across some RIA controls on the Design tab in HTML Composer. For example, inserting an accordion control shows multiple vertical lines through the accordion control page title toolbars. These lines are more visible when using darker RIA themes for your document. These multiple lines do not appear in the RIA page at run time.
When adding a Tab Control to the layout as part of an RIA page, you can switch between tabs on the Design tab in HTML Composer. Double-click the desired tab to switch between tabs or select the Tab Control, right-click, and choose Select next tab or Select previous tab from the context menu.

The following image shows a Tab Control on an RIA page with these options.

![Tab Control](image)

**Note:** You can change the text on a tab control by entering the text in the Title of element property field in the Properties window.

**Example:** Creating an RIA With HTML Composer

Suppose you want to create an RIA that shows:

- An image.
- A push button, that when clicked, animates the Sales Report window.
- An accordion control that shows a Sales Graph on one page.
- A report with controls to supply incoming parameter values on the Sales by Region page.

This example assumes that you are familiar with the basic Developer Studio features. The following example creates an RIA by:

- Creating a graph to be used in the RIA.
- Converting an existing HTML page to an RIA.
- Creating an RIA window component with a report that has drill downs.
- Adding a button that animates the RIA window.
- Creating an RIA accordion control that shows a frame on one page, and a report with chained controls on another page.

1. Create a graph to be used in the RIA.
   Create the sales graph to be used as a target from a drill-down report in the RIA.
   a. Create a new procedure in Developer Studio:
With the Procedures folder highlighted, select New/Procedure from the File menu.

or

Right-click the Procedures folder and select New/Procedure from the context menu.

The Add Procedure dialog box opens.

b. Enter graphbyproduct as the name for the new procedure in the File name field and click Open.

The Procedure Viewer opens.

c. Click a component connector (yellow diamond) and select Graph.

d. Select the ggsales.mas Master File and click Open.

Tip: The Gotham Grinds Sales data source (ggsales.mas) is available from the ibisamp Applications on localhost folder of Developer Studio. You may copy this source file to the project directory of your choice.

InfoAssist opens.

e. Select Build a Chart from the main menu.

Select the ggsales.mas Master File and click OK.

f. Select Format from the menu and click Pie from the Chart Types section.

InfoAssist refreshes showing a pie chart.

g. Drag State to the Slices category under the Query and then drag Budget Units to the Measures (Sum) category under the Query section.

h. Select the Header & Footer button from the Home menu and type By Product: Drag PRODUCT from the Field Tree in the Heading window to the Header & Footer window. <PRODUCT is inserted into the Header & Footer window. Position it after By Product.

The heading appears as By Product: <PRODUCT. Click Apply and OK.

i. Click on Product in the Data window. In the Home menu, click the Filter button. The Filter tool opens. Equal to is set as the default operator. In the Add: box, type Product Name. Click the add filter button. Click Ok and the Filter tool will create the following parameter: WHERE PRODUCT EQUAL To Product Name

j. In the Format menu, click the Labels button. The Axes and Legend buttons are now shown. Click the Legend button and select Left from the Legend Position drop-down list.

k. Save and close the graph and Procedure Viewer.

2. Convert an existing HTML page to an RIA and add objects to the page.
a. Create a copy of chaining_example.htm, that was created in *Applying Conditions to a Chain* on page 364 of this manual, and rename it to ria_example.htm.

b. Open ria_example.htm in HTML Composer.

c. Select *DOCUMENT* from the Properties window drop-down list.

   The available properties for the document object appear.

d. Select *Clean* from the RIA Theme drop-down list.

   The RIA theme is applied to all components on the page and the RIA Components toolbar is added to HTML Composer.

e. Move the report and control down the page, as we will use those components later.

f. From the Insert menu, select *Components*, then click *Image*.

   The cursor changes into a crosshair. Drag the crosshair to create the image object and size, and select an image from the Get source file dialog box.

g. Select *Push button* from the Components toolbar and drag it onto the Design canvas, underneath the image.

h. Rename the button by selecting the Push button on the Design tab and double-click in the field next to *Value* in the Properties window.

   **Tip:** The button object appears as button1<DIV> in the Properties window drop-down list.

i. Type *Animate Sales Report* in the Value property field and press the Enter key.

j. Click the *Animation Properties* ellipsis button from the Properties window.

   The Animation Properties dialog box opens.

k. Select the *Opacity Animator* check box to enable the opacity settings.

l. Select *blink* as the Type, and leave the Control to activate as *<Auto Start>*.

   This indicates that the blinking animation for the push button will start automatically in the RIA page.

m. Click *OK* to close the Animation Properties dialog box.

3. Create and animate an RIA window component.

   a. Select the Window button from the RIA Components toolbar.

   b. Drag the window onto the Design canvas.

   c. Release the mouse and resize the object.
d. Rename the window by typing \textit{Sales Report} in the Caption properties field of the Properties window.

\textbf{Tip:} The RIA window component appears as \texttt{window1< DIV> } in the Properties window drop-down list.

e. Select the Report button from the Components toolbar and drag it into the window object on the Design tab, release the mouse, and resize the report object within the window component.

f. Double-click the report object and select \texttt{ggsales.mas} to open Report Painter.

\textbf{Tip:} The Gotham Grinds Sales data source (\texttt{ggsales.mas}) is available from the ibisamp Applications on the localhost folder of Developer Studio. You may copy this source file to the project directory of your choice.

g. Create the sales report, with a drill down on the Product field, to be used in the RIA window:

- Insert \texttt{CATEGORY,PRODUCT, REGION, and ST} as the By fields, hiding the ST field.
- Insert \texttt{DOLLARS} as the Sum field.
- Add \texttt{Sales by: <GGSALES.SALES01.ST} in the Page Heading.
- Select the \textit{Product} field, right-click, and select \textit{Options} to open the Field Properties dialog box.

- Select the \textit{Drill Down} tab to apply a drill down to the Product field column data, that executes a procedure in a frame.

  Select \textit{Column Data} as the active object. Select \textit{Execute Procedure} as the Drill Down Type. Select \texttt{graphbyproduct.fex} as the Procedure name (which we created in step 1 of this example). Enter \texttt{iframe1} as the Target Frame location, which we will add later in HTML Composer.

- Select \textit{Add} from the With Parameters section of the Drill Down tab, and select \texttt{PRODUCT} from the Parameter name drop-down list. This is the parameter that we created in the graph. Leave \textit{Field} as the Parameter value and select \texttt{GGSALES.SALES01.PRODUCT} from the drop-down list.

- Close and save the report.

The drill down report appears in the RIA window component.

h. Select the report component and set the Auto Fit property field to \textit{True} in the Properties window.
i. Select the RIA window component on the Design tab and click the Animation Properties ellipsis button from the Properties window.

**Tip:** The RIA window component appears as window1<DIV> in the Properties window drop-down list.

The Animation Properties dialog box opens.

j. Select the Location Animator check box to enable the location settings.

k. Select button1 from the Control to activate the drop-down list.

   This indicates that clicking the Push button will activate this window at run time.

l. Type the From Position Left value as 10.

   This indicates that the location of the window will start the animation 10 pixels from the left position of the page when the window is animated.

m. Click OK to close the Animation Properties dialog box.

4. Create an RIA accordion control component.

   a. Select the Accordion Control button from the RIA Components toolbar.

   b. Drag the accordion control onto the Design canvas underneath the RIA window component.

   c. Release the mouse and resize the object.

   d. Rename the selected page of the accordion by typing Sales Graph in the Selected Page Title properties field of the Properties window.

   **Tip:** The RIA accordion control component appears as accordion1<DIV> in the Properties window drop-down list.

   e. Select the Frame button from the Components toolbar and drag it into the accordion object on the Design tab, release the mouse, and resize the frame object within the accordion page.

   **Note:** The frame component appears as iframe1<IFRAME> in the Properties window drop-down list. This is the name that we assigned as the Target Frame location for the drill-down report that appears in the RIA window.

   f. Select the Frame component and set the Auto Fit property field to True in the Properties window.

   g. Right-click the accordion component and choose Select next page from the context menu.

   The next page in the accordion control is selected.
h. Type Sales by Region in the Selected Page Title properties field of the Properties window.

i. Scroll down the Design tab and select the existing report and control by using the Shift key on your keyboard.

j. Press and hold the Alt key, drag the selected components onto the accordion page, and release the mouse.

The report and control are added within the Sales by Region accordion page. Resize the objects, if necessary.

k. Remove any unused pages from the accordion control by selecting and removing pages from the right-click context menu.

5. Save and run the RIA.

The following image shows the RIA at run time.
Using Maps in HTML Composer

This topic describes how to integrate maps with reports generated from HTML Composer. Google®, Bing®, and ESRI® Maps are services offering powerful, user-friendly mapping technology that can be customized to show points on a map with drill-down capabilities. You can customize the map properties and bind them to a WebFOCUS report.

**Note:** Google and Bing Maps are only available if you have an API license key.

In order to present points on a map generated by a WebFOCUS report, data needs to be in geocode. In other words, data needs to be enriched with geographical data. When binding WebFOCUS to a map, the source used to bind WebFOCUS reports needs to be defined by latitude and longitude coordinates and a marker value associated to a group of data in order for the map to launch properly. For more information, see *Creating WebFOCUS Procedures for Maps* on page 466.

**In this chapter:**

- Configuring WebFOCUS for Maps
- Creating WebFOCUS Procedures for Maps
- Adding a Map
- Customizing the Map Properties
- Integrating WebFOCUS With Maps
- Using the Maps Functionality
- Chaining for Maps
- Using JavaScript Code With Maps
- ESRI Flex Viewer Integration

**Configuring WebFOCUS for Maps**

To use Bing or Google Maps in HTML Composer, you must first obtain an API key and then apply that key to the WebFOCUS Administration Console.
Procedure: How to Configure WebFOCUS to Use Maps

To integrate WebFOCUS with Maps, set the Google or Bing configuration option in the WebFOCUS Administration Console.

1. Obtain a Bing Maps or Google Maps API Key.

   **Note:** You must use a Version 7 API key for Bing Maps and a Version 3 or Version 2 API key for Google Maps.

2. Access the WebFOCUS Administration Console, using one of the following methods.

   - Enter the following URL:
     
     `http://hostname:port/ibi_apps/console/webfocusconsole.jsp`

   - Select WebFOCUS Administration Console from the Start Programs menu of your WebFOCUS application.

     **Note:** This menu option is only available on the machine on which the WebFOCUS Client is installed.

   - From within Developer Studio, select a location from the WebFOCUS Environments section to activate the toolbar and select the WebFOCUS Administration Console icon.

     The WebFOCUS Administration Console appears. You may have to log on depending on how your configuration is set.

3. Select General from the Client Settings submenu of the Configuration menu.

4. Scroll down to the bottom of the Client Settings - General page to see the Google Maps and Bing Maps configuration settings.

5. In the google_maps_api_key or bing_maps_api_key input field, paste the appropriate map API license key that you saved earlier.

   **Note:** Google Maps API Version 3 does not require a key.
The following image is an example of the WebFOCUS Administration Console with these options set.

**Note:** A Version 7 API key is required for Bing maps.

6. Click Save and log off from the WebFOCUS Administration Console.

For more information about using the WebFOCUS Administration Console, see the *WebFOCUS Security and Administration* manual.
Creating WebFOCUS Procedures for Maps

Before binding maps to a WebFOCUS source, you must predefine marker fields in a source file. The source can be a URL, XML file, or external procedure.

Markers are presented at run time on the map by placing an image at specific geographical points. Clicking on the map marker can result in a drill down to a source file, and optionally, a Tooltip can be presented when pausing on a map marker.

Markers are defined by the following:

- Latitude and Longitude coordinates that are used to plot points, or the marker, on the map.
- Marker value, usually a calculated value (COMPUTE field or DEFINE field), that associates each location to a group or a specific icon type.
- Optionally:
  - Fields that contain Tooltips or drill downs for the marker.
  - Images to represent the marker on the map.

Marker fields are displayed by an image, drill down, and/or Tooltips in the map.

**Note:** The following procedures are applicable for using Google Maps, Bing Maps, and ESRI JavaScript API Maps.

**Procedure:** How to Create Map Latitude/Longitude Coordinates in the Source File

In order to plot points on the map, you must define each point by its latitude and longitude coordinates and associate a marker, or group assignment, to each point. The Source file must be XML format and must contain fields called LATITUDE, LONGITUDE and MARKER. Additional fields can be included for Tooltips or image icon information.

**Note:** The following example creates a source file for a map by:

- Using the Century Sales (centurysales.mas) Master File.
- Joining Century Sales to the Locale data source for latitude/longitude data.
- Grouping the location to the LINEPRICE field in the joined data source.

1. Join the Century Sales and Locale data sources.
Tip: The Century Sales and Locale data sources are available from the Master Files folder in the ibidemo application folder. You may copy these source files to the project directory of your choice.

a. Create a new procedure in Developer Studio:
   - With the Procedures folder highlighted, select New/Procedure from the File menu.
   - or
   - Right-click the Procedures folder and select New/Procedure from the context menu.
   The Add Procedure dialog box opens.

b. Enter gmlayer as the name for the new procedure in the File name field and click Open.
   The Procedure Viewer opens.

c. Click a component connector (yellow diamond) and select Join.
   The Open dialog box appears.

d. Select centurysales.mas and click Open.
   The Join dialog box opens.

e. Select the Add File button from the Join toolbar.
   The File Description List for Join dialog box opens.

f. Select locale.mas and click Open.
Developer Studio automatically creates a Join between the data sources if they both have fields with the same formats. The Join tool displays both data sources and the default Joins, as shown in the following image.

For more information about using the Join tool, see the Creating Reporting Applications With Developer Studio manual.

g. Close the Join tool to save the Join and update the procedure.
The Join is added to the Procedure Viewer.

2. Group the location to the LINEPRICE field.

a. From the Procedure Viewer, click and hold a component connector (yellow diamond) and select Report.
The Open dialog box appears.

b. Select centurysales.mas and click Open.
Report Painter opens.

c. Select By from the Columns toolbar and double-click LATITUDE and LONGITUDE from the Object Inspector.
If fields in your source are not called Latitude, Longitude, or Marker, you can:
   - Use the SET TOOL to Set ASNAMES = ON, to add AS Names in your procedure.
   - In Report Painter, right-click the field and select Column Title, to type in the correct name.
d. Select Sum from the Columns toolbar and double-click LINEPRICE from the Object Inspector.

e. Rename LINEPRICE to Line Total.

Each location (Latitude and Longitude) has been grouped to LINEPRICE for the report.

3. Save the report, but do not close it.

The following image is an example of a report with Latitude and Longitude coordinates.

![Image of a report with Latitude and Longitude coordinates]

The map Latitude and Longitude coordinates have been set. This source file will be selected as the source file from HTML Composer later on. For more information about selecting source files for a map, see Customizing the Map Properties on page 480.

**Procedure:** How to Create Map Marker Group Fields and Tooltip Fields in the Source File

Marker and Tooltip fields can be computed fields, or any field from your data source.

**Note:** If you are using a field from your data source as the Marker field, the field name must be renamed Marker.

A COMPUTE field is a calculated value in the source file that is used as the Marker field in the map. A COMPUTE field uses an expression that can be used to assign a value to a field. You create a COMPUTE field by using the Computes tab of the Report Options dialog box.

**Note:** If the HTML page where your map resides is created in the Repository area and the marker images also reside in the Repository area, then a fully qualified path to the image files (starting with /WFC) is needed, if using a DEFINE/COMPUTE to determine the marker image. For example:

```
IMAGE/A75='/WFC/repository/images/cust_'||IMAGE_COLOR||IMAGE_SIZE;
```

The following example creates marker fields and Tooltips fields by:

- Using the joined data source, Century Sales (centurysales.mas), that was created in the previous procedure (gmlayer.fex). For more information, see How to Create Map Latitude/Longitude Coordinates in the Source File on page 466.
Adding a COMPUTE field to create markers, or group assignments, for each location by using LINEPRICE to group the data.

Adding a second COMPUTE field to associate each group to a marker.

Optionally, adding a COMPUTE field as a Tooltip field.

1. Create markers, or group assignments, for each location.

   The Report Painter gmlayer.fex is still open. Create a COMPUTE field to assign an integer value determined by row-based values.

   a. From Report Painter, select Computes from the Report menu, or click the Computes button from the Setup toolbar.

      The Report Options dialog box opens at the Computes tab.

   b. Type LINEPRICE_CLASS as the Field name.

   c. Add a COMPUTE field to assign an integer based on the LINEPRICE value, as indicated in the following table.


<table>
<thead>
<tr>
<th>LINEPRICE</th>
<th>Integer</th>
<th>Marker</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 999,999</td>
<td>2</td>
<td>redicon</td>
</tr>
<tr>
<td>1,000,000 - 9,999,999</td>
<td>3</td>
<td>yellowicon</td>
</tr>
<tr>
<td>10,000,000 - 49,000,000</td>
<td>1</td>
<td>greenicon</td>
</tr>
<tr>
<td>50,000,000 or higher</td>
<td>0</td>
<td>blueicon</td>
</tr>
</tbody>
</table>
Enter the syntax, as shown in the example image below, to use LINEPRICE to group the data:

```
COMPUTE LINEPRICE_CLASS/I5 = IF LINEPRICE GE 50000000
    THEN 0 ELSE IF LINEPRICE GE 10000000
    THEN 1 ELSE IF LINEPRICE LE 1000000
    THEN 2 ELSE 3
```

d. Click Apply.
2. Associate each group to a marker.

Create a new COMPUTE field that sets the Marker field with a DECODE statement to convert the numerical grouping into icon names.

**Note:** A Marker field can also be any value field from your data source, but it must be renamed to *Marker*.

**a.** Click *New* from the Computes tab.

**b.** Type *MARKER* as the Field name.

**c.** Enter the syntax, as shown in the example image below, to associate each group to a marker.

```plaintext
COMPUTE MARKER/A10 = DECODE LINEPRICE_CLASS( 0 'blueicon' 1 'greenicon' 2 'redicon' ELSE 'yellowicon') ;
```

**d.** Click *Apply*.

3. Assign fields as Tooltips.
Optionally, if you want to include a Tooltip, create an additional COMPUTE field to assign fields as Tooltips.

**Note:** A Tooltip field can also be any value field from your data source.

1. Click **New** from the Computes tab.
2. Type **REVENUE_RANGE** as the Field name.
3. Enter the syntax, as shown in the example image below, to include a Tooltip.
   
   ```
   COMPUTE REVENUE_RANGE/A10 = DECODE LINEPRICE_CLASS( 0 'OVER 50M' 1 '10M to 50M' 2 'UNDER 1M' ELSE '1M TO 10M') ;
   ```

4. Click **Apply**.

5. Click **OK** to close the Computes tab.

The fields are added to the **Computed fields** folder in the Object Inspector and are automatically added to the report as LINEPRICE_CLASS, MARKER, and REVENUE_RANGE.

The Report Options dialog box opens at the Output tab.


   **Note:** The XML output format is available from the Unstyled formats folder.

7. Select *Web browser* from the Destination drop-down list.

8. Click *OK* to close the Report Options dialog box.

9. Save and close your report.

The following image is an example of a report with Marker fields and Tooltip fields set.

![Report Example](image)

**Procedure:** How to Create the Starting Center Point of the Map

In addition to creating the Latitude or Longitude coordinates and associating markers, you must set the center view of the map to a bound geographical point at run time. Center values can be set dynamically or by a constant value.

   **Note:** The following example creates a report that sets the starting point of your map by:

- Joining the Century Sales to the Locale data source for the latitude/longitude data.
- Creating the CITY value Where clause and retrieval limit in the report.
1. Join the Century Sales and Locale data sources.

**Tip:** The Century Sales and Locale data sources are available from the Master Files folder in the ibidemo application folder. You may copy these source files to the project directory of your choice.

a. Create a new procedure in Developer Studio:

- With the Procedures folder highlighted, select **New/Procedure** from the File menu.
- or
- Right-click the Procedures folder and select **New/Procedure** from the context menu.

The Add Procedure dialog box opens.

b. Enter `setcentervalue` as the name for the new procedure in the File name field and click **Open**.

The Procedure Viewer opens.

c. Click and hold a component connector (yellow diamond) and select **Join**.

The Open dialog box appears.

d. Select `centurysales.mas` and click **Open**.

The Join dialog box opens.

e. Select the **Add File** button from the Join toolbar.

The File Description List for Join dialog box opens.

f. Select `locale.mas` and click **Open**.

Developer Studio automatically creates a Join between the data sources, if they both have fields with the same formats. The Join tool displays both data sources and, the default Joins, as shown in the following example image.
g. Close the Join tool to save the Join and update the procedure.
   The Join is added to the Procedure Viewer.

2. Create the CITY value where clause in the report.
   a. Click and hold a component connector (yellow diamond) and select Report.
      The Open dialog box appears.
   b. Select centurysales.mas and click Open.
   c. Select By from the Columns toolbar and double-click LATITUDE and LONGITUDE from the Object Inspector.

   **Note:** If fields in your source are not called Latitude, Longitude, or Marker, you can:
   - Use the SET TOOL to Set ASNAMES = ON, to add AS Names in your procedure.
   - In Report Painter, right-click the Field and select Column Title, to type in the correct name.

   d. Select Where/If and click Where.
      The Expression Builder opens.
e. Create the following expression:

\[ \text{CITY EQ 'Nashville'} \]

f. Click Apply.

g. Select Where/If and click Retrieval Limits.

h. Enter 1 as the Record Limit.

i. Select Standard XML (XML) as the Unstyled format.

j. Click the Output tab and select Web browser from the Destination drop-down list.

k. Click OK to close the Report Options dialog box.

3. Save and close the report.

In this example, Nashville is set as the center value starting point for your report.

Adding a Map

Once you have configured the map controls and created a WebFOCUS procedure to get a center value, you may add a map through the Insert menu of HTML Composer.

**Procedure: How to Insert Maps in HTML Composer**

1. Create the HTML Composer Page that contains the map.
a. From Developer Studio Explorer, select the **HTML Files** folder in the desired project directory.

b. Right-click and select **New/HTML File** from the context menu.

The Add HTML File dialog box appears.

c. Type *maps* as the File name and click **Open**.

**Note:** The Template Selector will display if it has not been turned off. Clicking **Cancel** will open HTML Composer with no template selected.

HTML Composer opens.

2. Select which map you want to use by selecting either *Google map*, *Bing map*, or *ESRI map* from the Map type option in the Property sheet of the HTML page.

**Note:** When ESRI map is selected for the map type, the ArcGIS Server option is added to the Property sheet of the HTML page. A server must be specified or the map will not load without it.

3. From the Insert menu, select **Components**, then click **Map**.

**Note:** The Map and Refresh Parameters options will not be available from the right-click menu of a map control.

The cursor changes into a crosshair.

4. Drag the crosshair to create the map object and adjust it to the size you want.

The Properties and settings dialog box opens, from which you can set the map and layers properties. For details about using the map properties, see *Customizing the Map Properties* on page 480.

**Note:** If you close the Properties and settings dialog box, you can access it again by selecting **Properties and Settings** from the View menu.

The map control also has a set of properties for the object. For more information about setting these properties, see *Properties Window for Maps* on page 485.
The map appears as an image in HTML Composer, as shown in the image below.

**Note:** Once a map has successfully been inserted into the HTML page, the COORDINATES field becomes available for use by any other components, further in the chain.
Customizing the Map Properties

You may customize the map by using the Properties and settings dialog box and the Properties window.

Reference:  Properties and Settings Dialog Box for Maps

The following image is the Properties and settings dialog box that opens when you create a map object.

![Properties and settings dialog box](image)

**Center Location**

Sets the center view of the map to a bound geographical point at run time. The center location can be set dynamically or by a constant value.

- **Dynamic.** If these values are being retrieved from an external source, the source must contain two fields called LATITUDE and LONGITUDE, or if using an Address, a field called ADDRESS.
Select a Source Type and a Source. This binds a Source file that contains coordinates to set the center view of the map.

An external file should only return one Latitude and Longitude value for the center point. You can use the ASNAME command to rename an existing field to the required names.

- **Constant value.** Manually type in a center value.

**Location Type**

Geographical position can be defined by Latitude or Longitude, or by an address.

The default is Latitude or Longitude.

**Note:** A Center Location, using address as the Location Type, is not supported when using an ESRI JavaScript map.

**Source Type**

When using a Dynamic center value, select the source of your location data. Source Type options are URL, XML File, and External procedure.

If using an External procedure, the report output must be XML.

**Source**

When using a Dynamic center value, enter the source file for the source type.

The Source field provides an ellipsis button when using XML files and External procedures. Select the source file from the Get source file dialog box.

**Value**

When using a constant value, enter the Address or Latitude and Longitude value.

If entering a Latitude or Longitude value, the value entered should be Latitude and then Longitude, separated with a comma (and/or space).

If entering a Latitude and Longitude value, it must be defined as a numeric value. For example, the following is latitude and longitude for New York, NY 10001:

40° 45’ 58.73” N, 73° 59’ 1.48” W and converts to 40.7663277, -73.9920777.
An example of an Address value is: 2 Penn Plaza New York, NY 10001.

**Layers Settings**

Layers bind sources to the map in order to define map markers. Markers are presented at run time in the map, as indicated with images at specified geographical points. Clicking the map marker results in a drill down to a Source file and optionally, a Tooltip when pausing on a map marker.

Select a Source Type, Source and Marker. Each Layer row will yield a designated marker in the Marker Groups box. Optionally, a selected marker can be associated with an Image, Drill Down, and Tooltip.

**Layers**

You can rename the layers by typing in the Layers box. This name should be a unique name that is used to identify a layer in the layer control and in JavaScript calls.

**Note:** A default name of Layer1, Layer2, and so on, is applied when you click the Add New button. You may double-click in the field and manually type in a unique name.

**Source Type**

Select the source of your layer. Source Type options are URL, XML File, and External procedure.

If using an External procedure, the report output must be XML.

**Source Name**

Enter the source file for the source type.

**Note:** The Source field provides an ellipsis button which enables you to select the source file from the Get source file dialog box.

When the source is selected, the Marker Groups box is populated with the values from the field, MARKER, in the WebFOCUS procedure.

**Cache run time data**

When adding dynamic parameters to the HTML page, input controls retrieve data through procedures. Select this option to cache the run-time data for the selected input control. This setting is off by default. This setting overrides the Default caching option from the HTML Page tab, which is located in the Developer Studio Options dialog box.
Visible

Controls the initial visibility of the marker groups, from the layer control, when the map runs. The visible option is useful when you want to make selections on the map without other markers, from other layers, interfering. For example, when making selections and doing a drill down, only visible markers should be selected and passed along.

- True shows the marker groups when the map runs. This is the default visible setting.
- False hides the marker groups when the map runs.

Refresh (Seconds)

You can refresh the source for a layer when the map runs. You may refresh a layer on demand, or automatically, at a timed interval. The default refresh time is set to 0 (zero) seconds, which indicates that the automatic refresh is disabled. The minimum automatic refresh time is 60 seconds.

Refresh is not applicable to markers in the Marker Groups.

For more information about refreshing a map, see How to Refresh the Map Output on page 511.

Marker Groups

The Marker Group box lists all unique markers defined in the source of the highlighted source row. When the source is selected, the Marker Groups box changes, listing all markers in the selected Layer. Optionally, a selected marker can be associated with an Image, Drill Down, and Tooltip.

The possible values for markers are generated by previously defined fields in the Layer source. For more information about defining marker fields in a source, see Creating WebFOCUS Procedures for Maps on page 466.

Image/Tooltip

Select the Image and/or Tooltip to be associated for the selected marker.

- Select an image to be used to mark a point on the map at run time.
- When hovering over a map marker, a Tooltip containing a description of the selected map marker appears.
- If you do not specify marker images, the default marker image (a green pin) is used.

Source Type

- Images can be an image or a field.
Tooltips can be a constant value or a field.

**Source**

Enter the source field or constant value for the source type.

When the Source Type is Image, the Source field provides an ellipsis button which enables you to select the image file from the Get source file dialog box.
Reference: Properties Window for Maps

The following image is the Properties window when a map object is selected.

Map: Bullseye Inner Ring

The inner ring radius is the distance between the center of the bullseye chart to the first ring, where 10 miles is the radius of distance.
**Map: Bullseye Outer Ring**

The outer ring radius is the distance from the center of the bullseye chart, where 100 miles is the radius of distance.

**Map: Bullseye Rings**

The number of rings to draw for the bullseye chart, where three rings is the default number of rings.

When you set the number of rings, the inner radius, and the outer radius, any rings between the innermost and the outermost ring, are proportionally separated.

**Map: Default Type**

Sets the default map rendered at run time. Select from Map/Road, Satellite/Bird’s Eye, or Hybrid/Automatic. Each option is presented as part of the map in the output, allowing you to change views.

- **Map/Road.** Presents geographical borders and streets. This is the default map type.
- **Satellite/Bird’s Eye.** Presents real imagery.
- **Hybrid/Automatic.** Presents real imagery with borders and streets.

**Note:** Map, Satellite, and Hybrid are used for Google Maps while Road, Bird’s Eye, and Automatic are the equivalent for Bing Maps.

**Map: dragging**

Controls the ability to drag the map in order to reposition the center point to a new location. This option is set by default.

**Note:** This option cannot be disabled for Bing or ESRI maps. Selecting No from the dropdown list will not disable dragging.

**Map: Menu Layers**

The Layers menu control provides options to show or hide markers in the layers of the map, and manually refresh the layer(s).

**Map: Menu Polygon**

The New Polygon menu control provides options to select multiple markers on maps by creating shape selectors, such as a freehand polygon, rectangle, or bullseye chart.
You can select multiple markers on maps at run time by creating polygon shapes. Polygon features enable you to add both Tooltips and actions to all polygons when you pause on them in the map.

For details about how to create Polygon shape selectors in the map, see *How to Create Polygons in the Map Output* on page 513.

**Map: Menu Run**

The Run menu control runs the drill downs for the selected markers.

**Map: Polygon Action Copy**

Enables copying of a polygon.

**Map: Polygon Action Delete**

Enables deleting of a polygon.

**Map: Polygon Action Move**

Enables moving of a polygon.

**Map: Polygon Action Resize**

Enables resizing of a polygon.

**Map: Polygon Tooltip Area**

Tooltips appear when you pause on a shape selector in the map.

All Tooltip options are turned on by default.

Shows the Area Tooltip.

**Map: Polygon Tooltip Dimensions**

Shows the Dimensions Tooltip.

Dimensions appears as Radius (for a circle polygon shape) in the Tooltip.

**Map: Polygon Tooltip Markers Count**

Shows the Markers Count Tooltip.

**Map: Selected Marker Image**

Sets the icon or image associated with a marker when selected. Click the Selected Marker Image ellipsis button to open the Get source file dialog box and select a marker image. If you do not specify a selected marker image, the default selected marker image (a red bulb) is used.
Map: Units

Options for the location distance are miles (mi) or kilometers (km), where miles is the default unit selection.

Map: Zoom Continuous

Enables smooth, continuous zooming for select browsers.

Map: Zoom Double Click

Enables you to double-click to zoom in and out of the map.

Note: This option cannot be disabled for Bing maps. Selecting No from the drop-down list will not disable zooming when double-clicking.

Map: Zoom Level

Sets the default zoom level of the map at run time. The levels available are 0 through 18. If the zoom level is set to 8 or higher, the initial map will have only one point visible. The default value is 10.

You may also change the zoom level in the output with the scrolling and arrow buttons on the map.

Map: Zoom Scroll Wheel

Enables you to use the scroll wheel of your mouse to zoom in and out of the map.

Note: This option cannot be disabled for Bing maps. Selecting No from the drop-down list will not disable zooming using the scroll wheel.

Procedure: How to Customize a Map

Customize the map by selecting the map and layer options.

1. From the Properties and settings dialog box, select the starting center point for the map in the Center Location section.

   - If you are using a Dynamic value, select the Location Type, Source Type and a Source.

   Source Type options are URL, XML file, and External procedure. If you are using an External procedure, the report output must be XML.
For example, select *Dynamic, Latitude/Longitude* from the Location Type drop-down list, and *External procedure* from the Source Type drop-down list. Click the Source ellipsis button to open the Get source file dialog box and double-click `setcentervalue.fex` as the external XML file. For details about the starting center point, see *How to Create the Starting Center Point of the Map* on page 474.

- If you are using a Constant value, select the Location Type and enter the Value.

  An example of an Address value is: 2 Penn Plaza New York, NY 10001.

  If entering a Latitude and Longitude value, it must be defined as a numeric value. For example, the following is latitude and longitude for New York, NY 10001: 40 45' 58.73" N, 73 59" 1.48" W and converts to 40.7663277, -73.9920777.

2. To set the image for a selected marker at run time, in the *Map: Selected Marker Image* section of the Properties window, click the Source ellipsis button to open the Get source file dialog box, and select a marker image.

   For example, click the Source ellipsis button to open the Get source file dialog box and double-click `purplepin.png` as the marker image file.

3. In the map control Properties window, Change the Zoom level to 6 and keep the other Default Map Type options.

   For more information about these properties, see *Properties Window for Maps* on page 485.

4. From the *Layers Settings* section of the Properties and settings dialog box, bind one or more WebFOCUS procedures to load data into the map by selecting the Source Type and Source Name. Optionally, you may edit the name of the layer or the Visible and Refresh options for the source layer.

   For example, click the Add new button to create a layer. The default Source Type is External procedure. Click the Source Name ellipsis button to open the Get source file dialog box and double-click `gmlayer.fex` as the external procedure file. For more details about the procedure file, see *How to Create Map Latitude/Longitude Coordinates in the Source File* on page 466.

   When the source is selected, the Marker Groups box is populated with the values from the Field MARKERS in the WebFOCUS procedure.

   For more information about these properties, see *Properties and Settings Dialog Box for Maps* on page 480.

5. Double-click a group from the Marker Groups box to set the associated Image, Tooltip, and Drill Downs.
The following image is an example of the Marker Groups box populated with the marker groups created from the `gmlayer.fex` source file. For more information about creating marker groups in the source, see *How to Create Map Marker Group Fields and Tooltip Fields in the Source File* on page 469.

6. You may edit the Image, Tooltip, or Drill Down for each marker group selected. Each marker group can have its own image and Tooltip.

For example, select `greenicon` from the Marker Groups box. Double-click `greenpin.png` from the Image Source section. The marker image is automatically saved. Repeat this process to apply individual images to each of the marker groups.
Tip: To select multiple marker groups at one time:

- Press and hold the Shift key while selecting the marker groups from the Marker Groups box.
- Edit the Tooltip and drill-down options to apply the selections to all of the marker groups selected.

For example, apply the Tooltip to all of the marker groups by selecting Field as the Source Type and REVENUE_RANGE as the Source.

7. Select the map object from HTML Composer canvas, and set the size and position in the Properties window:

- Position: Left 30 px.
- Position: Top 30 px.
- Size: Height 260 px.
- Size: Width 640 px.

8. Save and run the report.
You may use map controls to navigate around the map, zoom in or out, drag the map to a new position, select different map types, and see marker groups. For example, click the minus icon on the map to zoom out and see all of the colored marker groups.

**Note:** The Zoom In and Zoom Out slider control appears on the map since the Size: Height property is greater than 280px. For details about setting properties, see *Properties Window for Maps* on page 485.

For more information about using map controls, see the documentation from the website of each respective map.

**Integrating WebFOCUS With Maps**

You can integrate WebFOCUS reports with maps by:

- Customizing map properties and binding them to a WebFOCUS report, enabling drill-down reports to be run from a map.

- Updating map views based on values selected in a WebFOCUS report.

Latitude and longitude values can be passed as a parameter from a map to update a WebFOCUS procedure. Latitude and longitude are sent as a pair of values, and HTML Composer uses a specific parameter, &COORDINATES, to parse the value pairs correctly.
**Procedure:** How to Update a WebFOCUS Report Based on a Map Location

By adding a drill down to a map, you can filter a WebFOCUS report by the latitude and longitude coordinates of the selected marker(s). The parameter to pass the longitude and latitude values must be called &COORDINATES. This HTML Composer parameter will parse the Latitude and Longitude as paired data sets.

The following example updates a WebFOCUS report based on a map location by:

- Joining Century Sales to the Locale data source.
- Creating a Revenue by Category report.
- Creating the &COORDINATES parameter in the report.
- Adding the report to HTML Composer.
- Changing the map properties to drill down to the embedded procedure.

1. From HTML Composer, with a map created, select New Report from the Insert menu.
   The cursor changes into a crosshair.
2. Drag the crosshair to create the report object and adjust it to the size you want.
3. Right-click on the report object and select Open procedure viewer from the context menu.
   The Procedure Viewer opens.
4. Join the Century Sales and Locale data sources.

   **Tip:** The Century Sales and Locale data sources are available from the Master Files folder in the ibidemo application folder. You may copy these source files to the project directory of your choice.

   a. Click and hold a component connector (yellow diamond) and select Join.
      The Open dialog box appears.
   b. Select centurysales.mas and click Open.
      The Join dialog box opens.
   c. Select the Add File button from the Join toolbar.
      The File Description List for the Join dialog box opens.
   d. Select locale.mas and click Open.
Developer Studio automatically creates a Join between the data sources if they both have fields with the same formats. The Join tool displays both data sources and the default Joins, as shown in the example image below.

For more information about using the Join tool, see the *Creating Reporting Applications With Developer Studio* manual.

e. Close the Join tool to save the Join and update the procedure.

The Join is added to the Procedure Viewer.
5. Create a Revenue by Category report.
   a. From the Procedure Viewer, click and hold a component connector (yellow diamond) and select Report.
      The Open dialog box appears.
   b. Select centurysales.mas and click Open.
      Report Painter opens.
   c. Select By from the Columns toolbar and double-click CITY, PRODUCTTYPE, REGION, STATE, and STORENAME from the Object Inspector.
   d. Click the mouse after the STORENAME field to add the next field.
   e. Select Sum from the Columns toolbar and double-click LINEPRICE from the Object Inspector.
   f. Rename the PRODUCTTYPE and LINEPRICE fields:
      □ Select PRODUCTTYPE, right-click and select Column Title from the context menu. Type Category in the Title dialog box and click OK.
      □ Select LINEPRICE, right-click and select Column Title from the context menu. Type Revenue in the Title dialog box and click OK.
   g. Type Revenue by Category in the Page Heading.

6. Create the &COORDINATES parameter.
   a. In the Object Inspector, expand the Variables folder, right-click on Report Variables and select the New Report Variable option.
      The Variable Editor opens.
   b. Enter COORDINATES in the Name box and click OK to exit the Variable Editor.
   c. Select Where from the Where/If menu.
      The Expression Builder opens.
d. In the Data pane, navigate to the Report Variables folder and drag &COORDINATES to the Criteria (WHERE) pane.

![Expression Builder](image)

7. Add the report to HTML Composer.
   a. The report and &COORDINATES parameter have been created. Save and close the report. You are returned to HTML Composer where the New Parameters dialog box appears.
   b. Clear the Create control check box for the parameter, and click OK. You will not need a control for the &COORDINATES parameter because the parameters will be passed by the map.
   c. Select the report object to view the associated properties in the Properties window.
   d. Select False from the Auto Execute drop-down list in the Properties window.
8. Change the map properties to drill down to an embedded procedure.
   
   a. Double-click the map object to open the Properties and settings dialog box.
   
   b. Click the mouse and hold the Shift key and select all marker groups.
   
   c. From the Drill Down section, select:
      
      - *Embedded procedure* as the Drill Down Action.
      
      - *report1* from the Source drop-down list.
      
      - Keep the default selections for Target Type and Target/Template Name.
   
   d. Click **OK** to close the Hyperlink Properties dialog box.

9. Select the **Parameters** tab.

10. Bind the map control to the &COORDINATES parameter.

11. Save and run the layout.

Click the markers on the map to update the report based on the location selected, as shown in the image below.

---

**Procedure:** How to Update the Map Based on Data in a Report

A JavaScript function is used in a WebFOCUS report to update a map. The JavaScript function panToPoint automatically scrolls the map to a specified Latitude and Longitude. In addition, the zoom level of the map can be specified. This will overwrite the zoom level set by default.
The following example updates a map based on data in a report by:

- Joining Century Sales to the Locale data source.
- Creating a Regional Revenue Results report.
- Adding `panToPoint` JavaScript drill down command.

This JavaScript function requires the following parameters (in the table below) in this order. Each parameter can be set to a Field, Constant Value or a Variable.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Drill Down Parameter Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LATITUDE</td>
<td>The latitude value.</td>
</tr>
<tr>
<td>LONGITUDE</td>
<td>The longitude value.</td>
</tr>
<tr>
<td>Unique Identifier</td>
<td>The Unique Identifier for the targeted map object.</td>
</tr>
<tr>
<td>Zoom Level</td>
<td>Numeric value between 0 and 18.</td>
</tr>
</tbody>
</table>

- Adding the drill down report to the map.
  1. From HTML Composer with a map created, select New Report from the Insert menu.
     The cursor changes into a crosshair.
  2. Drag the crosshair to create the report object and adjust it to the size you want.
  3. Right-click the report object and select Open procedure viewer from the context menu.
     The Procedure Viewer opens.
  4. Join the Century Sales and Locale data sources.

**Tip:** The Century Sales and Locale data sources are available from the Master Files folder in the ibidemo application folder. You may copy these source files to the project directory of your choice.

a. Click and hold a component connector (yellow diamond) and select Join.
   The Open dialog box appears.

b. Select `centurysales.mas` and click Open.
   The Join dialog box opens.
c. Select the Add File button from the Join toolbar.
   The File Description List for Join dialog box opens.

d. Select locale.mas and click Open.
   Developer Studio automatically creates a Join between the data sources if they both have fields with the same formats. The Join tool displays both data sources and the default Joins, as shown in the example image below.

For more information about using the Join tool, see the Creating Reporting Applications With Developer Studio manual.

e. Close the Join tool to save the Join and update the procedure.
   The Join is added to the Procedure Viewer.

5. Create a Regional Revenue Results report.

a. From the Procedure Viewer, click and hold a component connector (yellow diamond) and select Report.
   The Open dialog box appears.

b. Select centurysales.mas and click Open.
   Report Painter opens.

c. Select By from the Columns toolbar and double-click COUNTRY, REGION, STATE, STORENAME, LATITUDE, and LONGITUDE from the Object Inspector.

d. Hide the Latitude and Longitude fields:
Select LATITUDE, right-click and select Invisible and click On from the context menu.

Select LONGITUDE, right-click and select Invisible and click On from the context menu.

e. Click the mouse after the LONGITUDE field to add the next field.

f. Select Sum from the Columns toolbar and double-click LINEPRICE from the Object Inspector.

g. Rename the LINEPRICE field:

   Select LINEPRICE, right-click and select Column Title from the context menu.

   Type Revenue in the Title dialog box and click OK.

h. Type Regional Revenue Results in the Page Heading.

i. Add a Style Sheet to the report:

   Select the Style File Selection button from the Report menu.

   The StyleSheet Selection box opens.

   Click the Add new item button and select defltblu.sty from the StyleSheet File Selection dialog box.

   Click OK.

   The selected StyleSheet is added to the Include StyleSheet File section.

   Click Finish to close the StyleSheet Selection box.

   The StyleSheet is applied to the report.
6. Add JavaScript drill-down parameters for the (By) COUNTRY field.
   
   a. Select COUNTRY, right-click and choose Options from the context menu. The Field Properties dialog box opens at the Style tab.

   b. Click the Drill Down tab.

   c. Select Column Data from the active object drop-down list.

   d. Select JavaScript from the Drill Down Type drop-down list.

   e. Type panToPoint in the JavaScript input field.

   f. Click Add from the With Parameters section to add each required drill down parameter. The Drill Down Parameter dialog box opens.

   g. Add the following Drill Down Parameters:

      - With the Field Parameter value selected, select LATITUDE from the drop-down list and click OK.

      - Click Add to add the longitude parameter. With the Field Parameter value selected, select LONGITUDE from the drop-down list and click OK.

      - Click Add to add the unique identifier parameter. With the Constant Parameter value selected, type mapcontrol1 in the input field and click OK.

   
   **Note:** The name of the map object in HTML Composer is mapcontrol1.
Click Add to add the zoom level parameter. With the Constant Parameter value selected, type 3 in the input field and click OK.

The following image is an example of the Field Properties Drill Down tab with these options added.

![Field Properties for Field J0.SEQ01.COUNTRY](image)

h. Click OK to close the Field Properties dialog box.

7. Add JavaScript drill-down parameters for the (By) STATE field.
   a. Select STATE, right-click and choose Options from the context menu. The Field Properties dialog box opens at the Style tab.
   b. Click the Drill Down tab.
   c. Select Column Data from the active object drop-down list.
   d. Select JavaScript from the Drill Down Type drop-down list.
   e. Type panToPoint in the JavaScript input field.
   f. Click Add from the With Parameters section to add each required drill down parameter. The Drill Down Parameter dialog box opens.
With the Field Parameter value selected, select LATITUDE from the drop-down list and click OK.

Click Add to add the longitude parameter. With the Field Parameter value selected, select LONGITUDE from the drop-down list and click OK.

Click Add to add the unique identifier parameter. With the Constant Parameter value selected, type mapcontrol1 in the input field and click OK.

**Note:** The name of the map object in HTML Composer is mapcontrol1.

Click Add to add the zoom level parameter. With the Constant Parameter value selected, type 6 in the input field and click OK.

Click OK to close the Field Properties dialog box.

8. Save and close the report and Procedure Viewer.

The report appears in HTML Composer.

9. Save and run the layout.

The map and the report appear in the output. Click a drill-down link from the report. The map updates according to the location selected from the report.

For example, click on a link in the Country column to zoom and navigate to the selected country at the zoom level illustrated. Or click on a link in the State column to zoom and navigate to the selected state at the zoom level specified.

### Using the Maps Functionality

This section describes how to use maps with the custom functionality provided by Information Builders. You can select multiple markers on maps at run time and drill down to WebFOCUS procedures filtered by the marker locations selected.
**Note:** For Google and Bing maps, the functions in this section can be accessed by right-clicking on a map during run time. To access the same functions for ESRI JavaScript API maps you must click on the Tools button at the top of the map during run time.

There are several ways of selecting markers, such as:

- Shape Selection.
- Combination Selection.

**Note:** Selected markers are indicated by the Selected Marker Image that you supply on the map Properties window. For more information about the map Properties window, see *Properties Window for Maps* on page 485.

**Procedure:** How to Use Manual Selection in the Map

Manual selection is the act of clicking on one or more individual markers in succession.

1. To initiate a manual selection, click on a marker while pressing and holding the Ctrl key from your keyboard.
2. To clear a selected marker, press and hold the Ctrl key and click the marker again.
3. To make selections without the risk of clearing a marker, press and hold the Shift key, rather than the Ctrl Key.
For example, the image below shows a map with three markers, as indicated by a red, green, and blue marker.

When the green and blue markers are selected, they become purple markers, as shown in the following image.
Procedure: How to Use Shape Selection in the Maps

Shape selection is the act of clicking in a specific location on the map and then drawing an area with the mouse on the map to form a shape. This shape enables you to select all markers within the drawn area. The map provides various selector shapes to choose from.

Tip: The shape selection options are available from the right-click context menu on Google and Bing maps and through the Tools menu for ESRI JavaScript API maps. You may also customize these options from the map Properties window.

1. To initiate a shape selection, right-click anywhere on the map or click the Tools button if you are using an ESRI JavaScript API map.

The Tools menu appears, as shown in the image below.

You may create a new polygon shape, change the polygon settings, show or hide markers from a layer, and refresh a layer.

2. To create a shape selection, select an option from the New Polygon menu, drag your mouse from the shape selection point on the map.

Note: The method by which selections are made depends on the selector shape used. For details, see How to Create Polygons in the Map Output on page 513.
The shape selector is created with the selected markers. A Tooltip indicates the details of the shape selector, as shown in the example image below.

3. To clear the markers in the shape selection, unselect Select Markers from the Update Polygon menu.

**Note:** Selecting Clear Selection clears all of the selected markers from the map.
4. To remove the shape selection from the map, select Remove from the Update Polygon menu.

**Note:** Selecting Remove Polygons removes all the shape selectors from the map.

5. Optionally, to reposition any of the selector shapes to a different location on the map:
   - Pause the mouse over the center of the selector shape to be repositioned.
   - Drag from the middle of the shape to the new location.
The selector shape is repositioned over the new location.
**Procedure: How to Use Combination Selection in Maps**

Combination selection is the act of using both the manual selection method and the shape selection method separately, or in coordination with one another, to make marker selections. Multiple selections can be made by using any of the above procedures prior to drilling down to WebFOCUS procedures.

**Procedure: How to Show and Hide Markers in Maps**

All layer marker groups are visible in a map by default. You may edit the visibility option to hide the markers in a map at run time.

1. To edit the visibility option from the map output:
   - Right-click anywhere on the map (if you are using a Google or Bing map), or click the Tools button for ESRI JavaScript API maps.
   - The menu appears.
   - Select the layer name from the Layer menu.

   **Note:** The layer name is the unique name for the layer created in the Map Properties dialog box. For more information about the layer options, see *Properties and Settings Dialog Box for Maps* on page 480.

   - From the unique name layer menu, you may select the markers to hide from the selected layer. In the image below, the green icon markers from Layer1 will be hidden in the map.
The selected markers are not visible on the map, as shown in the image below.

Tip: To show all marker groups from all layers on the map, select Show All from the Layers menu.

2. To edit the visibility option from the Properties and settings dialog box:
   - From HTML Composer with a map created, go to the Properties and settings dialog box.
   - Click the Visible option so that it does not have a check mark in the box next to it.

Note: Only layers have a visibility option on the Properties and settings dialog box. You may hide individual markers from a layer in the map output, as described in the first step of this procedure.

When you run the map, all of the layer markers are not visible.

Procedure: How to Refresh the Map Output

You may refresh the map output on demand or by setting up an automatic refresh at a timed interval.

1. To refresh a map on demand:
From the map output, right-click anywhere on the map or click the Tools button if you are using an ESRI JavaScript API map.

The menu appears.

To refresh all layers on the map, select Refresh All from the Layers menu.

To refresh individual layers on a map, select Refresh Layer from the layer name of the Layer menu.
2. To automatically refresh the map output at a timed interval:
   - From HTML Composer with a map created, go to the Properties and settings dialog box.
   - Select the refresh time, in seconds, by using the **Refresh (Seconds)** option.

   **Note:** The default refresh time is set to 0 seconds, which indicates that the automatic refresh is disabled. The minimum automatic refresh time is 60 seconds.

   - Close the Properties and settings dialog box.

   Refresh is not applicable to markers in the Marker Groups.

   The source for the layer refreshes on the map at the set timed interval.

**Procedure:** **How to Create Polygons in the Map Output**

The available shape selections from the New Polygon menu are Freehand, N-sided Polygon, Rectangle, Bullseye Fixed, and Bullseye Freehand. For details about bullseye charts, see *How to Create Bullseye Charts in the Map Output* on page 517.

**Note:** Polygons created when using ESRI maps are unable to be moved, copied, or resized.

1. Create a freehand polygon.

   A freehand polygon shows the selector shape as a series of lines that you mark at specific points on the map.

   - For Google and Bing maps, right-click anywhere on the map and select **Freehand** from the New Polygon menu. For ESRI JavaScript API maps, click the **Tools** button and select **Freehand** from the New Polygon menu.

     A cross is indicated on the map.

   - Left-click to indicate the starting point and create the crosshair on the map.

   - Drag and release to drag a line from one point to the next. Repeat left-click, drag, and release. These clicks will represent the corners of the shape to be drawn.

   - When you close the connector lines, the selected markers are indicated within the polygon shape, as shown in the image below.
2. Create an N-sided polygon.

An n-sided polygon shows the selector shape as a continuous line you draw around the markers to be selected. N-sided indicates that you can select the number of sides for the polygon.

**Note:** The default polygon is a circle.

- For Google and Bing maps, right-click anywhere on the map and select *N-sided Polygon* from the New Polygon menu. For ESRI JavaScript API maps, click the *Tools* button and select *N-sided Polygon* from the New Polygon menu.

  A cross is indicated on the map.

- Left-click to indicate the starting point and create the crosshair on the map.

- Drag the crosshair to a different point on the map and around the markers to be selected.
Left-click to close the polygon. The selected markers are indicated within the polygon shape, as shown in the image below.

To change the number of sides for the polygon:

- Select *Number of Sides* from the Polygon Settings menu.

**Note:** The default polygon is a 12-sided polygon. You may change the number of sides for a polygon by using the Polygon Settings menu on the map.
Select the number of sides you wish to create. Options are 6-sided, 8-sided, 12-sided, 16-sided, or a Circle (this is the default), as shown in the image below.

Optionally, you may select to Show Tooltips for the polygons on the map.

Select *N-sided Polygon* from the New Polygon menu and drag the object on the map.

The polygon shape has the number of sides that you indicated from the Polygon Settings.

3. Create a rectangle.

   For Google and Bing maps, right-click anywhere on the map and select *Rectangle* from the New Polygon menu. For ESRI JavaScript API maps, click the *Tools* button and then select *Rectangle* from the New Polygon menu.

   A cross is indicated on the map.

   Left-click to indicate the starting point and create the crosshair on the map.

   Drag the crosshair to a different point on the map and around the markers to be selected.
Left-click to close the polygon. The selected markers are indicated within the rectangle shape, as shown in the image below.

---

**Procedure: How to Create Bullseye Charts in the Map Output**

You may create a fixed or freehand bullseye chart in the map output. A bullseye chart is used to show radius distance from a location using three rings of increasing size. The bullseye options are available from the New Polygon context menu on the map.

**Note:** You may customize the ring and radius options of the bullseye chart from the Map Properties dialog box. For more details, see *Properties Window for Maps* on page 485.

1. Create a fixed bullseye chart.

   A fixed bullseye chart applies a predetermined size at the selected location.

   - For Google and Bing maps, right-click anywhere on the map and select **Bullseye: Fixed** from the New Polygon menu. For ESRI JavaScript API maps, click the **Tools** button and select **Bullseye: Fixed** from the New Polygon menu.

   A cross is indicated on the map.

   - Left-click to insert the fixed bullseye chart in the map.

   The bullseye chart is inserted in the selected location with a randomly generated color.
2. Create a freehand bullseye chart.

A freehand bullseye chart enables you to create the size and location of the initial bullseye chart.

- For Google and Bing maps, right-click anywhere on the map and select *Bullseye: Freehand* from the New Polygon menu. For ESRI JavaScript API maps, click the *Tools* button and select *Bullseye: Freehand* from the New Polygon menu.

A cross is indicated on the map.

- Left-click to insert the freehand bullseye chart in the map.

- Drag the bullseye chart to the desired size and release the mouse.

The bullseye chart is inserted in the selected location with a randomly generated color.

- Optionally, you may drag the bullseye to another point on the map. The selected markers, and Tooltip for the bullseye chart are indicated, as shown in the image below.
3. Resize the bullseye chart.
   - Select the bullseye chart. Right-click if you are using a Google or Bing map, and choose Resize from the Update Polygon menu. For ESRI JavaScript API maps, click the Tools button and choose Resize from the Update Polygon menu.
   
   A white box appears in the center of the bullseye and on the outer ring.
   - Drag the box to the desired location.
   - Release the mouse to resize the bullseye.
   
   Optionally, you may select Freehand resize to manually resize the bullseye chart.

Reference: Clearing and Removing Shape Selectors on Maps

- To show or clear selected markers within an individual shape selector, select the shape selector, then right-click and choose Select Markers from the Update Polygon menu.

- To remove individual shape selectors from map, select the shape selector, then right-click and choose Remove from the Update Polygon menu.

- To clear all selected markers on the map, right-click anywhere on the map and select Clear Selection from the context menu.

   The polygon shapes will remain on the map when the markers are cleared.

- To remove all shape selectors from the map, right-click anywhere on the map and select Remove Polygons from the context menu.

   The polygon shapes are removed from the map but the markers remain selected.

Reference: Running Maps Against a Secured Server

Whenever maps are run against a secured server (SSL configuration), the user is prompted with a message for display of secured and unsecured content on the HTML page. This message originates from map provider and is shown because they establish a link to an unsecured server to present the map.
For Internet Explorer® 7, the message appears as follows.

![Security Information](image)

For Internet Explorer 8, the message appears as follows.

![Security Warning](image)

**Reference:** Enabling Actions for Shape Selectors on Maps

When actions are enabled from the map Properties window, you may Copy, Delete, Move, and Resize the polygon shape selectors on the map.

All action options are selected by default. For more information about enabling these options, see *Properties Window for Maps* on page 485.

- To copy a shape selector, left-click in the center of the polygon, press the Shift key, drag the polygon and release it to create a copy of the polygon.
- To delete the shape selector, left-click in the center of the polygon, and press the Delete key.
- To move the shape selector, left-click and hold in the center of the polygon and drag the polygon to move it.
- To resize the shape selector, drag the edge of the polygon shape to resize the polygon.
Chaining for Maps

When chaining maps with other controls in HTML Composer, you are able to pass fields that are not displayed by the map. These fields can be passed from one control to the map and then from the map to another control, where those undisplayed fields will then be used.

Example: Map Chaining

The following example shows how a map can be chained with other controls and how it can pass fields through the map for use later in the chain. For this example, the centurystores Master File was used.

This example contains an HTML page that has two list boxes and one map control. The Design tab view of this page is shown in the following image.
The Parameters tab view shows that these controls are chained together, as shown in the following image.

Listbox1 is populated with a list of store names from the centurystores Master File. When one of the stores on the list is selected, the store location is shown on the map, as shown in the following image.
When the store marker image is selected on the map, the store address is displayed in listbox2, as shown in the following image.
Listbox1 passes the necessary fields to mapcontrol1 so that it can display the store location on the map. In this case, it passes the STORENAME field.

The layer procedures include BY STORENAME to filter the layer to show only the markers for the selected store in listbox1. The layer procedures also include a BY STOREID reference, which the map does not display, but is used in listbox2 to retrieve the correct store address for the selected map marker.
Mapcontrol1 does not use this field. However, when the store marker is selected on the map, the STOREID field is passed from mapcontrol1 to listbox2, as shown in the following image.

STOREID is passed to listbox2 where it is used to filter out the store address from the selected marker.

Maps can pass fields that they do not display. They can then pass those unused fields to another control, down the chain, which can use the passed fields.
Using JavaScript Code With Maps

**Function: toggleLayer('mapId', 'layerName')**

The `toggleLayer('mapId', 'layerName')` function toggles the visibility of the specified layer.

**Syntax:** How to Toggle Layer Visibility

```javascript
function button1_onclick(ctrl) {
  toggleLayer('mapId', 'layerName');
}
```

where:

- **mapId**
  - Alphanumeric
  - Is the unique identifier of the map control. For example, mapcontrol1.

- **layerName**
  - Alphanumeric
  - Is the unique identifier of a layer within the map. For example, Layer1.

**Function: toggleMarker('mapId', 'layerName', 'markerName')**

The `toggleMarker('mapId', 'layerName', 'markerName')` function toggles the visibility of the specified marker.

**Syntax:** How to Toggle Marker Visibility

```javascript
function button2_onclick(ctrl) {
  toggleMarker('mapId', 'layerName', 'markerName');
}
```

where:

- **mapId**
  - Alphanumeric
  - Is the unique identifier of the map control. For example, mapcontrol1.

- **layerName**
  - Alphanumeric
  - Is the unique identifier of a layer within the map. For example, Layer1.
**Function: refreshLayer**('mapId', 'layerName')

The refreshLayer('mapId', 'layerName') function refreshes the specified layer.

**Syntax:** How to Refresh a Layer

```javascript
function button3_onclick(ctrl) {
  refreshLayer('mapId', 'layerName');
}
```

where:

- **mapId**
  - Alphanumeric
  - Is the unique identifier of the map control. For example, mapcontrol1.

- **layerName**
  - Alphanumeric
  - Is the unique identifier of a layer within the map. For example, Layer1.

**Function: panToAddress**('address', 'mapId', 'zoom')

The panToAddress('address', 'mapId', 'zoom') function pans to a designated address.

**Syntax:** How to Pan to an Address

```javascript
function button4_onclick(ctrl) {
  panToAddress('address', 'mapId', 'zoom');
}
```

where:

- **address**
  - Alphanumeric
  - Is the address you want to pan to. For example, 2 Penn Plaza New York NY 10121.

- **mapId**
  - Alphanumeric
Is the unique identifier of the map control. For example, mapcontrol1.

\textit{zoom}

Integer

Is how much you wish to zoom. For example, 7.

\textbf{Function: \texttt{panToPoint('lat', 'long', 'mapId', 'zoom')}}

The \texttt{panToPoint('lat', 'long', 'mapId', 'zoom')} function pans to a designated point based on latitude and longitude coordinates the user enters.

\textbf{Syntax: How to Pan To a Point}

\begin{verbatim}
function button5_onclick(ctrl) {
panToPoint('lat', 'long', 'mapId', 'zoom');
}
\end{verbatim}

where:

\textit{lat}

Integer

Is the latitude coordinate of the point you want to pan to. For example, 40.7663277.

\textit{long}

Integer

Is the longitude coordinate of the point you want to pan to. For example, -73.9920777.

\textit{mapId}

Alphanumeric

Is the unique identifier of the map control. For example, mapcontrol1.

\textit{zoom}

Integer

Is how much you wish to zoom. For example, 7.
**Function: showAllMarkers('mapId')**

The `showAllMarkers('mapId')` function displays all map markers, even if it was previously hidden.

**Syntax: How to Show All Map Markers**

```javascript
function button6_onclick(ctrl) {
  showAllMarkers('mapId');
}
```

where:

- **mapId**
  - Alphanumeric
  - Is the unique identifier of the map control. For example, mapcontrol1.

**Function: drawBullseye('mapId', 'lat', 'long', 'selectmarkers', 'units', 'rings', '(list-of-sizes)', '(list-of-colors)')**

The `drawBullseye('mapId', 'lat', 'long', 'selectmarkers', 'units', 'rings', '(list-of-sizes)', '(list-of-colors)')` function draws a bullseye at a point on the map. This function has optional parameters to select whether to display markers, the units of measure used for the bullseye, the number of rings, the size of the rings, and the color of the rings.

**Syntax: How to Draw a Bullseye**

```javascript
function button5_onclick(ctrl) {
  drawBullseye('mapId', 'lat', 'long', 'selectmarkers', 'units', 'rings', '(list-of-sizes)', '(list-of-colors)');
}
```

where:

- **mapId**
  - Alphanumeric
  - Is the unique identifier of the map control. For example, mapcontrol1.

- **lat**
  - Integer
  - Is the latitude coordinate of the point you want to pan to. For example, 40.7663277.

- **long**
  - Integer
Is the longitude coordinate of the point you want to pan to. For example, -73.9920777.

**selectmarkers**

Boolean

Is an operator that, when set to true, selects all markers within the Bullseye.

**units**

Alphanumeric

The unit of measure for the Bullseye rings. For example, mi for miles.

**rings**

Integer

The number of rings the bullseye uses. For example, 3.

**list-of-sizes**

Integer

A comma separated list of sizes for the bullseye rings. For example, 1, 3, 5.

**list-of-colors**

Alphanumeric

A comma separated list of colors for the bullseye rings. The colors can be RGB values or hexadecimal values. For example, Blue or #FFFF.
ESRI Flex Viewer Integration

The ESRI Flex Viewer creates a component that adds numerous controls, a report, and a map object when used. An ESRI Flex Viewer component can be seen in the following image.

The ESRI Flex Viewer component can be accessed from the Insert menu, by selecting Components and clicking ESRI Components. You can then drag the crosshair to the desired size for the ESRI Flex Viewer controls and report. The ESRI Flex Viewer component will contain a number of controls, a report, and a map object. It is recommended that the ESRI Flex Viewer component be drawn big enough to accommodate all of these items.
You will then choose the esriinfo XML file to use with the ESRI Flex Viewer component, as shown in the following image.

![Image of esriinfo XML file selection dialog box]

**Note:** The following line must be present in your esriinfo XML file for you to pass parameters from the controls to the map object and from the map object to the report.

```xml
<callback identify="parmcollect" map="IBI_GetLayoutPainterParameters" report="IBI_GetLayoutPainterParameters"/>
```

The New Parameter dialog box will open and you will be able to change the options for the parameters contained within the ESRI Flex Viewer component.

The ESRI Flex Viewer component will then be inserted into the HTML page.

**Note:** Controls and reports within the ESRI Flex Viewer can be chained. Maps within the ESRI Flex Viewer component cannot be chained.
Develop your dashboard using HTML Composer in Developer Studio. You can create controls from existing WebFOCUS reports or new reports that you create specifically for your analytical dashboard. When creating controls (graphs) in your dashboard, you must use data sources in VISDIS format.

This chapter covers tasks and options that are available for all Visual Discovery controls (unless otherwise noted). For tasks and options that are graph-type specific, see the Using WebFOCUS Visual Discovery Components With Developer Studio manual.

**In this chapter:**

- Creating Visual Discovery Output Files
- Developing an Analytic Dashboard From Developer Studio
- Working With Visual Discovery Controls on the Web
- Accessing Visual Discovery Online Help
- Visual Discovery Tutorial

### Creating Visual Discovery Output Files

Visual Discovery creates graphs using a tab-delimited data file as input. The first record of the data file contains the column titles for the data values. The next record can contain the Visual Discovery field formats. If this record is not present, Visual Discovery attempts to determine the formats of the data fields by reading the first 50 records from the data file, a process that is not guaranteed to create accurate representations of the WebFOCUS formats.

The FORMAT VISDIS option creates a tab-delimited output file with the extension .txt in which the first record has the column titles and the second record contains Visual Discovery formats based on the field formats of the data. A .fex with PCHOLD FORMAT VISDIS can also be created and used the same way as the .txt file.
Reference:  Format Conversions for FORMAT VISDIS

<table>
<thead>
<tr>
<th>FOCUS Format</th>
<th>Visual Discovery Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer</td>
<td>I</td>
</tr>
<tr>
<td>Decimal/Packed</td>
<td>R</td>
</tr>
<tr>
<td>Alphanumeric</td>
<td>S</td>
</tr>
<tr>
<td>Date format (smart date)</td>
<td>D%format%format%format (for example, D%Y%m%d). If the year is not a four-digit year, the format returned is S.</td>
</tr>
<tr>
<td>Other</td>
<td>S</td>
</tr>
</tbody>
</table>

Procedure:  How to Create a Visual Discovery Output File From Report Painter

1. Open Developer Studio.
2. If necessary, create a new project for the report.
3. Add the necessary Master File to your project.
5. Add fields to your report.
6. From the Report menu, select Output.
7. From the Output Format drop-down list, expand the Unstyled formats folder and select Tab delimited text file for Visual Discovery (VISDIS).
8. From the Destination drop-down list, select one of the following options:
   a. Save file to create a .txt output file.
      In the Name field, specify the destination path and name for the file, using the Browse (...) button to navigate the path. This option saves the output as a text file to a physical location on the disk.
   b. Web browser to create a .fex with PCHOLD FORMAT VISDIS output file.
      This option saves the output as a .fex, which uses live data. Only .fex files that have been saved with PCHOLD FORMAT VISDIS can be used as data for Visual Discovery controls.
9. Click Apply.
10. Click OK to exit the Report Options dialog box.
11. Save your work and click Run.

A new browser window opens with information similar to the following, where 581 is the total number of rows in the data source, and 5 is the total number of rows in the Visual Discovery file:

```
0  NUMBER OF RECORDS IN TABLE=  581  LINES=  5
```

**Syntax:**

How to Create a Visual Discovery Output File Using WebFOCUS Language

```
[ON TABLE] HOLD [AS filename] FORMAT VISDIS
[ON TABLE] PCHOLD [AS filename] FORMAT VISDIS
[ON TABLE] SAVE FILENAME 'application_name/filename.txt' FORMAT VISDIS
```

where:

**HOLD**

Creates the results in memory, but does not save them to a text file unless you specify the Dialogue Manager command, APP HOLD application_name, in the report request.

For details on HOLD, see the topics on saving and reusing report output in the Creating Reporting Applications With Developer Studio manual.

**PCHOLD**

Presents the results as output to a browser. When accessed by Visual Discovery, the procedure is initialized by the ActiveX control using the URL of the procedure. The ActiveX control then interprets the output. Visual Discovery uses a live data pool and does not require a physical output file.

**SAVE**

Creates a physical output file for use when the Visual Discovery page points to a static data pool.

**filename**

Is the name of the output file.

**Note:** A Master File is not created for format VISDIS.
Creating a Visual Discovery Output File Using WebFOCUS Language

Example:

Using the CENTURYSALES data source, the following request creates a Visual Discovery output file named AUDIOSYSTEMSSALES.TXT, which is stored in the Visual_Discovery application folder in Developer Studio.

```
TABLE FILE CENTURYSALES
SUM
   QUANTITY
   LINEPRICE AS 'Revenue'
BY PRODUCTCATEGORY
BY PRODUCTNAME
WHERE SALESREP EQ 'Web';
WHERE PRODUCTCATEGORY EQ 'Audio Systems';
ON TABLE SAVE FILENAME
 'VISUAL_DISCOVERY/AUDIOSYSTEMSSALES.TXT'
   FORMAT VISDIS
END
```

The following file is created. For clarity, the tab characters in the file are displayed as a greater than sign (>) surrounded by blanks. Note that the first record has the column titles and the second has the Visual Discovery formats.

```
Product Category > Product Name > Quantity > Revenue
S > S > I > R
Audio Systems > Home Theater 5.1 System > 2087 > 4171913.00
Audio Systems > Home Theater 7.1 THX System > 243 > 728757.00
Audio Systems > Home Theater Surround System > 703 > 702297.00
Audio Systems > Micro 5.1 System > 857 > 427643.00
Audio Systems > Micro HiFi Stereo System > 2096 > 836304.00
```

Developing an Analytic Dashboard From Developer Studio

Before you begin to develop your Visual Discovery controls, you must create the following objects:

1. The data file. For more information, see the Using WebFOCUS Visual Discovery to Develop Analytic Dashboards manual.

2. The canvas for your controls, using HTML Composer in Developer Studio. For more information, see the Using WebFOCUS Visual Discovery to Develop Analytic Dashboards manual.

After you create a canvas and insert a Visual Discovery control, you can begin to edit the control properties. For example, you can select the data, assign colors, show labels, and more. The topics in this chapter cover tasks and options that you may apply to all Visual Discovery controls (unless noted).
**Important:** When you edit the properties of a control, it is necessary to load the data first, and then select your x-axis field and y-axis field from the loaded data.

For a tutorial on creating a complete Visual Discovery dashboard using sample data, see *Visual Discovery Tutorial* on page 574.

For graph-type specific tasks and options, see the *Using WebFOCUS Visual Discovery to Develop Analytic Dashboards* manual.

**Procedure:** How to Create a WebFOCUS Visual Discovery Analytic Dashboard

1. Open Developer Studio.
2. From the Developer Studio Explorer, right-click the HTML Files folder in your project folder and select *New, HTML File*. The Add HTML File dialog box opens.
3. Enter a name for the file and click *Open*.
4. If the HTML Composer Template selector opens, click *No, thanks*.

The HTML Composer canvas opens.

5. Click the *Visual Discovery* button on the controls toolbar, or click *Insert, Controls*, then click *Visual Discovery Control*.
6. Drag your mouse across the canvas to insert the control. The Insert ActiveX Control dialog box opens.

**Tip:** When you insert a control, its size (height and width) defaults to predefined dimensions. However, after you select the type of control from the Insert ActiveX Control dialog box (step 6), you can change its size using any standard resizing feature.

7. Select a Visual Discovery control and click *OK*.
9. Add data and click *Open*. The selected data will appear in the Available Data Pools drop-down menu.
10. Click ActiveX Properties and edit your graph properties as desired.

### Naming Controls

When you add a new Visual Discovery control to the HTML Composer canvas, HTML Composer assigns it a default Name and Unique Identifier. The naming convention for the control is activex\(n\), where \(n\) is an iterative number.

For example, when you add the first control, it is assigned the name activex1. When you add the next control, it is assigned the name activex2, and so on.

You can view and modify the Name and Unique Identifier of a control in the Properties pane. If you rename a control, using a more descriptive Name and Unique Identifier, then the next control you add will still increase by 1.

### Selecting Data

All components in an analytic dashboard share the same data source. This means that when you select a data source for the first control, that data source is automatically added to the Available Data Pools list, and made readily available for all subsequent controls.

**Procedure:  How to Add and Select Data**

1. From the Properties and settings dialog box, click Add Data Pool. The Get source file dialog box opens.

2. Add your data source, a .txt file or .fex file with PCHOLD FORMAT VISDIS, and click Open. The selected data source appears in the Available Data Pools drop-down list.

   **Important:** If you are developing remotely, you must either map a drive to the remote location of the data source or copy the data source to the local machine.

3. Click ActiveX Properties and edit your graph properties as desired. Repeat step 2 as necessary.

4. Add fields by clicking the box adjacent to the field. Click once to add the x-axis field, click twice to add y-axis field.

5. Click Apply, and then OK.
**Reference:** Properties and Settings Dialog Box

The following image shows the Properties and settings dialog box.

![Properties and settings dialog box](image)

**Available Data Pools**

Enables you to select a data file to use to populate the Visual Discovery control. After you select the file name, and click *ActiveX Properties*, the file is loaded. Its tables and fields display in the tree view panel on the Data tab.

**Add Data Pool**

Enables you to select a data file to use to populate the Visual Discovery control and add it to a list of available data pools.

**Remove Data Pool**

Removes all data sources from Available Data Pools drop-down list.

**ActiveX Properties**

Opens the Visual Discovery Properties dialog box, where you can edit the fields, colors, control features, font style, and titles for a particular Visual Discovery control.

The first tab in the Visual Discovery Properties dialog box is the Data tab. It will guide you on which types of fields, and how many fields you can select.

**Reference:** Data Tab

The following image and brief description of the Data tab is to guide you as to which types of data fields, and how many fields you can select for a particular control.
The bar chart control was used for the example shown in the following image.

**Data Instructions**

The text that appears above the Size is drop-down selection menu, on the top-right corner of the Data tab, instructs you on how to select a category field for the x-axis, and one or more category fields for the y-axis.

**Size is**

Determines the method to calculate the size of the glyph. For more information, see the Using WebFOCUS Visual Discovery to Develop Analytic Dashboards manual.

**Note:** When creating Visual Discovery controls in HTML Composer at design time, you select the data source through the Properties and settings dialog box. At run time, this dialog box does not appear. Instead, you can select your data source, .txt files only, through a modified version of the Data tab.

**Reference:** **Data Tab Icons**

The following table shows the possible icons that appear in the Data tab and what they indicate for the field.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Indicates...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A table with no items colored.</td>
<td></td>
</tr>
</tbody>
</table>
### Assigning Color to the Data and the Graph

You can use color to change how your graph displays. You can change the color scale of the glyphs based on a field that you select. For more information, see the *Using WebFOCUS Visual Discovery to Develop Analytic Dashboards* manual. You can also change the colors of the basic graphical elements (such as background color, foreground color, label color, selected variables, and overlay text color) in your graph control.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Indicates...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>A table with a field that colors the graph.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>The field is a real number.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>The field is a real number and colors the graph.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>The field is a number (integer).</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>The field is a number (integer) and colors the graph.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>The field is a string.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>The field is a string and colors the graph.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>The field is a date.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>The field is a date and colors the graph.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Icon" /></td>
<td>An x-axis selected field.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Icon" /></td>
<td>A y-axis selected field.</td>
</tr>
<tr>
<td><img src="image12.png" alt="Icon" /></td>
<td>The field is not available for selection.</td>
</tr>
</tbody>
</table>
Procedure: How to Change Graph Element Colors

1. Select the control and click ActiveX Properties.
   The Visual Discovery Properties dialog box for the selected control opens.

2. Click the Colors tab.

3. Select the colors:
   ❑ Using one of the Standard Tool Element Colors options. When you select one of these (Black, Blue, or White), the colors in the Component Element Colors field automatically change to the colors associated with that color scheme.

   ❑ Manually in the Component Element Colors field. For details on each component in the Component Element Colors field, see the Using WebFOCUS Visual Discovery to Develop Analytic Dashboards manual.

4. Click Apply, and then OK.
Reference: Colors Tab

The following image shows the Colors tab in the Visual Discovery Properties dialog box.

![Colors Tab Image]

**Color Using Field**

These settings apply to the entire Visual Discovery webpage.

**Table**

Specifies the name of the table for the current view. Other tables may be selected, even if they are not shown by the current view, by entering the table name in this field. If you have entered the name before, you may select the arrow key to the right of the entry field and scroll down to the desired name.

**Field**

Names the field in the table that is used to color the graph. If no field is selected, the table is not colored.

**Re-apply color to field**

Reapplies the color scale to a subset of data.

**Color Scale**

Changes the color scale for the graph. For more information, see the *Using WebFOCUS Visual Discovery to Develop Analytic Dashboards* manual.
**Standard Tool Element Colors**

Changes the background color of the graphs to black (the default setting), blue, or white. A default set of visualization component element colors is automatically selected for each background color.

**Component Element Colors**

**Background**

Specifies the color behind the graph. By default, the background color is black. A default set of element colors is automatically selected to go with the black background. Select this to change just the background color. If you want to change the entire color scheme, select one of the options in the Standard Tool Element Colors section.

**Foreground**

Specifies a data element in the visualization component. For example, sometimes it is the color of the outline of the glyphs.

**Selected**

Specifies the color of the items that are selected. If a color scale has been used, that color scale is used instead of the default selected color if the graph corresponds to individual colored data items.

**Missing**

Specifies the color of values that are missing.

**Goal Lines**

Specifies the color of the visualization component line that you can create and place in bar and line graphs.

**Overlay**

Specifies the color of the label or labels (including text and/or items) and any graphs that may be used to denote the items in focus.

**Shine**

Specifies the color of the outline of the bottom and/or right of the graph objects. It helps provide the appearance of depth to the graph. This applies only to bar chart and line chart graphs.

**View Title**

Specifies the color for the title of the visualization component. You can change the title text from the Titles tab.
**Background2**

Specifies the color of the second background element, if one is available. For example, in the data sheet visualization component, a second background color (by default, gray) is used to make rows of data easier to read.

**Label**

Specifies the color of the static text or graphic that identifies items on a graph. For example, the field names for the x-axis and y-axis in the bar chart, histogram, or line chart graphs.

**Unselected**

Specifies the color of the items that are not selected.

**Border**

Specifies the color of the line that is drawn around glyphs so they stand out from the background. This applies only to bar chart and line chart graphs.

**Overplotting**

Specifies the color of the small tick marks (shown at the top of the graph) that indicate items are plotted on top of or overlapping other items.

This element is available for the bar chart, line chart, and time table graphs.

**Selector**

Specifies the color of the shape, indicated in the Selector Shape section of this tab, used to select items.

**Shadow**

Specifies the color of the outline of the top/left of graph objects. It helps provide the appearance of depth to the graph. This applies only to bar chart and line chart graphs.

**Axis Title**

Specifies the color for the x-axis and y-axis titles.
Coloring a Graph by a Field

When you color a graph by a field, you provide another level of meaning to the graph. It is a way to add more information, an additional variable, to the graph. The field you choose to control color is usually based on the type of data you want to analyze and how you want it to appear. Coloring by a particular field helps you study the effect of that field on your data. You can also use color to highlight exceptional values (for example, the high values in a distribution), as well as categories of values.

Coloring depends on the color scale you select. For example, the Rainbow color scale ranges from blue to red. Color is uniformly applied as a continuous scale across the entire range of values in that column. Colors are assigned from low to high for numeric values and in alphabetical order for string values.

Procedure: How to Color a Graph by a Selected Field

1. Select the control and click ActiveX Properties.

   Note: If you are selecting colors for a bar chart, histogram, line chart, or pie chart that has more than two fields, make sure the Stack Colors check box is selected on the chart-specific tab.

2. Click the Colors tab.

3. In the Color Using Field, ensure the correct data pool is selected from the Table drop-down list.

4. From the Field drop-down list, select the field you want to color the graph by.

5. In the Color Scale field, select the color scale:

   - *Green/Red* goes from green on one end to red on another. This color scale uses the stop light metaphor (green means go or OK, yellow means caution, and red means stop or immediate attention).

   - *Pastel* is a red to blue scale using pastel shades.

   - *Equalized* is an alternate scale with equal perceptual changes between each entry in the scale.

   - *Categorical* is a field for which the values represent categories or classes. Categorical variables do not have natural scale or units of measurement. A field containing country names, such as the United States, United Kingdom, and Germany, is categorical.

   - *Rainbow* is the common red-to-blue scale. This is the default.
Gray enables unselected items to be shown in gray, making them seem to fade from view. The Gray color scale uses shades of black and white, instead of a set of colors, to show differences or similarities between/among items.

Thermal mimics the color changes in a heated iron, from cold (black) through warm (yellow) to extremely hot (white).

Smallest Values are High Priority. By default, the highest values are set to the highest priority. This means that the values are assigned a color based on the placement of the value within the selected color scale. The highest value is at one end of the color scale and the lowest value is at the other end. By selecting this option, the coloring of the values is reversed.

6. Click Apply, and then OK.

Note: When you select a subset of data and exclude the unselected items, you might want to apply the color scale to the range of values in the subset instead of it remaining applied to the entire set of data. If the remaining items (the subset) are from the same area of the original data set, the colors of all the items might be very similar. If you reapply the color just to those remaining items, each item might stand out more because the color scale is applied to a smaller range.

To reapply the color scale to a subset of data, select Re-apply color to field in the Color Using Field section and click Apply.

Values are VisDis Color By

Another way to color your Visual Discovery controls is through an HTML Composer Visual Discovery integration feature called Values are VisDis Color By. Values are VisDis Color By is an option only available through the Properties and settings dialog box of a list box, drop-down list, or double list box. You must first create a canvas using HTML Composer, add a Visual Discovery control, and then add a list box, double list box or drop-down list that contains the field names from the data pool of the Visual Discovery control.

When you run the HTML page, you are able to select a field name from the list to change the colors of the Visual Discovery control.

Procedure: How to Color a Visual Discovery Control Using Values are VisDis Color By

The following procedure provides the steps to color a Visual Discovery control using the Values are VisDis Color By option.

1. In HTML Composer, create a Visual Discovery control, such as a bar chart.
2. Select a data pool, and the desired x-axis field and y-axis field for the control.
3. From the Insert menu, select Controls, then click Drop Down List.

**Note:** You may also choose a list box or a double list box instead of a drop-down list.

4. Drag your cursor across the canvas. The drop-down list appears.
5. With the drop-down list selected, click the Parameters tab in the lower-left corner of the HTML Composer window.

The Properties and settings dialog box appears, as shown in the following image.

![Properties and settings dialog box](image)

**Note:** If the Properties and settings dialog box does not appear, you must select it from the View menu.

6. Select Static from Data type radio button area.
7. Click the Values are VisDis Color By check box at the bottom of the dialog box.

**Note:** The Values are VisDis Color By check box only appears when Visual Discovery controls are on the HTML page.
8. Click the New button drop-down list, click *Visual Discovery ActiveX*, the name of your Visual Discovery control that contains the fields to be used as color by values, and then select a field name option from the cascading menus, as shown in the following image.

![Image of properties and settings dialog box with Visual Discovery ActiveX selected]

The New button drop-down list changes to allow the selection fields from data pools, only when you have clicked the Values are VisDis Color By check box.

9. Repeat step 6 for a second field name option of your choice.

You can also click *Add All Items*, which adds every available field name option to the drop-down list control.

10. Click the *Design* tab located in the lower-left corner of the HTML Composer window.

11. Save your work, and Run the page.
When you run the HTML page, select a field from the drop-down list. Notice that the colors of your Visual Discovery control are now colored according to the selected field.

**Choosing Selection Options**

In interactive data visualization controls, selection enables you to retrieve data of interest (and effectively answer questions about the data) just as written queries do. However, many of the methods to visually select data are different from written queries. Since all controls in your dashboard share the same data pool, when you select data in one control, the same data is selected in all controls.

You select by sweeping an area of the interactive data visualization control with the mouse, and clicking on items. Additionally, in the data sheet control, you can perform textual selection.

The Selecting tab controls how selection with the mouse works. These properties affect all views, not just the current view. In addition to selecting a group of items with the mouse, you can also select, unselect, exclude all data, and toggle the selection states using the pop-up menu.

**Note:**

- The data constellation control has specific selection features. For more information, see the *Using WebFOCUS Visual Discovery to Develop Analytic Dashboards* manual.

- Although all selector shapes can be selected on the tab, only the rectangle is allowed as a selector shape for 3D controls.
**Reference: Selecting Tab**

The following image shows the Selecting tab in the Visual Discovery Properties dialog box.

![Selecting Tab Diagram](image_url)

**Selector Shape**

**Rectangle**

The default shape used to select items. To select or sweep using a rectangle, move the cursor to one corner to the desired data, press and hold the left mouse button, move the cursor to the opposite corner of the desired area, and release the mouse button. The data within the rectangle is selected.

**Lasso**

When Lasso is selected, you may draw a free style curve. When the left mouse button is pressed, the lasso follows the cursor and selects items the cursor passes until the mouse button is release.

**Circle**

When Circle is selected, it enables you to sweep or select data within a circle, whose center is the position where the left mouse button was initially pressed, and the perimeter is where that mouse button is released. When the Circle selector shape is active, a dot appears in the small circle next to the text.

**Rectangular Brush**

When Rectangular Brush is selected, a rectangle follows the mouse and identifies objects that it passes over.
**Circle Brush**

When Circle Brush is selected as the selector shape, a circular shape follows the mouse and identifies objects that it passes over.

**Interactive Labeling**

**Details**

Options include the following. Note that details cannot be presented in a histogram, because the histogram displays the distribution of single continuous fields. Individual values are not shown.

**Hover or Shift.** The detailed information about a glyph appears when you hover over or move the cursor over an item while holding down the Shift key. This is the default.

**Hold Down Shift.** Turns on the detailed information when you press the Shift key and pass over the items. When you are not over an item, the option turns off until you press the Shift key again.

**Continuous.** When you pass over an item, the detailed information appears about that item.

**Location**

Options include:

**Continuous.** The coordinates (location on the x-axis and y-axis) of a glyph appear when you move the cursor over the item. This is the default.

**Hover or Shift.** When you hover over or move the cursor over an item while holding down the Shift key, you see the coordinates for that point.

**Hold Down Shift.** Turns on the location information when you press the Shift key and pass over the items.

**Flicker Free Drawing**

When the cursor moves over a graph, it may cause flickering. Select this option to eliminate the flicker. Graphs may take longer to render with this option set.

**Selector Operation**

**Replace**

Replaces the existing selection set with the next items identified.
**Toggle**

Reverses the selection state of items. Selected items become unselected. Unselected items become selected.

**Add**

Select this option to add identified items to the selection set.

**Subtract**

Removes identified items from the selection set, if they are in it.

**Intersect**

Selects only those items that were previously selected and are in the set of identified items.

**Specifying Fonts and Titles**

The Fonts tab sets the font type and size for the view title (the title for the control or graph, which you set in the Titles tab), the axis titles, and the labels. The Titles tab sets the titles of the view (the graph) and the axes of the graph.

**Reference: Fonts Tab**

The following image shows the Fonts tab in the Visual Discovery Properties dialog box.

![Fonts Tab Image]

To change the font, font style, or font size, click the appropriate Font button.
Reference: Titles Tab

The following image shows the Titles tab in the Visual Discovery Properties dialog box.

Type the titles in the Title Text field. If you do not alter the titles, they will default to the field names from the data table you selected in the Data tab.

This tab is not available for the counts, data sheet, parabox, or time table controls.

Using Goal Lines

You can use goal lines in a bar or line chart.

Goal lines are lines you can place on a bar or line chart in the report output. Goal lines display in front of the graphed data, enabling you to compare your data with one or more set values. You can see which values are above or below a level you specify.

Before selecting glyphs above or below a goal line, negative and positive values are added. If your graph contains negative and positive numbers, some glyphs that you may initially expect to appear above or below the goal line (depending on which button you select), may have a cumulative value different than what you might expect and the glyph will not be selected.

Note: Goal lines are not available when what you are using a spine plot, since the bar glyphs are the same height.

Procedure: How to Add Goal Lines

1. Ensure Show Goal Lines is selected on the bar chart or line chart pop-up menu.
2. From the pop-up menu, select Create Goal Line. A blue line appears.
3. Repeat step 2 for each desired goal line.

**Procedure: How to Move Goal Lines**
Select a goal line and drag it to the desired value. Use the focus information to position the goal line.

**Procedure: How to Hide Goal Lines**
From the pop-up menu, clear the check mark for Show Goal Lines.

**Note:** This does not permanently remove the goal line from the graph.

**Procedure: How to Remove Goal Lines**
1. Move the cursor over the goal line.
2. Click the close (X) button.

**Procedure: How to Select Values Above/Below the Goal Line**
1. Move the cursor over the goal line.
2. Click the:
   - **Up button** to select all values above the goal line.
   - **Down button** to select all values below the goal line.

The graph changes to reflect your selection.

**Animating Data**
You can animate data in a bar, line, or pie chart.

Animation is when each glyph is sequentially highlighted and then restored to its original state. Animation is especially helpful when you are analyzing two or more interactive data visualization controls at the same time because you can easily see the highlighted items in all displayed controls simultaneously. Animation is also helpful when you are viewing complex data, because it can highlight unexpected relationships.

When you set and control animation in a control (bar chart, line chart, and so on), the animation effect occurs in all the displayed controls that use the same data source.
Procedure: How to Animate a Bar, Line, or Pie Chart

1. In the Visual Discovery Properties dialog box, click the chart-specific tab (either the Bar Chart tab, Line Chart tab, or Pie Chart tab).

2. Select the Animate check box and click Apply.

3. To control animation, click the:
   - Backward button to go back one bar. Backward does not reverse animation.
   - Pause button to temporarily stop animation.
   - Resume button to restart the animation after it has been paused.
   - Forward button to go forward one bar. Forward does not restart animation.

4. To change the speed of animation, click:
   - Slower to slow down animation.
   - Faster to speed up animation.
   - Normal to return the animation to the default pace.

Tip: From the pop-up menu, select Animate.

Selecting Primary and Secondary Order

You can select primary and secondary order in a bar, line, or pie chart.

Order controls the sequence in which glyphs are presented. You can select primary and secondary order in bar, line, and pie charts.

Procedure: How to Select Primary and Secondary Order

1. In the Visual Discovery Properties dialog box, click the chart-specific tab (either the Bar Chart, Line Chart, or Pie Chart tab).

2. In the Order field, from the Primary drop-down list, select:
   - Original order to show the order in which the data was initially presented. This is the default.
   - Label order to alphabetize the data by category name.
- **Size** to display the categories by the number of cases (from the largest count to the smallest).
- **Total Selected** to display the categories by the number of cases selected.
- **% Selected** to display the categories by the percentage of cases in that category that are selected.

**Note:** The Primary drop-down list and the Secondary drop-down list contain the same options.

3. Select the **Secondary** order option.

Secondary order is applied at the same time as the primary order and becomes apparent only when two or more items have the same value according to the primary order.

4. Click **Apply**, and then click **OK**.

**Note:** On the pop-up menu, click **Primary Order** and then select an option.

### Displaying Labels

You can display labels in a bar, line, or pie chart.

You can choose how and which labels to display in the control when you are creating the control. You can also show and hide individual labels using the pop-up menu.

**Note:** X-axis and Y-axis labels come from the field names in your data source.

### Procedure: How to Select Label Mode

1. In the Visual Discovery Properties dialog box, click the chart-specific tab (either the Bar Chart, Line Chart, or Pie Chart tab).

2. Select the desired option from the Labels Shown drop-down list. Options include:
   - **Best Fit** which displays labels in equally spaced increments. This is the default option.
   - **Selected** which displays labels for the selected (colored) data only.
   - **All** which displays labels for all data on the graph.
   - **Off** which displays no labels.
   - **Custom** which enables you to select which labels to display.
3. Click Apply, and then click OK.

Tip: From the pop-up menu, select Label Mode and then select the desired option.

Procedure: How to Show or Hide Individual Labels Using the Pop-up Menu

1. Right-click the label you want to show or hide.
2. Select Label 'name' from the menu.

Preselecting Values

You can preselect values of a Visual Discovery control that display at run time, by adding the onInitialUpdate() function to the Embedded JavaScript tab of HTML Composer. When you run the HTML page, the values you preselected display.

Procedure: How to Preselect Values

1. In HTML Composer, create a Visual Discovery control, such as a bar chart.
2. Select a data pool, and the desired x-axis field and y-axis field for the control.
3. Click the Embedded JavaScript tab.
4. Below //End function window_onload, create the onInitialUpdate() function that calls the IbComposer_setCurrentSelection() JavaScript API function. Specify the necessary parameters to preselect and display values at run time.

An example of the onInitialUpdate() function code, with two preselected values, is shown in the following image.

```javascript
//Begin function window_onload
function window_onload() {
  UpdateData();
  // TODO: Add your event handler code here
  //add onInitialUpdate() function to make changes before initial run of the reports
  //End function window_onload
  function onInitialUpdate()
  {
    var arrValues = [];
    arrValues.push('some');
    arrValues.push('another');
    IbComposer_setCurrentSelection('activex1', arrValues, false);
  }
}
```

5. Run the page.
When you run the page, the preselected values will display on the Visual Discovery control, as shown in the following image.

![Dollar Sales per Product](image)

**Passing Between a Report and a Visual Discovery Control**

Using HTML Composer, you can add custom parameters that pass data between Visual Discovery controls and reports on a webpage. You can build a webpage in which a Visual Discovery control passes data to a report, or a webpage in which a report passes data to a Visual Discovery control. Each option requires use of the same data pool.

**Procedure: How to Pass a Parameter From a Visual Discovery Control to a Report**

The following procedure provides steps to create a Visual Discovery control parameter that passes data to a report at run time.

1. Create a parameterized procedure that shares the same values as the data pool you select for your Visual Discovery control.
2. In HTML Composer, create a Visual Discovery control, such as a bar chart.
3. Select a data pool, and the desired x-axis field and y-axis field for the control.
4. From the Insert menu, click *New Report*.
5. Drag your cursor across the canvas. A report placeholder opens.
6. Right-click the report placeholder and select *Reference existing procedure*. 
The Get source file dialog box opens.

7. Navigate to the parameterized procedure you created in step 1, and click Open.
   The New Parameters dialog box opens.

8. Click the ellipsis button under Control Type.

9. Click Existing control, and the name of your control.


11. Save your work and then run the webpage, as shown in the following image.

Select specific data in your Visual Discovery control, and click the Run button to view the report results, as shown in the following image.
**Procedure: How to Pass a Parameter From a Report to a Visual Discovery Control**

The following procedure provides steps to create a report parameter that passes data to a Visual Discovery control at run time.

1. In HTML Composer, create a Visual Discovery control, such as a bar chart.
2. Select a data pool, and the desired x-axis field and y-axis field for the control.
3. Click the **Parameters** tab.
4. Right-click the page and select **Add parameter**.
   
   The parameter Properties and settings dialog box opens.

5. Type a parameter name in the Name Field.

   **Note:** The same parameter name will be used in the report.

6. Select the new parameter, and create a binding line to your Visual Discovery control, as shown in the following image.

7. Select the arrow on the binding line.

   A new Properties and settings dialog box opens, as shown in the following image.

8. Click the ellipsis button and select the datapool field that should be selected, based on the parameter created in step 2.

9. Save your work and close HTML Composer.

   Once you have created the HTML webpage with a Visual Discovery control, you must then create a report that will pass data to the Visual Discovery control.
10. Open Report Painter to create a new Report using the same Master File as your data source.

11. Select the Report fields.

12. Right-click the field on the Report Painter canvas whose value should be passed to the Visual Discovery HTML page, and click Options.

The Field Properties for Field dialog box opens, as shown in the following image.

13. Click the Drill Down tab.

14. On the Active Object drop-down list, click Column Data.

15. On the Drill Down Type drop-down list, click URL.

16. Type the fully qualified URL to your HTML page.

17. Under With Parameters, click Add.
The Drill Down Parameter dialog box opens, as shown in the following image.

18. Type the same parameter name that you selected in step 2, and click OK.
19. Click OK to close the Drill Down Parameter dialog box.
20. Click OK to close the Field Properties for Field dialog box.
21. Save your work and run the report.

**Note:** When you run the report, the chosen parameter field appears with underlined text, as shown in the following image.
Click an underlined text field. Notice that the Visual Discovery control you created earlier appears with the appropriate parameter selected, as shown in the following image.

![Visual Discovery Control](image)

**Chaining Into a Visual Discovery Control**

Using the HTML Composer chaining feature, you can integrate Visual Discovery controls and data within a listbox, double list, or drop-down list. Adding this functionality to your dashboard creates an interactive webpage from which end users can select values in the list, and automatically view them in a Visual Discovery control.

**Procedure: How to Chain Into a Visual Discovery Control**

1. Create a parameterized, PCHOLD FORMAT VISDIS procedure that contains a multi-select parameter and the fields you want to be displayed in the Visual Discovery control.

   **Note:** Because a Visual Discovery control is always multi-select, you must always use a multi-select parameter.

2. In HTML Composer, create a Visual Discovery control, such as a bar chart, using the parameterized procedure you created as the data pool.

3. Create a list box that will display the values you want shown in the Visual Discovery control.

   **Note:** You may also use a double list or a drop-down list instead of a list box.
4. In the Properties pane, change the Multiple option to *Multiple*.
5. Click the *Parameters* tab.
6. Remove the multi-select parameter from the unbound box, as shown in the following image.

![Unbound Parameters](image1.png)

7. Bind your list box to the multi-select parameter and the Visual Discovery control, as shown in the following image.

![ListBox to ActiveX](image2.png)

8. Save your work and run the webpage.
The HTML page shows your list box, populated with the values, and your Visual Discovery control, as shown in the following image.

Selecting values from the list box will display data in the Visual Discovery control, for those values only. The following image shows three values selected with the corresponding data displayed in the Visual Discovery control.
Excluding and Restoring Data

In addition to the Visual Discovery selection features at run time, you can use the exclude and restore hyperlink actions to link Visual Discovery controls and button controls on a webpage. With this option, end users can select data on a control and click the *Exclude* button to view only the selected data. To restore the unselected data, end users can click the *Restore* button.

**Procedure: How to Exclude and Restore Data**

1. In HTML Composer, create a Visual Discovery control, such as a bar chart.
2. Select a data pool, and the desired x-axis field and y-axis field for the control.
3. Create two push buttons on the page with your Visual Discovery control.
4. Right-click the first button and click *Create hyperlink*.
   
   The Hyperlink Properties dialog box opens, as shown in the following image.

   ![Hyperlink Properties](image)

   5. In the Display Text field, type *Exclude*.
   6. Click the *new hyperlink* button.
   7. Edit the properties of the new hyperlink.

      - Select *Visual Discovery Exclude* from the Action drop-down list.
      - Select your controls data pool from the source drop-down list.
8. Click OK to close the Hyperlink Properties dialog box.

9. Repeat steps 3 through 7 for the second button, noting the following:
   - Name the button Restore and click Visual Discovery Restore from the Action drop-down list.

10. Save your work and run the webpage.

   When selecting data from the Visual Discovery control, you can click the Exclude button to hide all of the unselected data, as shown in the following images.
When you click the Restore button, the hidden data is brought back.

**Working With Visual Discovery Controls on the Web**

Anyone viewing Visual Discovery analytic dashboards on the web can alter the selection of data or the display of controls without requiring Developer Studio or any programming skills. You can select data, restore excluded data, change the display, such as orientation or sort order, or save the control as a GIF image for use in an external report.

**Selecting Data**

On your Visual Discovery analytic dashboard on the web, click inside a control and drag your cursor until part of the data is captured by an outline. Release the cursor to complete the selection. You will see the selection change the appearance not only of the control in which you made the selection, but in all the Visual Discovery controls on the dashboard.

To change the shape of the selection tool, select the control and click *ActiveX Properties*. Click the *Selecting* tab and choose a new selector shape. For more information, see the *Using WebFOCUS Visual Discovery to Develop Analytic Dashboards* manual.

**Restoring Excluded Data**

Once you have selected data on your Visual Discovery analytic dashboard on the web, the excluded data is grayed out or not present, depending on the options preselected by the Dashboard creator. If the excluded data is grayed out, you can restore it in the following ways:

- Clicking a gray section replaces the current selection.
- Pressing Ctrl + click adds the new section to the current selection.
- Dragging the selector shape across the control selects a new set of data.

If the excluded data disappears from the control, you can restore it by:

- Selecting the grayed-out data in another control.
- Right-clicking the control and selecting *Show unselected* to keep the selection area the same while displaying unselected data.
- Right-clicking the control and selecting *Select*, then *Select All* to restore all data to the selection.

**Changing the Display**

To change the orientation, label display, sort order, or glyph choice for any Visual Discovery control, right-click the control and select the appropriate item. For pie charts, you can also change the rotation, the measure of explosion, or the weighting.
For access to the complete set of control options, right-click the control and click Properties.

**Saving a Control as an Image**

To save a control as an image, right-click the control and click Save image. Specify the destination and file name to save the control as a GIF file.

**Saving the State of Analysis**

A bookmark is a combination of display characteristics, such as the selection state (data that is selected, unselected, or excluded) and the colors used in the control. The Visual Discovery bookmark feature allows you to save a specific state in your analysis, so you can return to it at a later time without recreating it from the beginning.

To save the current state of your analysis, select the control, click ActiveX Properties, and access the BookMarks tab in the Visual Discovery Properties dialog box. In the input field, type a name for the bookmark and click Create and OK. The new bookmark will be available from the Bookmarks option on the pop-up menu for the control.

**Reference: BookMarks Tab**

The following image shows the BookMarks tab in the Visual Discovery Properties dialog box.

![BookMarks Tab](image)

**Create**

This bookmarks the current view of the control on a webpage so that you can return to it at a later date. Type a name and click Create.
Go To
Select a bookmark and click Go To to return to that view of the control.

Remove
Select a bookmark and click Remove to delete the bookmark.

Accessing Visual Discovery Online Help
The Visual Discovery design-time and run-time environments provide online Help for the user interface and the JavaScript API. The JavaScript API online Help includes full documentation on all controls and their properties, methods, and expected behavior.

Procedure: How to Access Visual Discovery Online Help
This procedure describes how to access online Help for the user interface, and then navigate to information on the JavaScript API.

For specific steps on using online Help to set colors, see the example that follows this general procedure.

1. In the design-time environment, select the control whose properties you are setting and click ActiveX Properties.
   In the run-time environment, right-click the control and click Properties from the pop-up menu.
   The Visual Discovery Properties dialog box for the selected control opens.

2. Click the Help button in the lower-right corner of the dialog box.
   The Common Property Pages window opens. It provides information on all the tabs for the control. These common tabs are the same for many controls.

3. Scroll down the page to locate information on the tab that you are interested in.
   Online Help information explains what the fields on the tab allow you to do.

4. On the Search tab in the left pane, in the field labeled Type in the keyword to find, enter a search string and click List Topics.

5. Select the topic that applies and click Display.
   A new pane opens on the right, displaying the selected topic.

6. Scroll down the pane, following the highlighted instances of the keyword you entered until you come to the information you are looking for.

7. When you have retrieved and reviewed the information, close online Help to return to the Visual Discovery control.
Example: Using Visual Discovery Online Help to Set Colors

You can set the color of the various parts of a control, for instance, the background, the axis titles, the chart title, and so on. This example shows how to access online Help for information on the Colors tab of the user interface, then navigate to information on setting colors through the JavaScript API.

This example uses an HTML page with a bar chart. It accesses online Help from the design-time environment.

1. Open the HTML page in design mode in HTML Composer.
2. Select the bar chart control, whose color properties you are setting, and click ActiveX Properties. The Visual Discovery Bar Chart Properties dialog box opens.
3. Click the Help button in the lower-right corner of the dialog box, as shown in the following image.

![Visual Discovery Bar Chart Properties Dialog Box](image)

The Common Property Pages window opens. It provides information on all the tabs for the bar chart.
4. Scroll down the page to locate information on the Colors tab.

Online Help information explains what the fields on the tab allow you to do, for example, apply a color to a control element, such as background.

5. In this example, we would like to know more about setting colors and additional color capabilities available through the JavaScript API.
On the Search tab in the left pane, in the field labeled **Type in the keyword to find**, type **Background Color** and click **List Topics**, as shown in the following image.

6. Click **IVZView4** and click **Display**.

The VzView4 window opens in the right pane, with details on the standard JavaScript API for all Visual Discovery controls, including properties and methods.

Instances of the keyword you entered in the search pane are highlighted (background color and color).
7. Scroll down the right pane, following the highlighted instances of background color or color, until you come to the color properties, as shown in the following image. Here you find that a color is encoded as a string that gives the RGB (red/green/blue) value in hexadecimal notation (0xRRGGBB). For example, red is 0xFF0000 and blue is 0x0000FF.

Properties

```javascript
object.ForegroundColor = string;
stringvar = object.ForegroundColor;
object.BackgroundColor = string;
stringvar = object.BackgroundColor;
object.Background2Color = string;
stringvar = object.Background2Color;
object.SelectedColor = string;
stringvar = object.SelectedColor;
object.UnselectedColor = string;
stringvar = object.UnselectedColor;
object.OverlayColor = string;
stringvar = object.OverlayColor;
object.SelectorColor = string;
stringvar = object.SelectorColor;
object.LabelColor = string;
stringvar = object.LabelColor;
object.OverplotColor = string;
stringvar = object.OverplotColor;
object.MissingColor = string;
stringvar = object.MissingColor;
object.ShineColor = string;
stringvar = object.ShineColor;
object.ShadowColor = string;
stringvar = object.ShadowColor;
object.BorderColor = string;
stringvar = object.BorderColor;
object.GoallineColor = string;
stringvar = object.GoallineColor;
object.AxisColor = string;
stringvar = object.AxisColor;
object.TitleColor = string;
stringvar = object.TitleColor;
```

Get or set visualization component element colors. Colors are encoded as a string giving the RGB value of the color in hex: "0xRRGGBB". Thus red is "0xFF0000" and blue is "0x0000FF". See `VzDataColor` for a description of these colors and additional color controls.

Tables describing hexadecimal color codes are available on many websites.

8. Close online Help to return to the Visual Discovery control.

**Visual Discovery Tutorial**

The first part covers some of the most commonly used chart types and useful Visual Discovery add-ons. The second part allows you to create controls that can be customized for future applications, as well as creating an active report or PDF from the selected components.
Before You Begin

This tutorial assumes that you are already familiar with WebFOCUS Developer Studio and that you have done the following:

- Installed WebFOCUS Developer Studio.
- Confirmed that Developer Studio is connected to its internal WebFOCUS Reporting Server or to a remote WebFOCUS Reporting Server.
- Confirmed the use of Internet Explorer 8.0 or higher.
- Reviewed Visual Discovery documentation and learned how to create Visual Discovery .txt files (FORMAT VISDIS) and .fex files (PCHOLD FORMAT VISDIS).

Building an Analytic Dashboard With Visual Discovery Components

This section of the tutorial illustrates how to create an analytic dashboard that contains two bar charts, a data constellation, a pie chart, and a summary sheet. The first four controls show revenue by different values (store, region, city, product type). The last control (summary sheet) shows various values (quantity, returns, and revenue) for each sales representative. The data constellation is placed on top of a map of the United States.
Visual Discovery controls use data from a .txt or .fex (with PCHOLD FORMAT VISDIS) output file. To understand how to create this type of file, see the Using WebFOCUS Visual Discovery to Develop Analytic Dashboards manual. You create analytic dashboards using HTML Composer, which you can access from:

- The Developer Studio project area.
- WebFOCUS Environments: Data Servers.
- WebFOCUS Environments: Repository.

**Tip:** As you perform the steps in the tutorial, save your work frequently.
**Procedure:** How to Create the HTML File

1. In your project or application folder, right-click the HTML Files folder and click New, then select HTML File.

   If you are working in the Repository, right-click a folder and select New, HTML File.

2. Enter vzMySales as the file name and click Open.

   If the Template Selector opens, click No, thanks to close it.

   HTML Composer opens, as shown in the following image.

**Procedure:** How to Create the Bar Charts

1. Click the Vis (Visual Discovery) button on the components toolbar.

2. Drag your cursor across the canvas. The Insert ActiveX Control dialog box opens.

3. Click Visual Discovery Bar Chart and click OK.

4. Click the Empty Bar Chart component. The Properties and settings dialog box opens.

   You need to associate data with the control before specifying the characteristics of the bar chart.

5. Click Add Data Pool in the Properties and settings dialog box.
6. Navigate to your data file and click Open. In this example, we are using a file named vzstoresales.txt. You can copy this file to your current application from the \ibi\apps\session directory.

7. Click ActiveX Properties to open the Visual Discovery Bar Chart Properties dialog box.

8. In the Data tab, expand the data tree to see the available fields.

   The bar chart in this example uses the Revenue and Store Name fields.

9. Click:
   
   - Once on Store Name so an X appears in the box. This is the x-axis field.
   
   - Twice on Revenue so a Y appears in the box. This is the y-axis field.

   The following image shows the x-value and y-value selected in the Data tab.

10. Click the Bar Chart tab, as shown in the following image.

    - Confirm that the orientation of the chart is set vertically by clicking the first icon in the Orientation field.
Set the Labels Shown list to All, as shown in the following image.

11. Click the Colors tab, as shown in the following image. In the Field list, click Product Type. This colors the bars according to the values in the Product Type field.
12. Click the Fonts tab.

For Label Font, click the Font button and set the font to 10, as shown in the following image.
13. Click the Titles tab, as shown in the following image. Change the following:

- Title Text to Revenue by Store.
- X axis title to blank (no title).
- Y Axis title to Revenue.

14. Click Apply and then click OK to return to the HTML Composer window.

15. Save your work.

16. Access the Properties pane on the right (if needed, click Properties on the View menu).

   From the Properties drop-down list, select activex1 <OBJECT>, if not already selected. For information on the way that Visual Discovery names components, see the Using WebFOCUS Visual Discovery to Develop Analytic Dashboards manual.

   Specify the attributes as follows and then save your work:

   - Name: vzBarOne
   - Position: Left: 10px
   - Position: Top: 70px
   - Size: Height: 245px
Size: Width: 200px

Unique Identifier: vzBarOne

**Tip:** You do not need to enter px for pixels. That is the default value.

The following image shows the Properties pane.
17. Run the webpage. The output should look similar to the following image.

![Revenue by Store](image)

18. Close the webpage to return to HTML Composer.

19. Create another bar chart component by repeating steps 1 through 18 in this procedure. When you create the second bar chart, note the following:

- The vzstoresales.txt data source is already part of the data pool.
- From the Data tab, select Region as the x-axis field, then select Revenue as the y-axis field.
- From the Bar Chart tab, set the Labels Shown list to All.
- From the Titles tab, change the title text to Revenue by Region and leave the x-axis title blank.
On the Properties pane, remember to select `activex2 <OBJECT>` from the drop-down list, if not already selected. Set these attributes as follows, and then save your work:

- Name: `vzBarTwo`
- Position: Left: 220px
- Position: Top: 70px
- Size: Height: 245px
- Size: Width: 280px
- Unique Identifier: `vzBarTwo`

20. Run the webpage. The output should look similar to the following image.

21. Close the webpage to return to HTML Composer.
**Procedure: How to Create the Data Constellation**

1. Insert another Visual Discovery control.
2. This time, click *Visual Discovery Data Constellations*.
   
   Bring in a map with dimensions of about 512 x 256.

3. Click the *Empty Data Constellations* component, then select vzstoresales.txt from the Available Data Pools list on the Properties and settings dialog box.
   
   In the Properties and settings dialog box, note that the data source is already available in the Available Data Pools list since you added it for the bar charts. Visual Discovery controls share the same data pool. If you want to add additional data, you can add more tables here.

4. Click *ActiveX Properties*. The Visual Discovery Data Constellations Properties dialog box opens.

5. In the Data tab, expand the data tree and select *City*.

6. Click *Apply*.

7. Click the *Data Constellations* tab, as shown in the following image. In the:
   
   - Label area, select the *Label selected* check box.
   - Node and Link Selection area, select *Nodes Only* and *No Linking*. This shows only the specific cities as data points (nodes) and does not link the nodes.
Uncheck **Show Unselected**. When the webpage runs, all the glyphs that are not selected are removed.

8. Click the **Nodes/Links** tab, as shown in the following image. In the Nodes area:
   - In the Label list, click **City**.
   - In the Height list, click **Revenue**.
   - Move the Scale slider to the right to increase node size.
This labels all of the data points (nodes) with the value in the City field and determines the height of the node from the value in the Revenue field. It also scales the nodes so that they are visible on the map.

9. Click the **Placement** tab. Add the map image and the coordinates for longitude and latitude. In the Position File input area, three distinct parameter strings are required, each separated by a space, as follows:

```
longfield, latfield 'imagepath' minmax1~ minmax2
```

where:

- **longfield, latfield**
  - Are the actual names in the data source for the fields that contain the X,Y (longitude and latitude) coordinates for the nodes, respectively.

- **'imagepath'**
  - Is the full path of the map image. Use the Browse button to enter this value.

- **minmax1~ minmax2**
  - Are the minimum X and Y (lower-left corner of the map) and maximum X and Y (upper-right corner of the map) values, separated by a tilde (~) and a space.

a. In the Position area, click the map position image (the first image in the second row).
b. Click *Browse* and navigate to the map file. In this example, we are using a file named *usMainlandDark-125.5+23.5-67+50.jpg*. Change the Files of type drop-down list to All Files, then copy this file to your current application from the \ibi\apps\session directory.

c. Click the *Position File* text box and preceding the image path, enter the field names for the X, Y (longitude and latitude) coordinates. Ensure there is a space between Latitude and the path designation. For example:

```
Longitude,Latitude 'C:\ibi\apps\session\usMainlandDark-125.5+23.5-67+50.jpg'
```

d. In the Position File text box, go to the end of the string. Add the minimum X and Y and maximum X and Y values. Ensure the values are separated by a tilde (~) and a space, for example:

```
Longitude,Latitude 'C:\ibi\apps\session\usMainlandDark-125.5+23.5-67+50.jpg'-125.5,23.5~ -67,50
```

The following image shows the Placement tab.

![Placement Tab](image-url)

10. Click the *Colors* tab. Confirm that Product Type is selected from the Field drop-down list for Color Using Field. This colors the nodes by the values in the Product Type field.
11. Click the 3D tab, as shown in the following image. Select Parallel from the Projection field.

12. Click the Fonts tab.
   For Label Font, click the Font button and set Size to 9.

13. Click the Titles tab and for the Title Text, enter Revenue by City.
   Confirm that Show view title is checked.

14. Click Apply, and then click OK. Save your work.

15. Access the Properties pane on the right. From the drop-down list, select activex3 <OBJECT>, if not already selected.
   Specify the following values and then save your work:
   - Name: vzMap
   - Position: Left: 10px
   - Position: Top: 325px
   - Size: Height: 365px
   - Size: Width: 605px
   - Unique Identifier: vzMap
16. Save your work.

17. Run the webpage. The output should look similar to the following image.

18. Close the webpage to return to HTML Composer.

19. To enable handles on the map, which allows you to rotate the image during run time, change the data constellation 3D projection setting to Perspective.

To change the 3D projection setting:

- Run the form.
Right-click on the map and click *Properties*.

Click the 3D tab, and then click the *Perspective* radio button.

Drag the handles at the corners of the map to rotate the image.

**Procedure: How to Create the Pie Chart**

1. Insert another Visual Discovery control and click *Visual Discovery Pie Chart*.
2. Click the *Empty Pie Chart* component, and then select vzstoresales.txt from the Available Data Pool list.
3. Click *ActiveX Properties*.
4. In the Data tab, expand the data tree and click:
   - Once on *Product Type* so an X appears in the box. This is the x-axis field.
   - Twice on *Revenue* so a Y appears in the box. This is the y-axis field.
5. On the Pie Chart tab:
   - Set Rotation to 45.
   - Set the Labels Shown list to *All*. 
The following image shows the Pie Chart tab.

![Visual Discovery Pie Chart Properties](image)

6. Click the Titles tab and change the Title Text to *Revenue by Product Type*. Confirm that the following is checked: Show view title.

7. Click Apply, and then click OK.

8. Save your work.

9. Access the Properties pane on the right. From the drop-down list, click `activex4 <OBJECT>`, if not already selected. Specify the following values and then save your work:

- **Name:** `vzPie`
- **Position:** Left: `570px`
- **Position:** Top: `70px`
- **Size:** Height: `245px`
- **Size:** Width: `250px`
- **Unique Identifier:** `vzPie`
10. Run the webpage. The output should look similar to the following image.

11. Close the page to return to HTML Composer.

**Procedure: How to Create the Summary Sheet**

1. Insert another Visual Discovery control and click **Visual Discovery Summary Sheet**.
2. Click the **Empty Summary Sheet** component, and then select vzstoresales.txt from the Available Data Pool list.
3. Click **ActiveX Properties**, and then click the **Data** tab.
4. Click **Sales Rep** as the x-axis field. Click **Revenue** as the y-axis field.
5. Click the **Summary Sheet** tab. Click **Revenue** from the Sort By drop-down list and click **Reverse Sort By**.
The following image shows the Summary Sheet tab.

6. Click the Titles tab and remove any titles from the summary sheet.
7. Click Apply, and then click OK.
8. Save your work.
9. Access the Properties pane on the right. From the drop-down list, click activex5 <OBJECT>, if not it is already selected.

Specify the following values:

- Name: vzSummary
- Position: Left: 620px
- Position: Top: 325px
- Size: Height: 365px
- Size: Width: 305px
- Unique Identifier: vzSummary

10. Save your work.
11. Run the webpage. The final output should look similar to the following image.

![Diagram of chart controls](image)

12. Close and save the page.

**Building an Application With Advanced Chart Controls**

This section of the tutorial illustrates how to build a sample chart control interface that allows the manipulation of information on the HTML page during run time. The chart controls are applied to the sample page, vzMySales.htm, using Visual Discovery controls and JavaScript API.

For more information on the JavaScript API, see the Using WebFOCUS Visual Discovery to Develop Analytic Dashboards manual.
The final output should look similar to the following image:

---

**Procedure:** How to Create a Visual Discovery Control Panel Menu Bar

1. From the Insert menu, click Controls, then click Group Box.

2. Drag your cursor across the top of the canvas. A group box appears.

3. Delete the Group Box text by right-clicking the words Group Box and selecting Delete.

4. Access the Properties menu pane on the right. If needed, select Properties from the View menu.

   Make sure that `groupbox1 <FIELDSET>` is the selected property in the Properties menu pane, then click the Styling: Advanced (CSS) ellipsis button.

5. From the options on the left, click Background, then click Silver from the color drop-down list in the Background color section.

6. From the options on the left, click Position. Specify the attributes as follows:

   - Top: 10px
   - Left: 15px
7. Click **OK** and save your work.
8. From the **Insert** menu, click **Components**, then click **Line**.
9. Drag your cursor within the group box to draw the line.
10. Access the Properties menu pane on the right. If needed, click **Properties** from the View menu.
    
    Make sure that *line1* is the selected property in the Properties menu pane, then click the **Styling: Advanced (CSS)** ellipsis button.

11. From the options on the left, click **Background**, then select **Gray** from the color drop-down list in the Background color section.

12. From the options on the left, click **Position**. Specify the attributes as follows:

    - **Top**: 0px
    - **Left**: 240px
    - **Height**: 54px
    - **Width**: 2px

13. From the options on the left, click **Edges**. In the Borders section, specify the attributes as follows:

    - **Style**: *Inset*
    - **Width**: *Thin*

14. Click **OK** and save your work.

15. Create another line by repeating steps 8 through 13 in this procedure. When you create the second line, note the following:

    - The selected property in the Properties menu pane should now be *line2*.
    - The positioning will be as follows:

        - **Top**: 0px
        - **Left**: 690px
        - **Height**: 54px
16. When the second line is inserted, save your work and run the webpage.
17. Close the webpage and return to HTML Composer.

**Procedure: How to Create a Drop Down List Control for Selector Shapes**

This procedure adds a Drop Down List control to the menu bar, which can be used to set the way the mouse selects data graphically at run time. This applies to non-3D components only.

1. From the Insert menu, click **Controls**, then click **Drop Down List**.
2. Drag your cursor within the group box. The drop-down list appears.
3. Access the Properties menu pane on the right. If needed, select **Properties** from the View menu.

Make sure that `combobox1 <SELECT>` is the selected property in the Properties menu pane. Set these attributes as follows:

- **Name:** `cboSelection`
- **Position:** Left: `5px`
- **Position:** Top: `25px`
- **Size:** Width: `100px`
- **Styling:** Font: `Arial 8pt`
- **Unique Identifier:** `cboSelection`
4. Click the **Parameters** tab located in the lower-left corner of the HTML Composer window.

The Properties and settings dialog box appears.

**Note:** For the steps below, it is important that you make sure that *cboSelection <SELECT>* is the selected property in the Properties menu pane before you open the Parameters window. If it is not selected, you can select it from the drop-down menu at the top of the Properties menu. If it does not appear in the drop-down menu, you need to refresh the menu. You can do this by clicking anywhere on the active form, then back on the Properties menu pane.

5. Click **Static** from the Data Type radio button area.
6. Click the New button, and add the following options:

<table>
<thead>
<tr>
<th>Value</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Rectangle</td>
</tr>
<tr>
<td>1</td>
<td>Lasso</td>
</tr>
<tr>
<td>2</td>
<td>Circle</td>
</tr>
<tr>
<td>3</td>
<td>Rectangular brush</td>
</tr>
<tr>
<td>4</td>
<td>Circular brush</td>
</tr>
</tbody>
</table>

The following image shows the Properties and settings box with the newly added options.

7. Return to the Design view by clicking on the Design tab located in the lower-left corner of the HTML Composer window.

8. Click the Events tab located at the bottom of the Properties toolbox pane.

9. To add an event to the drop-down list whenever you select an option at run time, select the event `onchange` and click the ellipsis button.
10. Add the code below to the cboSelection_onchange function and then save your work.

```javascript
//VzSelectorShapeEnum
/*Shape         Value     Description
------------------------------------
VzSelRectangle    0       Rectangle
VzSelLasso        1       Lasso
VzSelCircle       2       Circle
VzSelRectBrush    3       Rectangular brush
VzSelCircleBrush  4       Circular brush
*/
var vzBarOne = document.getElementById('vzBarOne');
var varSelected = ctrl.options[ctrl.selectedIndex].value;
vzBarOne.SelectorShape = varSelected;
```

**Note:** The steps above added JavaScript code to the project. For more information on JavaScript standards and best practices, see the *Using WebFOCUS Visual Discovery to Develop Analytic Dashboards* manual.

11. Return to the design view by selecting the Design tab and return to the Properties menu pane by selecting the Properties tab at the bottom of the Properties toolbox pane.

12. From the Insert menu, click Components, then click Text.

13. Drag your cursor within the group box. The text appears.

14. Double-click inside the text object. Enter the text **Selector shape**.

15. Access the Properties menu pane on the right. If needed, click Properties from the View menu.

Make sure that text1 `<SPAN>` is the selected property in the Properties menu pane. Set these attributes as follows:

- Position: Left: 5px
- Position: Top: 8px
- Size: Height: 28px
- Size: Width: 100px
- Unique Identifier: txtSelector

16. Save your work, then run the webpage.
**Note:** The selector shape control allows you to choose portions of the Visual Discovery controls during run time, through use of different shape selection options. With the HTML page open, click *Circle*, in the Selector shape drop-down list. Drag your cursor across the pie chart. Notice the selection you choose is selected in a circular shape.

**Procedure:** How to Create a Drop Down List Control to Color By Fields

This procedure adds a Drop Down List control to the menu bar, which can be used to color any table in the data pool by the specified field at run time.

1. From the Insert menu, click *Controls*, then click *Drop Down List*.
2. Drag your cursor within the group box. The drop-down list appears.
3. Access the Properties menu pane on the right. If needed, click *Properties* from the View menu.

   Make sure that *combobox2 <SELECT>* is the selected property in the Properties menu pane. Set these attributes as follows:

   - **Name:** *cboColorBy*
   - **Position:** Left: 115px
   - **Position:** Top: 25px
   - **Size:** Width: 100px
   - **Styling:** Font: *Arial 8pt*
   - **Unique Identifier:** *cboColorBy*

   **Note:** For the steps below, it is important that you make sure that *cboColorBy <SELECT>* is the selected properly in the Properties menu pane before you open the Parameters window. If it is not selected, you can select it from the drop-down menu at the top of the Properties menu. If it does not appear in the drop-down menu, you need to refresh the menu. You can do this by clicking anywhere on the active form, then back on the Properties menu pane.

4. Click the *Parameters tab* located in the lower-left corner of the HTML Composer window.

   **Note:** The Properties and settings dialog appears, if not, select *View* in the HTML Composer menu bar, and then click *Properties and settings*.

5. Click *Static* from the Data Type radio button area.
6. Click the **Values are VisDis Color By** check box at the bottom of the dialog box.

7. Click the **New** button chart control drop-down list, select **Visual Discovery ActiveX**, and choose the following options from the cascading menus:
   - Select **vzBarOne**, then **Store Name**.
   - Select **vzBarTwo**, then **Region**.
   - Select **vzPie**, then **Product Type**.

The following image shows the cascading menu options of the Properties and settings dialog box.

8. Return to the Design view by clicking on the **Design** tab located in the lower-left corner of the HTML Composer window.

9. On the Insert menu, click **Components**, then click **Text**.

10. Drag your cursor within the group box. The text appears.
11. Double-click inside the text object. Enter the text \textit{Color by Field}.

12. Access the Properties menu pane on the right. If needed, click \textit{Properties} on the View menu.

Make sure that \textit{text2 <SPAN>} is the selected property in the Properties menu pane. Set these attributes as follows:

- Position: Left: 115px
- Position: Top: 8px
- Size: Height: 28px
- Size: Width: 100px
- Unique Identifier: \textit{txtColorBy}

13. Save your work, then run the webpage.

\textbf{Note:} The Color by Field control allows you to select a field in run time, and color the Visual Discovery controls on the page based on the field you choose. With the HTML page open, click \textit{Region}, in the Color by Field drop-down list. Notice Visual Discovery controls on the page change color according to the region data. The same can be repeated for Store Name and Product Type.

\textbf{Procedure:} \textbf{How to Create a Push Button Control That Hides Excluded Items}

This procedure adds a Push Button control to the menu bar that omits unselected items from the current display.

\textbf{Note:} This method is different from excluding. When you hide unselected items, the data is still present in other views. It would not be if excluded.

1. From the Insert menu, click \textit{Controls}, then click \textit{Push Button}.
2. Drag your cursor within the group box. The push button appears.
3. Access the Properties menu pane on the right. If needed, select \textit{Properties} from the View menu.

Make sure that \textit{button1 <INPUT>} is the selected property in the Properties menu pane. Set these attributes as follows:

- Name: \textit{btnHide}
- Position: Left: 705px
4. Right-click *Hide Unselected* and click *Create Hyperlink*.

5. In the Hyperlink properties dialog box, click the *New* button.

6. Click *Visual Discovery Exclude* from the Action drop-down list, then the *vzstoresales* data pool from the Source drop-down list.

   The following image shows Visual Discovery Exclude and vzstoresales selected in the Hyperlink Properties dialog box.

7. Save your work, then run the webpage.
**Procedure:** How to Create a Push Button Control That Toggles Actively Selected Items

This procedure adds a Push Button control to the menu bar that toggles the actively selected items. Selected items become unselected, and the unselected items become selected.

1. From the Insert menu, select Controls, then click Push Button.
2. Drag your cursor within the group box. The push button appears.
3. Access the Properties menu pane on the right. If needed, click Properties from the View menu.

   Make sure that button2 <INPUT> is the selected property in the Properties menu pane. Set these attributes as follows:

   - Name: btnToggle
   - Position: Left: 835px
   - Position: Top: 20px
   - Size: 15px
   - Size: Height: 25px
   - Size: Width: 75px
   - Styling: Font: Arial 8pt Bold
   - Unique Identifier: btnToggle
   - Value: Toggle

4. Click the Events tab located at the bottom of the Properties toolbox pane.
5. To add an event to the button whenever it is clicked, select the event onclick and click the ellipsis button.
6. Add the code below to the btnToggle_onclick function and then save your work.

   ```vz
   vzBarOne.Command(7117, ",", 0, 0); //***Toggle Unselected
   ```
7. Return to the design view by selecting the Design tab and return to the Properties menu pane by selecting the Properties tab at the bottom of the Properties toolbox pane.

8. Save your work, then run the webpage.

**Note:** The Toggle button allows you to switch views between selected data of a Visual Discovery control and the unselected data. With the HTML page open, click Video in the pie chart. Click Toggle and notice that the unselected data in the controls are selected. Click Toggle again then notice that the Video data is selected.

**Procedure: How to Create a Push Button Control to Refresh Components**

This procedure adds a Push Button control to the menu bar that refreshes all components on the page to their original state.

1. From the Insert menu, click Controls, then click Push Button.
2. Drag your cursor within the group box. The push button appears.
3. Access the Properties menu pane on the right. If needed, click Properties from the View menu.

Make sure that button3 <INPUT> is the selected property in the Properties menu pane. Set these attributes as follows:

- Name: btnReset
- Position: Left: 920px
- Position: Top: 20px
- Size: 44px
- Size: Height: 25px
- Size: Width: 75px
- Styling: Font: Arial 8pt Bold
- Unique Identifier: btnReset
- Value: Reset
4. Click the Events tab located at the bottom of the Properties toolbox pane.

5. To add an event to the button whenever it is clicked, select the event onclick and click the ellipsis button.

6. Add the code below to the btnReset_onclick function and then save your work.

   ```javascript
   vzBarOne.Command(7112, "", 0, 0); //***Restore Excluded
   vzBarOne.Command(7115, "", 0, 0); //***Select All
   ```

**Note:** The steps above added JavaScript code to the project. For more information on JavaScript standards and best practices, see the Using WebFOCUS Visual Discovery to Develop Analytic Dashboards manual.

7. Return to the design view by selecting the Design tab and return to the Properties menu pane by selecting the Properties tab at the bottom of the Properties toolbox pane.

8. Save your work, then run the webpage. The HTML Page should look similar to the following image.
**Procedure:** How to Create Radio and Push Button Controls to Collect Data and Pass to a Report

This procedure adds a Radio Button control and a Push Button control to the menu bar. Each control generates a list of strings representing the labels displayed for the selected items. One displays an active report, and the other displays a PDF.

1. From the Insert menu, click Components, then click Text.
2. Drag your cursor within the group box. The text appears.
3. Double-click inside the text object. Enter the text *Make selections in the Bar and/or Pie charts*.
4. Access the Properties menu pane on the right. If needed, click Properties from the View menu.

Make sure that *text3 <SPAN>* is the selected property in the Properties menu pane. Set these attributes as follows:

- Position: Left: 255px
- Position: Top: 10px
- Size: Height: 35px
- Size: Width: 194px
- Unique Identifier: txtCollect

5. From the Insert menu click New Report, and drag your cursor across a blank area of the dashboard to draw a report container.
6. Right-click the report container, and click Reference existing procedure. The Get source file dialog box opens.
7. Click the *VZDashboard.fex* file and click Open.

**Note:** If you did not add the ibidemo folder directory when you first created your new project in HTML Composer, you must copy the file into your application folder. *VZDashboard.fex* can be copied from \ibi\apps\ibidemo.

8. In the New Parameters dialog box, click the ellipsis buttons under Control Type as follows:
PRODUCTTYPE. Select Existing control, then vzPie.

STORENAME. Select Existing control, then vzBarOne.

REGION. Select Existing control, then vzBarTwo.

9. Select Do not create a form from the Parameter grouping options section. The following image shows the New Parameters dialog box.

![New Parameters dialog box]

10. Click OK. A panel with the PDF icon and radio button appear on your dashboard.

11. From the Properties pane drop-down list, select radio1 <SPAN>.

The chart control Properties and Settings dialog box opens.

12. From the Properties and settings dialog box, click the New button to add a new control. Value2 appears below the PDF value.

13. Edit Value2 as follows:

- Name Value2, AHTML, under Value and Display.
- Click the ellipsis button under Display. Select format_ahtml_32.png and click Open.

An AHTML report icon and radio button appear next to the PDF icon and radio button.

**Note:** format_ahtml_32.png, should be copied from the \ibi\DevStudio81\ibi_html\javaassist\ibi\html\describe folder to your application folder.
14. Click the Parameters tab, at the bottom left of your screen.
   You must map the parameter names to the data pool fields properly to run the report selections properly.

15. Click the arrowhead under vzBarOne.
   A Properties and settings dialog box appears.

16. Click Store Name from the Use Value From drop-down list.

17. Repeat for vzBarTwo, and vzPie. Select:
   Region under vzBarTwo. Product Type under vzPie.

18. Select radio1 <SPAN> in the Properties pane, hold down the ALT key and drag the radio buttons up to the group box, next to the Make selections in the Bar and/or Pie Charts text.

19. Make sure that <radio1 <SPAN> is the selected property in the Properties menu pane. Set the attributes as follows:
   - Position: Left: 405px
   - Position: Top: 0px
   - Size: Height: 55px
   - Width: 205px

20. Select button4 <INPUT>, hold down the ALT key and drag the button up to the group box, next to the radio button selections.

21. Right-click button4 <INPUT>, and click Hyperlink properties.
   The Hyperlink Properties dialog box opens.

22. In the Hyperlink Properties dialog box, make the following changes:
   - Delete text from the Display Text field.
   - Select Window from the Target Type drop-down list.
   - Select New Window from the Target/Template Name drop-down list.
The following image shows the Hyperlink Properties dialog box.

![Hyperlink Properties dialog box](image)

23. Make sure that `button4 <INPUT>` is the selected property in the Properties menu pane. Set these attributes as follows:

- Name: `btnRun`
- Position: Left: 626px
- Position: Top: 20px
- Size: 20px
- Size: Height: 22px
- Size: Width: 38px
- Unique Identifier: `btnRun`

24. From the Properties pane drop-down list, select `panel1 <SPAN>` and press Delete on your keyboard. Repeat for `report1 <IFRAME>`.
25. Save your work, then run the webpage. The final output should look similar to the following image.

26. Make selections in the bar and pie charts, then select the desired output format, PDF or AHTML, and click the Run button.

The values from the charts are passed to the report. The report contains the selected data only.

**Note:** To accurately reflect the parameter values selected from the three charts, you must update the WHERE statements in the Vzdashboard.fex to use multi-select syntax.

To update the Vzdashboard.fex:

1. Make a backup copy of the Vzdashboard.fex file.
2. Comment out the following lines:

   ```
   WHERE (PRODUCTTYPE EQ '&PRODUCTTYPE');
   WHERE (STORENAME EQ '&STORENAME');
   WHERE (REGION EQ '&REGION');
   ```

Designing a User Interface for a Web Application With HTML Composer 613
3. Add the following multi-select WHERE statements:

```sql
WHERE PRODUCTTYPE EQ &PRODUCTTYPE.(OR(FIND PRODUCTTYPE IN CENTURYSALES)).;
WHERE STORENAME EQ &STORENAME.(OR(FIND STORENAME IN CENTURYSALES)).;
WHERE REGION EQ &REGION.(OR(FIND REGION IN CENTURYSALES)).;
```

4. Save the updated Vzdashboard.fex file.

5. Run the webpage. Now, when you make selections in the bar and pie charts, multiple parameters can be passed to the report.
HTML Composer provides a straightforward and precise method for controlling the display of multiple reports, graphs, images (such as corporate logos), and other Web objects in a single HTML form. HTML Composer makes it easy to layout report components to your exact specifications. You can develop report and graph procedures from HTML Composer. The reports and graphs are positioned on the HTML form based on your settings.

With HTML Composer, you can create a reporting application with procedures and HTML forms in one integrated process.

In this chapter:

- **HTML Composer Tutorial Overview**
- **Creating the Century Project**
- **Creating the Graph**
- **Creating the Layout and the Report**
- **Running the Reporting Application**

**HTML Composer Tutorial Overview**

In this tutorial, before you run your reporting application, you will:

- Create the Century project.
- Add Master Files to the project.
- Create a graph.
- Create a layout into which you will insert text, an image, a report, a frame for drill-down output, and selection parameters.
- Create and style a report.
- Drill down from the report to the graph.
Creating the Century Project

As an application developer for Century Corporation, your task is to create an application that contains reports about the sales metrics for all of the plants in the company. The report should include drill-down links that enable users to view a graphical display of data.

First, you will create a project called Century in the local projects area of the Developer Studio Explorer. This is where you access and create files. You will build your reporting application within this project.

**Note:** For details on how to create a project in the Developer Studio Explorer, see the *Creating Reporting Applications With Developer Studio* manual.

Add Master Files to Your Project

1. Click the Master Files folder under the Century project.

You will see a list of all Master Files in the path specified when you created the project.
Notice that the borders around each of the file icons in the Name column are dimmed. This indicates that the files are available, but not active for your project. In the following steps, you will associate the Master File required for the tutorial with the Century project.

2. Right-click CENTORD.MAS.

3. Select Add to Project from the menu.

The icon for this Master File is now active for your project and the border around this file icon is no longer grayed out.

4. Click the binoculars button to limit the list to the active Master Files.

**Tip:** You can view the full Master File list by clicking the binoculars button again.

### Add the CENTORD Data Source to Your Project

The Centord data source is not installed by default. For the purposes of this tutorial, you must add the data source to your project.

1. Click the Procedures folder under the Century project.
2. Click the binoculars button to show all .fex procedure files in this folder.
3. Right-click loadord.fex (scroll down to find this file) and select Add to Project.
4. Right-click loadord.fex and select Run.
Creating the Graph

A new browser window opens displaying the following message:

*Your request did not return any output to display*

This should confirm that the Centord data source has been added to your project.

5. Close the browser window.

**Creating the Graph**

Begin by creating a procedure that contains a graph. Later, you will add this graph to a frame in the HTML file and drill down to it from a report that you will soon create.

**Procedure: How to Create the Graph**

1. Right-click the Procedures folder under the Century project.
2. Select New, then select Procedure from the context menu.
   The Add Procedure dialog box opens.
3. Type STORSAL in the File name text box and verify that Procedure Files (*.fex) is selected from the Files of type drop-down menu.
4. From the Create with drop-down menu, select Procedure Viewer.
5. Click Create.
   The Procedure viewer window opens.
6. Click the diamond to the right of the default Comment component and select Graph from the component connector toolbar.
7. Select the CENTORD Master File and click Ok.
   InfoAssist opens.
8. Select the Format tab and click Other from the Chart group.
   The Other Chart Types window opens.
9. Select Lines from the Chart Types group.
   InfoAssist refreshes showing a sample absolute line chart.
10. From the Data panel, double-click Line, Total to add it to Measure (Sum) in the Query panel.
11. From the Data panel, double-click Store, Name to add it to X-Axis in the Query panel.
12. Select Product, Name in the Data panel, then drag the field into the Multi-graph heading in the Query panel.
13. Click Save.
**Procedure:  How to Create a Heading for the Graph**

Adding a heading to your graph provides important information to describe the data you want to display. You can add headings and footings for your graph by clicking the Heading & Footing button, located in the Home menu. In this tutorial, you will add a heading.

1. Click the Home tab, if it is not already selected.
2. Click the **Header & Footer** button.
   
   The Header & Footer dialog box opens. Page Header is selected by default
3. Type **Sales of** and leave a space.
4. Drag **PRODNAME** from the Field list into the Header & Footer dialog box.
   
   <CENTORD.INVSEG.PRODNAME is added to the Heading.
5. Place the cursor after <PRODNAME and leave a space.
6. Type **for Each Store**.

   Your header will look like the following: **Sales of**<PRODNAME for Each Store
7. Click **Apply** then **OK** to apply and close the Heading dialog box.

**Procedure:  How to Limit Graphed Data**

You can limit the data displayed in a report or graph by adding a filter. Here you will create a statement that limits the data in the graph to a certain product. You will enter this criteria as a parameter, and use the parameter later in the tutorial when you set the drill-down option for the report.

1. Click the **Data** tab.
2. Click the **Advanced** button from the Filter group to view the Advanced Filter expression builder.
3. In the Advanced Filter expression builder:
   - Click the New Filter button.
   - From the Field drop-down list, select Product, Name.
   - Select Equal to from the Logical Relation drop-down list. Equal to is the default value.
   - From the Value drop-down change the Type to Parameter.
   - Change the Parameter to Static.
   - Type PNAME in the Name field.
   - Type Product Description in the Description field.
   - Select the Get Values button and click All.
     The box beneath the Get Values button is populated by data from the Product, Name field.
   - Select all values in the now populated box and move them to the Multiple Values box by clicking ➔.
   - Check the Select multiple values at run-time box.

4. Click OK to save your filter.
Creating the Layout and the Report

Here you will create the layout for the project and add elements to it, such as text, background color, reports, images, and a target frame for the drill-down output. You will also customize the parameters and rearrange the items in your layout.

For the report (which you will create directly from the layout), you will add calculated values, Where statements to limit the data in the report, and drill-down capabilities. You will also style the report with color, borders, and a page heading.

Procedure: How to Create the Report Layout

Complete the following steps to create a Layout procedure called PRODREP.

1. Right-click the HTML Files folder under the Century project.
2. Select New, then select HTML File from the context menus.
   The Add HTML dialog box opens.
3. Type PRODREP in the File name text box.

   ![Add HTML File dialog box]

   Note: Composer is selected as the default.

4. Click Create.
HTML Composer opens, as shown in the following image.

Procedure: How to Add Text and Color to the Layout

Add a heading to your application, style the heading, and add a background color.

1. Click the Insert Text button  
   
   Your mouse pointer will change to crosshairs.
2. Drag the crosshairs to create a rectangular text box.
   
   You can resize the box after you enter and style the text.
3. Click on the box and type Century Corporation Report and Graph.
4. Click anywhere outside of the heading text box, then right-click the text box and select Style from the context menu.
   
   The Style Composer dialog box opens with Font highlighted in the list at the far left.
5. To set the font type, in the Font name area, select the Family option, then click the ellipsis button to the right. The Font Picker dialog box opens, select Arial in the installed fonts area, click the right arrow to move Arial to the Selected fonts area, and click OK.
6. To set the font style, select Bold from the Absolute drop-down list in the Bold area.
7. To set the font size, in the Size area, select px from the Specific drop-down list and type 16 in the input area to the left.
8. To set the font color, select Navy from the Color drop-down list in the Font attributes area.
9. To set the text alignment, select Text below Background in the list at the far left, then select Centered from the Horizontal drop-down list in the Alignment area.

This centers the heading text horizontally within the text box.

10. To set the heading background color, select Background below Font in the list at the far left, then select the Transparent option below the Background color menu.

This allows the light color you will select for the background color to show through the heading.

11. Click OK to close the Style Composer.

12. Resize the heading text box as necessary by clicking and dragging the borders.

13. To set the background color for the HTML page, select BODY from the top drop-down list in the Properties tab of the Properties bar.

14. Click once in the empty field to the right of Background color, then click the ellipsis button that appears at the far right of the empty field.

The Color Picker dialog box opens.

15. Select any light color and click OK.

The following image shows how HTML Composer should appear at this point, depending on the size of your text box.

![HTML Composer Image]

**Procedure:** How to Create a Report From the Layout

You will now create the report in Report Painter which is accessed directly from HTML Composer.
1. Click the Report button.
   The mouse pointer changes to crosshairs.

2. Drag the crosshairs and create a report area placeholder.

   **Note:** You can resize and reposition the report placeholder at any time.

3. Double-click the report placeholder.
   The Open dialog box opens.

4. Select the CENTORD Master File and click Ok.
   Report Painter opens.

   **Note:** To change the Object Inspector to Field Tree view, right-click in the Object Inspector and select Show Field Tree.

5. Double-click the following fields in the Object Inspector Fields tab to add them to the report:
   - PRODNAME (in the INVSEG directory)
   - LINEPRICE (in the PINFO directory)
   - LINE_COGS (in the INVSEG directory)

6. Select the Product Name field and click the By button on the toolbar. This sorts all of the data vertically by product name.

7. Select the Line Total column and click the Sum button. This sums the data in the Line Total column.

   The following image shows how the new report should appear at this point.
**Procedure: How to Add a Calculated Value to the Report**

Continue creating your report by adding a calculated value, called PROFIT. This field is created using a calculation with two existing fields in the CENTORD data source, LINE_PRICE and LINE_COGS.

1. Select *Computes* from the Report menu, or click the *Computes* button from the Setup toolbar. The Report Options dialog box opens at the Computes tab.

2. Type `PROFIT` in the input area labeled Field.

3. Type `D4.2` in the input area labeled Format.

   **Tip:** In this case, you know the exact format you want for this field. If you are unsure of the format and want to see all available formats, click the *Format* button to access the Format dialog box.

4. Place the cursor in the box below the input area labeled Field.

5. Create the following expression: 
   
   ```
   (CENTORD.PINFO.LINEPRICE / CENTORD.INVSEG.LINE_COGS) - 1.
   ```

   To create this expression:
   - Click the *Fields* button.
   - Double-click `LINEPRICE` in the CENTORD field list box.
   - Click the forward slash (/) on the Report Options calculator.
   - Double-click `LINE_COGS` in the CENTORD field list box.
   - Highlight the statement and click the double parentheses ( ).
   - Click the minus (-) sign and then the number 1.
The following image shows how the Report Options expression should appear.

6. Click OK.

The new column PROFIT is added to the Report Painter window.

7. Select the PROFIT column and then click the Sum button.

8. Right-click the PROFIT column and select Column Title.

9. Change the title by typing Profit Margin.

10. Click OK.

The following image shows how the report should appear at this point.
**Procedure:** How to Limit the Data to a Selected Plant and Year

You will now create a list of acceptable values for the plant location and the year. These are the values the user will be able to select when they are using this application. Later, you will use each set of values you create here to run a parameterized report.

To do this, you will need to create two Where statements.

1. Click the `Where/If` button on the toolbar.
   The Report Options dialog box opens at the Where tab.

2. Click Where.
   The Expression Builder opens.

3. To create the first Where statement:
   - From the Fields list, double-click `PLANT` (under Location Dimension).
   - From the Logical Relation drop-down list, select `equals`.
   - In the Compare Type box, select `Parameter`.
   - Double-click the Compare Value box to open the Variable Editor.

4. In the Variable Editor:
   - For Name, type `LOCATION`.
   - In the Prompt input field, type `Please select a Plant`.

5. From the Variable Type drop-down list, select `Multiselect OR`.

6. In the Data Context area, select `Values for field`.

7. Click the `Select a field` ellipsis button to get values for the PLANT field. The Value Retrieval dialog box opens.
   The Value Retrieval dialog box provides a list of available fields in your data source. Double-click the `PLANT` field to close the Value Retrieval dialog box and return to the Variable Editor. The available values for the PLANT field are listed.

8. Double-click each of the following values (`BOS, DAL, LA, ORL, SEA, STL`) to add them to the Accept List.
The following image shows the Variable Editor populated with the values you selected.
9. Click OK to close the Variable Editor.

The following image shows the Expression Builder populated with the values you selected.

10. To create the second Where statement:

- From the Fields list, double-click YEAR (under the Time Period Dimension).
- From the Logical Relations drop-down list select equals.
- In the Compare Type box select Parameter.
- Double-click in the Compare Value box to open the Variable Editor.

11. In the Variable Editor:

- For Name, type YRVAL.
- In the Prompt input field, type Please select a Year.

12. From the Variable Type drop-down list, select Multiselect OR.

13. In the Data Context area, select Values for field.
14. Click the `Select a field` ellipsis button to get values for the YEAR field. The Value Retrieval dialog box opens.

The Value Retrieval dialog box provides a list of available fields in your data source. Double-click the YEAR field to close the Value Retrieval dialog box and return to the Variable Editor. The available values for the YEAR field are listed.

15. Double-click each of the following values (2000, 2001, 2002) to add them to the Accept List. The following image shows the Variable Editor populated with the values you selected.

16. Click OK to close the Variable Editor.

17. Click OK to close the Expression Builder.

**Procedure: How to Create a Page Heading for the Report**

Now you will create a page heading for the report. Page headings appear at the top of every report page.

1. In the Report Painter window, click the Page Heading button on the toolbar.

2. Double-click YEAR in the Object Inspector Fields tab.

   The embedded field `<YEAR` appears in the Page Heading area.

3. After the `<YEAR` field, type `Sales Metrics for All Products`.  

   ![Variable Editor](image)
4. Press the Enter key.

5. Type *For the* followed by one space.


7. Move the cursor into the Page Heading area after <PLANTLNG and type *Plant*.

The following image shows how the report should appear at this point.

8. Highlight the second line of text in the heading.

9. From the Font toolbar, select the following font attributes:
   - For font type, select *Arial*.
   - For font style, select *Bold*.
   - For font size, select *10*.

10. Right-click in the *Page Heading* area and select *Options*.

    The Properties for Page Header dialog box opens.

11. Select the *Style* tab, then click the *Single Color* option in the Background Coloring section.

12. Click the *Select Colors* button and choose a color from the color palette.

13. Click the *Justification* drop-down list and select *Center*.

14. Click *OK* to close the Properties for Page Header dialog box.

**Procedure: How to Style Your Report**

You will now style the report by adding alternating row colors to the report data and a border around the heading.

1. From the Report menu, select *Styling*.

2. Select *Data* from the active object drop-down list.
Creating the Layout and the Report

The following image shows the Report Options dialog box populated with the values you selected.

3. In the Background Color area, select the *Alternating Colors* option.
4. Click *Select Colors*.

   The Choose Background Colors dialog box opens.

5. Leave the first color as the default selection of white.
6. Select the *Second Color* check box and select the second color.
7. Select the *Alternate On A By Field* check box.
8. Select the PRODNAME field.

The following image shows the Choose Background Colors dialog box.

![Choose Background Colors dialog box]

9. Click OK to close the Choose Background Colors dialog box.

10. Click Apply to apply your selection.

   Leave the Report Options dialog box open to add a border to the heading.

11. In the Report Options dialog box, select Heading from the active object drop-down list.

12. In the Graphical area, click Select Borders.

13. Deselect the Make all borders the same check box.

14. In the Top Border area, select:

   - Medium for width.
   - Dotted for style.
   - Black for color.

15. In the Bottom Border area, select the Same as Top Border check box.
16. In the Left Border and Right Border areas, select OFF from the Width drop-down lists. The following image shows the Border dialog box populated with the selected values.

17. Click OK to close the Borders dialog box.

18. Click Apply in the Report Options dialog box, then click OK.

**Procedure: How to Set Up the Drill-Down Report**

Now you will set up this report so you can drill down from the data in the Product Name column to the STORSAL graph you created earlier. Drill down on the Product Name field, so the information you see in the resulting graph will be specific to that product.

1. In Report Painter, right-click the Product Name column and select Options.
   
   The Field Properties dialog box opens.

2. Click the Drill Down tab.

3. In the active object drop-down list, select Column Data.

4. In the Drill Down Type drop-down list, select Execute Procedure.

5. Click the Procedure Name Browse button, select STORSAL.fex from the Open dialog box, and click Open.
6. In the Target Frame area, type `graphframe`.

7. In the With Parameters area, click `Add`.

   The Drill Down Parameter dialog box opens.

8. Type `PNAME` in the Parameter Name input box.

   `PNAME` is the parameter you created in the STORSAL procedure.

9. In the Parameter value area, select the `Field` option.

10. Select the `PRODNAME` field from the drop-down list in the Parameter value area.

11. Click `OK` to close the Drill Down Parameter dialog box.
The following image shows the Field Properties dialog box populated with the values you selected.

12. Click OK to close the Field Properties dialog box.

13. Select Close from the File menu to close Report Painter.

14. When you are prompted to save your changes, click Yes.

   You are returned to HTML Composer, and the New Parameters dialog appears.

15. Click OK to automatically add your parameters to the HTML page.
The following image shows how HTML Composer should look at this point.

![HTML Composer interface](image)

**Procedure: How to Customize Parameters**

You will now customize the Plant (LOCATION) parameter by modifying the value from the data source to make it more user-friendly. You will also change the control type for the Year (YRVAL) parameter from a list box to a radio button, rearrange the order of values, and change the default value.

1. In HTML Composer, select the **Parameters** tab.
   
   The Properties and settings dialog box opens, showing a Legend of the available controls for the parameters on the HTML page.

2. Click the list box control (Input control `listbox1`) associated with the LOCATION parameter.
3. Change the control type to a drop-down list by right-clicking the LOCATION list box control (Input control listbox1) and select Drop down list from the Set Control Type context menu.

4. From the Properties and settings dialog box, double-click each of the values in the Display column and type the full city name, as indicated below:

- Change BOS to Boston
- Change DAL to Dallas
- Change LA to Los Angeles
- Change ORL to Orlando
- Change SEA to Seattle
- Change STL to St. Louis

This changes the display name in the drop-down list from the value stored in the data source to the values you specify.

5. To make Boston the default selection, click the Boston check box in the Selected column.
6. Click the list box control (Input control `listbox2`) associated with the YRVAL parameter.

7. Change the control type to a Radio button by right-clicking the YRVAL list box control (Input control `listbox2`) and select `Radio button` from the Set Control Type context menu.
8. From the Properties and settings dialog box, drag and drop the Year values so they appear in descending order.

or

Select a year and use the up/down arrows above the Static Values area to change the order of the years.

9. To make 2002 the default selection, click the check box in the Selected column for the 2002 value.

The following image shows how the YRVAL Radio button settings should appear.

10. Close the Properties and settings dialog box for the YRVAL Radio button.

11. Switch to the Design tab to view the Parameter changes on the HTML page.

**Procedure:** How to Create the Target Frame For Drill-Down Output

You will now add an output target frame that will contain the graph output from the main report when a user selects a drill-down link. The frame is invisible to the user until a drill-down link is selected.

1. In HTML Composer from the Insert menu, select Components, then select Frame.

   Your mouse pointer changes to crosshairs.

2. Scroll down past the report placeholder to insert the frame by dragging the crosshairs to form a rectangular box just below the report area.
3. Click anywhere inside the frame you inserted and view the Properties window. The properties associated with the new frame are displayed in the Properties window.

4. Double-click the iframe1 value in the right column next to Name in the left column of the Properties tab. Replace this value by typing graphframe which is the same Target Name entered in the Drill Down tab. For more information, see How to Set Up the Drill-Down Report on page 634.

**Procedure: How to Reorganize the Layout and Add an Image**

Now you will move some items around in HTML Composer and add an image.

1. Rearrange the heading, the Please select a Plant prompt and selection box, and the Please select a Year prompt and option buttons so the report page in HTML Composer appears like the following image.

2. Click the new frame and grab the handles to resize it to almost the same size as the report placeholder.
Creating the Layout and the Report

This frame will contain graph output when a user clicks a drill-down link in the report.

3. Press the Ctrl key and click the report placeholder and then the frame placeholder.

4. Click the Make same size button.

5. Click the Align right button.

6. Click the Insert image button.
   The cursor changes into a crosshair.

7. Drag the crosshair to create a rectangular image box below the bottom-left corner of the new frame.
   The Get source file dialog box opens.

8. Select the following from the drop-down box:
   a. Developer Studio Desktop
   b. Window's Desktop
   c. My Computer

9. Navigate to the following directory (where install_dir is most likely the C directory):
   \install_dir:\ibi\apps\ibinccen\images\powered.gif

10. Click Open.
    The powered.gif image is added to your report layout.

11. Pressing the Ctrl key, click the image and then the frame.

12. Click the Relate Bottom Left button.
    This ensures that the image always appears in relation to the bottom-left corner of the frame, regardless of the size of the frame.

13. From the File menu, select Save.
The following image shows the completed reporting application. Your report layout will appear somewhat different depending on the size and location of the components you added to the `PRODREP.htm` file.

14. From the File menu, select Close.

**Running the Reporting Application**

You have completed developing your reporting application. Now you can run it.

**Procedure: How to Run Your Reporting Application**

1. From the Projects area, open the `HTML Files` folder in the Century project.
2. Right-click the `PRODREP.htm` file and select Run.
Note: You can run your reporting application directly from HTML Composer by opening the PRODREP.htm file and clicking Run.

The following image shows how the completed reporting application should appear when you click Run.

3. Select a plant location and a year, then click the submit report button.
The report appears.

4. Click a link in the report and the graph output appears below the report.
The following image shows an example of how the graph output should appear.

Sales of 110 VHS-C Camcorder 20 X for Each Store
HTML Composer creates HTML reporting applications. You can use a mobile device to access HTML pages created with HTML Composer.

In this chapter:

- Using an HTML Composer Application on an iPad or iPhone
- Using an HTML Application on an Android Device

Using an HTML Composer Application on an iPad or iPhone

When you access HTML pages from the Safari® browser of the iPad® or iPhone®, the functionality of certain elements is restricted or altered. The following is a list of the known issues and considerations when using the iPad or iPhone.

- The display and functionality of double list controls is different. For more information, see Double List Controls on page 647.
- Use finger swipes on the iPad or iPhone to scroll with an HTML control that normally has scroll bars. For more information, see Scrolling on page 650.
- The functionality for slider controls is restricted. For more information, see Slider Controls on page 651.
- The functionality of chained controls is different. For more information, see Chained Controls on page 651.
- RIA pages and regular pages are supported on the iPad and iPhone.

Double List Controls

Columns in a double list control display the name of a selected value only if a single value is selected. If no values are selected, the column displays 0 Items and if more than one value is selected, the column displays n Items, where n is the number of values selected.
It is important to note that the number of items displayed refers only to the number of values that are selected, not all of the values in the column. To see all of the values currently in a column and to select more values, tap on a column and a pop-up menu appears, as shown in the following image.

Since columns do not display the names of all available values, you must tap on a column to select values. You can move values between columns in the same way, regardless of how the HTML page is accessed.

The following image shows the left column with no values selected and 0 Items displayed.
A column with no values selected does not mean that the column contains no values. The following image shows the pop-up menu for the left column. All of the values shown are contained in the column, but none are currently selected.

The following image shows the pop-up menu with England selected.

The following image shows the left column with England selected. The column displays the name of the selected value since there is only one value selected.
The following image shows the pop-up menu with England and France selected.

The following image shows the left column with England and France selected. The column displays 2 items since there is more than one value selected.

You can press the right arrow to move the selected values from the left column to the right column. In this example, England and France move from the left column to the right column. The left column now contains only the remaining values, as shown in the following image.

**Scrolling**

Elements that typically require scrolling do not utilize scroll bars on the iPad.
A frame that contains a report automatically expands to fit the entire report, depending on the Sizing and Scrolling property setting of the frame.

**Slider Controls**

Slider functionality is limited when you access an HTML page on the iPad or iPhone.

The slider bar on a slider cannot be used to slide the values up or down. To change the value, you must tap the end arrows to increase or decrease the selected number. The following image displays a slider control.

![Salary Select [25K - 100K]](image)

**Note:** A double tap in the Safari browser causes a zoom in. The iPad and iPhone interprets tapping the end arrows too quickly as a double tap and zooms in.

**Chained Controls**

The functionality of a chain of controls is not automatically triggered when a multi-select control is included in the chain. You must tap *Done* from the pop-up box of the multi-select control for the next control in the chain to populate. In the following image, the Done button is highlighted by a red box.
Using an HTML Application on an Android Device

When you access HTML pages from the Browser on an Android® device, the functionality of certain elements is restricted or altered. The following is a list of the known issues and considerations when using HTML Composer on Android devices.

- RIA pages and regular pages are supported using the native Browser on the Motorola Xoom tablet. The Motorola Xoom uses the Android 3.0 Honeycomb OS.

- Devices running the Android 2.2 OS do not support RIA pages.

- On devices running Android 2.2 OS, regular pages are supported in Mozilla Firefox® for Android but not the native Browser. This is because of an issue with XMLHttpRequest calls. The runtime for the RIA pages require both synchronous and asynchronous responses. The native Browser always sends these requests asynchronously, even if the call requests it to be synchronous.

Double List Controls

Double list controls in RIA pages behave similarly to double list controls in desktop browsers.

When an HTML report is run, all values are visible in the double list control. Double clicking a value will highlight and move it from list box1 to list box2 and vice versa.
This appendix describes which browsers support certain CSS properties.

**In this appendix:**
- CSS Support Matrix for Internet Explorer
- CSS Support Matrix for Firefox, Chrome, Safari, and Opera

### CSS Support Matrix for Internet Explorer

The following table is a list of all CSS properties and whether they are supported in Internet Explorer 9 and Internet Explorer 10.

<table>
<thead>
<tr>
<th>CSS3 Property</th>
<th>Internet Explorer 9</th>
<th>Internet Explorer 10</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Borders</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>border-radius</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>box-shadow</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>border-image</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td><strong>Background</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>background-size</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>background-origin</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td><strong>Animations</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>keyframes</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-name</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-duration</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td><strong>CSS3 Property</strong></td>
<td><strong>Internet Explorer 9</strong></td>
<td><strong>Internet Explorer 10</strong></td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>animation-timing-function</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-delay</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-iteration-count</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-direction</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-play-state</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>text-shadow</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>word-wrap</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>text-overflow</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>word-break</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>text-justify</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td><strong>2D and 3D Transforms</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>transform</td>
<td>ms-transform - only 2D</td>
<td>Supported - 2D and 3D</td>
</tr>
<tr>
<td>transform-origin</td>
<td>ms-transform - only 2D</td>
<td>Supported - 2D and 3D</td>
</tr>
<tr>
<td>transform-style</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>perspective</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>perspective-origin</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>backface-visibility</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td><strong>Fonts</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>font-feature-settings</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>hyphens</td>
<td>Not Supported</td>
<td>ms-hyphens</td>
</tr>
<tr>
<td>CSS3 Property</td>
<td>Internet Explorer 9</td>
<td>Internet Explorer 10</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>hyphenate-limit-zone</td>
<td>Not Supported</td>
<td>ms-hyphenate-limit-zone</td>
</tr>
<tr>
<td>hyphenate-limit-chars</td>
<td>Not Supported</td>
<td>ms-hyphenate-limit-chars</td>
</tr>
<tr>
<td>hyphenate-limit-lines</td>
<td>Not Supported</td>
<td>ms-hyphenate-limit-lines</td>
</tr>
</tbody>
</table>

**Multi Column Layout**

<table>
<thead>
<tr>
<th>Multi Column Property</th>
<th>IE 9</th>
<th>IE 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>columns</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-count</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-gap</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule-color</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule-style</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule-width</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-span</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-width</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>column-fill</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>break-after</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>break-before</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>break-inside</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>

**Transitions**

<table>
<thead>
<tr>
<th>Transition Property</th>
<th>IE 9</th>
<th>IE 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>transition</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-property</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-duration</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>
### CSS Support Matrix for Firefox, Chrome, Safari, and Opera

The following table is a list of CSS properties and whether they are supported in Firefox, Chrome, Safari, and Opera™ browsers.

<table>
<thead>
<tr>
<th>CSS3 Property</th>
<th>Firefox</th>
<th>Chrome</th>
<th>Safari</th>
<th>Opera</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Borders</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>border-radius</td>
<td>Supported - 4+</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>box-shadow</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>

#### CSS3 Property

<table>
<thead>
<tr>
<th>CSS3 Property</th>
<th>Internet Explorer 9</th>
<th>Internet Explorer 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>transition-timing-function</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-delay</td>
<td>Not Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>

**User Interface**

<table>
<thead>
<tr>
<th>CSS3 Property</th>
<th>Firefox</th>
<th>Chrome</th>
<th>Safari</th>
<th>Opera</th>
</tr>
</thead>
<tbody>
<tr>
<td>resize</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>border-box</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>outline-offset</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>appearance</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
</tbody>
</table>

**Gradients**

<table>
<thead>
<tr>
<th>CSS3 Property</th>
<th>Firefox</th>
<th>Chrome</th>
<th>Safari</th>
<th>Opera</th>
</tr>
</thead>
<tbody>
<tr>
<td>linear-gradient</td>
<td>Not Supported</td>
<td>Supported - ms-linear-gradient</td>
<td>Supported - ms-linear-gradient</td>
<td>Supported - ms-linear-gradient</td>
</tr>
<tr>
<td>radial-gradient</td>
<td>Not Supported</td>
<td>Supported - ms-radial-gradient</td>
<td>Supported - ms-radial-gradient</td>
<td>Supported - ms-radial-gradient</td>
</tr>
<tr>
<td>repeating-linear-gradient</td>
<td>Not Supported</td>
<td>Supported - ms-repeating-linear-gradient</td>
<td>Supported - ms-repeating-linear-gradient</td>
<td>Supported - ms-repeating-linear-gradient</td>
</tr>
<tr>
<td>repeating-radial-gradient</td>
<td>Not Supported</td>
<td>Supported - ms-repeating-radial-gradient</td>
<td>Supported - ms-repeating-radial-gradient</td>
<td>Supported - ms-repeating-radial-gradient</td>
</tr>
<tr>
<td>CSS3 Property</td>
<td>Firefox</td>
<td>Chrome</td>
<td>Safari</td>
<td>Opera</td>
</tr>
<tr>
<td>---------------</td>
<td>----------</td>
<td>----------</td>
<td>------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>border-image</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported - Safari 6 webkit-border-image</td>
<td>o-border-image</td>
</tr>
<tr>
<td>background-size</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>background-origin</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Animations</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>keyframes</td>
<td>Supported</td>
<td>webkit-keyframes</td>
<td>webkit-keyframes</td>
<td>Supported</td>
</tr>
<tr>
<td>animation</td>
<td>Supported</td>
<td>webkit-animation</td>
<td>webkit-animation</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-name</td>
<td>Supported</td>
<td>webkit-animation-name</td>
<td>webkit-animation</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-duration</td>
<td>Supported</td>
<td>webkit-animation-duration</td>
<td>webkit-animation</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-timing-function</td>
<td>Supported</td>
<td>webkit-animation-timing-function</td>
<td>webkit-animation</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-delay</td>
<td>Supported</td>
<td>webkit-animation-delay</td>
<td>webkit-animation</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-iteration-count</td>
<td>Supported</td>
<td>webkit-animation-iteration-count</td>
<td>webkit-animation</td>
<td>Supported</td>
</tr>
<tr>
<td>animation-direction</td>
<td>Supported</td>
<td>webkit-animation-direction</td>
<td>webkit-animation</td>
<td>Supported</td>
</tr>
<tr>
<td>CSS3 Property</td>
<td>Firefox</td>
<td>Chrome</td>
<td>Safari</td>
<td>Opera</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------</td>
<td>--------------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>animation-play-state</td>
<td>Supported</td>
<td>webkit-animation-play-state</td>
<td>webkit-animation</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>text-shadow</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>word-wrap</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>text-overflow</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>word-break</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>text-justify</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>2D and 3D Transforms</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>transform</td>
<td>Supported</td>
<td>webkit-transform - 2D and 3D</td>
<td>webkit-transform - 2D and 3D</td>
<td>Supported</td>
</tr>
<tr>
<td>transform-origin</td>
<td>Supported</td>
<td>webkit-transform-origin - 2D and 3D</td>
<td>webkit-transform-origin - 2D and 3D</td>
<td>Supported</td>
</tr>
<tr>
<td>transform-style</td>
<td>Supported</td>
<td>webkit-transform-style</td>
<td>webkit-transform-style</td>
<td>Not Supported</td>
</tr>
<tr>
<td>perspective</td>
<td></td>
<td>webkit-perspective</td>
<td>webkit-perspective</td>
<td>Not Supported</td>
</tr>
<tr>
<td>perspective-origin</td>
<td></td>
<td>webkit-perspective-origin</td>
<td>webkit-perspective-origin</td>
<td>Not Supported</td>
</tr>
<tr>
<td>backface-visibility</td>
<td>moz-backface-visibility</td>
<td>webkit-backface-visibility</td>
<td>webkit-backface-visibility</td>
<td>Not Supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fonts</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSS3 Property</td>
<td>Firefox</td>
<td>Chrome</td>
<td>Safari</td>
<td>Opera</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>----------------</td>
<td>-----------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>hyphens</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>hyphenate-limit-zone</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>hyphenate-limit-chars</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>hyphenate-limit-lines</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td><strong>Multi Column Layout</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>columns</td>
<td>moz-columns</td>
<td>webkit-columns</td>
<td>webkit-columns</td>
<td>Supported</td>
</tr>
<tr>
<td>column-count</td>
<td>moz-columns-count</td>
<td>webkit-column-count</td>
<td>webkit-column-count</td>
<td>Supported</td>
</tr>
<tr>
<td>column-gap</td>
<td>moz-columns-gap</td>
<td>webkit-column-gap</td>
<td>webkit-column-gap</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule</td>
<td>moz-columns-rule</td>
<td>webkit-column-rule</td>
<td>webkit-column-rule</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule-color</td>
<td>moz-columns-rule-color</td>
<td>webkit-column-rule-color</td>
<td>webkit-column-rule-color</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule-style</td>
<td>moz-columns-rule-style</td>
<td>webkit-column-rule-style</td>
<td>webkit-column-rule-style</td>
<td>Supported</td>
</tr>
<tr>
<td>column-rule-width</td>
<td>moz-columns-rule-width</td>
<td>webkit-column-rule-width</td>
<td>webkit-column-rule-width</td>
<td>Supported</td>
</tr>
<tr>
<td>column-span</td>
<td>Not Supported</td>
<td>webkit-column-span</td>
<td>webkit-column-span</td>
<td>Supported</td>
</tr>
<tr>
<td>CSS3 Property</td>
<td>Firefox</td>
<td>Chrome</td>
<td>Safari</td>
<td>Opera</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
<td>--------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>column-width</td>
<td>moz-column-width</td>
<td>webkit-column-width</td>
<td>webkit-column-width</td>
<td>Supported</td>
</tr>
<tr>
<td>column-fill</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>break-after</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>break-before</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>break-inside</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
</tbody>
</table>

**Transitions**

<table>
<thead>
<tr>
<th></th>
<th>Firefox</th>
<th>Chrome</th>
<th>Safari</th>
<th>Opera</th>
</tr>
</thead>
<tbody>
<tr>
<td>transition</td>
<td>Supported</td>
<td>Supported</td>
<td>webkit-transition</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-property</td>
<td>Supported</td>
<td>Supported</td>
<td>webkit-transition-property</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-duration</td>
<td>Supported</td>
<td>Supported</td>
<td>webkit-transition-duration</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-timing-function</td>
<td>Supported</td>
<td>Supported</td>
<td>webkit-transition-timing-function</td>
<td>Supported</td>
</tr>
<tr>
<td>transition-delay</td>
<td>Supported</td>
<td>Supported</td>
<td>webkit-transition-delay</td>
<td>Supported</td>
</tr>
</tbody>
</table>

**User Interface**

<table>
<thead>
<tr>
<th></th>
<th>Firefox</th>
<th>Chrome</th>
<th>Safari</th>
<th>Opera</th>
</tr>
</thead>
<tbody>
<tr>
<td>resize</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>border-box</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>outline-offset</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>appearance</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>

**Gradients**

<table>
<thead>
<tr>
<th></th>
<th>Firefox</th>
<th>Chrome</th>
<th>Safari</th>
<th>Opera</th>
</tr>
</thead>
<tbody>
<tr>
<td>linear-gradient</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
</tbody>
</table>
### A. CSS Support Matrix for Browsers

<table>
<thead>
<tr>
<th>CSS3 Property</th>
<th>Firefox</th>
<th>Chrome</th>
<th>Safari</th>
<th>Opera</th>
</tr>
</thead>
<tbody>
<tr>
<td>radial-gradient</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>repeating-linear-gradient</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>repeating-radial-gradient</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
</tbody>
</table>
CSS Class Mapping

This section contains two lists. One is a list of IBI classes that are used to style various components and controls. The second list contains the IBI classes and how they are defined in the Default_Theme.css file and IBI.css file. The IBI.css file is the file that is used for the default Information Builders theme.

**In this appendix:**
- CSS Class Mapping List

### CSS Class Mapping List

The following is a list of components and controls and the classes used to style them.

**Note:** The IBIfield class is not used in new HTML pages but can still be used if it is present in existing HTML pages. It was defined in the Default_Theme.css for font size and family. This section presents the following information as if it were being used in a new HTML page and does not list the IBIfield class.

<table>
<thead>
<tr>
<th>Components/Controls</th>
<th>Classes Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Body</td>
<td>IBI_PageBg</td>
</tr>
<tr>
<td>Report</td>
<td>IBI_Report-iFrame; IBI_rounded_m</td>
</tr>
<tr>
<td>Chart</td>
<td>IBI_Report-iFrame; IBI_rounded_m</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>IBI_LinkItem</td>
</tr>
<tr>
<td>Button</td>
<td>IBI_button</td>
</tr>
<tr>
<td>Reset</td>
<td>IBI_button</td>
</tr>
<tr>
<td>Label</td>
<td>IBI_ReportControlLabel</td>
</tr>
<tr>
<td>Form</td>
<td>IBI_ReportControlPanel; IBI_rounded_m</td>
</tr>
<tr>
<td>Components/Controls</td>
<td>Classes Used</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Submit Button</td>
<td>IBI_button; IBI_btn-run</td>
</tr>
<tr>
<td>Reset Button</td>
<td>IBI_button; IBI_btn-reset</td>
</tr>
<tr>
<td>Save Selection Button</td>
<td>IBI_btn-saveselection</td>
</tr>
<tr>
<td>Defer Button</td>
<td>IBI_btn-defer</td>
</tr>
<tr>
<td>Schedule Button</td>
<td>IBI_btn-schedule</td>
</tr>
<tr>
<td>Panel</td>
<td>IBI_Panel; IBI_rounded_m</td>
</tr>
<tr>
<td>Map</td>
<td>IBI_ReportControlTarget</td>
</tr>
<tr>
<td>Frame</td>
<td>IBI_rounded_m</td>
</tr>
<tr>
<td>Edit box</td>
<td>IBI_ReportControlTarget; IBI_rounded_s</td>
</tr>
<tr>
<td>Drop down</td>
<td>IBI_ReportControlTarget; IBI_rounded_s</td>
</tr>
<tr>
<td>List Box</td>
<td>IBI_ReportControlTarget; IBI_rounded_s</td>
</tr>
<tr>
<td>Double List</td>
<td>Clearfloats</td>
</tr>
<tr>
<td>Radio Button</td>
<td>IBI_ReportControlTarget; IBI_Radio</td>
</tr>
<tr>
<td>Check Box</td>
<td>IBI_ReportControlTarget; IBI_CheckBox</td>
</tr>
<tr>
<td>Text Area</td>
<td>IBI_rounded_m</td>
</tr>
<tr>
<td>Single Source Tree</td>
<td>IBI_ReportControlTarget</td>
</tr>
<tr>
<td>Multi Source Tree</td>
<td>IBI_ReportControlTarget</td>
</tr>
<tr>
<td>Horizontal Slider</td>
<td>IBI_ReportControlTarget; IBI_rounded_s; IBI_SliderInput; IBI_buttonSliderNav; IBI_btn-left; IBI_btn-right; IBI_SliderTrack; IBI_SliderHandle</td>
</tr>
<tr>
<td>Components/Controls</td>
<td>Classes Used</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vertical Slider</td>
<td>IBI_ReportControlTarget; IBI_rounded_s; IBI_SliderInput; IBI_buttonSliderNav;</td>
</tr>
<tr>
<td></td>
<td>IBI_buttonSliderNavVert; IBI_btn-up; IBI_btn-down; IBI_SliderTrack; IBI_SliderTrackVert; IBI_SliderHandle;</td>
</tr>
<tr>
<td></td>
<td>IBI_SliderHandleVert</td>
</tr>
<tr>
<td>Info Window</td>
<td>IBI_InfoWnd; IBI_InfoWndTitleBar; IBI_InfoWndFrame</td>
</tr>
<tr>
<td>Tab</td>
<td>IBI_MultiContentPlugin; IBI_DisplayBlock</td>
</tr>
<tr>
<td>Tab Header</td>
<td>IBI_pageHeader; IBI_pageHeaderLogo</td>
</tr>
<tr>
<td>Left or Right Tab</td>
<td>IBI_pageHeader_Vertical</td>
</tr>
<tr>
<td>TabHeader Top and Bottom</td>
<td>IBI_pageHeaderTab_TopBottom</td>
</tr>
<tr>
<td>TabHeader - Bottom Tab</td>
<td>IBI_pageHeaderTab_Bottom</td>
</tr>
<tr>
<td>TabHeader - Left Tab</td>
<td>IBI_pageHeaderTab_Left</td>
</tr>
<tr>
<td>TabHeader - Right Tab</td>
<td>IBI_pageHeaderTab_Right</td>
</tr>
<tr>
<td>Tab Selected</td>
<td>IBI_pageHeader_Selected</td>
</tr>
<tr>
<td>Left or Right Tab Selected</td>
<td>IBI_pageHeaderVertical_Selected</td>
</tr>
<tr>
<td>Tab Heading Text</td>
<td>IBI_pageHeaderText</td>
</tr>
<tr>
<td>Tab Heading Text - Left Tab</td>
<td>IBI_textVerticalTopToBottom</td>
</tr>
<tr>
<td>Tab Heading Text - Right Tab</td>
<td>IBI_textVerticalBottomToTop</td>
</tr>
<tr>
<td>Tab Content</td>
<td>IBI_pageContent</td>
</tr>
<tr>
<td>Tab Content - Top</td>
<td>IBI_pageContentTab_Top</td>
</tr>
<tr>
<td>Tab Content - Bottom</td>
<td>IBI_pageContentTab_Bottom</td>
</tr>
<tr>
<td>Tab Content - Left</td>
<td>IBI_pageContentTab_Left</td>
</tr>
<tr>
<td>Tab Content - Right</td>
<td>IBI_pageContentTab_Right</td>
</tr>
</tbody>
</table>
### Components/Controls

<table>
<thead>
<tr>
<th>Classes Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accordion Header Horizontal</td>
</tr>
<tr>
<td>Accordion Content Horizontal</td>
</tr>
<tr>
<td>Accordion Content Vertical</td>
</tr>
<tr>
<td>Window Content</td>
</tr>
<tr>
<td>Tab/Accordion/Window</td>
</tr>
</tbody>
</table>

### Classes Used

<table>
<thead>
<tr>
<th>Classes Used</th>
<th>Default_Theme.css</th>
<th>IBI.css</th>
</tr>
</thead>
<tbody>
<tr>
<td>body</td>
<td>Background, color, and</td>
<td>Not defined</td>
</tr>
<tr>
<td></td>
<td>font</td>
<td></td>
</tr>
<tr>
<td>IBl_btn-reset</td>
<td>Background image</td>
<td>Background image</td>
</tr>
<tr>
<td>IBl_btn-run</td>
<td>Background image</td>
<td>Background image</td>
</tr>
<tr>
<td>IBlbtn_up</td>
<td>Background image</td>
<td>Background image</td>
</tr>
<tr>
<td>IBlbtn_down</td>
<td>Background image</td>
<td>Background image</td>
</tr>
<tr>
<td>IBlbtn_right</td>
<td>Background image</td>
<td>Background image</td>
</tr>
<tr>
<td>IBlbtn_left</td>
<td>Background image</td>
<td>Background image</td>
</tr>
<tr>
<td>IBl btn-saveselection</td>
<td>Background image</td>
<td>Background image</td>
</tr>
<tr>
<td>IBl_btn-defer</td>
<td>Background image</td>
<td>Background image</td>
</tr>
<tr>
<td>Classes Used</td>
<td>Default_Theme.css</td>
<td>IBI.css</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>IBI_btn-schedule</td>
<td>Background image</td>
<td>Background image</td>
</tr>
<tr>
<td>IBI_Report-iFrame</td>
<td>Not defined</td>
<td>Border</td>
</tr>
<tr>
<td>IBI_rounded_m</td>
<td>Not defined</td>
<td>Border-radius - 5px</td>
</tr>
<tr>
<td>IBI_rounded_s</td>
<td>Not defined</td>
<td>Border-radius - 3px</td>
</tr>
<tr>
<td>IBI_button</td>
<td>Background color, background position, height and width</td>
<td>Background image, color, text align, border and border-radius</td>
</tr>
<tr>
<td>IBI_ReportControlPanel</td>
<td>Background image and border</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_ReportControlTarget</td>
<td>Font size</td>
<td>Background color and color</td>
</tr>
<tr>
<td>IBI_Panel</td>
<td>Not defined</td>
<td>Border</td>
</tr>
<tr>
<td>IBI_Radio</td>
<td>Not defined</td>
<td>Background color</td>
</tr>
<tr>
<td>IBI_CheckBox</td>
<td>Not defined</td>
<td>Background color</td>
</tr>
<tr>
<td>IBI_SliderInput</td>
<td>Float, width, height, margin and clear</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_buttonSliderNav</td>
<td>Width, height, float, background-position, margin and cursor</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_SliderTrack</td>
<td>Float, height, margin, background-color</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_SliderHandle</td>
<td>Float, height, width and background-color</td>
<td>Background image, color, text align, border and border-radius</td>
</tr>
<tr>
<td>IBI_buttonSliderNavVert</td>
<td>Clear and margin</td>
<td>Not defined</td>
</tr>
<tr>
<td>Classes Used</td>
<td>Default_Theme.css</td>
<td>IBI.css</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>IBI_SliderTrackVert</td>
<td>Width, clear and margin-right</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_MultiContentPlugin</td>
<td>Border, overflow, margin and position</td>
<td>Background color and border</td>
</tr>
<tr>
<td>IBI_pageHeader</td>
<td>Background color, padding, height, margin and border</td>
<td>Background image, color, border top left and right radius</td>
</tr>
<tr>
<td>IBI_pageHeader_Vertical</td>
<td>Not defined</td>
<td>Border bottom left radius and background image</td>
</tr>
<tr>
<td>IBI_pageHeaderTab_TopBottom</td>
<td>Width, float and margin</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_pageHeaderAccordion_Horizontal</td>
<td>Width, float, padding and height</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_pageHeaderTab_Bottom</td>
<td>Not defined</td>
<td>Border bottom right and left radius</td>
</tr>
<tr>
<td>IBI_pageHeaderTab_Left</td>
<td>Not defined</td>
<td>Border top left and bottom left radius</td>
</tr>
<tr>
<td>IBI_pageHeaderTab_Right</td>
<td>Not defined</td>
<td>Border top right and bottom right radius</td>
</tr>
<tr>
<td>IBI_pageHeader_Selected</td>
<td>Background color and display</td>
<td>Background image</td>
</tr>
<tr>
<td>IBI_pageHeaderVertical_Selected</td>
<td>Width, float and margin</td>
<td>Background image</td>
</tr>
<tr>
<td>IBI_pageHeaderLogo</td>
<td>Height, min-width, background image, and background position</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_pageHeaderText</td>
<td>Font size and position</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_textVerticalTopToBottom</td>
<td>Rotate and scale</td>
<td>Not defined</td>
</tr>
<tr>
<td>Classes Used</td>
<td>Default_Theme.css</td>
<td>IBI.css</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>IBI_textVerticalBottomToTop</td>
<td>Rotate and scale</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_pageContent</td>
<td>Position, display, and overflow</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_pageContentTab_Top</td>
<td>Border-top</td>
<td>Border-top</td>
</tr>
<tr>
<td>IBI_pageContentTab_Bottom</td>
<td>Border-bottom</td>
<td>Border-bottom</td>
</tr>
<tr>
<td>IBI_pageContentTab_Left</td>
<td>Border-left</td>
<td>Border-left</td>
</tr>
<tr>
<td>IBI_pageContentTab_Right</td>
<td>Border-right</td>
<td>Border-right</td>
</tr>
<tr>
<td>IBI_pageContentAccordion_Horizontal</td>
<td>Float</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_pageContentAccordion_Vertical</td>
<td>Float</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_pageContentWnd</td>
<td>Not defined</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_windowNavBox</td>
<td>Width, height, position, background color, and cursor</td>
<td>Background image, border, opacity, and border-bottom-left-radius</td>
</tr>
<tr>
<td>IBI_windowNav</td>
<td>Width, height, float and cursor</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_windowMaxRestore</td>
<td>Margin-right</td>
<td>Margin-right</td>
</tr>
<tr>
<td>IBI_windowMaximize</td>
<td>Background-image</td>
<td>Background-image</td>
</tr>
<tr>
<td>IBI_windowMinimize</td>
<td>Background-image</td>
<td>Background-image</td>
</tr>
<tr>
<td>IBI_windowTiles</td>
<td>Background-image</td>
<td>Background-image</td>
</tr>
<tr>
<td>IBI_windowFlipRight</td>
<td>Background-image</td>
<td>Background-image</td>
</tr>
<tr>
<td>IBI_windowFlipLeft</td>
<td>Background-image</td>
<td>Background-image</td>
</tr>
<tr>
<td>IBI_InfoWnd</td>
<td>Border-radius, position, border, and background color</td>
<td>Border-radius, border, background color, and background-image</td>
</tr>
<tr>
<td>Classes Used</td>
<td>Default Theme.css</td>
<td>IBI.css</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>IBI_InfoWndTitleBar</td>
<td>Border-bottom-right-radius, border-bottom-left-radius, position, width, and height</td>
<td>Border-bottom-right-radius and border-bottom-left-radius</td>
</tr>
<tr>
<td>IBI_InfoWndFrame</td>
<td>Width and height</td>
<td>Radius</td>
</tr>
<tr>
<td>IBI_DisplayNone</td>
<td>Display</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_DisplayBlock</td>
<td>Display</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_PageBg</td>
<td>Font size and family</td>
<td>Commented</td>
</tr>
<tr>
<td>IBI_LinkItem</td>
<td>Not defined</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_Draggable</td>
<td>Not defined</td>
<td>Not defined</td>
</tr>
<tr>
<td>IBI_Resizable</td>
<td>Not defined</td>
<td>Not defined</td>
</tr>
</tbody>
</table>
### Glossary

<table>
<thead>
<tr>
<th><strong>active report</strong></th>
<th>An active report is a self-contained report that is designated for offline analysis. It contains all of the data and JavaScript within the output file.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active Technologies Dashboard</strong></td>
<td>An HTML form with one or more active report procedures, and controls to mimic active report menu options, to allow global modification of multiple active reports in HTML pages.</td>
</tr>
<tr>
<td><strong>chaining</strong></td>
<td>Enables you to populate controls based on the selected value from the prior control in the chain. You can chain static and dynamic controls, link or unlink parts of a chain, and create conditions on links in a chain. Chains are represented by lines connecting control objects on the Parameters tab. When you click the arrowhead in a link of a chain, the Properties and Settings dialog box opens. You can modify and set properties and conditions of the chain.</td>
</tr>
<tr>
<td><strong>component</strong></td>
<td>Objects that you can insert into the HTML page, for example, a report, graph, or image.</td>
</tr>
<tr>
<td><strong>control</strong></td>
<td>A control supplies a list of possible values, except in the instance of a text box, where the user supplies the value. A control enables you to prompt users for a parameter value. You can also add an input control and bind it to a parameter, using the Parameters tab.</td>
</tr>
<tr>
<td><strong>dashboard</strong></td>
<td>See Active Technologies Dashboard.</td>
</tr>
<tr>
<td><strong>Design tab</strong></td>
<td>A tab at the bottom of the HTML Composer window. You can add and position objects on the page layout.</td>
</tr>
</tbody>
</table>
### Document Composer
A Developer Studio tool. Document Composer allows you to coordinate and distribute layouts made up of multiple reports and graphs in a single document. For more information, see the *Creating Compound Reports With Document Composer* manual.

### Embedded JavaScript tab
A tab at the bottom of HTML Composer that displays the HTML code and the JavaScript code for objects in the HTML layout.

### form
See page layout.

### graph
A graphical representation of data within a Master File. You can use the Graph tool to create graphs, which can be inserted in the page layout.

### Graph tool
A Developer Studio application, in which you can create and style complex graphs.

### latitude/longitude coordinates
Fields that must be in a report for a map to point to specific locations.

### maps
A component you can insert into an HTML page. You can use either ESRI JavaScript, Bing, or Google maps.

### object
Any component, parameter, or control that is on the Design View or Parameters View.

### page layout
An individual document, or page, that displays images, drawing objects, text, page settings, reports, and graphs. You can save this pre-styled page and reuse it as a template, or make it available to others.
**Parameters tab**

A tab at the bottom of the HTML Composer window that you can use to create and modify parameter values, input controls, and customize parameter conditions. You can also bind parameters to controls and chain controls to one another.

**Properties and Settings dialog box**

This dialog box enables you to change the settings of components, controls, and parameters. When you select an object, or when an object is added to the canvas, the settings for that object display in the Properties and Settings dialog box. This dialog box opens when you select an object in the Design View or the Parameters View.

**Properties window**

Shows the properties of the object or objects you selected. For example, if you select a hyperlink, the Properties window shows the properties of the hyperlink. General properties for the entire HTML page are shown when no object is selected. The Events subtab displays the JavaScript events associated with objects in the layout.

**Report**

A component you can insert into the page layout. A visual representation of data within a Master File. You can use Report Painter to create reports.

**Report Painter**

A Developer Studio tool that you can use to create and style complex reports. You can design the report in the Report Painter window, a graphical representation of the report page.

**ReportCaster schedule**

A control that adds a schedule button in the HTML Composer page layout. A schedule button enables you to schedule a report or graph, using ReportCaster. Once you have created the schedule, you can access ReportCaster to edit information about the schedule.
| **RIA (Rich Internet Application)** | Enables you to create an interactive webpage. Using RIA, you can generate the look and feel of a Windows-based graphical user interface in your web applications. RIAs provide rich and powerful graphics and themes. You may set a RIA theme and animation properties for objects in the Design tab of HTML Composer. Additionally, you may convert an existing page to a RIA or create a new page as a RIA. |
| **template** | You can use templates to standardize the layout and theme of HTML pages. Templates provide report and chart frames, a form for controls, text boxes, and other objects arranged in a fixed layout that simplifies the design process. You only have to provide information for the objects to create an HTML page that is ready to use. Controls cannot be added manually, they must come from parameters in the reports and charts. If you build a page using templates, you will not be able to freely arrange objects or add controls manually. |
| **Visual Discovery** | A type of control. Visual Discovery creates graphs using a tab-delimited data file as input. |
Index

.fex file 576
//TODO 120, 127
&COORDINATES parameter 493

A

accessing HTML Composer 27, 331
accordion controls 440
active charts 394
active dashboards
distributing 411
exporting 409
scheduling 411
ActiveX Properties 539
button 539
Add Data Pool 539
Add Move Items control 181
Add Paging control 185
Add Search control 191
adding a data source 538
adding data 538
adding data pools 538
adding objects to HTML pages 36, 37, 38, 44, 45,
50, 52, 57, 62, 65, 67, 68, 69, 74, 75
frames 44, 45
graphs 37, 38
group boxes 67, 68
hyperlinks 62, 65
images 52
lines 50
push buttons 69
reports 37, 38
reset buttons 74	tab controls 75
text 57
adding text 57
Text Properties window 57

B

background color 541
background images 84, 85
bar charts
animating data 555, 556
primary order 556
secondary order 556
binding active reports 393
binding buttons 247
binding objects 393, 394
Button Properties window 73

C

calculated values 625
calendars 235, 241
Cascading Style Sheets 272
categorical color scale 546
chain controls 355, 358, 360, 378, 385
populating 385
reversing the order 360
chaining 222, 351, 352, 359, 364, 367, 378
automatic 352
breaking chains 359
chaining (continued)
  conditions 364
  controls 351
  example 378
  logic 364
  new conditions 367
  removing links 359
  tree controls 222

chaining into a Visual Discovery control 564

changing the layout 641

Check Box Properties window 201
check boxes
  supplying parameter values 198

circle brush selector 551

circle selector 551

color 541, 542, 546
  graph elements 542
  using a field 546

Color By 547

color scale 543

Colors tab 543

component element colors 543

Components toolbar 31

conditions
  actions 368
  cache processing 377
  multiselect operator 369
  new 367
  parameter compare operators 376
  resolving parameters 375
  values compare operator 368

control names 538

controls (continued)
  changing 163
  check boxes 198
  defer button 308
  drop-down lists 173
  list boxes 178
  populating 247
  radio buttons 201
  supplying parameter values 98, 158
  text boxes 167
  types 164

Create controls for all Parameters 161

creating a data constellation with a map 585

creating a data file 533

creating an HTML file 577

custom procedures 133

customizing colors 542

customizing HTML pages 274

D

dashboards 536

data 538

data files 533, 576

data filtering 627

data pool 538

data sources 617

Data tab 540
  icons 540

defer button 308

Delete Container Only option 165

deleting objects 398

designing user interfaces 25

Developer Studio Explorer 616

developing a dashboard 533, 536
Double List Box Properties window 185
double list control 181
drill-down outputs 621, 640
Drop Down List Properties window 175, 178
drop-down lists 173, 175, 178
   Drop Down List Properties window 178
   multiple values 175
   supplying parameter values 173
dynamic calendars 235
dynamic values 118

E
Embedded JavaScript tab 558
embedded procedures 206
equalized color scale 546
Events subtab 88
everything value option 115
excluding data 567
Export as Procedure 410, 411
   limitations 411
Expression Builder 627
external reports 260, 261

F
fields
   coloring data by 546
filters 619
flicker-free drawing 551
Form Settings dialog box 291, 298
   Add defer button 291
   Add schedule button 291
   Default slider control type 291
   Number of columns 291
   Start each chain on a new line 291
   Vertical distance between controls 291
format conversions for format VISDIS 534
FORMAT VISDIS 533
formatting reports 630, 631
formatting text 58
Formatting toolbar 35, 83
Frame Properties window 44, 45, 50, 51
frames 44, 45, 46, 50, 51
   adding to HTML pages 44, 45
   Frame Properties window 44, 45, 50, 51
   hiding 46
   showing 46
full screen mode 77

G
getting started 26
global search and paging option 193
goal lines 554, 555
   adding 554
   hiding 555
   moving 555
   removing 555
   selecting values 555
Google Maps 463, 464, 466, 469, 474, 477, 480,
   488, 492, 493, 497, 503, 506, 510, 511,
   513, 517, 519, 520
   API license key 464
   bullseye charts 517
   center location 474
   clearing and removing shape selectors 519
   combination of marker selection methods 510
   customizing 480, 488
   freehand polygons 513
   inserting 477
   integrating WebFOCUS 492
   latitude/longitude coordinates 466
   marker fields 469
   marker visibility 510
   N-sided polygons 513
   polygon shape selectors 520
   polygons 513
Google Maps (continued)
  rectangle polygons 513
  refreshing 511
  shape selection 506
  showing and hiding markers 510
  ToolTip fields 469
  updating a WebFOCUS report 493
  updating with JavaScript commands 497
  WebFOCUS features and functionality 503
  WebFOCUS procedures 466

graph element colors 542
Graph Properties window 40, 41
graphs 37, 38, 40, 41, 42, 43, 619
  adding to HTML pages 37, 38
  Graph Properties window 40, 41
  headings for 619
  limiting data in 619
  Manage Layout dialog box 42, 43
  modifying components 42, 43
  selecting components 42
  selection criteria for 619
  styling 619
gray color scale 546
green/red color scale 546
Group Box Properties window 67, 68, 69
  adding to HTML pages 67, 68
  Group Box Properties window 67, 68
  grouping objects 286

H

headings and footings 139
headings for graphs 619
headings for reports 630
hidden parameters 243
HTML Composer 537
HTML Composer Visual Discovery integration 547

HTML files
  loading screens 323
HTML forms
  converting to FOCUS procedure 410
  exporting 409
HTML pages 25, 36, 50, 272, 273, 274, 285, 286
  adding lines 50
  creating 25
  customizing 274
HTML Page Properties window 273
  laying out objects 285, 286
  layout 285
  properties 273
  styling 272
  templates 272
  themes 272
HTML templates 272
Hyperlink Properties dialog box 70
hyperlinks 62, 65, 67, 247, 261, 305
  adding to HTML pages 62, 65
  adding to text 65
  binding 247
  images 67
  properties 305
  push buttons 67
  supplying parameter values 261

| ibComposer_enableHtmlElement 319 |
| ibComposer_execute 317 |
| ibComposer_getCurrentSelection 313, 314, 315, 526, 527, 528, 529 |
| ibComposer_isSelected 317 |
| ibComposer_ResetDownChainControls 319 |
| ibComposer_selectTab 320, 321 |
| ibComposer_setCurrentSelection 316 |
| ibComposer_showHtmlElement 318 |
| icons in Data tab 540 |
iframe 46
ignore value option 114
Image Properties window 52, 54
images 52, 67, 247, 260, 641
adding to HTML pages 52
adding to reports 641
binding 247
hyperlinks 67
Image Properties window 52
supplying parameter values 260
input controls 166, 427
interface 28

J
JavaScript code 313

L
label color 541
Label Properties window 88
labels 87, 88, 557, 558
hiding 558
in bar, line, and pie charts 557
inserting 87
Label Properties window 88
showing 558
lasso selector 551
latitude/longitude coordinates in Google Maps 466
launch pages 634
line charts
animating data 555, 556
primary order 556
secondary order 556
lines 50, 51
adding to HTML pages 50
Frame Properties window 51
List Box Properties window 180
list boxes 178, 180, 181, 185
Double List Box Properties window 185
List Box Properties window 180
reordering values 181
supplying parameter values 178
loading screens 323
Location Animator 448

M
Maintain procedures 74
Manage Layout dialog box 42, 43
mask text property 168
Master Files 616
minimizing window controls 439
multiple tab controls 80
multiple-layer forms 159

N
naming conventions 538
New Parameters dialog box 159, 220, 352

O
object relationships 285, 286, 287
breaking 286
grouping objects 286
Positioning toolbar 287
setting distance 285
setting size 285
On Demand Paging 426
onafterload 323
onbeforeload 322
Opacity Animator 449
order 556
primary 556
order (continued)
  secondary 556
output formats 533
overlay text color 541

P

  adding filters 130
  amper variables 159
  binding 164
  check boxes 198
  controls 158
  creating 97
  custom procedures 133
  customizing 637
  default 151
  drop-down lists 173
  duplicate values 132
  dynamic 118, 123, 130, 133, 151
  dynamic list 98
  everything value option 115
  from a procedure 116
  hidden 243
  hyperlink actions 245
  ignore value option 114
  importing 117
  list boxes 178
  list options 138
  Parameters (Dynamic Values) tab 119
  Parameters (Static Values) window 102
  Parameters tab 98
  populating fields 138
  radio buttons 201
  sending display values 139
  sorting 131
  static 102, 112
  static list 98
  supplying 158
  text areas 171

parameter values (continued)
  text boxes 167
  unbound 99
parameter values in active reports 400
parameterized procedure 559
Parameters (Dynamic Values) tab 119
Parameters (Static Values) window 102
Parameters tab 98, 132, 358, 637
  Check for duplicate values 132
passing between a Visual Discovery control and a report 559
pastel color scale 546
PCHOLD FORMAT VISDIS 576
pie charts
  animating data 555, 556
  primary order 556
  secondary order 556
populating controls 247
Positioning toolbar 287
preselecting values 558
primary order 556
properties 397
Properties and settings 539
Properties and settings dialog box
  bound parameters 107, 122
  Check for duplicate values 132
  conditions 364
  dynamic values 119
  incoming static parameter 102
  unbound control 102
  unbound parameters 104
Properties and settings dialog box for active reports 400
Properties subtab 88
Properties window
  moving 91
Push Button Properties window 73
push buttons 67, 69, 70, 73, 258
adding to HTML pages 69
hyperlinks 67
Push Button Properties window 73
supplying parameter values 258

R
radio buttons 201
supplying parameter values 201
Radio Buttons Properties window 205
rainbow color scale 546
re-apply color to field 546
rectangle selector 551
rectangular brush selector 551
refreshing active reports 407
Remove Data Pool 539
report layouts 621
Report Library
creating a dynamic list of values 421
creating a static list of values 414
Custom library 421
hyperlink properties 414, 421
integration 413
Show versions option 421
Report Options dialog box 427
Report Painter 158, 426, 623
Report Properties window 40, 41
ReportCaster schedule page 300, 307
reports 36, 37, 38, 40, 42, 43, 308, 396, 397, 427,
493, 621, 622, 625, 630, 631, 634, 641, 643
adding calculated values to 625
adding images to 641
adding to HTML pages 37, 38
drill-down 634
formatting 621, 622, 630, 631
headings for 630
layout 36

reports (continued)
Manage Layout dialog box 42, 43
modifying components 42, 43
On Demand Paging 427
properties 397
Report Properties window 40
running 643
running deferred 308
selecting components 42
synchronized 396
Table of Contents 427
updating Google Map location 493
Reset Button Properties window 75
reset buttons 74
resizing objects 285
restoring data 567
returning a range of dates 242
RIA Components toolbar 435, 440
Rich Internet Applications (RIA) 431, 432, 433, 435,
454, 456
adding components 433
animating objects 433
applying themes 432
creating pages 433
demonstration 456
usage notes 454
window components 435
running deferred reports 308

S
Save Selection button 34
Schedule button 300, 303
manually adding 303
schedule capabilities 300
schedule page 305, 307
default template 305
search control 191
secondary order 556
selecting data 538
Selecting tab 551
selection options 550
Single source Tree control 216
single-layer forms 159
Size Animator 449
slider bars 231
Slider Control Properties window 234
slider controls 231, 233
   changing the default 233
smallest values are high priority option 546
standard tool element colors 543
Standard toolbar 30
static parameters
   importing 117
static values 102
Style Composer 46, 85, 275, 276, 277, 278, 279,
   281, 282, 283, 284
   background properties 277
   edge styles 282
   font styles 276
   interface effects 284
   layout styles 281
   list styles 283
   position mode 279
   text styles 278
submit buttons 69, 70
supplying parameter values
   hyperlinks 261
   images 260
   push buttons 258
synchronized reports 396
synchronizing active reports 393
synchronizing objects 393, 394

T

   tab body 86
      adding components 86
   tab controls 75, 76, 77, 80, 82, 83
      formatting 83
      full screen mode 77
      location 83
      multiple 80
      properties 82
      size 83
   tab edges 83
   tab items 84, 85
      background images 85
Table of Contents options 426
target frames 640
text
   adding to HTML pages 57
Text Area Properties window 173
text areas 171
   supplying parameter values 171
Text Box Properties window 167, 170
text boxes 167, 168, 170
   masked text 168
   properties 170
Text Properties window 57, 62
thermal color scale 546
Thumbnails tab 88
TOC data type 427
TOC objects 427
toolbars 28, 30, 31, 35, 287, 435
   Components 31
   Formatting 35
   Positioning 287
   RIA Components 435
   Standard 30
tree controls 205, 208, 216, 220, 222, 230
   chaining 222
   creating new controls 220
   multi source 208
   properties 230
tree controls (continued)
  static values 216
tutorial 615

U

Unbound Parameters box 164
using color 541

V

Variable Editor 627
Vis button 537
VisDis Color By 547
VISDIS format 533
Visual Discovery
  button 537
Visual Discovery (continued)
  Exclude 567
  format 533
  restore 567
Visual Discovery controls 537, 564
  chaining 564

W

web features 569
WebFOCUS Administration Console 464
Where statements 627
Where tab 627
Where/If button 627
window controls 439
  minimizing 439
working on the web 569
Customer Connections

Where users partner with Information Builders to provide feedback and create quality documentation.

Partner With Us

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also join a usability study to get an early look at new documentation products and services. Your participation helps us create documentation products that meet your needs.

To send us feedback or make a customer connection, contact Michele Brady, Service Director, Technical Content Management at Michele_Brady@ibi.com.

Request Permission to Use Copyright Material

To request permission to repurpose copyrighted material, please contact Frances Gambino, Vice President, Technical Content Management at Frances_Gambino@ibi.com.

Visit the Information Builders Technical Content Library

To visit the Technical Content Library, go to http://documentation.informationbuilders.com/.